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Develop your applications quickly and easily with the
world's most intuitive mikroPascal PRO for PIC
Microcontrollers.

Highly sophisticated IDE provides the power you need with
the simplicity of a Windows based point-and-click
environment.

With useful implemented tools, many practical code
examples, broad set of built-in routines, and a
comprehensive Help, mikroPascal PRO for PIC makes a
fast and reliable tool, which can satisfy needs of
experienced engineers and beginners alike.
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DISCLAIMER:

mikroPASCAL PRO for PIC and this manual are owned by mikroElektronika and are pro-
tected by copyright law and international copyright treaty. Therefore, you should treat this
manual like any other copyrighted material (e.g., a book). The manual and the compiler
may not be copied, partially or as a whole without the written consent from the mikroEelk-
tronika. The PDF-edition of the manual can be printed for private or local use, but not for
distribution. Modifying the manual or the compiler is strictly prohibited.

HIGH RISK ACTIVITIES:

The mikroPASCAL PRO for PICcompiler is not fault-tolerant and is not designed, manufac-
tured or intended for use or resale as on-line control equipment in hazardous environments
requiring fail-safe performance, such as in the operation of nuclear facilities, aircraft navigation
or communication systems, air traffic control, direct life support machines, or weapons sys-
tems, in which the failure of the Software could lead directly to death, personal injury, or severe
physical or environmental damage ("High Risk Activities"). mikroElektronika and its suppliers
specifically disclaim any express or implied warranty of fithess for High Risk Activities.

LICENSE AGREEMENT:

By using the mikroPASCAL PRO for PIC compiler, you agree to the terms of this agreement.
Only one person may use licensed version of mikroPascal PRO for PIC compiler at a time.
Copyright © mikroElektronika 2003 - 2009.

This manual covers mikroPASCAL PRO for PIC version 1.0 and the related topics.
Newer versions may contain changes without prior notice.

COMPILER BUG REPORTS:
The compiler has been carefully tested and debugged. It is, however, not possible to
guarantee a 100 % error free product. If you would like to report a bug, please contact us at
the address office@mikroe.com. Please include next information in your bug report:

- Your operating system

- Version of mikroPASCAL PRO for PIC

- Code sample

- Description of a bug

CONTACT US:
mikroElektronika

Voice: + 381 (11) 36 28 830
Fax: + 381 (11) 36 28 831
Web: www.mikroe.com
E-mail: office@mikroe.com

Windows is a Registered trademark of Microsoft Corp. All other trade and/or services marks
are the property of the respective owners.
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Introduction to
mikroPascal PRO for PIC

Help version: 2009/03/19

The mikroPascal PRO for PIC is a powerful, feature-rich development tool for PIC
microcontrollers. It is designed to provide the programmer with the easiest possi-
ble solution to developing applications for embedded systems, without compromis-

ing performance or control.
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mikroPascal PRO for PIC IDE
Features
mikroPascal PRO for PIC allows you to quickly develop and deploy complex applications:

- Write your Pascal source code using the built-in Code Editor (Code and Parameter
Assistants, Code Folding, Syntax Highlighting, Auto Correct, Code Templates, and more.)

- Use included mikroPascal PRO for PIC libraries to dramatically speed up the develop-
ment: data acquisition, memory, displays, conversions, communication etc.

- Monitor your program structure, variables, and functions in the Code Explorer.

- Generate commented, human-readable assembly, and standard HEX compatible with
all programmers.

- Use the integrated mikrolCD (In-Circuit Debugger) Real-Time debugging tool to monitor
program execution on the hardware level.

- Inspect program flow and debug executable logic with the integrated Software Simulator.

- Get detailed reports and graphs: RAM and ROM map, code statistics, assembly listing,
calling tree, and more.

- mikroPascal PRO for PIC provides plenty of examples to expand, develop, and use as
building bricks in your projects. Copy them entirely if you deem fit — that's why we includ-
ed them with the compiler.
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Where to Start

- In case that you're a beginner in programming PIC microcontrollers, read carefu-
lly the PIC Specifics chapter. It might give you some useful pointers on PIC
constraints, code portability, and good programming practices.

- If you are experienced in Pascal programming, you will probably want to consult
mikroPascal PRO for PIC Specifics first. For language issues, you can always refer
to the comprehensive Language Reference. A complete list of included libraries is
available at mikroPascal PRO for PIC Libraries.

- If you are not very experienced in Pascal programming, don’t panic! mikroPascal
PRO for PIC provides plenty of examples making it easy for you to go quickly. We
suggest that you first consult Projects and Source Files, and then start browsing
the examples that you're the most interested in.
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MIKROELEKTRONIKA ASSOCIATES LICENSE STATEMENT AND
LIMITED WARRANTY

IMPORTANT - READ CAREFULLY

This license statement and limited warranty constitute a legal agreement (“License
Agreement”) between you (either as an individual or a single entity) and mikroElek-
tronika (“mikroElektronika Associates”) for software product (“Software”) identified
above, including any software, media, and accompanying on-line or printed docu-
mentation.

BY INSTALLING, COPYING, OR OTHERWISE USING SOFTWARE, YOU AGREE
TO BE BOUND BY ALL TERMS AND CONDITIONS OF THE LICENSE
AGREEMENT.

Upon your acceptance of the terms and conditions of the License Agreement,
mikroElektronika Associates grants you the right to use Software in a way provided
below.

This Software is owned by mikroElektronika Associates and is protected by copy-
right law and international copyright treaty. Therefore, you must treat this Software
like any other copyright material (e.g., a book).

You may transfer Software and documentation on a permanent basis provided. You
retain no copies and the recipient agrees to the terms of the License Agreement.
Except as provided in the License Agreement, you may not transfer, rent, lease,
lend, copy, modify, translate, sublicense, time-share or electronically transmit or
receive Software, media or documentation. You acknowledge that Software in the
source code form remains a confidential trade secret of mikroElektronika Associates
and therefore you agree not to modify Software or attempt to reverse engineer,
decompile, or disassemble it, except and only to the extent that such activity is
expressly permitted by applicable law notwithstanding this limitation.

If you have purchased an upgrade version of Software, it constitutes a single prod-
uct with the mikroElektronika Associates software that you upgraded. You may use
the upgrade version of Software only in accordance with the License Agreement.
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LIMITED WARRANTY

Respectfully excepting the Redistributables, which are provided “as is”, without war-
ranty of any kind, mikroElektronika Associates warrants that Software, once updat-
ed and properly used, will perform substantially in accordance with the accompany-
ing documentation, and Software media will be free from defects in materials and
workmanship, for a period of ninety (90) days from the date of receipt. Any implied
warranties on Software are limited to ninety (90) days.

mikroElektronika Associates’ and its suppliers’ entire liability and your exclusive
remedy shall be, at mikroElektronika Associates’ option, either (a) return of the price
paid, or (b) repair or replacement of Software that does not meet mikroElektronika
Associates’ Limited Warranty and which is returned to mikroElektronika Associates
with a copy of your receipt. DO NOT RETURN ANY PRODUCT UNTIL YOU HAVE
CALLED MIKROELEKTRONIKAASSOCIATES FIRST AND OBTAINED ARETURN
AUTHORIZATION NUMBER. This Limited Warranty is void if failure of Software has
resulted from an accident, abuse, or misapplication. Any replacement of Software
will be warranted for the rest of the original warranty period or thirty (30) days,
whichever is longer.

TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW,
MIKROELEKTRONIKA ASSOCIATES AND ITS SUPPLIERS DISCLAIM ALL
OTHER WARRANTIES AND CONDITIONS, EITHER EXPRESSED OR IMPLIED,
INCLUDED, BUT NOT LIMITED TO IMPLIED WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, TITLE, AND
NON-INFRINGEMENT, WITH REGARD TO SOFTWARE, AND THE PROVISION
OF OR FAILURE TO PROVIDE SUPPORT SERVICES.

IN NO EVENT SHALL MIKROELEKTRONIKA ASSOCIATES OR ITS SUPPLIERS
BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT, OR CONSEQUENTIAL
DAMAGES WHATSOEVER (INCLUDING, WITHOUT LIMITATION, DAMAGES
FOR LOSS OF BUSINESS PROFITS AND BUSINESS INFORMATION, BUSINESS
INTERRUPTION, OR ANY OTHER PECUNIARY LOSS) ARISING OUT OF THE
USE OF OR INABILITY TO USE SOFTWARE PRODUCT OR THE PROVISION OF
OR FAILURE TO PROVIDE SUPPORT SERVICES, EVEN IF
MIKROELEKTRONIKAASSOCIATES HAS BEEN ADVISED OF THE POSSIBILITY
OF SUCH DAMAGES. IN ANY CASE, MIKROELEKTRONIKA ASSOCIATES
ENTIRE LIABILITY UNDER ANY PROVISION OF THIS LICENSE AGREEMENT
SHALL BE LIMITED TO THE AMOUNT ACTUALLY PAID BY YOU FOR
SOFTWARE PRODUCT PROVIDED, HOWEVER, IF YOU HAVE ENTERED INTO
A MIKROELEKTRONIKA ASSOCIATES SUPPORT SERVICES AGREEMENT,
MIKROELEKTRONIKA ASSOCIATES’ ENTIRE LIABILITY REGARDING
SUPPORT SERVICES SHALL BE GOVERNED BY THE TERMS OF THAT
AGREEMENT.
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HIGH RISK ACTIVITIES

Software is not fault-tolerant and is not designed, manufactured or intended for use
or resale as on-line control equipment in hazardous environments requiring fail-safe
performance, such as in the operation of nuclear facilities, aircraft navigation or
communication systems, air traffic control, direct life support machines, or weapons
systems, in which the failure of Software could lead directly to death, personal injury,
or severe physical or environmental damage (“High Risk Activities”). mikroElektron-
ika Associates and its suppliers specifically disclaim any expressed or implied war-
ranty of fitness for High Risk Activities.

GENERAL PROVISIONS

This statement may only be modified in writing signed by you and an authorised offi-
cer of mikroElektronika Associates. If any provision of this statement is found void
or unenforceable, the remainder will remain valid and enforceable according to its
terms. If any remedy provided is determined to have failed for its essential purpose,
all limitations of liability and exclusions of damages set forth in the Limited Warran-
ty shall remain in effect.

This statement gives you specific legal rights; you may have others, which vary, from
country to country. mikroElektronika Associates reserves all rights not specifically
granted in this statement.

mikroElektronika
Visegradska 1A,
11000 Belgrade,
Europe.

Phone: + 381 11 36 28 830
Fax: +381 11 36 28 831
Web: www.mikroe.com
E-mail: office@mikroe.com
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TECHNICAL SUPPORT

In case you encounter any problem, you are welcome to our support forums at
www.mikroe.com/forum/. Here, you may also find helpful information, hardware tips,
and practical code snippets. Your comments and suggestions on future develop-
ment of the mikroPascal PRO for PIC are always appreciated — feel free to drop a
note or two on our Wishlist.

In our Knowledge Base www.mikroe.com/en/kb/ you can find the answers to Fre-
quently Asked Questions and solutions to known problems. If you can not find the
solution to your problem in Knowledge Base then report it to Support Desk
www.mikroe.com/en/support/. In this way, we can record and track down bugs more
efficiently, which is in our mutual interest. We respond to every bug report and ques-
tion in a suitable manner, ever improving our technical support.

How to Register

The latest version of the mikroPascal PRO for PIC is always available for download-
ing from our website. It is a fully functional software libraries, examples, and com-
prehensive help included.

The only limitation of the free version is that it cannot generate hex output over 2
KB. Although it might sound restrictive, this margin allows you to develop practical,
working applications with no thinking of demo limit. If you intend to develop really
complex projects in the mikroPascal PRO for PIC, then you should consider the pos-
sibility of purchasing the license key.

Who Gets the License Key

Buyers of the mikroPascal PRO for PIC are entitled to the license key. After you
have completed the payment procedure, you have an option of registering your
mikroPascal. In this way you can generate hex output without any limitations.

How to Get License Key

After you have completed the payment procedure, start the program. Select Help »
How to Register from the drop-down menu or click the How To Register Icon = .
Fill out the registration form (figure below), select your distributor, and click the Send
button.
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[ Hovww To Register El =] @

Step 1. Fill in the form below, Please, make sure yvou fill in all required fields,

Step 2. Make sure that you provided a walid email address in the "EMAIL" edit box. This email will be used for
sending you the activation key.

Step 3. Make sure you select a correct distributor which will malke the registration process faster. If your
distributor is not on the list then select "Other" and type in distributor's email address in the box below,

Step 4. Press the SEMD button to send key request. A default email client will open with ready-to-send rmessage.
Mote: If email client does not open, you may copy text of the message and paste it manually into a new email
message before sending it to your distributor's email.

| NAME* Marko Jovanovic

’W Enter wour address
INWOICE Enter invoice number if available in the Form AA48448 /BB

’m Enter 2CheckOut Order Mumber iF available (10 digits)

,W marko@mikroe, com

’W marko@rmikroe, com

,W Enter company narne

[ PRODUCTID | 515C-557269-6FE072-6755

,W Enter comments on your order

DISTRIBUTDR™ | mikroFlektronika key@rnikroe, com -

* Required fields
I have made the payment and I wish to request activation key For mikroPascal PRG for PIC

Name:
Marko Jovanovic

Address:

Invoice number:

2CheckOut order number:
Company:

E-Mail:
marko@rmikroe, com

Product key:
515C-557269-6F6072-6755

E2) Copy to clipboard [24] sEND Cancel

This will start your e-mail client with message ready for sending. Review the infor-
mation you have entered, and add the comment if you deem it necessary. Please,
do not modify the subject line.

Upon receiving and verifying your request, we will send the license key to the e-mail
address you specified in the form.
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After Receving the License Key

The license key comes as a small autoextracting file — just start it anywhere on your
computer in order to activate your copy of compiler and remove the demo limit. You
do not need to restart your computer or install any additional components. Also,
there is no need to run the mikroPascal PRO for PIC at the time of activation.

Notes:

- The license key is valid until you format your hard disk. In case you need to format
the hard disk, you should request a new activation key.

- Please keep the activation program in a safe place. Every time you
upgrade the compiler you should start this program again in order to
reactivate the license.
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mikroPASCAL PRO for PIC

IDE OVERVIEW

D]

The mikroPascal PRO for PIC is an user-friendly and intuitive environment:

Ele fdt View Project fum Took Help
Y.(he

Bl S

Led_Cud (LCD_CURSOR_OPF) 5
o LED_Ous (1,6, TxEd);
LED_out (2, 6, tXE4) ;
Delay_ma (2000) 2

Led_Crd (LCD_CLEAR) ¢

Mot

Troe0af
Taos
Delay ma (500} 5

B - Led_Gut_CP(Lxtd)

F Prosect Setngs 7
=g@0edken

Mame: |PIEFE07 - e
Rove_Delayi):

Vs 000000 M while TRUE do
megin LD RS: sbet
= Bubt/ Detugom Tips. . !-: ai-‘ to & do
wl egin
Buid Type
e e Led_Coed (LCD_SKIFT L

S

Code Assistant

. nove_Delay():

o . end:

® Sowae D 2

far 1170 ta ¢ do
bogin

) Ervars el warmzs s
s Mg Massage Tt

o 1 BRI, v HSF -00G <E16FG87 UICD-C ¥ L 01 1111114 -f08 4G Frogram Flestpy | 7

LED_But (2,4, txtd) Heite text in sacond fow

3 [

PC= AN Cugles szn

~ [hmbropascsl for PICIDRASY -SICHE

sk 259 1%) From ROM (brtes) 32509 (99%)

3 e Compiea e

- The Code Editor features adjustable Syntax Highlighting, Code Folding, Code
Assistant, Parameters Assistant, Spell Checker, Auto Correct for common typos

and Code Templates (Auto Complete).

- The Code Explorer is at your disposal for easier project management.

- The Project Manager alows multiple project management

- General project settings can be made in the Project Settings window

- Library manager enables simple handling libraries being used in a project

- The Error Window displays all errors detected during compiling and linking.

- The source-level Software Simulator lets you debug executable logic step-by-step

by watching the program flow.

- The New Project Wizard is a fast, reliable, and easy way to create a project.

- Help files are syntax and context sensitive.

- Like in any modern Windows application, you may customize the layout of

mikroPascal PRO for PIC to suit your needs best.

- Spell checker underlines identifiers which are unknown to the project. In this way
it helps the programmer to spot potential problems early, much before the project

is compiled.

Spell checker can be disabled by choosing the option in the Preferences dialog (F12).

12
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MAIN MENU OPTIONS

Available Main Menu options are:

File

Edit

Wigy

Project

Bun

Tools

Help

Related topics: Keyboard shortcuts
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mikroPASCAL PRO for PIC

FILE MENU OPTIONS

The File menu is the main entry point for manipulation with the source files.

[ Wewunit  Chri+n
= Open Chrl+0

Recent Files 4
H szave Ctrl45
H Save As...
i. Close Ctrl4+F4
fa Prink..  Chrl4+P
g Ext Al

File Description
'] Mewlnit ctrl+M |[[Open a new editor window.
2 Open Ctr+2 || Open source file for editing or image file for viewing.
Recert Files * | Reopen recently used file.

H save Ctrl+5 | Save changes for active editor.
B savea Save the active source file with the different name or
: e change the file type.
Tl Close Alt+F4 (| Close active source file.
s Prink... Ckrl+P [ Print Preview.
B Eui alt+% | Exit IDE.

Related topics: Keyboard shortcuts, File Toolbar, Managing Source Files

14
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EDIT MENU OPTIONS

<A Undo Ctr+Z
fr Redo Shift+Ctrl+Z
b Cut Chrl+x
2 Copy Chrl+C
[E Paste Chrl+y
X Delete

Select Al Chrl+a
42 Eind... Chrl+F
b Find Mext F3
43 Find Previous  Shift+F3
)ﬂ Replace. .. Chrl+R,
9] FindinFies...  Ak+F3
%] Gotoline... Ctrl+G

Advanced 3

Edit Description
<3 Undo Ctrl+Z | Undo last change.
fr Redo shift+Ctr4+2 || Redo last change.
j‘:‘h Cuk Ctrl+x% || Cut selected text to clipboard.
= Copy Ctrl+C | Copy selected text to clipboard.
ﬂ-; Paste Ctrl+v || Paste text from clipboard.
> Delete Delete selected text.
Select Al Crel+a || Select all text in active editor.
A2 Eind... Chrl+F | Find text in active editor.
)% Find Mext F3 | Find next occurence of text in active editor.
33 Find Previous  shift+F3 | Find previous occurence of text in active editor.
M2 Replace.., Ctri+R. ||Replace text in active editor.
@ o S Find text in current file, in all opened files, or in files
ind nes... from desired folder.
¢-_'] Goto Line. ., Chrl+G || Goto to the desired line in active editor.
Advanced Advanced Code Editor options
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Advanced » Description
1.1 Comment it Chrle Comment sel_ected code_or put single line com-
ment if there is no selection.
(.1 Uncomment  Shift+Cri+, Uncomme_nt sele(_:ted code or remove single line
comment if there is no selection.
25 Indent shift+Ctrl+I | Indent selected code.
=% Outdent shift+Ctrl+J | Outdent selected code.
A3l Lowercase Ckrl+alk+L | Changes selected text case to lowercase.
af| Uppercase Chrl+alk+0 | Changes selected text case to uppercase.
A Titlecase Ctr+alt+T | Changes selected text case to titlercase.
Find Text

Dialog box for searching the document for the specified text. The search is per-
formed in the direction specified. If the string is not found a message is displayed.

Find Text =23
Search far: -
—options Direction

Case sensitivity @ Forward

whole words only

Search from caret ' Backward

Selected text anly

Regular expression (o] 4 Cancel

16
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Replace Text

Dialog box for searching for a text string in file and replacing it with another text

string.

[1] Replace Text (== ==
Search for: mikroE lektranika -
Beplace with: mikroE -
—Options———— [~ Direction

@ Forward
Whole wards anly
Search from caret - Backward
Selected text anly
Begular expreszion 0k Cancel

Find In Files

Dialog box for searching for a text string in current file, all opened files, or in files on
a disk.

The string to search for is specified in the Text to find field. If Search in directories option
is selected, The files to search are specified in the Files mask and Path fields.

Grep search (=3
Text to find: | [galAe] SIS Tl ot %] -
~options———————————— ~Where

Case sensitive ! Current file

_ All opened files
wrhole words

@ Search in directories

—Search directory options

Files mask: *.* -

Path: C:\Program filesh, -

Include subdirectaries

(o] 4 Cancel
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Go To Line

Dialog box that allows the user to specify the line number at which the cursor should
be positioned.

Go To Line =]

Go To Line Nuber -

QK Cancel

Regular expressions

By checking this box, you will be able to advance your search, through Regular
expressions.

Find Text @
Search for: unsignedyx20int -
—Options———— ~Direction

Case sensitivity @ Forward

Whole words anly

Search from caret § o

Selected text only

(o] 4 Cancel

Related topics: Keyboard shortcuts, Edit Toolbar, Advanced Edit Toolbar
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VIEW MENU OPTIONS

Toolbars 4
Debug Windows 4
T Routine List Chrl+L

Project Settings
T8 Code Explarer
Project Manager  Shift+Chrl+F11
Library Manager
Bookmarks
Messages

Macra Editar

7| Windows

View Description

Toolbars ¥ | Show/Hide toolbars.

Show/Hide Software Simulator/mikrolCD (In-
Circuit Debugger) debug windows.

Debug Windows

T Routines List Show/Hide Routine List in active editor.
Praject Settings Show/Hide Project Settings window.
T2 Code Explorer Show/Hide Code Explorer window.

Project Manager  shift+Ctri+F11 | Show/Hide Project Manager window.

Library Manager Show/Hide Library Manager window.

Bookmarks Show/Hide Bookmarks window.

Messages Show/Hide Error Messages window.

Macro Editor Show/Hide Macro Editor window.
Windows Show Window List window.
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mikroPASCAL PRO for PIC

TOOLBARS

File Toolbar
D& HG H46 &

File Toolbar is a standard toolbar with following options:

Icon

Description

Opens a new editor window.

Open source file for editing or image file for viewing.

Save changes for active window.

Save changes in all opened windows.

LD D] Ge i

Close current editor.

B

Close all editors.

-

Print Preview.

Edit Toolbar
@ IE

Edit Toolbar is a standard toolbar with following options:
Icon Description
43  |Undo last change.

Redo last change.

Cut selected text to clipboard.

Copy selected text to clipboard.

| iy |82

Paste text from clipboard.
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Advanced Edit Toolbar
Lalatotal SRR o)

Advanced Edit Toolbar comes with following options:

15
1

Ll

Icon Description

{.} Comment selected code or put single line comment if there is no selection

. Uncommgnt selected code or remove single line comment if there is
no selection.

M Select text from starting delimiter to ending delimiter.

et Go to ending delimiter.

¢-_'] Go to line.

Indent selected code lines.

Outdent selected code lines.

Generate HTML code suitable for publishing current source code on
d the web.

Find/Replace Toolbar
P RP K|

Find/Replace Toolbar is a standard toolbar with following options:

Icon Description

Find text in current editor.

Find next occurence.

Find previous occurence.

Replace text.

[ =0 | oo

Find text in files.
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mikroPASCAL PRO for PIC

Project Toolbar
i e S o R e i T

Project Toolbar comes with following options:

Icon

Description

New project.

4

Open Project

Save Project

Close current project.

Edit project settings.

Add existing project to project group.

Remove existing project from project group.

Add File To Project

(| [ | G 50 | G| 28| O | 22

Remove File From Project

Build Toolbar
o - T N

Build Toolbar comes with following options:

Icon

Description

Build current project.

Build all opened projects.

E
-

;';J. ﬂ- ‘:}'

Build and program active project.

Start programmer and load current HEX file.

Open assembly code in editor.

Open lisitng file in editor.

B Lk |

View statistics for current project.
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Debugger

@

2By B0 A 0D o] | @ [ &

Debugger Toolbar comes with following options:

Icon Description

Eﬁ, Start Software Simulator or mikrolCD (In-Circuit Debugger).

Bil Run/Pause debugger.
E—?g Stop debugger.

g0 Step into.

) Step over.

S+ Step out.

gl Run to cursor.

= Toggle breakpoint.

Toggle breakpoints.

l‘@t Clear breakpoints.
&

View watch window

; View stopwatch window

Styles Toolbar

Office 2003 Qlive

Office WP
Chocolate
A_rctic:

Styles toolbar allows you to easily customize your workspace.
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Tools Toolbar

N N EN

Tools Toolbar comes with following default options:

Icon Description

Bl |Run USART Terminal
| |EEPROM
A ASCI| Chart

@' Seven segment decoder tool.

E Options menu

The Tools toolbar can easily be customized by adding new tools in Options(F12)
window.

Related topics: Keyboard shortcuts, Integrated Tools, Debugger Windows

24 MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



mikroPASCAL PRO for PIC

CHAPTER 2
Environment

PROJECT MENU OPTIONS

E ¥ & &

(8. iR R g e G0 [

Build Ctrk+Fa
Build &ll Projects shift+F2
Build + Program Zhrl+F11

Wiens Assembly
Edit Search Paths. ..

Clean Project Folder...

Add File To Project. ..

Remaowve File From Project

Import Project.., Zhrl+1

MNew Project. .. Shift-+Chr+M
Open Project...  Shift+Ckr+O
Save Project

Edit Project... Shift+Ckr+E
Open Project Group...

Close Project Group

Save Project As,..

Recent Projects

Close Project
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mikroPASCAL PRO for PIC

Project

Description

Ewild Chrl+-F9

Build active project.

Build &l Projects

Shift+F3

Build all projects.

Build + Program

Chr4+-F11

Build and program active project.

[ [ e |

YWigw Assembly

View Assembly.

Edit Search Paths...

Edit search paths.

Clean Project Falder. ..

Clean Project Folder

4dd File To Project, ..

Add file to project.

Remove File From Project

Remove file from project.

Irnpoart Praject. ..

Chrl+1

Import projects created in previous versions of
mikroPascal.

Mew Project. .,

Open New Project Wizard

Cpen Projeck...  Shift+Ckrl+O

Open existing project.

Save Projeck

Save current project.

Edit Project. ..

Shift+CtrH-E

Edit project settings

Dpen Projeck Group, .,

Open project group.

Close Project Group

Close project group.

| 0B | 8 | o[ OB o | O || e || e[ o |

Save Project As,..

Save active project file with the different name.

Recent Projects

Open recently used project.

Close Project

08

Close active project.

Related topics: Keyboard shortcuts, Project Toolbar, Creating New Project, Project

Manager, Project Settings

26
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RUN MENU OPTIONS

é}; Start Debugger F9

Eﬂa Stop Debugger Chrl+F2

S|} Pauss Debugger Fé&

qxi1 Skep Into F7

d>[] Step Cwer Fg

0 Shep gk Chrl+Fa

@ Jump Ta Interrupt Fz

= | Toaggle Breakpaint FS

i=| Breakpoints Shift+F4

[§, Clear Breakpoints  Shift+Ctrl+FS

& Wakch Window Shift+F3

@-) Wiens Stopwatch

Disassermbly mode Alk+D
Run Description

Ii_h N = Start Software Simulator or mikrolCD (In-Cir-
=i =2mart ehugger cuit Debugger).
|';=E] Stop Debugger Ctrl+Fz | Stop debugger.
[_%JJ Pause Debugger F& |Pause Debugger.
g0} Skep Into F7 |Step Into.
@4, Shep Ower Fa |Step Over.

3 Skep Cuk iCtrl+Fg | Step Out.
qbl Jurnp To Inkerrupt Fz |Jump to interrupt in current project.
E Toggle Breakpoint F5 | Toggle Breakpoint.

i=| Show/Hide Breakpoints  Shift+F4 | Breakpoints.
[ Clear Breaskpoints  Shift+Ctr+FS | Clear Breakpoints.
& Wakch Window Shift+F5 | Show/Hide Watch Window

{f—} YWiew Stopwatch Show/Hide Stopwatch Window

Toggle between Pascal source and disas-
Disassembly mode Ckrl+D s e?ngbly

Related topics: Keyboard shortcuts, Debug Toolbar
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TOOLS MENU OPTIONS

q% mE Programmer F11

Bl USART Terminal Chrl4+T
] EEPROM Editor

| Ascii Chart
@' Seven Segment Converkor
L] Export Code To HTML

LCD Custarn Character

(4 GLCD Bitmap Editor
HID Terminal
UDP Terminal

mikroBoatloader

gl Options F1z
Tools Description
% mE Programmet F11 |Run mikroElektronika Programmer
Bl UsarRT Terminal Ctr4+T |Run USART Terminal
" EEPROM Editar Run EEPROM Editor
A Becii Chart Run ASCII Chart
@' Seven Seqgment Conwverkor Run Seven Segment Convertor

Generate HTML code suitable for publishing

Ll Export Code To HTML source code on the web.

LCD Custom Characker Run Lcd custom character
(9 GLCD Bitmap Editor Run Glcd bitmap editor
HID Terminal Run HID Terminal
LIDP Terminal Run UDP communication terminal
mikroBootloader Run mikroBootloader
& Options Fiz |Open Options window

Related topics: Keyboard shortcuts, Tools Toolbar
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HELP MENU OPTIONS
&) Help F1

Migration Docurnent

Check For Updates
mikroElekkronika Support Forums
miky oElekkronika Web Page

' How To Reqister

About

File Description
& Help F1 |Open Help File.
Migration Document Open Code Migration Document.
Check Far Updates Check if new compiler version is available.

Open mikroElektronika Support Forums in
a default browser.

Open mikroElektronika Web Page in a

mikroElekironika Support Farurms

mikroElekironika \WWeb Page default browser.
2 How To Register Information on how to register
about Open About window.

Related topics: Keyboard shortcuts

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD 29



CHAPTER 2

Environment mikroPASCAL PRO for PIC

KEYBOARD SHORTCUTS

Below is a complete list of keyboard shortcuts available in mikroPascal PRO for PIC IDE.

IDE Shortcuts Ctrl+S Save Unit

F1 Help Ctrl+Shift+S Save All
Ctrl+N New Unit Ctrl+Vv Paste
CtrI+O Open Ctrl+X Cut
Ctrl+Shift+O | Open Project Ctri+Y Delete Entire Line
CtrI+Shift+N  |New Project Ctrl+Z Undo
CtrI+K Close Project Ctrl+Shift+Z Redo
Ctrl+F4 Close unit Advanced Editor Shortcuts
Ctrl+Shift+E | Edit Project Ctrl+Space Code Assistant
Ctrl+F9 Build Ctrl+Shift+Space |Parameters Assistant
Shift+F9 Build All Ctrl+D Find Declaration
Ctrl+F11 Build And Program Ctrl+E Incremental Search
Shift+F4 View Breakpoints Ctrl+L Routine List
Ctrl+Shift+F5 |Clear Breakpoints Ctrl+G Goto Line
F11 Start mE Programmer Ctrl+J Insert Code Template
Ctrl+Shift+F 11 | Project Manager Ctrl+Shift+. Comment Code
F12 Options Ctrl+Shift+, Uncomment Code
Alt + X Close mikroPascal PRO for PIC | [ Ctrl+number Goto Bookmark

Basic Editor Shortcuts Ctrl+Shift+number | Set Bookmark
F3 Find, Find Next Ctrl+Shift+l Indent Selection
Shift+F3 Find Previous Ctrl+Shift+U Unindent Selection
Alt+F3 Grep Search, Find In Files TAB Indent Selection
Ctrl+A Select All Shift+TAB Unindent selection
CtrlI+C Copy Alt+Select Select Columns
Ctrl+F Find Ctrl+Alt+Select Select Columns
CtrI+R Replace CtrlI+Alt+L Convert Selection to Lowercase
CtrlI+P Print CtrlI+Alt+U Convert Selection to Uppercase

30
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mikroPASCAL PRO for PIC Environment
Ctrl+Alt+T Convert to Titlecase
mikrolCD Debugger and Software Simulator

Shortcuts

F2 Jump to Interrupt

F4 Run to Cursor

F5 Toggle Breakpoint

F6 Run/Pause Debugger

F7 Step Into

F8 Step Over

F9 Debug

Ctrl+F2 Stop Debugger

Ctrl+F5 Add to Watch List

Ctrl+F8 Step Out

Alt+D Dissasembly View

Shift+F5 Open Watch Window

Ctrl+Shift+A Show Advanced Breakpoints
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IDE OVERVIEW

The mikroPascal PRO for PIC is an user-friendly and intuitive environment:

0] T

Select varisble bom st #
Vi

Seaich ot vaiab by sasenb) ame:

137 Usec A (s 263 (1%) Free 20 (Bytes): 32508 (20%)

- The Code Editor features adjustable Syntax Highlighting, Code Folding, Code
Assistant, Parameters Assistant, Spell Checker, Auto Correct for common typos
and Code Templates (Auto Complete).

- The Code Explorer is at your disposal for easier project management.

- The Project Manager alows multiple project management

- General project settings can be made in the Project Settings window

- Library manager enables simple handling libraries being used in a project

- The Error Window displays all errors detected during compiling and linking.

- The source-level Software Simulator lets you debug executable logic step-by-step
by watching the program flow.

-The New Project Wizard is a fast, reliable, and easy way to create a project.

- Help files are syntax and context sensitive.

- Like in any modern Windows application, you may customize the layout of
mikroPascal PRO for PIC to suit your needs best.

- Spell checker underlines identifiers which are unknown to the project. In this way
it helps the programmer to spot potential problems early, much before the project
is compiled.

Spell checker can be disabled by choosing the option in the Preferences dialog (F12).
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CUSTOMIZING IDE LAYOUT
Docking Windows

You can increase the viewing and editing space for code, depending on how you
arrange the windows in the IDE.

Step 1: Click the window you want to dock, to give it focus.

4 % LedBlinking.mpppi
4 177 sources

: LedBlinking.mpas
{El Einaries

1770 Project level defines
{77 Image Files
{77 Oukput: Files

L7 Other Files

Step 2: Drag the tool window from its current location. A guide diamond appears.
The four arrows of the diamond point towards the four edges of the IDE.
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Step 3: Move the pointer over the corresponding portion of the guide diamond. An
outline of the window appears in the designated area.

Step 4: To dock the window in the position indicated, release the mouse button.

Tip: To move a dockable window without snapping it into place, press CTRL while
dragging it.

Saving Layout

Once you have a window layout that you like, you can save the layout by typing the
name for the layout and pressing the Save Layout Iconﬂ.

To set the layout select the desired layout from the layout drop-down list and click
the Set Layout Icon .

To remove the layout from the drop-down list, select the desired layout from the list
and click the Delete Layout Icon .

Debug Layout

<Drefault Layout:
Code Layout
Debug Layout
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Auto Hide

Auto Hide enables you to see more of your code at one time by minimizing tool win-
dows along the edges of the IDE when not in use.

- Click the window you want to keep visible to give it focus.
- Click the Pushpin Icon # on the title bar of the window.

=Nl
[E=N T e
52| Project Manager ]
] =D EallE =N R X
a_— - 3
s [ FirstProject.mpppi = [ Project Mana ]
4 A Sources . — : - 1
E] SecondPraject. mpas |. |_|% &5 %_
() Binaies 4| 434 FirstPro| & =
=] Project level defines S e U g L
[ Image Files = % %_
[ Output Files ] Binar] = o
[ Other Files 1 Proje 5
1 Imag E
[ Cutp i
=) Cthe

-

When an auto-hidden window loses focus, it automatically slides back to its tab on
the edge of the IDE. While a window is auto-hidden, its name and icon are visible
on a tab at the edge of the IDE. To display an auto-hidden window, move your point-
er over the tab. The window slides back into view and is ready for use.
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ADVANCED CODE EDITOR

The Code Editor is advanced text editor fashioned to satisfy needs of professionals.
General code editing is the same as working with any standard text-editor, including
familiar Copy, Paste and Undo actions, common for Windows environment.

Advanced Editor Features

- Adjustable Syntax Highlighting

- Code Assistant

- Code Folding

- Parameter Assistant

- Code Templates (Auto Complete)
- Auto Correct for common typos

- Spell Checker

- Bookmarks and Goto Line

- Comment / Uncomment

You can configure the Syntax Highlighting, Code Templates and Auto Correct from
the Editor Settings dialog. To access the Settings, click Tools » Options from the
drop-down menu, click the Show Options Icon g‘ or press F12 key.
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Options

==

IV Editor

Editor Settings

Project Files

W Restore Last Opened Praject " Restore all Opened Files

W Save Breakpaints W Save Bookmarks

@ Relnad file, but do not prompk

TF Opened File Is Externally Modified
[C‘ Prampt For action

() Ignore externally made changes

AUt Save

minutes

W Enable Auto Save Timeout Interval: 3

Highlighter

[ Highlight: beqin..end pairs
W Highlight: brackets
Speling

W Check speling

Comment skyle
®

@ {f {single line)

Advanced Editor Options

3 Open options dialog

Code Folding
W Enable code falding

I Show Ident Guides

oK Apply Cancel

Code Assistant

If you type the first few letters of a word and then press Ctrl+Space, all valid identi-
fiers matching the letters you have typed will be prompted in a floating panel (see
the image below). Now you can keep typing to narrow the choice, or you can select

one from the list using the keyboard arrows and Enter.

sp

i

variable  sfr SPDR: byte
variable sfr GPSR: byte
variable  sfr SPCR: byvie
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Code Folding

Code folding is IDE feature which allows users to selectively hide and display sec-
tions of a source file. In this way it is easier to manage large regions of code within
one window, while still viewing only those subsections of the code that are relevant
during a particular editing session.

While typing, the code folding symbols ( [~ and [+ ) appear automatically. Use the
folding symbols to hide/unhide the code subsections.

%hegin

PORTA :=0;

PORTE :=0;

Led Inici):

LCD out (1,1, text[0]];
LCD out(z,1,exc[1]];
delay ms({1000) ;

Led Cmdil)

LCD out(l,1,exc[1]];
LCD Out (2,4, txt[2]];
delay ms(500]);

end.

hegin El

If you place a mouse cursor over the tooltip box, the collapsed text will be shown in
a tooltip style box.

hegin [:,)
) A
hegin
PORTA :=0;
PORTE := 0;

Led Indit():

LCD_Out (1,1,txt[0]):
LCD_Out(2,1,txt[1]):
delay ms(1000) ;

Led Cmd (1)

LCD_Out (1,1,txt[1]):
LCD_Out (2,4,txt[2]):
delay ms (500) ;

end:
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Parameter Assistant

The Parameter Assistant will be automatically invoked when you open parenthesis
“(” or press Shift+Ctrl+Space. If the name of a valid function precedes the parenthe-
sis, then the expected parameters will be displayed in a floating panel. As you type
the actual parameter, the next expected parameter will become bold.

channel : byte
ADC_PRea

Code Templates (Auto Complete)

You can insert the Code Template by typing the name of the template (for instance,
whiles), then press Ctrl+J and the Code Editor will automatically generate a code.

You can add your own templates to the list. Select Tools » Options from the drop-down
menu, or click the Show Options Icon E and then select the Auto Complete Tab. Here
you can enter the appropriate keyword, description and code of your template.

Autocomplete macros can retreive system and project information:

- $DATES% - current system date

- $TIMES - current system time

- 2DEVICES - device(MCU) name as specified in project settings
- $DEVICE CLOCK? - clock as specified in project settings

- $COMPILER% - current compiler version

These macros can be used in template code, see template ptemplate provided with
mikroPascal PRO for PIC installation.

Auto Correct

The Auto Correct feature corrects common typing mistakes. To access the list of rec-
ognized typos, select Tools » Options from the drop-down menu, or click the Show
Options Icon g and then select the Auto Correct Tab. You can also add your own
preferences to the list.

Also, the Code Editor has a feature to comment or uncomment the selected code by sim-
ple click of a mouse, using the Comment Icon {..} | and Uncomment Icon ¢ 1 | from the
Code Toolbar.
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Spell Checker

The Spell Checker underlines unknown objects in the code, so they can be easily
noticed and corrected before compiling your project.

Select Tools » Options from the drop-down menu, or click the Show Options
Icon E and then select the Spell Checker Tab.

Bookmarks

Bookmarks make navigation through a large code easier. To set a bookmark, use
Ctrl+Shift+number. To jump to a bookmark, use Ctrl+number.

Goto Line

The Goto Line option makes navigation through a large code easier. Use the short-
cut Ctrl+G to activate this option.

Comment / Uncomment

Also, the Code Editor has a feature to comment or uncomment the selected
code by simple click of a mouse, using the Comment Icon /1| and Uncom-
ment Icon ¢ 1 from the Code Toolbar.
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CODE EXPLORER

The Code Explorer gives clear view of each item declared inside the source code.
You can jump to a declaration of any item by right clicking it. Also, besides the list of
defined and declared objects, code explorer displays message about first error and

it's location in code.

Code Explorer

)

]

QUses

4 Wmain
- B LCD_RS

o LCO_EN

o LCD_Dd4

o LCD_DS

o LCD_D6

o LCD_D7

@ LCD_RS_Direction

@ LCD_EN_Direction

@ LCD_Dd_Direction

@ LCD_D5_Direction

@ LCD_De_Direction

@ LCD_D7_Direction

B tatl

B tatz

Ll #sac]

B tah

@

GMDVE_DBlaY

Following options are available in the Code Explorer:

Icon

Description

‘E" Expand/Collapse all nodes in tree.

L | Locate declaration in code.
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ROUTINE LIST

Routine list diplays list of routines, and enables filtering routines by name. Routine
list window can be accessed by pressing Ctrl+L.

You can jump to a desired routine by double clicking on it.

TR

0 Leary Manager
AR | ] ]
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PROJECT MANAGER

Project Manager is IDE feature which allows users to manage multiple projects.
Several projects which together make project group may be open at the same time.

Only one of them may be active at the moment.

Setting project in active mode is performed by double click on the desired project

in the Project Manager.

Project Manager E
5|1 |2 BB 5 iy (|57 | [ | &2
A-L'il, LedBlinking.mpppi
4 Sources
% LedElinking. mpas
1 Binaries
[ Praject level defines
1 Image Files
41 Qutput Files
% LedBlinking. hex
% LedBlinking, asm
% LedElinking. lst
) Other Files

Following options are available in the Project Manager:

Icon Description

Save project Group.

Open project group.

Close the active project.

Close project group.

Add project to the project group.

Remove project from the project group.

Add file to the active project.

Remove selected file from the project.

Build the active project.

| o | | o (G| | OB 0| 08 | P

Run mikroElektronika's Flash programmer.

For details about adding and removing files from project see Add/Remove Files from

Project.

Related topics: Project Settings, Project Menu Options, File Menu Options, Project

Toolbar, Build Toolbar, Add/Remove Files from Project

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD 43



CHAPTER 2
Environment mikroPASCAL PRO for PIC

PROJECT SETTINGS WINDOW

Following options are available in the Project Settings Window:

- Device - select the appropriate device from the device drop-down list.
- Oscillator - enter the oscillator frequency value.
- Build/Debugger Type - choose debugger type.

Project Settings
Sl Device

Name: |p1gFasy

4

qu Oscillator

Value: 5.000000 | MHz
1=l Build) Debugger Type -

Build Type

@ Release () 1€ Debug
Debugger

@ Software () mikrolCD

Related topics: Edit Project, Customizing Projects
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LIBRARY MANAGER

Library Manager enables simple handling libraries being used in a project. Library
Manager window lists all libraries (extencion .mcl) which are instantly stored in the
compiler Uses folder. The desirable library is added to the project by selecting check
box next to the library name.

In order to have all library functions accessible, simply press the button Check
All "] and all libraries will be selected. In case none library is needed in a
project, press the button Clear All © and all libraries will be cleared from the
project.

Only the selected libraries will be linked.

Library Manager @
IR (][] &
[T apc

- [¥] Button

- [J] can_sP1

- [[] compact_Flash_FaT16
- [] Compact_Flash
3 |:| Conversions

- [T EERRGM

- [] FLASH

|:| Glcd_Fonts

- [ Eled

> [ 12¢

- || Keypaddxd
D Led_Conskants
[ Led

- [7] Manchester

- [ Mme_FaT16
[ e

3 |:| One_\Wire

- || Port_Expander
> [ psz

[ Ptz

- [ Pgeaz

<[] Pvmgs

- [ rs4as

- [7] software_tzc
- [ software_sPI

- [ Saftware_UART
+ | Sound

- [ SP1_Ethernet

- [ sp1_cled

- [C]5p1_Led

[ 5P1_Leds

[ sp1_Teosac

- [@] sp1

- [ sprinkf

- [ sprinti

- [7] sprinkl

» [ Te963C

3 |:| Time

: Trigonometry
[CJuarT
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need refreshing.

mikroPASCAL PRO for PIC
Icon Description
— Refresh Library by scanning files in "Uses" folder.Useful when new
= libraries are added by copying files to "Uses" folder.
N Rebuild all available libraries. Useful when library sources are available and

Include all available libraries in current project.

No libraries from the list will be included in current project.

B ||

Restore library to the state just before last project saving.

Related topics: mikroPascal PRO for PIC Libraries, Creating New Library

ERROR WINDOW

In case that errors were encountered during compiling, the compiler will report them
and won’t generate a hex file. The Error Window will be prompted at the bottom of
the main window by default.

The Error Window is located under message tab, and displays location and type of
errors the compiler has encountered. The compiler also reports warnings, but these
do not affect the output; only errors can interefere with the generation of hex.

Messages [E3]
Etrors Warnings Hirits
Line Message Mo,  Message Text Linit
u] 1 mPRIC.exe -DEG -pP16FES7 -MSF - -DL -011111114 -fod -...
1] 132 Compilation Started CHPROGRAM FILES\MIKROELEKTRONIKAMIKROPASCAL PRO FOR PIC 4.,
43 304 Synkax error Expected ") but "end" Found Sound.mpas
45 301 "procedure"is not +alid identifier Sound.mpas
45 304 Synkax error: Expected "end"” but "procedure” Found Sound.mpas
45 304 Synkax error: Expected ;" but "Melodw" Found Sound.mpas
45 304 Synkax error: Expected " but "{" found Sound.mpas
u] 102 Finished (with errars): 29 Mo 2008, 09:35:07 Sound. mpppi

Double click the message line in the Error Window to highlight the line where the
error was encountered.

Related topics: Error Messages
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STATISTICS

After successful compilation, you can review statistics of your code. Click the Statis-
tics Icon

Memory Usage Windows
Provides overview of RAM and ROM usage in the various forms.
RAM Memory Usage

Displays RAM memory usage in a pie-like form.

Statistics =]
PErint to file
RAM Memary
Usage
RAM Memory Usage
Used RAM
Locations
SFRLocations e
[ 104 btes 21%
ROM Memory
e L] Free: 391 bytes 79 %
ROM Memory Total: 455 bytes
Constants
Functions Sorted
By Neme
Functions Sorted
By Size.
Functions Sorted
By Address
Functions Sorted
By Mame Chart
Functions Sorted
By Size Chart
Functions Sorted
By Address Chart
Functions Tree
Summary
Time: 2/24]2000 8:47:11 AM
v mikros com
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Used RAM Locations

Displays used RAM memory locations and their names.

e
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SFR Locations

Displays list of used SFR locations.

SFR Locations

SFRLocations
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mikroPASCAL PRO for PIC

ROM Memory Usage

Displays ROM memory space usage in a pie-like form.

Statistics
Print to file

RAM Memory
Usage

Used RAM
Locations.

SFRLocations

ROM Memary
Usage

ROM Memary
Constants

Functions Sorted
By Mame

Functions Sorted
By Size

Functions Sorted
By Address

Functions Sorted
By Name Chart

Functions Sorted
By Size Chart

Functions Sorted
By Address Chart

Functions Tree

Summary

ROM Memory Usage

ROM Lisage
m Used: 5758 bytes 70 %
D Fres: 2433 bvtes 30%
Totak: 8191 bytes
Tie; 2{24/2000 §:47:11 AM
e mikros. com
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ROM Memory Constants

Displays ROM memory constants and their addresses.

Statistics
Print to file
RAM Memory
Usage
ROM Memory Constants
Used RAM
Locations
Address Name

SFRLocations

Ox0780 ?1CS?Istrl_Gled
ROM Memory 0x0787 1CS?Istr2_Gled
e 00730 71CS7Istr3_6lcd
ROM Memary 0x07A2 21CS?Istrd_Gled
Constants Ox0748 20CS?IstrS_Gled

0x0800 Charactergx?
By Nx et 0x15EA fontsx7

0x1400 FontSystem5x7_v2
Functions Sorted 0x06B0
By Size

0x1000 truck_bmp
Functions Sorted
By Address
Functions Sorted
By Name Chart
Functions Sorted
By Size Chart
Functions Sorted
By Address Chart
Functions Tree
Summary

Time: 2/24/2009 3:47:11 AM
e mikros.com
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Functions Sorted By Name

Sorts and displays functions by their addresses, symbolic names, and unique
assembler names.

Functions Sorted By Name

Functions Serted
By Name
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Functions Sorted By Size

Sorts and displays functions by their size, in the ascending order.

Functions Sorted By Size
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Functions Sorted By Addresses

Sorts and displays functions by their addresses, in the ascending order.

Print to file

Functions Sorted By Address

Functions Sorted
By Address
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Functions Sorted By Name Chart

Sorts and displays functions by their names in a chart-like form.

Statistics
Print to file
RAM Memory
Usage Functions sorfed by Name
Used RAM
Locations
SFRLocations
ROM Memory
Usage
ROM Memory
Canstants
Functions Sorted [ 91 oytes) |-
By Name Giod_init Jo)  [E3 (oytes) |-t
. Gled_Line —
e Gkt Reod Doto ] [Z e}
Gled_Rectangle S ]
Functions Serted Gled Set_Foot £ ¢ (5 otes] -
By Address cicd_set_Page fom) (11 mptes ] <~
o se_soe £
Funetions Sorted ocd_set_x | [mmgtesi]
By Name Chart -
Lot Gled Y Line [ [27 gues)
: Glod White_Char —
Functions Sorted " " "
By Size Chart Glcd it Dots [0 (TR ] b
Gled e _Tedt o] | (37 (bvtes) |-~ R T At ettt i
Functions Sorted N
BrAddrom Chat 116U ] [43 (tes | -
wa ot U ] [Foptest]
Functions Tree strabe {2 [8oyies) i j : | ! : : :
0 M 40 ED 80 100 120 140 160 180 00 20 M0 260 80 W0 30 MO
Summary
Time: 2{24]2009 8:47111 AM
v mibros-com
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mikroPASCAL PRO for PIC

Functions Sorted By Size Chart

Sorts and displays functions by their sizes in a chart-like form.

Statistics &
Print to file
RAM Memary
Usage
Used RAM Delay_tus ] [Fibovtesi]
Locatians Delay_50us £ [ 5 iovies) |-
Detay_10us 3 [(6 (bytes)
SFRLocations —Poce £ [ropes ]
svoee [ ,
Gled Wite £l 11 (b -~
p o g
sl e (el
_ccaow o] 12 ioytes) | -
ROM Memary deiy2s L [1dfbes] -
Constants ol set Fort L2 (15 (oytes)] -1
Giod_Sed_Side ] i
Functions Sorted Gled_Sel_x
- N —
Gled_Resd_Dets Lo [ toyles) |-
Gled_Resd_Dat:
HE | Resd_Dats o] d i
By Size Gied v _Line [T 27 (bytes) : :
Gicd ¥ Line ) [ (oyten) ] : |
Functions Sorted Glce_Box 28 (tvtes) | : . ! ]
By Address Glcd_Wirite_Text I T ] [ St SaaRt SEEEERE s e
m WL_16x18_U { ] [43 e |-+
Functions So :
By Hame Ch LU s—————— e . 1
cled o ) ([S2 ytes) |- d
Functions Sorted Gied_Rectsngle L) [P0 greesed ]
By Size Chart Glod_image ] i :
E— Gid_Dot I ETTS) i 1 : : ]
Functions Sorted Gicd_Write_Char — 1 [eomaes ] : : : + K
By Address Chart Gled_Circke |
mein )
Functions Tree Gled_Lina I 3%5@
o 20 40 &0 &0 100 120 140 160 180 200 21;11 240 260 0 300 320 340
Summary

Time: 2/24/2009 3:57 44 AM
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Functions Sorted By Addresses Chart

Sorts and displays functions by their addresses in a chart-like form.

Statistics
RaMMemory
Usage

Used RAM
Locations

SFRLocations.

ROM Memory
Usage

ROM Memory
Constants
Functions Sorted
By Neme
Functions Sorted
By Size
Functions Sorted
By Address

Functions Sorted
By Name Chart

Functions Sorted
By Size Chart

Functions Sorted
By Address Chart

Functions Tree

Summary

Print to file

Gled_wirte_Dala §---
Gied_Set % J- -

Gled_Read_Data
Gled_Se1_Side
Gicd_Set_Page

S

Time: 2/24/2009 5:57:44 AM
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Function Tree

Displays Function Tree with the relevant data for each function.

| - Dalay_Lous
Ml _16x16 U
| __boicp
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Memory Summary

Displays summary of RAM and ROM memory in a pie-like form.

Statistics
Print to file

RAM Memory
Usage

Used RAM
Locations

SFRLocations

ROM Memory
Usage

ROM Memory
Canstants.

Functions Sorted
By Name

Functions Sorted
By Size

Functions Sorted
By Address

Functions Sorted
By Name Chart

Functions Sorted
By Size Chart

Functions Sorted
By Address Chart

Functions Tree

| Summary

Summary

mUSed:

m Free:

104 bytes 21%
391 bytes 79 %

Total:

455 bvtes

~RCM Usage:

Q Free:

bytes STS8 4, 70
btes 2433 % 30

Tatd

brvtes 8191

Time: 2/24/2009 3:57:44 AM
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INTEGRATED TOOLS

USART Terminal

The mikroPascal PRO for PIC includes the USART communication terminal for
RS232 communication. You can launch it from the drop-down menu Tools » USART

Terminal or by clicking the USART Terminal Icon =l from Tools toolbar.

R5232 Terminal =

—Settings —Communication

Corn Port: [C H
[g800 ~|

Baud:

Stop Bits: ’One Stop Bit ']

Parity: Mone v]

Check Parity

Echo
Append: CR

LF

Send as typing

Send as number

[ Send . 'E?"la
. Siart L ogging

Clear History

Receive data a
Ir-'f'- ASCII

) HEX

) DEC

Data hits: ’Eight v]

—Commands

RIS
@ off
3 on

Connect

Connected to COM3 -
Sent: Echo

| Lusconnact
—Status

Send Receive CTS DsR
[~ [~ [ @

—Log Files

=
Read from:
irite to:

+ Append to + Create file
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EEPROM Editor

The EEPROM Editor is used for manipulating MCU's EEPROM memory. You can
launch it from the drop-down menu Tools » EEPROM Editor. When Use this
EEPROM definition is checked compiler will generate Intel hex file
project name.ihex that contains data from EEPROM editor.

When you run mikroElektronika programmer software from mikroPascal PRO for
PIC IDE - project name.hex file will be loaded automatically while ihex file must be
loaded manually.

mikroElektronika EEPROM Tool

. EEPROM Editor

(=]
Help

|| Use Eeprom in project

EEPROM Data

[IX) FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF PV PRV
[IEl rF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF PRV PRV
[2) FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
[T}{) FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF

FF |FF | FF | FF |FF | FF |FF | FF | FF | FF | FF | FF | FF [ FF | FF | FF

[T} FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF YRRV <
EEPROM Edit:

Input Format: Edit ¥alue:

n EEPROM Address: i —

| Dec Hex No: O Edit

@ Hex Start Address: 0% FFFF

= Float — Size:

= ] AutoInc ") Byte T word @ pword

) String

Device: EEPROM Size: EEPROM Fill: EEPROM File
Custom M - gyz| Brtes ¥Yalue: OxFF | Fill | | Load | | Save |
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ASCII Chart

The ASCII Chart is a handy tool, particularly useful when working with Lcd display.
You can launch it from the drop-down menu Tools » ASCII chart or by clicking the
View ASCII Chart Icon i from Tools toolbar.

Ascii Chart =]

o|1|2((3 (4|5 |6 (7|8 |9 |A|B|(C|D]|E F

MUL SOH|STX ETX EOT ENQ ACK BEL | BS HT | LF ¥T | FF |[CR |50  SI

0
o |1z a 4 s e 789 || |12|13][14]15
4 |DLE DC1|DC2 DC3 DC4 NAK SYN ETB CAN EM |SUB ESC FS | GS |RS | US
16 | 17 |18 |19 |20 |21 |22 |23 |24 |25 |26 |27 |23 |28 |30 | #
o [SPCt " # § % Te a7, 1T-1.-1T+7

32 |33 | 34 | 35 | 36 | 37 | 38 | 39 | 40 | 41 | 42 | 43 | 44 | 45 | 46 | 47
3 1] 1 2 3 4 5 ] 7 8 9 5 8
48 |49 |50 | 51 | 52 |53 |54 |55 56 | 57 | 58 | 59 | A0 | Al | 62 | A3
@ A B C D E F G H I ] K L M N o

64 | 65 | 66 | 67 63 69 | 70 | 1 | Fe (73 0 074 |5 | e | FF 7 | 79
s|P Q@ R S5 T U Vv W x ¥ 2z [ % ] °
80 | 81 | 82 | 83 | &4 | 85 | 86 92 [ 93 [ 94 | 95
T a b ¢ d e f
96 | 97 | 95 | 99 | 100 101 | 102
?pqrstuv
112 (113 114 | 115 | 116 | 117 | 118

108 | 109 | 110 | 111
| } ~ DEL

124 | 125 | 126 | 127

a | € A E b
128 | 129 1130 | 131 | 132 [ 133 [ 134 | 135 | 136 | 137 | 135 | 139 | 140 | 141 | 142 | 143
— ' ] w » - — =™ g y | e 4 ¢
9
144 | 145 | 146 | 147 | 1458 | 149 | 150 | 151 | 152 | 153 | 154 | 155 | 156 | 157 | 158 IE?
A i ¢ £ =2 | ¥ H § T @2 |« = - |®
160 | 161 | 162 | 163 | 164 | 165 | 166 | 167 | 168 | 169 | 170 | 171 | 172 | 173 | 174 | 175
B o + 2 3 - n L] . , 1 o wo| Ve | Ve 34 | &

176 | 177 | 178 | 179 | 180 | 181 | 182 | 183 | 184 | 185 | 186 | 187 | 185 | 189 | 190 | 191
C A A A A A A =m C E E E E I 1 I I

192 | 193 | 194 | 195 | 196 | 197 | 193 | 199 | 200 | 201 | 202 | 203 | 204 | 205 | 206 | 207
b N o 1] n} 1] n} * a u u u u Y =] B
205 | 209 | 210 ) 211 | 212 | 213 | 214 | 215 | 216 | 217 | 218 | 219 | 220 | 221 | 222 | 223
g |a @ 4 &8 | & &4 e | g | & & & B8 i i ir

224 | 225 | 226 | 227 | 225 | 229 | 230 | 231 | 232 | 233 | 234 | 235 | 236 | 237 | 233 | 239

da fi|bdb o6 6 & o6+ | @ | 0 0 | 0 0|y b|¥
240 | 241 | 242 | 243 | 244 | 245 | 246 | 247 | 248 | 240 | 250 | 251 | 252 | 253 | 254 | 255
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Seven Segment Convertor

The Seven Segment Display Convertor is a convenient visual panel which returns

decimal/hex value for any viable combination you would like to display on 7seg.

Click on the parts of 7 segment image to get the requested value in the edit boxes.

You can launch it from the drop-down menu Tools > Seven Segment Convertor or

by clicking the Seven Segment Icon @ from Tools toolbar.

Seven Segment Editor

B

Common cathode:
0x71

Cormmon anode:
0+8E

Decoding Format;
Decimnal

Lcd Custom Character

mikroPascal PRO for PIC includes the Lcd Custom Character. Output is mikroPas-
cal PRO for PIC compatible code. You can launch it from the drop-down menu Tools
> Led Custom Character.

LCD custom character
" %A -
T 'z H
5x7 5=x10 Save...

L]
L]
N (e
N [

HEEEE
N (e
LI
L

[E=H N>
= = =) =)
Load.._ Fill all Clear all Invert

Font Preview:

{v 55 7 + cursor line: I:I E

¢ 8% 10 + cursor line

CGRAM address:

Char:

[=] =]
Ak 4b

Char data row:

GENERATE
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Graphic Lcd Bitmap Editor

The mikroPascal PRO for PIC includes the Graphic Lcd Bitmap Editor. Output is the
mikroPascal PRO for PIC compatible code. You can launch it from the drop-down
menu Tools > Glcd Bitmap Editor.

|mikroEIektronika Graphic LCD Bitmap generator

File loaded: truck.brp

Picture preview 12864 pix [ bw
[ Load BMP Ficture ]

[ Create CODE ]

——
[ InvertPICTURE ]

GLCD Size | controller

i
/7 GLCD Picture name: truck.bmp
## GLCD Model: KSO108 128x64

s

m| »

Copy CODE ta Clipboard

conat truck_bmp : arrayliB24]1 of hyte =

¢
- B. A, o o . 8. 8. 8. 8. 8, B, 12, 12, 12, 12,
12, 18, 18, 18, 18, 18, 18, 2. 9. 9, 9. 9. 9. 9, 9, o
9. 9. 9. 9., 9. 9, 9 9. 9. 9.137,137,137,137.137.137.
137,137.13°7.137.137,137,137, 9. 9. 9. 9. 9. 9. 9, 9, 9,
SRR S gL
ver: 20.1 - 27012005 Systemn status: Win NT like OS
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HID Terminal

The mikroPascal PRO for PIC includes the HID communication terminal for USB
communication. You can launch it from the drop-down menu Tools » HID Terminal.

% mikroElektronika USE (HID) Terminal

" DEC

ol = =S

Terminal | Descriptor
HID Devices; e
ABBAHOHE -
ABBAHOWE
nikroE HID Library test El
Dell Premium USB Optical House -
Communication

[HID Read/Write Test Send

I |w Send as Typing

™ I~ Send as Number

Format

&+ AsCll " HEX

Clear

HID Read/Write Test
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UDP Terminal

The mikroPascal PRO for PIC includes the UDP Terminal. You can launch it from
the drop-down menu Tools » UDP Terminal.

E'_EI_ UDP Communication Terminal @
Settings

IP Address: [192.166.20.25

Port [100m

Send:

| mikroElektronika Send
Append: [ CR [~ Send as typing

[~ LF [ Send as number
mikroE lektronika
»
Clear

Receive

& ASCI " HEX " DEC

Clear

mikroBootloader

What is a Bootloader

(From Microchip’s document AN732) The PIC16F87X family of microcontrollers has
the ability to write to their own program memory. This feature allows a small boot-
loader program to receive and write new firmware into memory. In its most simple
form, the bootloader starts the user code running, unless it finds that new firmware
should be downloaded. If there is new firmware to be downloaded, it gets the data
and writes it into program memory. There are many variations and additional fea-
tures that can be added to improve reliability and simplify the use of the bootloader.

Note: mikroBootloader can be used only with PIC MCUs that support flash write.
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How to use mikroBootloader

1. Load the PIC with the appropriate hex file using the conventional programming
techniques (e.g. for PIC16F877A use p16£877a.hex).

2. Start mikroBootloader from the drop-down menu Tools > Bootoader.

3. Click on Setup Port and select the COM port that will be used. Make sure that
BAUD is set to 9600 Kpbs.

4. Click on Open File and select the HEX file you would like to upload.

5. Since the bootcode in the PIC only gives the computer 4-5 sec to connect, you
should reset the PIC and then click on the Connect button within 4-5 seconds.

6. The last line in then history window should now read “Connected”.

7. To start the upload, just click on the Start Bootloader button.

8. Your program will written to the PIC flash. Bootloader will report an errors that
may occur.

9. Reset your PIC and start to execute.

’ i rnikroElektranika o mikroBootloader w1.0.0.2 EI = @
Historny Window

Setup: Port COMS - Setup Port

Open HEX file
Start bootlioader

Terminal ‘Windaw

@ @ @

Connect  Tx Rx

Features

The boot code gives the computer 5 seconds to get connected to it. If not, it starts
running the existing user code. If there is a new user code to be downloaded, the
boot code receives and writes the data into program memory.

The more common features a bootloader may have are listed below:

- Code at the Reset location.

- Code elsewhere in a small area of memory.

- Checks to see if the user wants new user code to be loaded.

- Starts execution of the user code if no new user code is to be loaded.

- Receives new user code via a communication channel if code is to be loaded.
- Programs the new user code into memory.
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Integrating User Code and Boot Code

The boot code almost always uses the Reset location and some additional program
memory. It is a simple piece of code that does not need to use interrupts; therefore,
the user code can use the normal interrupt vector at 0x0004. The boot code must
avoid using the interrupt vector, so it should have a program branch in the address
range 0x0000 to 0x0003. The boot code must be programmed into memory using
conventional programming techniques, and the configuration bits must be pro-
grammed at this time. The boot code is unable to access the configuration bits,
since they are not mapped into the program memory space.
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MACRO EDITOR

A macro is a series of keystrokes that have been 'recorded' in the order performed.
A macro allows you to 'record' a series of keystrokes and then 'playback’, or repeat,
the recorded keystrokes.

Macros =]
& B[22 &

Mame

Macra3

'l [ | »

The Macro offers the following commands:

Icon Description

‘? Starts 'recording' keystrokes for later playback.

Stops capturing keystrokesthat was started when the Start Recordig com-
d? mand was selected.

[;a@? Allows a macro that has been recorded to be replayed.
_'E) New macro.
@ Delete macro.

Related topics: Advanced Code Editor, Code Templates
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OPTIONS

Options menu consists of three tabs: Code Editor, Tools and Output settings
Code editor

The Code Editor is advanced text editor fashioned to satisfy needs of professionals.
Tools

The mikroPascal PRO for PIC includes the Tools tab, which enables the use of

shortcuts to external programs, like Calculator or Notepad.
You can set up to 10 different shortcuts, by editing ToolO - Tool9.

Tool Mame: Toold

File Name: Press button to open file dialog

Parameters:

Mario: HEs FILE NANE Fullpath and name of the aut... | v Inset

Fi1 -

38 Clear all fields

Olutput
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Output settings

By modifying Output Settings, user can configure the content of the output files.
You can enable or disable, for example, generation of ASM and List file.

Also, user can choose optimization level, and compiler specific settings, which
include case sensitivity, dynamic link for string literals setting (described in
mikroPascal PRO for PIC specifics).

Build all files as library enables user to use compiled library (* .mc1) on any PIC
MCU (when this box is checked), or for a selected PIC MCU (when this box is left
unchecked).

For more information on creating new libraries, see Creating New Library.

Options @
Cukput Settings
OutpLt W Generate ASM File

W Include HEX oprodes

W Indude ROM constants

¥ Indude ROM Addresses
W Generate lisk file
¥ Indude debug infa

¥ Indude source lines in oukput Files

Optimization level:

Four =

Compiler

W Case sensitive
W' Drynamic link For string literals

W Build all files as library

oK

Cancel
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REGULAR EXPRESSIONS
Introduction

Regular Expressions are a widely-used method of specifying patterns of text to
search for. Special metacharacters allow you to specify, for instance, that a particu-
lar string you are looking for, occurs at the beginning, or end of a line, or contains n
recurrences of a certain character.

Simple matches

Any single character matches itself, unless it is a metacharacter with a special
meaning described below. A series of characters matches that series of characters
in the target string, so the pattern "short" would match "short" in the target string.
You can cause characters that normally function as metacharacters or escape
sequences to be interpreted by preceding them with a backslash "\".

For instance, metacharacter "A" matches beginning of string, but "\A" matches char-
acter "~", and "\\" matches "\", etc.

Examples :

unsigned matches string 'unsigned'
\“unsigned matches string '*unsigned’

Escape sequences

Characters may be specified using a escape sequences: "\n" matches a newline,
"\t" a tab, etc. More generally, \xnn, where nn is a string of hexadecimal digits,
matches the character whose ASCII value is nn.

If you need wide (Unicode) character code, you can use '\x{nnnn}', where 'nnnn'
- one or more hexadecimal digits.

\xnn - char with hex code nn

\x{nnnn) - char with hex code nnnn (one byte for plain text and two bytes for Unicode)
\t - tab (HT/TAB), same as \x09

\n - newline (NL), same as \x0a

\r - car.return (CR), same as \x0d

\f - form feed (FF), same as \x0c

\a - alarm (bell) (BEL), same as \x07

\e - escape (ESC), same as \x1b

Examples:

unsigned\x20int matches 'unsigned int' (note space in the middle)
\tunsigned matches 'unsigned' (predecessed by tab)

72 MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



CHAPTER 2
mikroPASCAL PRO for PIC Environment

Character classes

You can specify a character class, by enclosing a list of characters in [], which will
match any of the characters from the list. If the first character after the "[" is "~",
the class matches any character not in the list.

Examples:

count [aeiou] r finds strings 'countar’, 'counter’, etc. but not 'countbr’, 'counter’, etc.
count[*aeiou] r finds strings 'countbr’, 'countcr', etc. but not 'countar', 'counter', etc.

Within a list, the "-" character is used to specify a range, so that a-z represents all

characters between "a" and "z", inclusive.

If you want "-" itself to be a member of a class, put it at the start or end of the list,
or precede it with a backslash.
If you want "1, you may place it at the start of list or precede it with a backslash.

Examples:
[-az] matches 'a', 'z' and '-'
[az-] matches 'a', 'z'and '-'
[a\-z] matches 'a', 'z'and '-'

[a-z] matches all twenty six small characters from 'a' to 'z'
[\n-\x0D] matches any of #10,#11,#12,#13.

[\d-t] matches any digit, '-' or 't'.
[1-a] matches any char from "]'..'a".
Metacharacters

Metacharacters are special characters which are the essence of regular expres-
sions. There are different types of metacharacters, described below.

Metacharacters - Line separators

~ - start of line

$ - end of line

\A - start of text

\z - end of text

. - any character in line
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Examples:

~PORTA - matches string ' PorT2 ' only if it's at the beginning of line
PORTAS - matches string ' PorT2 ' only if it's at the end of line
~PORTAS - matches string ' PorTA ' only if it's the only string in line
PORT . r - matches strings like 'PORT2', 'PORTE', 'PORT1' and so on

The "~ metacharacter by default is only guaranteed to match beginning of the input
string/text, and the "s" metacharacter only at the end. Embedded line separators
will not be matched by ~" or "s.

You may, however, wish to treat a string as a multi-line buffer, such that the "~ will
match after any line separator within the string, and "< will match before any line
separator.

Regular expressions works with line separators as recommended at http://www.uni-
code.org/unicode/reports/tr18/

Metacharacters - Predefined classes

\w - an alphanumeric character (including " ")
\W - a nonalphanumeric character

\d - a numeric character

\D - a hon-numeric character

\s - any space (same as [\t\n\r\£])

\S - a non space

You may use \w, \d and \s within custom character classes.
Example:

routi\de - matches strings like 'routile', 'routiée' and so on, but not 'routine’,
'routime' and so on.

Metacharacters - Word boundaries

A word boundary ("\b") is a spot between two characters that has an alphanumer-
ic character ("\w") on one side, and a nonalphanumeric character ("\w") on the
other side (in either order), counting the imaginary characters off the beginning and
end of the string as matching a "\w".

\b - match a word boundary)
\B - match a non-(word boundary)
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Metacharacters - Iterators

Any item of a regular expression may be followed by another type of metacharac-
ters - iterators. Using this metacharacters,you can specify number of occurences of
previous character, metacharacter or subexpression.

* - zero or more ("greedy"), similar to {0,}

+ - one or more ("greedy"), similar to {1,}

2 - zero or one ("greedy"), similar to {0,1}

{n} - exactly n times ("greedy")

{n,} - at least n times ("greedy")

{n,m} - at least n but not more than m times ("greedy")
*2 - zero or more ("non-greedy"), similar to {0,}?

+2 - one or more ("non-greedy"), similar to {1,}?

22 - zero or one ("non-greedy"), similar to {0,1}?

{n}? - exactly n times ("non-greedy")

{n,}? - at least n times ("non-greedy")

{n,m}? - at least n but not more than m times ("non-greedy")

So, digits in curly brackets of the form, {n,m}, specify the minimum number of times
to match the item n and the maximum m. The form {n} is equivalent to {n,n} and
matches exactly n times. The form {n,} matches n or more times. There is no limit
to the size of n or m, but large numbers will chew up more memory and slow down
execution.

If a curly bracket occurs in any other context, it is treated as a regular character.
Examples:

count.*r B- matches strings like 'counter', 'countelkjd£1kj9r' and 'countr'
count.+r - matches strings like 'counter', 'countelkjd£1kj9r' but not 'countr'
count. ?r - matches strings like 'counter', 'countar' and 'countr' but not 'countelkjor'
counte{2}r - matches string 'counteer’

counte{2, } r - matches strings like 'counteer’, 'counteeer’, 'counteeer' etc.
counte{2,3}r - matches strings like 'counteer’, Or 'counteeer' but Not 'counteeceer’

A little explanation about "greediness". "Greedy" takes as many as possible, "non-
greedy" takes as few as possible.

For example, 'b+' and 'b*' applied to string 'abbbbc' return 'bbbb', 'b+?'
returns 'b', 'b*?' returns empty string, 'b{2,3}?' returns 'bb', 'b{2,3}"'
returns 'bbb' .
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Metacharacters - Alternatives

You can specify a series of alternatives for a pattern using " | " to separate them, so
that bit|bat|bot will match any of "bit", "bat", or "bot" in the target string as
would "b(ilalo)t)". The first alternative includes everything from the last pattern
delimiter (" (", " ", or the beginning of the pattern) up to the first " |", and the last
alternative contains everything from the last " | " to the next pattern delimiter. For this
reason, it's common practice to include alternatives in parentheses, to minimize

confusion about where they start and end.

Alternatives are tried from left to right, so the first alternative found for which the
entire expression matches, is the one that is chosen. This means that alternatives
are not necessarily greedy. For example: when matching rou|rout against "rou-
tine", only the "rou" part will match, as that is the first alternative tried, and it suc-
cessfully matches the target string (this might not seem important, but it is important
when you are capturing matched text using parentheses.) Also remember that " | "
is interpreted as a literal within square brackets, so if you write [bit|bat|bot],
you're really only matching [biao]].

Examples:

rou (tine|te) - matches strings 'routine' or 'route'.
Metacharacters - Subexpressions

The bracketing construct ( ... ) may also be used for define regular subexpressions.
Subexpressions are numbered based on the left to right order of their opening
parenthesis. First subexpression has number '1'

Examples:

(int) {8,10} matches strings which contain 8, 9 or 10 instances of the 'int'
routi ([0-9] |a+) e matches 'routile, 'routile', 'routine', 'routinne’,
'routinnne' etc.

Metacharacters - Backreferences

Metacharacters \ 1 through \ 9 are interpreted as backreferences. \ matches previ-
ously matched subexpression #.

Examples:

(.)\1+ matches 'aaaa' and 'cc'.

(.+)\1+ matches 'abab' and '123123"

(['"1?) (\d+)\1 matches "13" (in double quotes), or "4 (in single quotes) or 77
(without quotes) etc
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MIKROPASCAL PRO FOR PIC COMMAND LINE OPTIONS

Usage:mPPIC.exe [-<opts> [-<opts>]] [<infile> [-<opts>]] [-<opts>]]
Infile can be of *.mpas and *.mcl type.

The following parameters and some more (see manual) are valid:

-p : MCU for which compilation will be done.

-ro : Set oscillator [in MHZ].

-sp : Add directory to the search path list.

- : Output files generated to file path specified by filename.
-5 : Save compiled binary files (+ .mc1) to 'directory’.
-0 : Miscellaneous output options.

-DBG : Generate debug info.

-1, : Check and rebuild new libraries.

-pL : Build all files as libraries.

-v : Dynamic link for string literals.

-utch @ ICD build type.

Example:
mPPIC.exe -MSF -DBG -pl6F887 -011111114 -fo8 -
N"C:\Lcd\Lcd.mpppi" -SP"C:\Program

Files\Mikroelektronika\mikroPascal PRO for PIC\Defs\"

-SP"C:\Program Files\Mikroelektronika\mikroPascal PRO
for PIC\Uses\P16\" -SP"C:\Lcd\" "Led.mpas” " _Lib Math.mcl"
"__Lib MathDouble.mcl"

" Lib System.mcl" " Lib Delays.mcl"
" _Lib LcdConsts.mcl" "__ Lib Led.mel”

Parameters used in the example:

-MsF : Short Message Format; used for internal purposes by IDE.

-DBG : Generate debug info.

-pl6r8g7 : MCU 16F887 selected.

011111114 : Miscellaneous output options.

-fo8 : Set oscillator frequency [in MHz].

-N"C:\Lcd\ Lcd.mpppi" -SP"C:\Program Files\Mikroelektronika\mikro-
pascal PRO for PIC\defs\" : QOutput files generated to file path specified by
filename.

-SP"C:\Program Files\Mikroelektronika\mikroPascal PRO for PIC\Defs\"
: Add directory to the search path list.

-SP"C:\Program Files\Mikroelektronika\mikroPascal PRO for
PIC\Uses\ P16\ " : Add directory to the search path list.
-sp"c:\Led\ " : Add directory to the search path list.

"Lcd.mpas" " Lib Math.mcl" " Lib MathDouble.mcl"
~ Lib System.mcl" " Lib Delays.mcl" " Lib LcdConsts.mcl"
" Lib Led.mel" : Specify input files.
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PROJECTS

The mikroPascal PRO for PIC organizes applications into projects, consisting of a
single project file (extension .mpppi) and one or more source files (extension mpas).
mikroPascal PRO for PIC IDE allows you to manage multiple projects (see Project
Manager). Source files can be compiled only if they are part of a project.

The project file contains the following information:

- project name and optional description,

- target device,

- device flags (config word),

- device clock,

- list of the project source files with paths,
- image files,

- other files.

Note that the project does not include files in the same way as preprocessor does,
see Add/Remove Files from Project.

New Project

The easiest way to create a project is by means of the New Project Wizard, drop-
down menu Project » New Project or by clicking the New Project Icon :L from
Project Toolbar.

78 MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



CHAPTER 2
mikroPASCAL PRO for PIC Environment

New Project Wizard Steps

Start creating your New project, by clicking Next button:

Mew Project Wizard

Welcome to the New Project
Wizard

This wizard helps you:

e Create a new project

# Select the device for your project

e Setup device clock and choose device flags
s Select desired memaory model

-+ Add project files

Click Mext to continue

Back Mext 9 Cancel

Step One - Select the device from the device drop-down list.

MNewy Project Wizard @

Select the device you want to use.

Device Mame:

4 Back Next o Cancel
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Step Two - Enter the oscillator frequency value.

MNewy Project Wizard

(5]

Setup the clock, for example 11,0592 MHz.

Dewvice Clock: 11.0592EID| MHz

4@ Back Next &

Cancel

Step Three - Specify the location where your project will be saved
MNewy Project Wizard

(=)
Specify where your project will be saved.

Project File Name:

21\ ProjectstFirstProjectiFirstProject, mpppi

4@ Back Next &

Cancel
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Step Four - Add project file to the project if they are avaiable at this point. You can
always add project files later using Project Manager.

Mew Project Wifizard =3

Step 475
4dd project files if they are available at this point.
vou can always add project files later using the Project Manager in IDE.

Add File To Project:

D:\Projects\FirstProject\Definit. mpas . Add ¢
File Mame
[:Projects\FirstProjectDefinit. mpas
Remove
Remove All
4@ Back Mext 5 Cancel
Step Five - Click Finish button to create your New Project:
Mew Project Wifizard =z

Step 575

You have successfully created a new project. Click Finish to save the changes
and to close the wizard.

- d

N

4@ Back

Cancel

Related topics: Project Manager, Project Settings
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CUSTOMIZING PROJECTS

You can change basic project settings in the Project Settings window, like chip and
oscillator frequency. Any change in the Project Setting Window affects currently
active project only, so in case more than one project is open, you have to ensure
that exactly the desired project is set as active one in the Project Manager. Also, you
can change configuration bits of the selected chip in the Edit Project window.

Managing Project Group

mikroPascal PRO for PIC IDE provides covenient option which enables several proj-
ects to be open simultaneously. If you have several projects being connected in
some way, you can create a project group.

The project group may be saved by clicking the Save Project Group Icon % from
the Project Manager window. The project group may be reopend by clicking the
Open Project Group Icon % . All relevant data about the project group is stored in
the project group file (extension .mpg)

ADD/REMOVE FILES FROM PROJECT

The project can contain the following file types:

.mpas source files

.mc1 binary files

.pld project level defines files

image files

.hex, .asmand . 1st files, see output files. These files can not be added or
removed from project.

other files
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Project Manager ]
FEEEEEEEEYE
1\35_-, T6963C_240x128.mpppi

4[] Sources

£ Te953C_240x128 mpas
Ej bitmap.mpas

Binaries

bitmapz2.mcl

Praject level defines
Image Files

sample.jpg

Qutput Files

| TBR63C_240x128 hex
E=5| TBEG3C_240x126,a5m
g TARIGIC_240x1 28 sk
a-| ) Other Files

&) paTA - doc32a6. pdf

|
|
|
|

The list of relevant source files is stored in the project file (extension .mppp1).

To add source file to the project, click the Add File to Project Icon ._—jf . Each added
source file must be self-contained, i.e. it must have all necessary definitions after
preprocessing.

To remove file(s) from the project, click the Remove File from Project Icon Lf .
See File Inclusion for more information.
Project Level Defines

Project Level Defines (.p14) files can also be added to project. Project level define
files enable you to have defines that are visible in all source files in the project. One
project may contain several pld files. A file must contain one definition per line, for
example:

ANALOG
DEBUG

TEST

There are some predefined project level defines. See predefined project level
defines

Related topics: Project Manager, Project Settings, Edit Project
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SOURCE FILES

Source files containing Pascal code should have the extension .mpas. The list of
source files relevant to the application is stored in project file with extension .mppp1,
along with other project information. You can compile source files only if they are
part of the project.

Managing Source Files
Creating new source file

To create a new source file, do the following:

1. Select File » New Unit from the drop-down menu, or press Ctrl+N, or click the
New File Icon |j from the File Toolbar.

2. A new tab will be opened. This is a new source file. Select File » Save from the
drop-down menu, or press Ctrl+S, or click the Save File Icon [ from the File
Toolbar and name it as you want.

If you use the New Project Wizard, an empty source file, named after the project with

extension .mpas, will be created automatically. The mikroPascal PRO for PIC does

not require you to have a source file named the same as the project, it’s just a mat-
ter of convenience.

Opening an existing file

1. Select File » Open from the drop-down menu, or press Ctrl+O, or click the Open
File Icon év from the File Toolbar. In Open Dialog browse to the location of the
file that you want to open, select it and click the Open button.

2. The selected file is displayed in its own tab. If the selected file is already open, its
current Editor tab will become active.

Printing an open file

1. Make sure that the window containing the file that you want to print is the active
window.

2 Select File » Print from the drop-down menu, or press Ctrl+P.

3. In the Print Preview Window, set a desired layout of the document and click the
OK button. The file will be printed on the selected printer.
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Saving file

1. Make sure that the window containing the file that you want to save is the active
window.

2. Select File » Save from the drop-down menu, or press Ctrl+S, or click the Save
File Icon |4 from the File Toolbar.

Saving file under a different name

1. Make sure that the window containing the file that you want to save is the active
window.

2. Select File » Save As from the drop-down menu. The New File Name dialog will
be displayed.

3. In the dialog, browse to the folder where you want to save the file.

4. In the File Name field, modify the name of the file you want to save.

5. Click the Save button.

Closing file

1. Make sure that the tab containing the file that you want to close is the active tab.

2. Select File » Close from the drop-down menu, or right click the tab of the file that
you want to close and select Close option from the context menu.

3. If the file has been changed since it was last saved, you will be prompted to save
your changes.

Related topics:File Menu, File Toolbar, Project Manager, Project Settings,
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CLEAN PROJECT FOLDER

This menu gives you option to choose which files from your current project you want

to delete.

Files marked in bold can be easily recreated by building a project. Other files should
be marked for deletion only with a great care, because IDE cannot recover them.

Clean Project Folder

project is rebuilt,

=]

Below is the list of all files in the project folder. Files in bold are those
generated by the compiler and they can be easily recreated when the

Select which files you want to remove from the project folder. Please
note that selected files will be permanently deleted from your disk if

- [¥] spiEthernet.asm

- [] =piEthernet.mpas

[ SpiEthernet . mpas.ini

[ spiEthernet.cp

-.[¥] spiEthernet.dbg

-.[] spiEthernet.dct

--[V] SpiEthernet.dlt

-] spiEthernet.hex

-.[] spiEthernet.lst

- [] SpiEthernet.mel

- [] =piEthenet. mpppi

-.[¥] SpiEthernet.mcproj_callertable.bxt
piEthernet.mil

[ spiEthernet. user, dic

-~

Clean

Cancel

ChProgram Files\MikroelektranikatmikroPascal PRO far PICY

Related topics: Customizing Projects
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COMPILATION

When you have created the project and written the source code, it's time to compile
it. Select Project > Build from the drop-down menu, or click the Build Icon “# ' from
the Project Toolbar. If more more than one project is open you can compile all open
projects by selecting Project > Build All from the drop-down menu, or click the Build
All Icon % from the Project Toolbar.

Progress bar will appear to inform you about the status of compiling. If there are

some errors, you will be notified in the Error Window. If no errors are encountered,
the mikroPascal PRO for PIC will generate output files.

Output Files
Upon successful compilation, the mikroPascal PRO for PIC will generate output files

in the project folder (folder which contains the project file .mpppi). Output files are
summarized in the table below:

Format Description File Type

Intel style hex records. Use this file to program
PIC MCU.

mikro Compiled Library. Binary distribution of
application that can be included in other projects.

Intel HEX

.hex

.mcl

Binary

Overview of PIC memory allotment: instruction

List File addresses, registers, routines and labels.

Human readable assembly with symbolic names,

Assembler File extracted from the List File.

ASSEMBLY VIEW

After compiling the program in the mikroPascal PRO for PIC, you can click the View
Assembly icon [l or select Project > View Assembly from the drop-down menu
to review the generated assembly code (.zsm file) in a new tab window. Assembly
is human-readable with symbolic names.

Related topics:Project Menu, Project Toolbar, Error Window, Project Manager, Pro-
ject Settings
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ERROR MESSAGES

Compiler Error Messages:

- "%s" is not valid identifier.

- Unknown type "2s".

- Identifier "=s" was not declared.

- Syntax error: Expected "<s" but "s" found.

- Argument is out of range "=s".

- Syntax error in additive expression.

- File "=s" not found.

- Invalid command "2s".

- Not enough parameters.

- Too many parameters.

- Too many characters.

- Actual and formal parameters must be identical.

- Invalid ASM instruction: "=s".

- Identifier "=s" has been already declared in "2s".

- Syntax error in multiplicative expression.

- Definition file for "<s" is corrupted.

- ORG directive is currently supported for interrupts only.
- Not enough ROM.

- Not enough RAM.

- External procedure "<s" used in "2s" was not found.
- Internal error: "<s".

- Unit cannot recursively use itself.

- "3s" cannot be used out of loop.

- Actual and formal parameters do not match ("2s" to "ss").
- Constant cannot be assigned to.

- Constant array must be declared as global.

- Incompatible types ("ss" to "ss").

- Too many characters ("%s").

- Soft_Uart cannot be initialized with selected baud rate/device clock.
- Main label cannot be used in modules.

- Break/Continue cannot be used out of loop.

- Preprocessor Error: "2s".

- Expression is too complicated.

- Duplicated label "=s™.

- Complex type cannot be declared here.

- Record is empty.

- Unknown type "2s".

- File not found "<s".

- Constant argument cannot be passed by reference.

- Pointer argument cannot be passed by reference.
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- Operator "2s" not applicable to these operands "2s".

- Exit cannot be called from the main block.

- Complex type parameter must be passed by reference.

- Error occured while compiling "2s".

- Recursive types are not allowed.

- Adding strings is not allowed, use "strcat" procedure instead.
- Cannot declare pointer to array, use pointer to structure which has array field.
- Return value of the function "<s" is not defined.

- Assignment to for loop variable is not allowed.

- "3s" is allowed only in the main program.

- Start address of "2s" has already been defined.

- Simple constant cannot have fixed address.

- Invalid date/time format.

- Invalid operator "<s".

- File "=s" is not accessible.

- Forward routine "=s" is missing implementation.

- ™" is not allowed before "else".

- Not enough elements: expected "=s", but "2s" elements found.
- Too many elements: expected "<s" elements.

- "external" is allowed for global declarations only.

- Destination size ("2s") does not match source size ("3s").

- Routine prototype is different from previous declaration.

- Division by zero.

- Uart module cannot be initialized with selected baud rate/device clock.
- "%s" cannot be of "5 type.

- Array of "%s" can not be declared.

- Incomplete variable declaration: "2s".

- Recursive build of units is not allowed (""%s"").

- Object must be smaller than 64kb in size: ""ssm".

- Index out of bounds.

- With statment cannot be used with this argument ""ss"".

- Reset directive is available only on P18 family.
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Warning Messages:

- Variable "<s" is not initialized.

- Return value of the function "<s" is not defined.

- Identifier "=s" overrides declaration in unit "2s".

- Generated baud rate is %s bps (error = =5 percent).

- Result size may exceed destination array size.

- Infinite loop.

- Implicit typecast performed from "ss" to "2s".

- Implicit typecast of integral value to pointer.

- Library "<s" was not found in search path.

- Interrupt context saving has been turned off.

- Source size (%s) does not match destination size (%s).
- Aggregate padded with zeros (%s) in order to match declared size (%s).
- Suspicious pointer conversion.

- Source size may exceed destination size.

HINT MESSAGES:

- Constant "2s" has been declared, but not used.
- Variable "2s" has been declared, but not used.

- Unit "2s" has been recompiled.

- Variable "<s" has been eliminated by optimizer.
- Compiling unit "=s".
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SOFTWARE SIMULATOR OVERVIEW

The Source-level Software Simulator is an integral component of the mikroPascal
PRO for PIC environment. It is designed to simulate operations of the PIC MCUs

and assist the users in debugging Pascal code written for these devices.

Upon completion of writing your program, choose Release build Type in the Project

Settings window:

Choose Release type
if you want to use
software simulator

Project Settings
SlggnDevice

Mame: | p1eFa774 -

B@ Oscillator

Value: 5.000000| MHz

1=l Buildf Debugger Type

i B K

Build Type

P @ Rel () D Debug

Debugger
@ Software () mikrolCD

After you have successfully compiled your project, you can run the Software Simu-

lator by selecting Run > Start Debugger from the drop-down menu, or by clicking
the Start Debugger Icon Eb, from the Debugger Toolbar. Starting the Software Sim-
ulator makes more options available: Step Into, Step Over, Step Out, Run to Cursor,

etc. Line that is to be executed is color highlighted (blue by default).

Note: The Software Simulator simulates the program flow and execution of instruc-
tion lines, but it cannot fully emulate PIC device behavior, i.e. it doesn’t update
timers, interrupt flags, etc.
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Breakpoints Window

The Breakpoints window manages the list of currently set breakpoints in the project.
Doubleclicking the desired breakpoint will cause cursor to navigate to the correspon-
ding location in source code.

Breakpoints =]

Line File Mame

50 Lcd. mpas
54 Led. mpas
58 Lcd. mpas
64 Led. mipas
75 Lcd. mpas
76 Lcd. mpas

Watch Window

The Software Simulator Watch Window is the main Software Simulator window which
allows you to monitor program items while simulating your program. To show the Watch
Window, select View > Debug Windows » Watch from the drop-down menu.

The Watch Window displays variables and registers of the MCU, along with their
addresses and values.

There are two ways of adding variable/register to the watch list:

- by its real name (variable's name in Pascal code). Just select desired variable/register
from Select variable from list drop-down menu and click the Add Button == Add

- by its name ID (assembly variable name). Simply type name ID of the variable/register
you want to display into Search the variable by assemby name box and click the Add
Button == Add

Variables can also be removed from the Watch window, just select the variable that
you want to remove and then click the Remove Button ¥ rRemove

Add All Button 4 AddAll  adds all variables.

Remove All Button 'wi Remove All removes all variables.
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You can also expand/collapse complex variables, i.e. struct type variables, strings...

Values are updated as you go through the simulation. Recently changed items are

colored red.

Watch Walues =]
5 B G 100 % o0 o1 | & (] B |
ae Add  $8 Remove <) Properties kgl AddAll g Remove All

Select variable from list:

r -

Search for variable by assembly name:

FARG_TEIBIC_circle+4 @

| Penipherals Freeze | Advance Breakpoints

Marme Yalue Address
pic 1] 00039
panel i} 00031
TE963C_dataPort 1] 0050
TEIE3C_cntlrst 1] O=0094
TEIE3C_grividth 1] 0020
start il 00046
mode a 00034
r a 0x0036

PZ= 0x0009FE Cycle= 560,00

Double clicking a variable or clicking the Properties Button

) Properties opens

the Edit Value window in which you can assign a new value to the selected
variable/register. Also, you can choose the format of variable/register representation
between decimal, hexadecimal, binary, float or character. All representations except
float are unsigned by default. For signed representation click the check box next to

the Signed label.

An item's value can be also changed by double clicking item's value field and typing

the new value directly.

[ Edit Value: ACD (===

0100 0000 1000 0011 0001 00100110 1111

Representation
Dec Hex @) Bin Float Char

Signed oK l [ Cancel
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View RAM Window

Debugger View RAM Window is available from the drop-down menu, View » Debug
Windows > View RAM.

The View RAM Window displays the map of PIC’'s RAM, with recently changed
items colored red.

RAM &
RAM | Histary

DDlDl|02|03|04|DS|DSlD?|DS|09|DF\|UB|DC|DD|DE|DF|-°'5CH |“

ooooy oo ooc ) 95 | OC 00 | OO0 0 3F 00 00 00 0O 00 00 oo DR 2
ooy oo o0 00 | DF 00 o A0 00 00 00 00 C0 A0 00 00 | OF
oozof oo 00 04 00 00 | ED ) &80 00 | 02 84 81 oo 0l 03 | 20 | oo
oo30f 11 oo 25 00 4% | 03 00 40 04 | 00 | 44 o oo o o0 0o
o040 00 &84 20 | 00 1z a0 00 | 2z | 00 o oo | ool a0 04 | 00 43
oosof oo o0 00 | 04 00 | 00 20 &0 01 oo 00 o0 02 | oo 0l i}
ooe0f 4C 08 20 | 00 03 | 02 00 03 | OF 14 | 01 19 o0 o o0 &0
ooFQy oo 0F 15 el | 0p 00 | 01 i} JLUNRENTHY zl 66 26 | S0 00 0o
oogof oo FF o %5 | OC 00 | 3F  FF  FF  FF 07 OO0 00 | 00 00 00 0o
oooof oo oo FF O OO0 00 | OO 00 00 O 00 OO 00 O o0 o0 0o
ooaoy S0 01 44 00 40 0 | 03 00 | 00 04 00 & | o0 41 000
ooEoy O oo Ol ooz oo o0 00 o0 o0 o4 40 02 ZE 0 24 &2
oocoj oo 22 ool 11 o6 | ¥ 11 58 84 | 00 02 o | oo 80 23 | &0
oopoy oo o0 ) of uli} o oo 10 m | 4 o4 00 oo o0 ool 40 | 84
O0ECY 00 00 04 | 20 SO0 | 20 00 90 | 00 | 40 40 | &4 21 14 | a0 | 25

QoOFO) 00 05 15 B0 i) oo o1 05 10 o1 21 BE 26 S0 oo oo
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Stopwatch Window

The Software Simulator Stopwatch Window is available from the drop-down menu,
View > Debug Windows » Stopwatch.

The Stopwatch Window displays a current count of cycles/time since the last Soft-
ware Simulator action. Stopwatch measures the execution time (number of cycles)
from the moment Software Simulator has started and can be reset at any time. Delta
represents the number of cycles between the lines where Software Simulator action
has started and ended.

Note: The user can change the clock in the Stopwatch Window, which will recalcu-
late values for the latest specified frequency. Changing the clock in the Stopwatch
Window does not affect actual project settings — it only provides a simulation.

Stopwatch =]

Cycles: Time:
Current Count: |8 9,60 us

Delta: 2 2.40us

Stopwatch: a 9.60 us

Reset To Zero

Clock: 10 MHz
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SOFTWARE SIMULATOR OPTIONS

Format Description File Type Tcl::(l)I:‘ar
e Start Software Simulat F9 B
Debugger art Software Simulator. [F9] E
Run/Pause . =
Debugger Run or pause Software Simulator. [F6] E:]J
Stop . -
bebugger Stop Software Simulator. [Ctri+F2] | =%

Toggle breakpoint at the current cursor position. To

view all breakpoints, select Run > View Break-
Toggle

Breakpoints points from the drop—down menu. Double clicking [F5] &

an item in the Breakpoints Window List locates the

breakpoint.
Run to Execute all instructions between the current

. . " [F4] &
cursor instruction and cursor position.

Execute the current Pascal (single or multi-cycle)
cien Tnio instruction, then halt. If the instruction is a routine [F7] -~

. call, enter the routine and halt at the first instruc-

tion following the call.

Execute the current Pascal (single or multi-cycle) o
SeR Over Linstruction, then hallt. [F8] Ll
Step Out Execute all remaining instructions in the current [Ctrl+F8] -

routine, return and then halt.

Related topics: Run Menu, Debug Toolbar
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CREATING NEW LIBRARY

mikroPascal PRO for PIC allows you to create your own libraries. In order to create
a library in mikroPascal PRO for PIC follow the steps bellow:

1. Create a new Pascal source file, see Managing Source Files
2. Save the file in one of the subfolders of the compiler's Uses folder:
DriveName:\ Program Files\Mikroelektronika\mikroPascal PRO for
PIC\Uses\ P16\
DriveName:\ Program Files\Mikroelektronika\mikroPascal PRO for
PIC\Uses\ P18\
If you are creating library for PIC16 MCU family the file should be saved in P16 folder.
If you are creating library for PIC18 MCU family the file should be saved in P18 folder.
If you are creating library for PIC16 and PIC18 MCU families the file should be
saved in both folders.
3. Write a code for your library and save it.
4.Add 1ib Example file in some project, see Project Manager. Recompile the
project.
If you wish to use this library for all MCUs, then you should go to Tools » Options
> Output settings, and check Build all files as library box.
This will build libraries in a common form which will work with all MCUs. If this box
is not checked, then library will be built for selected MCU.
Bear in mind that compiler will report an error if a library built for specific MCU is
used for another one.
5. Compiled file __Lib Example.mcl should appear in ...\mikroPascal PRO
for PIC\Uses\P16\ folder.
6. Open the definition file for the MCU that you want to use. This file is placed in the
compiler's Defs folder:
DriveName:\ Program Files\Mikroelektronika\mikroPascal PRO for
pIC\Defs\ and itis named vcu NaME.mlk, for example 165887 .m1k
7. Add the the following segment of code to <1.TBrRARTES> node of the definition file
(definition file is in XML format):
<LIB>
<ALIAS>Example Library</ALIAS>
<FILE> Lib Example</FILE>
<TYPE>REGULAR</TYPE>
</LIB>
8. Add Library to mlk file for each MCU that you want to use with your library.
9. Click Refresh button in Library Manager
10. Example Library should appear in the Library manager window.
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Multiple Library Versions

Library Alias represents unique name that is linked to corresponding Library .mcl
file. For example UART library for 16F887 is different from UART library for 18F4520
MCU. Therefore, two different UART Library versions were made, see mlk files for
these two MCUs. Note that these two libraries have the same Library Alias (UART)
in both mlk files. This approach enables you to have identical representation of
UART library for both MCUs in Library Manager.

Related topics: Library Manager, Project Manager, Managing Source Files
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(In-Circuit Debugger)

mikrolCD is highly effective tool for Real-Time debugging on hardware level. ICD
debugger enables you to execute a mikroPascal program on a host PIC microcon-
troller and view variable values, Special Function Registers (SFR), memory and

EEPROM as the program is running.
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[ StepNo.1 N
If you have appropriate hardware and software for using mikrolCD, then, upon com-
pletion of writing your program, you will have to choose ICD Debug build type.
Project Settings E
Elgzbevice -
E@Oscillator -
Choose ICD Debug
Value: MHz type if you want
- Lu l;Jsca mikrolCD
1= Buildf Debuager Type ebug.
EBuild Tvpe
") Releass @) ICD Debug  -f—
Debugger
() Software @ mikroICD
[ StepNo.2 N
You can run the mikrolCD by selecting Run > Debug from the drop-down menu, or
by clicking Debug Icon E@ . Starting the Debugger makes more options available:
Step Into, Step Over, Run to Cursor, etc. Line that is to be executed is color high-
lighted (blue by default). There is also notification about program execution and it
can be found on Watch Window (yellow status bar). Note that some functions take
time to execute, so running of program is indicated on Watch Window.
o — -
e . | TRISB := 0x00: 8 ) Bh o0 @ ve o | @ FE ™
e d text := 'mikroElektronika'; & Add 9@ Remove <) Properties bt Add All gl Remove All
Select variable from list:
@ . Led Initi): TRIZE -
® o Leod Cmd (LCD_CLEAR) ; Search for variable by assembly name:
° : Led Cmd (LCD_CURSOR_OFF) : TRISE &
L] . for i:=1 te 17 d0 |
. : Led Chril,i,text[i-1]); Name Value Address
@ - end. text {0k 0x0063
FORTE o 00038
TRISE 255 0x0062
PC= 0<000064 Cycle= 26980339.00
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MIKROICD DEBUGGER OPTIONS

Name Description Function

Key

Debug Starts Debugger. [F9]

Run/ Pause

Debugger Run or pause Debugger. [F6]

Toggle breakpoint at the current cursor position. To
Toggle view all the breakpoints, select Run » View Break- [F5]
Breakpoints points from the drop-down menu. Double clicking an

item in window list locates the breakpoint.

Execute all instructions between the current
Run to cursor . . " [F4]
instruction and the cursor position.

Execute the current C (single— or multi-cycle)
instruction, then halt. If the instruction is a routine

rep nte call, enter the routine and halt at the first instruc- [F7]
tion following the call.
Execute the current C (single— or multi-cycle)

. instruction, then halt. If the instruction is a routine

Step Over [F8]

call, skip it and halt at the first instruction follow-
ing the call.

Flushes current PIC RAM. All variable values will be
Flush RAM . ; N/A
changed according to values from watch window.

Disassembly Toggle between disassembly and Pascal source

View view. [Alt+D]
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MIKROICD DEBUGGER EXAMPLE

Here is a step by step mikrolCD Debugger Example.

First you have to write a program. We will show how mikrolCD works using this
example:

program Lcd Demo;

var LCD RS : sbit at RB4 bit;
var LCD EN : sbit at RB5 bit;
var LCD D4 : sbit at RBO bit;
var LCD D5 : sbit at RB1 bit;
var LCD D6 : sbit at RB2 bit;
var LCD D7 : sbit at RB3 bit;

var LCD RS Direction : sbit at TRISB4 bit;
var LCD EN Direction : sbit at TRISBS bit;
var LCD D4 Direction : sbit at TRISBO bit;
var LCD D5 Direction : sbit at TRISB1 bit;
var LCD D6 Direction : sbit at TRISB2 bit;
var LCD D7 Direction : sbit at TRISB3 bit;

var text : arrayl 16] of char;
i : byte;

begin
PORTB := O0;
TRISB := 0;
ANSEL = 0y
ANSELH := 0;
text := 'mikroElektronika';

Led Init ()
Led Cmd ( LCD_CLEAR) ;
Lcd Cmd( LCD CURSOR OFF) ;

for i := 1 to 17 do
Led Chr(l, 1, text[ i-1]1);
end.
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After successful compilation and PIC programming press F9 for starting mikrolCD.
After mikrolCD initialization blue active line should appear.

z0| Hhegin
= g TRISE := 0O:
= IMNSEL = O;
@ ANSELH := O;
. = text := 'mikroElektronika’:
e - Led Indti):
° . Led Crod (LCD_CLERR) ;
° . Led Cwd (LCD_CURSOR_OFF) :
30
. E for i := 1 to 17 do
e - Led Chr(l, i, text[i-1]):
. g end.

Wfatch Walues
Zh 2 5 | 2o & oo oI
== Add

Select vanable from list:

text

Search far variable by assembly name:
_text

| Peripheralz Freeze

Mame Yalue Address
FORTE o 0x0008
TRISE 127 0x0086
ANSEL 255 0=0188
ANSELH 63 0=0189

+ text {0} 0x0022

PC= 0x000005 Cycle= 0,00

K Remove O Properties

I AddAll L Remove All

We will debug program line by line. Pressing F8 we are executing code line by line.
It is recommended that user does not use Step Into [F7] and Step Over [F8] over
Delays routines and routines containing delays. Instead use Run to cursor [F4] and

Breakpoints functions.

All changes are read from PIC and loaded into Watch Window. Note that TRISB

changed its value from 255 to 0.

z0| Hhegin
= g TRISE := 0O:
@ AMSEL = O;
= ANSELH = O;
= = text := 'mikroElektronika':
- E Led Inic():
e . Led Crod (LCD_CLEAR) ;
° . Led Cmd (LCD CURSOR OFF) ;
20
. . for i := 1 to 17 do
. . Led Chril, i, text[i-1]):
= e end.

Watch Walues
[zh =) Bg | 20 ® oo &l
K Remove < Pr

Select varisble from list:
text

% Add

Search for variable by assembly name:
_beut

/| Peripherals Fresze

Marmne Walue Address
PORTE o 00006
TRISE 127 0=0086
ANSEL 255 Ox0185
ANSELH 63 0x0189

+  bext ik 0x0022

PC= 0000005 Cpcle=0.00

lug Add Al [ Remove All
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Step No. 4
Step Into [F7] and Step Over [F8] are mikrolCD debugger functions that are used in
stepping mode. There is also Real-Time mode supported by mikro ICD. Functions
that are used in Real-Time mode are Run/ Pause Debugger [F6] and Run to cursor
[F4]. Pressing F4 goes to line selected by user. User just have to select line with cur-
sor and press F4, and code will be executed until selected line is reached.
20 | IREEE Wiatch Walues =]
L] PORTE := 0O: ) .
° TRISE := 0O: =5 ) [=h (oo ® ve ol & [
L INSEL  := 0O; o Add ¥ Remove < Properties lg Add All L Remove All
= ANSELH = O; . .
Select variable from list:
4 1 text := 'mikroElektronika': Lext -
Search for variable by assembly name:
B 27 Leod Indt () ; _tewt @
y | IbE] (Eel (e GRITEY & /| Peripherak Freeze
o @ Led Cwd (LCD_CURSOR_OFF) ; T N—
30 Mame alue Address
@ g for i := 1 to 17 do PORTE 128 0x0006
. g Lod Chril, i, text[i-1]): TRIZE &4 00086
° I lena. ANSEL 0 0x0188
ANSELH o 0x0189
+  text .3 0=0022
PC= 0x000041 Cocle=0.00
| StepNo.5 N
Run(Pause) Debugger [F6] and Toggle Breakpoints [F5] are mikrolCD debugger
functions that are used in Real-Time mode. Pressing F5 marks line selected by user
for breakpoint. F6 executes code until breakpoint is reached. After reaching break-
point Debugger halts. Here at our example we will use breakpoints for writing
"mikroElektronika" on Lcd char by char. Breakpoint is set on Lcd_Chr and program
will stop everytime this function is reached. After reaching breakpoint we must press
F6 again for continuing program execution.
2o | IS Wiéatch Walues B
L FPORTE := 0O; 5 .
° TRISE := 0: (3 B Bl (o0 & vo ol [ @ [ & [ 4
e INSEL = 0O; & Add P Remove < Pr lg Add Al L Remove Al
= ANSELH := 0O; 5 . .
elect vaiiable from list:
. - text := 'mikroElektronika’: Lext -
Search for variable by assembly name:
L] . Lod Init(): _ltext &l
i i 1) (Bl (e SILTRY) V] Peripherals Fresze
= Lod Cmd (LC SRS | —
a0 Mame Yalue Address
= i for i := 1 to 17 do PORTE 129 0x0006
3z Lod Chr(l, i, text[i-11): TRISE 64 0x0086
° A Liend? ARNSEL 0 0x0165
ANSELH o 0=0189
+  bext fook 0x0022
PC= 0x000046 Crcle= 0,00
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Breakpoints has been separated into two groups. There are hardware and software
break points. Hardware breakpoints are placed in PIC and they provide fastest
debug. Number of hardware breakpoints is limited (1 for P16 and 1 or 3 or 5 for
P18). If all hardware brekpoints are used, next breakpoints that will be used are soft-
ware breakpoint. Those breakpoints are placed inside mikro ICD, and they simulate
hardware breakpoints. Software breakpoints are much slower than hardware break-
points. This differences between hardware and software differences are not visible
in mikrolCD software but their different timings are quite notable, so it is important
to know that there is two types of breakpoints.

. FFFRERFERENFE S
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MIKROICD (IN-CIRCUIT DEBUGGER) OVERVIEW

Breakpoints Window

The Breakpoints window manages the list of currently set breakpoints in the project.
Doubleclicking the desired breakpoint will cause cursor to navigate to the correspon-
ding location in source code.

Breakpaints =)
Line File Name
50 Lcd. mpas
54 Lcd. mpas
58 Led. mpas
64 Led.mpas
75 Led.mpas
76 Led.mpas

Watch Window

Debugger Watch Window is the main Debugger window which allows you to moni-
tor program items while running your program. To show the Watch Window, select
View > Debug Windows > Watch Window from the drop-down menu.

The Watch Window displays variables and registers of PIC, with their addresses and
values. Values are updated as you go through the simulation. Use the drop-down
menu to add and remove the items that you want to monitor. Recently changed
items are colored red.

Watch Walues =
E}}Eﬂ“ﬁg S0 Sy of 3T | @ =

e Add 3 Remove <) Properties g AddAll Ll Remove All

Select variable from list

Search for vanable by assembly name:
ADRESH

Peripherals Freeze

[L‘_ﬂ‘

Name Value Address

CCPLCON a 0=0017
CYRCOM o 00090
EEADR. 58 00100
EEDATA 255 00102
FER a 0:=0004
INTCON o 0=0008
PCL 150 00002
PCLATH o 00004
SSPCON a 0=0014
SSPBLF 223 0=0013
TEREG a 0x0019
TMRZ a 0=0011
ADCOMND 0:=0F 0=001F
ADCOML o 0=009F

PC= 0000005 Cycle= 0,00
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Double clicking an item opens the Edit Value window in which you can assign a new
value to the selected variable/register. Also, you can change view to binary, hex,
char, or decimal for the selected item.

[0 Edit Value: ACD F=R[EER(EE)

01000000 10000011 0001 00100110 1111

Representation
Dec Hex @) Bin Float Char

EEPROM Watch Window

mikrolCD EEPROM Watch Window is available from the drop-down menu, View >
Debug Windows > View EEPROM.

The EEPROM Watch window shows current values written into PIC internal
EEPROM memory. There are two action buttons concerning EEPROM Watch win-
dow - Write EEPROM and Read EEPROM. Write EEPROM writes data from
EEPROM Watch window into PIC internal EEPROM memory. Read EEPROM reads
data from PIC internal EEPROM memory and loads it up in EEPROM window.

EEPROM Watch B

Read EEPROM Write EEPROM

UUlUllUZ|03|04|US

=

6|U?|Ua|09|UA|UB|UC|UD|UE|UF|ASCII |‘

ooso| FF | FF | FF | FF | FF FF | FF | FF | FF | FF | FF FF | FF  FF | FF | FF

wra| FF | FF | FF | FF | FF FF | FF | FF | FF | FF | FF FF | FF FF | FF | FF

ooso| FF | FF | FF | FF | FF FF | FF | FF | FF | FF | FF FF | FF  FF | FF | FF

oooo| FF | FF | FF | FF | FF FF | FF | FF | FF | FF | FF FF | FF  FF | FF | FF

ooa0| FF | FF | FF | FF  FF FF | FF | FF | FF | FF | FF FF | FF FF | FF | FF

woso| FF | FF | FF FF | FF FF | FF | FF | FF | FF | FF | FF | FF FF  FF | FF

woco| FF | FF | FF | FF  FF FF (FF | FF | FF | FF | FF FF | FF FF | FF | FF

oooo| FF | FF | FF | FF  FF FF | FF | FF | FF | FF | FF  FF | FF  FF | FF | FF

ooEo| FF | FF | FF | FF | FF FF | FF | FF | FF | FF | FF FF | FF FF | FF | FF

wFo| FF | FF | FF | FF | FF FF | FF | FF | FF | FF | FF FF | FF FF | FF | FF

000§ 00 | 00 | DO 00 0D 00 00 00 00 | 00 D0 00 00 00 00 00 e

010§ 00 | 00 | DO 00 0D 00 00 00 00 | 00 | DO 00 00 00 00 00 | ceeeiaeeeiaeia

01z0f 00 | 00 | DO OO0 0D 00 00 00 00 | 00 DO 00 00 00 00 00 | ceeeiaeeeiaeia

01304 00 | 00 | DO OO0 0D 00 00 00 00 | 00 D0 00 00 00 00 00 | ceeeiaeeeiaeiae

01400 00 | 00 | OO OO0 OO0 OO OO0 00 00 |00 OO0 OO0 00 00 00 00  «oveivevenneinns

01504 00 uli] oo o0 00 00 | 00 00 00 a0 a0 00 00 00 00 | 00 e

01604 00 an op o000 0O 00 00 00 oo o 00 00 00 00 | 0D e

01704 00 | 00 | DO OO0 0D 00 00 00 00 | 00 D0 00 00 00 00 00 e

01504 00 | 00 | DO 00 0D 00 00 00 00 | 00 | D0 00 [ 00 00 00 | 00 | ceeiaeeeaena 52
STATUS: Idle
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Code Watch Window

mikrolCD Code Watch Window is available from the drop-down menu, View >
Debug Windows > View Code.

The Code Watch window shows code (hex code) written into PIC. There is action
button concerning Code Watch window - Read Code. Read Code reads code from
PIC and loads it up in View Code Window.

Also, you can set an address scope in which hex code will be read.

CODE ‘atch =l
Address Scope
000000 003FFF |

il | 01 | 0z | 03 | 04 | 05 | 05 | o7 | ASCIT B
1E00 FF E03 1683 1703 E3 EE3 304 E4 ¢ <ETHm <503 f <5
1E08 S04 ES 1584 1604 1653 1703 a0E 1683 <lF <BS= &, 5 <MAk
1E10 1703 E7 1683 1703 0F 1683 1703 £ <ETH= <ETB= ¢, F <5
1E18 1683 1703 1706 1386 1283 1703 1786 oo F 5Nz <ETH= <ETB
1E20 1F06 2E20 1606 2E22 1386 1683 1703 1786 ARz <US= <3PCH
1E28 1683 1703 3018 ED 1283 1703 1O, 2E2E F 5Nz <ETH> <ETH
1E30 1BO& 2E30 1003 1B86 1403 1683 1703 DEA <ACK= <ESC= 0, <E
1E38 DEE DEC EBED ZE2C 301E 2 E&C 390F & <CR>1 <CR> 1 <VT>
1E40 3E44 1803 ABA 82 2ES4 2EEE 2E84 2E8C D= <ETX> <CAN: 5«
1E48 ZEAT ZED3 ZEFS ZF1E 2FS51 2FSE ZE28 2E28 5,08, <ESCx | Qf
1ES0 ZE28 2EZ5 2EZ5 ZE25 1683 1703 1386 1683 ol Fagie <
1E58 1703 67 EE 866 EC 3010 ED 301E <ET> <ETE> g <B5>
1E80 E9 3064 E3 2F82 1283 1703 1386 1683 é.d0g. [ fDiz>
1E68 1703 1786 2E28 1683 1703 1386 1683 1703 <ET#= <ETB= T <ETB
1E70 3001 EA 30E3 EE 57F EC 3018 ED <S0H=08. 508, «
1E78 301E E9 3070 E3 2Fa2 1283 1703 1386 “RS=0&.}0&. [ F
1E80 1683 1703 1786 2E28 1383 186C 1783 866 F 5Nz <ETH> <ETE
1E8S @4 Y a0 ZEZE 1383 186 1783 1633 v i <BS=E (L F DO
1E20 1703 1386 184 1683 1703 500 EC 3008 <ET:= <ETB= t <DC3

1E98 ED 301E E9 309E E3 2F8z Fa4 ZE93 i =R3=0e. 2080 _
< [ +

STATUS: Idle
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View RAM Window

Debugger View RAM Window is available from the drop-down menu, View » Debug
Windows > View RAM.

The View RAM Window displays the map of PIC’'s RAM, with recently changed

items colored red.

RAhA

RAM | Histary
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Common Errors

- Trying to program PIC while mikrolCD is active.

- Trying to debug Release build Type version of program.
- Trying to debug changed program code which hasn't been compiled and pro-

grammed into PIC.
- Trying to select line that is empty for Run to cursor [F4] and Toggle Breakpoints

[F5] functions.
- Trying to debug PIC with mikrolCD while Watch Dog Timer is enabled.
- Trying to debug PIC with mikrolCD while Power Up Timer is enabled.

- It is not possible to force Code Protect while trying to debug PIC with mikrolCD.
- Trying to debug PIC with ICD with pull-up resistors set to ON on RB6 and RB7.
- For correct mikrolCD debugging do not use pull-ups.
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MIKROICD ADVANCED BREAKPOINTS

mikrolCD provides the possibility to use the Advanced Breakpoints. Advanced
Breakpoints can be used with PIC18 and PIC18FJ MCUs. To enable Advanced
Breakpoints set the Advanced Breakpoints checkbox inside Watch window :

| Advanced Breakpoints

To configure Advanced Breakpoints, start mikrolCD [F9] and select View » Debug
Windows > Advanced Breakpoints option from the drop-down menu or use
[CtrI+Shift+A] shortcut.

[ Advanced Breakpaints
Breakpoint #1

| Program Memary Break

Address 0200

File Register Break,

Read Access

oo Write Access

Filz Register Equal

an

Passcount |

Emulator Features
Event Breakpaints

Ereak on Watchdog Timer
/| Break on SLEEP

Breakpoint #2
Program Memary Break
oo
/| Filz Register Break.

Address
aFs

@) Read Access

Wite Access
/| File Register Equal

Yalue 9

Passcount 2

Breakpoint #3
Program Memary Break

ooon

File Reqister Break,

Read Access

onn Wirite Access

Fil= Register Equal

an

Enable Stopwatch

EBreak on Stack OverfUnderflow

Halt on Start Condition (Breakpaint 2)
Hal: on Skop Condition {Breakpoint 3)

Reset Stopwatch on Run

==

o

[ o ) [ ea ] [ s |

Note: When Advanced Breakpoints are enabled mikrolCD operates in Real-Time
mode, so it will support only the following set of commands: Start Debugger [F9],
Run/Pause Debugger [F6] and Stop Debugger [Ctrl+F2]. Once the Advanced
Breakpoint is reached, the Advanced Breakpoints feature can be disabled and
mikrolCD debugging can be continued with full set of commands. If needed,
Advanced Breakepoints can be re-enabled without restarting mikrolCD.

Note: Number of Advanced Breakpoints is equal to number of Hardware break-
points and it depends on used MCU.
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Program Memory Break

Program Memory Break is used to set the Advanced Breakpoint to the specific
address in program memory. Because of PIC pipelining mechanism program exe-
cution may stop one or two instructions after the address entered in the address
field. Value entered in the Address field must be in hex format.

Note: Program Memory Break can use the Passcount option. The program execu-
tion will stop when the specified program address is reached for the N-th time,
where N is the number entered in the Passcount field. When some Advanced Break-
point stops the program execution, passcount counters for all Advanced Breakpoints
will be cleared.

File Register Break

File Register Break can be used to stop the code execution when read/write access
to the specific data memory location occurs. If Read Access is selected, the File
Register Equal option can be used to set the matching value. The program execu-
tion will be stopped when the value read from the specified data memory location is
equal to the number written in the Value field. Values entered in the Address and
value fields must be in hex format.

Note: File Register Break can also use the Passcount option in the same way as
Program Memory Break.

Emulator Features
Event Breakpoints

- Break on Stack Overflow/Underflow : not implemented.

- Break on Watchdog Timer : not implemented.

- Break on SLEEP : break on SLEEP instruction. SLEEP instruction will not be
executed. If you choose to continue the mikrolCD debugging [F6] then the program
execution will start from the first instruction following the SLEEP instruction.

Stopwatch
Stopwatch uses Breakpoint#2 and Breakpoint#3 as a Start and Stop conditions.

To use the Stopwatch define these two Breakpoints and check the Enabile
Stopwatch checkbox.
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Stopwatch options:

- Halt on Start Condition (Breakpoint#2) : when checked, the program execution
will stop on Breakpoint#2. Otherwise, Breakpoint#2 will be used only to start the
Stopwatch.

- Halt on Stop Condition (Breakpoint#3) : when checked, the program execution
will stop on Breakpoint#3. Otherwise, Breakpoint#3 will be used only to stop the
Stopwatch.

- Reset Stopwatch on Run : when checked, the Stopwatch will be cleared before
continuing program execution and the next counting will start from zero. Otherwise,
the next counting will start from the previous Stopwatch value.
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mikroPascal PRO for PIC
Specifics

The following topics cover the specifics of mikroPascal PRO for PIC compiler:

- Pascal Standard Issues

- Predefined Globals and Constants
- Accessing Individual Bits

- Interrupts

- PIC Pointers

- Linker Directives

- Built-in Routines

- Code Optimization
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PASCAL STANDARD ISSUES

Divergence from the Pascal Standard

- Function recursion is not supported because of no easily-usable stack and limited
memory PIC Specific

Pascal Language Extensions

mikroPascal PRO for PIC has additional set of keywords that do not belong to the
standard Pascal language keywords:

- code
- data
- rx

- sfr
- at

- sbit
- bit

Related topics: Keywords, PIC Specific
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PREDEFINED GLOBALS AND CONSTANTS

SFRs and related constants

All PIC SFRs are implicitly declared as global variables of volatile word type. These
identifiers have an external linkage, and are visible in the entire project. When cre-
ating a project, the mikroPascal PRO for PIC will include an appropriate (*.mpas) file
from defs folder, containing declarations of available SFRs and constants (such as
PORTB, ADPCFG, etc). All identifiers are in upper case, identical to nomenclature
in the Microchip datasheets.

For a complete set of predefined globals and constants, look for “Defs” in the
mikroPascal PRO for PIC installation folder, or probe the Code Assistant for specif-
ic letters (Ctrl+Space in the Code Editor).

Math constants

In addition, several commonly used math constants are predefined in mikroPascal

PRO for PIC:

PI = 3.1415926
PI HALF = 1.5707963
TWO PI = 6.2831853
E = 2.7182818

Predefined project level defines

These defines are based on a value that you have entered/edited in the current proj-
ect, and it is equal to the name of selected device for the project.

If 16F887 is selected device, then 16F887 token will be defined as 1, so it can be
used for conditional compilation:

{ SIFDEF P16F887}
{ SENDIF}

Related topics: Project level defines
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ACCESSING INDIVIDUAL BITS

The mikroPascal PRO for PIC allows you to access individual bits of 8-bit variables.
It also supports sbit and bit data types

Accessing Individual Bits Of Variables

If you are familiar with a particular MCU, you can access bits by name:

// Clear Global Interrupt Bit (GIE)
GIE bit := 0;

Also, you can simply use the direct member selector (.) with a variable, followed by
a primary exression. Primary expression can be variable, constant, function call or
an expression enclosed by parentheses. For individual bit access there are prede-
fined global constants r0, B1, ..., B7 with B7 being the most significant bit:

// predefined globals as bit designators
// Clear bit 0 in INTCON register
INTCON.BO := 0;

// literal constant as bit designator
// Set bit 5 in ADCONO register
ADCONO.5 := 1;

// expression as bit designator
// Set bit 6 in STATUS register
i :=5;

STATUS. (i+1) := 1;

When using literal constants as bit designators instead of predefined ones, make
sure not to exceed the appropriate type size.

There is no need of any special declarations. This kind of selective access is an
intrinsic feature of mikropascal PRO for PIC and can be used anywhere in the code.
Identifiers BO—B7 are not case sensitive and have a specific namespace. You may
override them with your own members BO—B7 within any given structure.

See Predefined Globals and Constants for more information on register/bit names.
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sbit type

The mikroPascal PRO for PIC compiler has sbit data type which provides access to
bit-addressable SFRs. You can access them in several ways:

var LEDA : sbit at PORTA.BO;
var bit name : sbit at sfr-name.B<bit-position>;

var LEDB : sbit at PORTB.O;
var bit name : sbit at sfr-name.<bit-position>;

// If you are familiar with a particular MCU and its ports and direc-

tion registers (TRIS), you can access bits by their names:
var LEDC : sbit at RCO bit;
var bit name : sbit at R<port-letter><bit-position> bit;

var TRISCO : sbit at TRISCO bit;
var bit name : sbit at TRIS<port-letter><bit-position> bit;

bit type

The mikroPascal PRO for PIC compiler provides a bit data type that may be used
for variable declarations. It can not be used for argument lists, and function-return
values.

var bf : bit; // bit variable

There are no pointers to bit variables:

var—etr——2bit; // invalid

An array of type bit is not valid:

var—rr————btt; // invalid

Note :

- Bit variables can not be initialized.

- Bit variables can not be members of records.

- Bit variables do not have addresses, therefore unary operator ¢ (address of) is

not applicable to these variables.

Related topics: Predefined globals and constants
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INTERRUPTS

Interrupts can be easily handled by means of reserved word interrupt. mikroPascal
PRO for PIC implictly declares procedure interrupt which cannot be redeclared.

Write your own procedure body to handle interrupts in your application. Note that
you cannot call routines from within interrupt due to stack limitations.

mikroPascal PRO for PIC saves the following SFR on stack when entering interrupt
and pops them back upon return:

- PIC12 family: w, sTATUS, FSR, PCLATH
- PIC16 family: w, sTATUS, FSR, PCLATH
- PIC18 family: rsr (fast context is used to save wrREG, STATUS, BSR)

P18 priority interrupts

Note: For the P18 family both low and high interrupts are supported.

For P18 low priority interrupts reserved word is interrupt low:

1. function with name interrupt will be linked as ISR (interrupt service routine) for
high level interrupt

2. function with name interrupt low will be linked as ISR for low level

interrupt_low

If interrupt priority feature is to be used then the user should set the appropriate SFR
bits to enable it. For more information refer to datasheet for specific device.

Routine Calls from Interrupt

Calling functions and procedures from within the interrupt routine is now possible.
The compiler takes care about the registers being used, both in "interrupt" and in
"begin" thread, and performs "smart" context-switching between the two, saving
only the registers that have been used in both threads.

The functions and procedures that don't have their own frame (no arguments and
local variables) can be called both from the interrupt and the "begin" thread.
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Interrupt Examples

Here is a simple example of handling the interrupts from Tvr0 (if no other interrupts
are allowed):

procedure interrupt;

begin
counter := counter + 1;
T™MRO := 96;
INTCON := $20;

end;

In case of multiple interrupts enabled, you need to test which of the interrupts
occurred and then proceed with the appropriate code (interrupt handling):

procedure interrupt;

begin
if TestBit (INTCON, TMROIF) = 1 then
begin
counter := counter + 1;
TMRO := 96;

ClearBit (INTCON, TMROF) ;

// ClearBit is realised as an inline function,

// and may be called from within an interrupt
end

else

if TestBit (INTCON, RBIF) = 1 then
begin
counter := counter + 1;
TMRO := 96;
ClearBit (INTCON, RBIF);
end;
end;
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LINKER DIRECTIVES

mikroPascal PRO for PIC uses internal algorithm to distribute objects within memo-
ry. If you need to have a variable or a routine at the specific predefined address, use
the linker directives absolute and org.

Note: You must specify an even address when using the linker directives.
Directive absolute

Directive absolute specifies the starting address in RAM for a variable. If the vari-
able spans more than 1 word (16-bit), the higher words will be stored at the consec-
utive locations.

Directive absolute is appended to the declaration of a variable:

var x : word; absolute $32;
// Variable x will occupy 1 word (16 bits) at address $32

y : longint; absolute $34;
// Variable y will occupy 2 words at addresses $34 and $36

Be careful when using the absolute directive because you may overlap two vari-
ables by accident. For example:

var 1 : word; absolute $42;
// Variable 1 will occupy 1 word at address $42;

j3j : longint; absolute $40;

// Variable will occupy 2 words at $40 and $42; thus,

// changing 1 changes jj at the same time and vice versa

Note: You must specify an even address when using the absolute directive.
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Directive org

Directive org specifies the starting address of a routine in ROM. It is appended to
the declaration of a routine. For example:

procedure proc(par : byte); org $200;

begin

// Procedure will start at address $200;

end;

org directive can be used with main routine too. For example:

program Led Blinking;

procedure some proc();
begin

end;
org 0x800; // main procedure starts at 0x800
begin

TRISB := 0;

while TRUE do

begin
PORTB := 0x00;
Delay ms (500);
PORTB := OXxFF;
Delay ms (500);
end;

end.

Note: You must specify an even address when using the org directive.

Directive orgall

Use the orgall directive to specify the address above which all routines, constants
will be placed. Example:

begin

orgall (0x200) // All the routines, constants in main program will
be above the address 0x200

end.
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BUILT-IN ROUTINES

The mikroPascal PRO for PIC compiler provides a set of useful built-in utility func-
tions.

The 10, Hi, Higher, Highest routines are implemented as macros. If you want to
use these functions you must include built_in.h header file (located in the iniclude
folder of the compiler) into your project.

The pelay us and Delay ms routines are implemented as “inline”; i.e. code is gen-
erated in the place of a call, so the call doesn’t count against the nested call limit.

The vdelay ms, Delay Cyc and Get Fosc kiHz are actual Pascal routines. Their
sources can be found in pelays.mpas file located in the uses folder of the compiler.

-Lo

- Hi

- Higher
- Highest

- Inc
- Dec

- SetBit
- ClearBit
- TestBit

- Delay_us
- Delay_ms

- Clock_KHz
- Clock_MHz

- Reset
- Clrwdt

- DisableContextSaving
- SetFuncCall

- GetDateTime
- GetVersion
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Lo
Prototype function Lo (number: longint): byte;
Returns Lowest 8 bits (byte)of number, bits 7. .0.
Function returns the lowest byte of number. Function does not interpret bit pat-
terns of number — it merely returns 8 bits as found in register.
Description
This is an “inline” routine; code is generated in the place of the call, so the call
doesn’t count against the nested call limit.
Requires Arguments must be variable of scalar type (i.e. Arithmetic Types and Pointers).
E I d := 0x1AC30F4;
Xxample tmp := Lo(d); // Equals 0xF4
Hi
Prototype function Hi (number: longint): byte;
Returns Returns next to the lowest byte of number, bits 8..15.
Function returns next to the lowest byte of number. Function does not interpret
bit patterns of number — it merely returns 8 bits as found in register.
Description
This is an “inline” routine; code is generated in the place of the call, so the call
doesn’t count against the nested call limit.
Requires Arguments must be variable of scalar type (i.e. Arithmetic Types and Pointers).
E I d := 0x1AC30F4;
xample tmp := Hi(d); // Equals 0x30
Higher
Prototype function Higher (number: longint): byte;
Returns Returns next to the highest byte of number, bits 16..23.
Function returns next to the highest byte of number. Function does not interpret
bit patterns of number — it merely returns 8 bits as found in register.
Description
This is an “inline” routine; code is generated in the place of the call, so the call
doesn’t count against the nested call limit.
Requires Arguments must be variable of scalar type (i.e. Arithmetic Types and Pointers).
E I d := 0x1AC30F4;
xample tmp := Higher (d); // Equals 0xAC
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Highest

Prototype function Highest (number: longint): byte;

Returns Returns the highest byte of number, bits 24..31.
Function returns the highest byte of number. Function does not interpret bit pat-
terns of number — it merely returns 8 bits as found in register.

Description
This is an “inline” routine; code is generated in the place of the call, so the call
doesn’t count against the nested call limit.

Requires Arguments must be variable of scalar type (i.e. Arithmetic Types and Pointers).

Example ?m;:;gxlllzj;igz;(m ; // Equals 0x01

Inc

Prototype [procedure Inc(var par : longint);

Returns Nothing.

Description [Increases parameter par by 1.

Requires Nothing.

Example | T

Dec

Prototype procedure Dec (var par : longint);

Returns Nothing.

Description |Decreases parameter par by 1.

Requires Nothing.

Example |7 ° T
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SetBit
Prototype procedure SetBit (var register : byte; rbit : byte);

Returns Nothing.

Function sets the bit rbit of register. Parameter rbit needs to be a variable or
literal with value 0..7. See Predefined globals and constants for more informa-
. tion on register identifiers.

Description
This is an “inline” routine; code is generated in the place of the call, so the call
doesn’t count against the nested call limit.

Requires Nothing.

Example SetBit (PORTB, 2); // Set RB2

ClearBit

Prototype procedure ClearBit (var register : byte; rbit : byte);

Returns Nothing.

Function clears the bit rbit of register. Parameter rbit needs to be a vari-
able or literal with value 0..7. See Predefined globals and constants for more
o information on register identifiers.

Description
This is an “inline” routine; code is generated in the place of the call, so the call
doesn’t count against the nested call limit.

Requires Nothing.

Example ClearBit (PORTC, 7); // Clear RC7

TestBit

PrOtOtype function TestBit (register, rbit : byte) : byte;
Returns If the bit is set, returns 1, otherwise returns 0.

Function tests if the bit rbit of register is set. If set, function returns 1, otherwise
returns 0. Parameter rbit needs to be a variable or literal with value 0..7. See Pre-
e defined globals and constants for more information on register identifiers.
Description
This is an “inline” routine; code is generated in the place of the call, so the call
doesn’t count against the nested call limit.

Requires Nothing.

Example flag := TestBit (PORTE, 2); // 1 if RE2 is set, otherwise 0
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Delay_us

Prototype procedure Delay us(time in us: const longword);

Returns Nothing.
Creates a software delay in duration of time in us microseconds (a constant).
Range of applicable constants depends on the oscillator frequency.

Description
This is an “inline” routine; code is generated in the place of the call, so the call
doesn’t count against the nested call limit.

Requires Nothing.

Example Delay us(1000); // One millisecond pause

Delay_ms

Prototype procedure Delay ms(time in ms: const longword);

Returns Nothing.
Creates a software delay in duration of time in ms milliseconds (a constant).
Range of applicable constants depends on the oscillator frequency.

Description
This is an “inline” routine; code is generated in the place of the call, so the call
doesn’t count against the nested call limit.

Requires Nothing.

Example Delay ms(1000); // One second pause

Clock_KHz

Prototype |function Clock KHz(): word;

Returns Device clock in KHz, rounded to the nearest integer.
Function returns device clock in KHz, rounded to the nearest integer.

Description This is an “inline” routine; code is generated in the place of the call, so the call
doesn’t count against the nested call limit.

Requires Nothing.

Example clk := Clock kHz();
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Clock_MHz
Prototype function Clock MHz(): byte;
Returns Device clock in MHz, rounded to the nearest integer.

Function returns device clock in MHz, rounded to the nearest integer.

Description This is an “inline” routine; code is generated in the place of the call, so the call

doesn’t count against the nested call limit.

Requires Nothing.

Example clk := Clock MHz();

Reset

Prototype |procedure Reset;

Returns Nothing.
. This procedure is equal to assembler instruction reset. This procedure works
Description
only for P18.

Requires Nothing.

Example Reset; //Resets the PIC MCU

Clrwdt

Prototype procedure ClrWdt () ;

Returns Nothing.

Description |This procedure is equal to assembler instruction clrwdt.

Requires Nothing.

Example Clrwdt; //Clears PIC's WDT
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DisableContextSaving

Prototype procedure DisableContextSaving() ;

Returns Nothing.

Use the DisableContextSaving() to instruct the compiler not to automatically
perform context-switching. This means that no regiser will be saved/restored by
Description |the compiler on entrance/exit from interrupt service routine. This enables the
user to manually write code for saving registers upon entrance and to restore
them before exit from interrupt.

Requires This routine must be called from main.

DisableContextSaving(); //instruct the compiler not to automati-

Example cally perform context-switching

SetFuncCall

Prototype procedure SetFuncCall (FuncName: string);

Returns Nothing.

Function informs the linker about a specific routine being called. SetFuncCall
has to be called in a routine which accesses another routine via a pointer.
Description
Function prepares the caller tree, and informs linker about the procedure usage,
making it possible to link the called routine.

Requires Nothing.

procedure first(p, g: byte);
begin

Example SetFuncCall (second); // let linker know that we will call the
routine 'second'

end
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GetDateTime

Prototype function GetDateTime() : string;

Returns String with date and time when this routine is compiled.

Description |Use the GetDateTime() to get date and time of compilation as string in your code.

Requires Nothing.

Example str := GetDateTime();
GetVersion

Prototype [function GetvVersion() : string;
Returns String with current compiler version.

Description |Use the GetVersion() to get the current version of compiler.

Requires Nothing.

str := GetVersion(); // for example, str will take the value of

Example '8.2.1.6"
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CODE OPTIMIZATION

Optimizer has been added to extend the compiler usability, cut down the amount of
code generated and speed-up its execution. The main features are:

Constant folding

All expressions that can be evaluated in the compile time (i.e. are constant) are
being replaced by their results. (3 + 5 -> 8);

Constant propagation

When a constant value is being assigned to a certain variable, the compiler recog-
nizes this and replaces the use of the variable by constant in the code that follows,
as long as the value of a variable remains unchanged.

Copy propagation

The compiler recognizes that two variables have the same value and eliminates one
of them further in the code.

Value numbering

The compiler "recognizes" if two expressions yield the same result and can there-
fore eliminate the entire computation for one of them.

"Dead code" ellimination

The code snippets that are not being used elsewhere in the programme do not affect
the final result of the application. They are automatically removed.

Stack allocation

Temporary registers ("Stacks") are being used more rationally, allowing VERY com-
plex expressions to be evaluated with a minimum stack consumption.

Local vars optimization

No local variables are being used if their result does not affect some of the global or
volatile variables.

Better code generation and local optimization

Code generation is more consistent and more attention is payed to implement spe-
cific solutions for the code "building bricks" that further reduce output code size.
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In order to get the most from your mikroPascal PRO for PIC compiler, you should
be familiar with certain aspects of PIC MCU. This knowledge is not essential, but it
can provide you a better understanding of PICs’ capabilities and limitations, and

their impact on the code writing.
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Types Efficiency

First of all, you should know that PIC’s ALU, which performs arithmetic operations,
is optimized for working with bytes. Although mikroPascal PRO for PIC is capable of
handling very complex data types, PIC may choke on them, especially if you are
working on some of the older models. This can dramatically increase the time need-
ed for performing even simple operations. Universal advice is to use the smallest
possible type in every situation. It applies to all programming in general, and doubly
so with microcontrollers.

Get to know your tool. When it comes down to calculus, not all PIC MCUs are of
equal performance. For example, PIC16 family lacks hardware resources to multi-
ply two bytes, so it is compensated by a software algorithm. On the other hand,
PIC18 family has HW multiplier, and as a result, multiplication works considerably
faster.

Nested Calls Limitations

Nested call represents a function call within function body, either to itself (recursive
calls) or to another function. Recursive function calls are supported by mikroPascal
PRO for PIC but with limitations. Recursive function calls can't contain any function
parameters and local variables due to the PIC’s stack and memory limitations.

mikroPascal PRO for PIC limits the number of non-recursive nested calls to:

- 8 calls for PIC12 family,
- 8 calls for PIC16 family,
- 31 calls for PIC18 family.

Note that some of the built-in routines do not count against this limit, due to their
“inline” implementation.

Number of the allowed nested calls decreases by one if you use any of the follow-
ing operators in the code: = / <. It further decreases if you use interrupts in the pro-
gram. Number of decreases is specified by number of functions called from inter-
rupt. Check functions reentrancy.

If the allowed number of nested calls is exceeded, the compiler will report a stack
overflow error.
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PIC18FxxJxx Specifics
Shared Address SFRs

mikroPascal PRO for PIC does not provide auto setting of bit for acessing alternate
register. This is new feature added to pic18fxxjxx family and will be supported in
future. In several locations in the SFR bank, a single address is used to access two
different hardware registers. In these cases, a “legacy” register of the standard
PIC18 SFR set (such as OSCCON, T1CON, etc.) shares its address with an alter-
nate register. These alternate registers are associated with enhanced configuration
options for peripherals, or with new device features not included in the standard
PIC18 SFR map. A complete list of shared register addresses and the registers
associated with them is provided in datasheet.

PIC16 Specifics
Breaking Through Pages

In applications targeted at PIC16, no single routine should exceed one page (2,000
instructions). If routine does not fit within one page, linker will report an error. When
confront with this problem, maybe you should rethink the design of your application
— try breaking the particular routine into several chunks, etc.

Limits of Indirect Approach Through FSR

Pointers with PIC16 are “near”: they carry only the lower 8 bits of the address. Com-
piler will automatically clear the 9th bit upon startup, so that pointers will refer to
banks 0 and 1. To access the objects in banks 2 or 3 via pointer, user should man-
ually set the IRP, and restore it to zero after the operation. The stated rules apply to
any indirect approach: arrays, structures and unions assignments, etc.

Note: It is very important to take care of the IRP properly, if you plan to follow this
approach. If you find this method to be inappropriate with too many variables, you
might consider upgrading to PIC18.

Note: If you have many variables in the code, try rearranging them with the linker
directive absolute. Variables that are approached only directly should be moved to
banks 3 and 4 for increased efficiency.

Related topics: mikroPascal PRO for PIC specifics
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MEMORY TYPE SPECIFIERS

The mikroPascal PRO for PIC supports usage of all memory areas. Each variable may be explic-
itly assigned to a specific memory space by including a memory type specifier in the declaration,
or implicitly assigned.

The following memory type specifiers can be used:
- code
- data

- X

- sfr

Memory type specifiers can be included in variable declaration.

For example:

var data buffer : char; data; // puts data buffer in data ram
const txt = 'Enter parameter'; code; // puts text in program memory
code

Description | The code memory type may be used for allocating constants in program memory.

// puts txt in program memory

Exan“ﬂe const txt = 'Enter parameter'; code;

data

Description | This memory specifier is used when storing variable to the internal data SRAM.

// puts data buffer in data ram

Example var data buffer : char; data;

rx
This memory specifier allows variable to be stored in the Rx space (Register file).

o Note: In most of the cases, there will be enough space left for the user variables

Description |. . : )
in the Rx space. However, since compiler uses Rx space for storing temporary
variables, it might happen that user variables will be stored in the internal data
SRAM, when writing complex programs.

Example // puts y in Rx space

var y : char; rx;
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sfr

This memory specifier in combination with (rx, io, data) allows user to access
Description |special function registers. It also instructs compiler to maintain same identifier in
Pascal and assembly.

Example var y : char; rx; sfr;

// puts y in Rx space

Note: If none of the memory specifiers are used when declaring a variable, d=tz specifier will be
set as default by the compiler.

Related topics: Accessing individual bits, SFRs, Constants, Functions
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mikroPascal PRO for PIC
Language Reference

The mikroPascal PRO for AVR Language Reference describes the syntax, seman-
tics and implementation of the mikroPascal PRO for AVR language.

The aim of this reference guide is to provide a more understandable description of
the mikroPascal PRO for AVR language to the user.
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Lexical Elements
Whitespace
Comments
Tokens
Literals
Keywords
Identifiers
Punctuators
Program Organization
Program Organization
Scope and Visibility
Units
Variables
Constants
Labels
Functions and Procedures
Functions
Procedures
Types
Simple Types
Arrays
Strings
Pointers
Records
Types Conversions
Implicit Conversion
Explicit Conversion
Operators
Introduction to Operators
Operators Precedence and Associativity
Arithmetic Operators
Relational Operators
Bitwise Operators
Boolean Operators
Expressions
Expressions
Statements
Introduction to Statements
Assignment Statements
Compound Statements (Blocks)
Conditional Statements
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If Statement
Case Statement
Iteration Statements (Loops)
For Statement
While Statement
Repeat Statement
Jump Statements
Break and Continue Statements
Exit Statement
Goto Statement
asm Statement
Directives
Compiler Directives
Linker Directives

LEXICAL ELEMENTS OVERVIEW

The following topics provide a formal definition of the mikroPascal PRO for PIC lex-
ical elements. They describe different categories of word-like units (tokens) recog-

nized by mikroPascal PRO for PIC.

In the tokenizing phase of compilation, the source code file is parsed (i.e. broken
down) into tokens and whitespace. The tokens in mikroPascal PRO for PIC are
derived from a series of operations performed on your programs by the compiler.
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WHITESPACE

Whitespace is a collective name given to spaces (blanks), horizontal and vertical
tabs, newline characters and comments. Whitespace can serve to indicate where
tokens start and end, but beyond this function, any surplus whitespace is discarded.
For example, two sequences

var 1 : char;

j : word;and
var
i : char;

J : word;

are lexically equivalent and parse identically to give nine tokens:

var
i

char

word

Whitespace in Strings

The ASCII characters representing whitespace can occur within string literals, in
which case they are protected from the normal parsing process (they remain a part
of the string). For example,

some string := 'mikro foo';

parses into four tokens, including a single string literal token:

some string

'mikro foo!

’
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COMMENTS

Comments are pieces of a text used to annotate a program, and are technically
another form of whitespace. Comments are for the programmer’s use only. They are
stripped from the source text before parsing.

There are two ways to create comments in mikroPascal. You can use multi-line com-
ments which are enclosed with braces or (* and *):

{ All text between left and right brace

constitutes a comment. May span multiple lines. }

(* Comment can be

written in this way too. *)
or single-line comments:

// Any text between a double-slash and the end of the

// line constitutes a comment spanning one line only.
Nested comments

mikroPascal PRO for PIC doesn’t allow nested comments. The attempt to nest a
comment like this

{ i { didentifier } : word; }

fails, because the scope of the first open brace “{” ends at the first closed brace “}".
This gives us

. word; }

which would generate a syntax error.
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TOKENS

Token is the smallest element of the Pascal program that compiler can recognize.
The parser separates tokens from the input stream by creating the longest token
possible using the input characters in a left—to—right scan.

mikroPascal PRO for PIC recognizes the following kinds of tokens:

- keywords
- identifiers
- constants
- operators
- punctuators (also known as separators)

Token Extraction Example

Here is an example of token extraction. Take a look at the following example code
sequence:

end flag := 0;

First, note that end_flag would be parsed as a single identifier, rather than as the
keyword end followed by the identifier f1ag.

The compiler would parse it as the following four tokens:

end flag // variable identifier
1= // assignment operator
0 // literal

// statement terminator

Note that := parses as one token (the longest token possible), not as token : fol-
lowed by token =.
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LITERALS

Literals are tokens representing fixed numeric or character values.

The data type of a constant is deduced by the compiler using such clues as numer-
ic value and format used in the source code.

Integer Literals

Integral values can be represented in decimal, hexadecimal, or binary notation.

In decimal notation, numerals are represented as a sequence of digits (without com-
mas, spaces, or dots), with optional prefix + or - operator to indicate the sign. Values

default to positive (6258 is equivalent to +6258).

The dollar-sign prefix ($) or the prefix Ox indicates a hexadecimal numeral (for
example, $8F or 0x8F).

The percent-sign prefix (%) indicates a binary numeral (for example, 501010000).

Here are some examples:

11 // decimal literal

S11 // hex literal, equals decimal 17
0x11 // hex literal, equals decimal 17
%11 // binary literal, equals decimal 3

The allowed range of values is imposed by the largest data type in mikroPascal
PRO for PIC — longint. Compiler will report an error if the literal exceeds 2147483647
($7FFFFFFF).

Floating Point Literals
A floating-point value consists of:
- Decimal integer
- Decimal point
- Decimal fraction
- e or & and a signed integer exponent (optional)

You can omit either the decimal integer or decimal fraction (but not both).

Negative floating constants are taken as positive constants with the unary operator
minus (-) prefixed.
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mikroPascal PRO for PIC limits floating-point constants to range +1.17549435082 *
10-38 . +6.80564774407 * 1038

Here are some examples:

0. // = 0.0

-1.23 // = -1.23
23.45e6 // = 23.45 * 10”76
2e-5 // = 2.0 * 10"-5
3E+10 // = 3.0 * 10710

.09E34 // = 0.09 * 10734
Character Literals

Character literal is one character from the extended ASCII character set, enclosed
with apostrophes.

Character literal can be assigned to variables of the byte and char type (variable of
byte will be assigned the ASCII value of the character). Also, you can assign char-
acter literal to a string variable.

Note: Quotes ("") have no special meaning in mikroPascal PRO for PIC.

String Literals

String literal is a sequence of characters from the extended ASCII character set,
written in one line and enclosed with apostrophes. Whitespace is preserved in string
literals, i.e. parser does not “go into” strings but treats them as single tokens.

Length of string literal is a number of characters it consists of. String is stored inter-
nally as the given sequence of characters plus a final null character. This null char-
acter is introduced to terminate the string, it does not count against the string’s total
length.

String literal with nothing in between the apostrophes (null string) is stored as a sin-
gle nul1 character.

You can assign string literal to a string variable or to an array of char.
Here are several string literals:

'Hello world!' // message, 12 chars long
'Temperature is stable' // message, 21 chars long

! ! // two spaces, 2 chars long
'C! // letter, 1 char long

v // null string, 0 chars long

The apostrophe itself cannot be a part of the string literal, i.e. there is no escape
sequence. You can use the built-in function Chr to print an apostrophe: chr (39).
Also, see String Splicing.
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KEYWORDS

Keywords are the words reserved for special purposes and must not be used as nor-

mal identifier names.

Beside standard Pascal keywords, all relevant SFRs are defined as global variables
and represent reserved words that cannot be redefined (for example: W0, TMR1,
T1CON, etc). Probe the Code Assistant for specific letters (Ctrl+Space in Editor) or
refer to Predefined Globals and Constants.

Here is the alphabetical listing of keywords in Pascal:

- absolute

- abstract

- and

- array

- as

- asm

- assembler
- at

- automated
- bdata

- begin

- bit

- case

- cdecl

- class

- code

- compact

- const

- constructor
- contains

- data

- default

- deprecated
- destructor
- dispid

- dispinterface
- div

- do

- downto

- dynamic

- end

- except

- export

- exports

- external

- far

- file

- final

- finalization
- finally

for
forward
goto
helper
idata

if

ilevel
implementation
implements
in

index
inherited
initialization
inline
interface
is

label
library
message
mod

name

near

nil
nodefault
not
object

of

on
operator
or

org

out
overload
override
package
packed
pascal
pdata
platform
private

procedure
program
property
protected
public
published
raise
read
readonly
record
register
reintroduce
repeat
requires
safecall
sbit
sealed
set

shl

shr

small
stdcall
stored
string
threadvar
to

try

type

unit
until
uses

var
virtual
volatile
while
with
write
writeonly
xdata

XOor
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Also, mikroPascal PRO for PIC includes a number of predefined identifiers used in
libraries. You can replace them by your own definitions, if you plan to develop your
own libraries. For more information, see mikroPascal for PIC Libraries.

IDENTIFIERS

Identifiers are arbitrary names of any length given to functions, variables, symbolic
constants, user-defined data types and labels. All these program elements will be
referred to as objects throughout the help (don't get confused about the meaning of
object in object-oriented programming).

Identifiers can contain the letters a to z and A to Z, underscore character “_”, and
digits from 0 to 9. The only restriction is that the first character must be a letter or an
underscore.

Case Sensitivity
Pascal is not case sensitive, so sum, sum, and suM are an equivalent identifier.
Uniqueness and Scope

Although identifier names are arbitrary (according to the stated rules), if the same
name is used for more than one identifier within the same scope then error arises.
Duplicated names are illegal within same scope. For more information, refer to
Scope and Visibility.

Identifier Examples

Here are some valid identifiers:

temperature V1
Pressure

no hit
dat2string
SUM3

_vtext

... and here are some invalid identifiers:

7temp // NO -- cannot begin with a numeral

$higher // NO -- cannot contain special characters

Xor // NO -- cannot match reserved word

323.07.04 // NO -- cannot contain special characters (dot)
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PUNCTUATORS
The mikroPascal punctuators (also known as separators) are:

- [ ] — Brackets

- () — Parentheses
-,—Comma

- ; — Semicolon

- . — Colon
-.—Dot

Brackets

Brackets [ ] indicate single and multidimensional array subscripts:

var alphabet : array| 1..30] of byte;
//
alphabet[ 3] := 'c';

For more information, refer to Arrays.
Parentheses

Parentheses ( ) are used to group expressions, isolate conditional expressions and
indicate function calls and function declarations:

d :=c* (a + b); // Override normal precedence

if (d = z) then ... // Useful with conditional statements
func () ; // Function call, no arguments
function func2(n : word); // Function declaration with parameters

For more information, refer to Operators Precedence and Associativity, Expressions
and Functions and Procedures.

Comma

Comma (,) separates the arguments in function calls:

LCD Out (1, 1, txt);

Further, the comma separates identifiers in declarations:

var i, j, k : byte;

The comma also separates elements of array in initialization lists:

const MONTHS : array[ 1..12] of byte =
(31,28,31,30,31,30,31,31,30,31,30,31);

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD 147



CHAPTER 6
Language Reference mikroPASCAL PRO for PIC

Semicolon

Semicolon (;) is a statement terminator. Every statement in Pascal must be termi-
nated with a semicolon. The exceptions are: the last (outer most) end statement in
the program which is terminated with a dot and the last statement before end which
doesn't need to be terminated with a semicolon.

For more information, see Statements.

Colon

Colon (:) is used in declarations to separate identifier list from type identifier. For

example:

var
i, 3 : byte;
k : word;

In the program, use the colon to indicate a labeled statement:
start: nop;

goto start;

For more information, refer to Labels.

Dot

Dot (.) indicates an access to a field of a record. For example:
person.surname := 'Smith';

For more information, refer to Records.

Dot is a necessary part of floating point literals. Also, dot can be used for accessing
individual bits of registers in mikroPascal.
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PROGRAM ORGANIZATION

Pascal imposes quite strict program organization. Below you can find models for
writing legible and organized source files. For more information on file inclusion and
scope, refer to Units and Scope and Visibility.

Organization of Main Unit

Basically, the main source file has two sections: declaration and program body. Dec-
larations should be in their proper place in the code, organized in an orderly man-
ner. Otherwise, the compiler may not be able to comprehend the program correctly.

When writing code, follow the model presented below. The main unit should look like
this:

program { program name }
uses { 1include other units }

//****************************~)<***************************

//* Declarations (globals):

//****************************~)<***************************

{ constants declarations }
const ...

{ types declarations }

type

{ wvariables declarations }

var Name[ , Name?2...] : [ "] type; [ absolute 0x123;] [ external;]
[ volatile;] [ register;] [ sfr;]

{ labels declarations }
label

{ procedures declarations }

procedure procedure name (parameter list);
{ local declarations }
begin
end;

{ functions declarations }

function function name (parameter list) : return type;
{ local declarations }
begin
end;
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//*k**k**k**k**k**k**k**k**k**k**k**k**k**k**k**k**k***********************

//* Program body:

//*k**k**k**k**k**k**k**k**k**k**k**k**k**k**k**k**k***********************

begin
{ write your code here }
end.

Organization of Other Units

Units other than main start with the keyword unit. Implementation section starts with
the keyword implementation. Follow the model presented below:

unit { unit name }
uses { 1include other units }

//*k**k**k**k**k**k**k**k**k**k**k**k**k**k**k**k**k***********************

//* Interface (globals):

//*k**k**k**k**k**k**k**k**k**k**k**k**k**k**k**k**k***********************

{ constants declarations }
const

{ types declarations }
type

{ wvariables declarations }
var Name[ , Name2...] : [ "] type; [ absolute 0x123;] [ external;]
[ volatile;] [ register;] [ sfr;]

{ procedures prototypes }
procedure procedure name ([ var] [ const] ParamName : [ "] type; [ var]
[ const] ParamName2, ParamName3 : [ "] type);

{ functions prototypes }
function function name ([ var] [ const] ParamName : [ "] type; [ var]
[ const] ParamName2, ParamName3 : [ "] type) : [ "] type;

//*k**k**k**k**k**k**k**k**k**k**k**k**k**k**k**k**k***********************

//* Implementation:
//*k**k**k**k**k**k**k**k**k**k**k**k**k**k**k**k**k***********************

implementation

{ constants declarations }
const

{ types declarations }
type
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{ wvariables declarations }
var Name[ , Name?2...] : [ "] type; [ absolute 0x123;] [ external;]
[ volatile;] [ register;] [ sfr;]

{ labels declarations }
label

{ procedures declarations }

procedure procedure name ([ var] [ const] ParamName : [ "] type; [ var
[ const] ParamName2, ParamName3 : [ "] type); [ ilevel 0x123;] [ over-
load;] [ forward;]

{ local declarations }

begin

end;

{ functions declarations }
function function name ([ var] [ const] ParamName : [ *] type; [ var
[ const] ParamName2, ParamName3 : [ "] type) : [ "] type; [ ilevel 0x123;]
[ overload;] [ forward;]

{ local declarations }

begin

end;

end.

Note: constants, types and variables used in the implementation section are inac-
cessible to other units. This feature is not applied to the procedures and functions in
the current version, but it will be added to the future ones.

Note: Functions and procedures must have the same declarations in the interface
and implementation section. Otherwise, compiler will report an error.

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD 151



CHAPTER 6
Language Reference mikroPASCAL PRO for PIC

SCOPE AND VISIBILITY

Scope

The scope of an identifier is a part of the program in which the identifier can be used
to access its object. There are different categories of scope, which depends on how
and where identifiers are declared:

Place of declaration Scope

Scope extends from the point where it is declared
to the end of the current block, including all
blocks enclosed within that scope. Identifiers in
the outermost scope (file scope) of the main unit
are referred to as globals, while other identifiers

Identifier is declared in the
declaration of a program, func-
tion, or procedure

are locals.

Scope extends the interface section of a unit from
Identifier is declared in the the point where it is declared to the end of the
interface section of a unit unit, and to any other unit or program that uses

that unit.

Identifier is declared in the
implementation section of a
unit, but not within the block of
any function or procedure

Scope extends from the point where it is declared
to the end of the unit. The identifier is available to
any function or procedure in the unit.

Visibility
The visibility of an identifier is that region of the program source code from which

legal access to the identifier’s associated object can be made.

Scope and visibility usually coincide, though there are circumstances under which
an object becomes temporarily hidden by the appearance of a duplicate identifier,
i.e. the object still exists but the original identifier cannot be used to access it until
the scope of the duplicate identifier is ended.

Technically, visibility cannot exceed scope, but scope can exceed visibility.
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UNITS

In mikroPascal PRO for PIC, each project consists of a single project file and one or
more unit files. Project file, with extension .mpppi contains information about the
project, while unit files, with extension .mpas, contain the actual source code.

Units allow you to:

- break large programs into encapsulated parts that can be edited separately,
- create libraries that can be used in different projects,
- distribute libraries to other developers without disclosing the source code.

Each unit is stored in its own file and compiled separately. Compiled units are linked
to create an application. In order to build a project, the compiler needs either a
source file or a compiled unit file (.mc1 file) for each unit.

Uses Clause

mikroPascal PRO for PIC includes units by means of the uses clause. It consists of
the reserved word uses, followed by one or more comma-delimited unit names, fol-
lowed by a semicolon. Extension of the file should not be included. There can be at
most one uses clause in each source file, and it must appear immediately after the
program (or unit) name.

Here’s an example:
uses utils, strings, Unit2, MyUnit;

For the given unit name, the compiler will check for the presence of .mcl and .mpas
files, in order specified by the search paths.

- If both .mpas and .mc1 files are found, the compiler will check their dates and
include the newer one in the project. If the .mpas file is newer than .mc1, a new
library will be written over the old one;

- If only .mpas file is found, the compiler will create the .mc1 file and include it in the
project;

- Ifonly .mc1 file is present, i.e. no source code is available, the compiler will include
it as it is found;

- If none found, the compiler will issue a “File not found” warning.
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Main Unit

Every project in mikroPascal PRO for PIC requires a single main unit file. The main
unit file is identified by the keyword program at the beginning; it instructs the com-
piler where to “start”.

After you have successfully created an empty project with the Project Wizard, the
Code Editor will display a new main unit. It contains the bare-bones of the Pascal
program:

program MyProject;
{ main procedure }
begin

{ Place program code here }
end.

Nothing should precede the keyword program except comments. After the program
name, you can optionally place the uses clause.

Place all global declarations (constants, variables, types, labels, routines) before the
keyword begin.

Other Units

Units other than main start with the keyword uni+. Newly created blank unit contains
the bare-bones:

unit MyUnit;
implementation
end.

Other than comments, nothing should precede the keyword unit. After the unit
name, you can optionally place the uses clause.

Interface Section

Part of the unit above the keyword implementation is referred to as interface sec-
tion. Here, you can place global declarations (constants, variables, labels and types)
for the project.

You do not define routines in the interface section. Instead, state the prototypes of
routines (from implementation section) that you want to be visible outside the unit.
Prototypes must match the declarations exactly.
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Implementation Section

Implementation section hides all irrelevant innards from other units, allowing encap-
sulation of code.

Everything declared below the keyword implementation is private, i.e. has its
scope limited to the file. When you declare an identifier in the implementation sec-
tion of a unit, you cannot use it outside the unit, but you can use it in any block or
routine defined within the unit.

By placing the prototype in the interface section of the unit (above the implementa-
tion) you can make the routine public, i.e. visible outside of unit. Prototypes must
match the declarations exactly.
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VARIABLES

Variable is object whose value can be changed during the runtime. Every variable is
declared under unique name which must be a valid identifier. This name is used for
accessing the memory location occupied by a variable.

Variables are declared in the declaration part of the file or routine — each variable needs
to be declared before being used. Global variables (those that do not belong to any
enclosing block) are declared below the uses statement, above the keyword begin.

Specifying a data type for each variable is mandatory. Syntax for variable declara-
tion is:

var identifier list : type;

identifier list is a comma-delimited list of valid identifiers and type can be any
data type.

For more details refer to Types and Types Conversions. For more information on
variables’ scope refer to the chapter Scope and Visibility.

Pascal allows shortened syntax with only one keyword var followed by multiple vari-
able declarations. For example:

var i, j, k : byte;
counter, temp : word;
samples : array[ 100] of word;

External Modifier

Use the external modifier to indicate that the actual place and initial value of the vari-
able, or body of the function, is defined in a separate source code unit.

Variables and PIC

Every declared variable consumes part of RAM. Data type of variable determines
not only allowed range of values, but also the space variable occupies in RAM. Bear
in mind that operations using different types of variables take different time to be
completed. mikroPascal PRO for PIC recycles local variable memory space — local
variables declared in different functions and procedures share the same memory
space, if possible.

There is no need to declare SFRs explicitly, as mikroPascal PRO for PIC automatically
declares relevant registers as global variables of volatile word see SFR for details.
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CONSTANTS

Constant is a data whose value cannot be changed during the runtime. Using a con-
stant in a program consumes no RAM. Constants can be used in any expression,
but cannot be assigned a new value.

Constants are declared in the declaration part of a program or routine. You can
declare any number of constants after the keyword const:

const constant name [ : type] = value;

Every constant is declared under unique constant name which must be a valid
identifier. It is a tradition to write constant names in uppercase. Constant requires
you to specify va1lue, which is a literal appropriate for the given type. type is option-
al and in the absence of «ype, the compiler assumes the “smallest” of all types that
can accommodate value.

Note: You cannot omit type when declaring a constant array.

Pascal allows shorthand syntax with only one keyword const followed by multiple
constant declarations. Here’s an example:

const
MAX : longint = 10000;
MIN = 1000; // compiler will assume word type
SWITCH = 'n'; // compiler will assume char type
MSG = 'Hello'; // compiler will assume string type

MONTHS : array[ 1..12] of byte =
(31,28,31,30,31,30,31,31,30,31,30,31);
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LABELS

Labels serve as targets for goto statements. Mark the desired statement with a label
and colon like this:

label identifier : statement

Before marking a statement, you must declare a label. Labels are declared in dec-
laration part of unit or routine, similar to variables and constants. Declare labels
using the keyword 1abel:

label labell, ..., labeln;

Name of the label needs to be a valid identifier. The label declaration, marked state-
ment, and goto statement must belong to the same block. Hence it is not possible
to jump into or out of a procedure or function. Do not mark more than one statement
in a block with the same label.

Here is an example of an infinite loop that calls the reep procedure repeatedly:

label loop;
loop:

Beep;

goto loop;

Note: label should be followed by end of line (CR) otherwise compiler will report an
error:

label loop;

loop: Beep; // compiler will report an error
loop: // compiler will report an error
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FUNCTIONS AND PROCEDURES

Functions and procedures, collectively referred to as routines, are subprograms
(self-contained statement blocks) which perform a certain task based on a number
of input parameters. When executed, a function returns a value while procedure
does not.

mikroPascal PRO for PIC does not support inline routines.

Functions

A function is declared like this:

function function name (parameter list) : return type;
{ local declarations }
begin

{ function body }
end;

function name represents a function’s name and can be any valid identifier.
return type is a type of return value and can be any simple type. Within parenthe-
ses, parameter list is a formal parameter list very similar to variable declaration.
In Pascal, parameters are always passed to a function by the value — to pass an
argument by address, add the keyword var ahead of identifier.

Local declarations are optional declarations of variables and/or constants, local
for the given function. Function body is a sequence of statements to be executed
upon calling the function.

Calling a function

Afunction is called by its name, with actual arguments placed in the same sequence
as their matching formal parameters. The compiler is able to coerce mismatching
arguments to the proper type according to implicit conversion rules. Upon a function
call, all formal parameters are created as local objects initialized by values of actu-
al arguments. Upon return from a function, a temporary object is created in the place
of the call and it is initialized by the value of the function result. This means that func-
tion call as an operand in complex expression is treated as the function result.

In standard Pascal, a function_name is automatically created local variable that can
be used for returning a value of a function. mikroPascal PRO for PIC also allows you
to use the automatically created local variable result to assign the return value of a
function if you find function name to be too ponderous. If the return value of a func-
tion is not defined the compiler will report an error.
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Function calls are considered to be primary expressions and can be used in situa-
tions where expression is expected. A function call can also be a self-contained
statement and in that case the return value is discarded.

Example

Here’s a simple function which calculates xn based on input parameters x and n (n

> 0):
function power(x, n : byte) : longint;
var 1 : byte;
begin

i := 0; result := 1;

if n > 0 then

for i := 1 to n do result := result*x;

end;

Now we could call it to calculate 312 for example:

tmp := power (3, 12);
PROCEDURES

Procedure is declared like this:

procedure procedure name (parameter list);
{ local declarations }

begin
{ procedure body }

end;

procedure name represents a procedure’s name and can be any valid identifier.
Within parentheses, parameter 1ist is a formal parameter list very similar to vari-
able declaration. In Pascal, parameters are always passed to a procedure by the
value — to pass an argument by address, add the keyword var ahead of identifier.

Local declarations are optional declaration of variables and/or constants, local for
the given procedure. Procedure body is a sequence of statements to be executed
upon calling the procedure.
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Calling a procedure

A procedure is called by its name, with actual arguments placed in the same
sequence as their matching formal parameters. The compiler is able to coerce mis-
matching arguments to the proper type according to implicit conversion rules. Upon
procedure call, all formal parameters are created as local objects initialized by the

values of actual arguments.

Procedure call is a self-contained statement.

Example

Here’s an example procedure which transforms its input time parameters, preparing

them for output on Lcd:

procedure time prep(var sec,

begin
sec := ((sec and S$FO)
min := ((min and S$FO)
hr := ((hr and S$FO0)
end;

hr

shr 4)*10 +
shr 4)*10 +
shr 4)*10 +

byte);

(sec and $OF);
(min and $O0F);

(hr

and SOF) ;

A function can return a complex type. Follow the example bellow to learn how to

declare and use a function which returns a complex type.

Example:

This example shows how to declare a function which returns a complex type.

program Example;

type TCircle = record

CenterX, CenterY: word;

Radius: byte;
end;

var MyCircle: TCircle; // Global variable

function DefineCircle (x,

function returns a Record

begin
result.CenterX := x;
result.CenterY := y;
result.Radius = r;
end;

r:

byte) :

TCircle; // DefineCircle
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begin

MyCircle := DefineCircle (100, 200, 30); //
Get a Record wvia function call

MyCircle.CenterX := DefineCircle (100, 200, 30).CenterxXx + 20; //
Access a Record field via function call

// |- \ | ————- \

// |

// Function returns TCircle Access to one
field of TCircle
end.

Forward declaration

A function can be declared without having it followed by it's implementation, by hav-
ing it followed by the forward procedure. The effective implementation of that func-
tion must follow later in the unit. The function can be used after a forward declara-
tion as if it had been implemented already. The following is an example of a forward
declaration:

program Volume;

var Volume : word;
function First(a, b : word) : word; forward;
function Second(c : word) : word;
var tmp : word;
begin
tmp := First (2, 3);
result := tmp * c;
end;
function First(a, b : word) : word;
begin
result := a * Dby
end;
begin
Volume := Second(4);
end.

Functions reentrancy

Functions reentrancy is allowed. Remember that the PIC has memory limitations
that can vary between MCUs.
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TYPES

Pascal is strictly typed language, which means that every variable and constant
need to have a strictly defined type, known at the time of compilation.

The type serves:

- to determine correct memory allocation required,
- to interpret the bit patterns found in the object during subsequent accesses,
- in many type-checking situations, to ensure that illegal assignments are trapped.

mikroPascal PRO for PIC supports many standard (predefined) and user-defined
data types, including signed and unsigned integers of various sizes, arrays, strings,
pointers and records.

Type Categories
Types can be divided into:

- simple types
- arrays

- strings

- pointers

- records
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SIMPLE TYPES

Simple types represent types that cannot be divided into more basic elements and
are the model for representing elementary data on machine level. Basic memory
unit in mikroPascal PRO for PIC has 16 bits.

Here is an overview of simple types in mikroPascal PRO for PIC:

Type Size Range
byte, char 8-bit 0..255
short 8—bit -127 .. 128
word 16—bit 0 .. 65535
integer 16—bit -32768 .. 32767
dword 32-bit 0 .. 4294967295
longint 32-bit -2147483648 .. 2147483647
. 3o bit 117549435082 * 1038 -
+6.80564774407 * 1038
bit 1-bit Oor1
sbit 1-bit Oor1

You can assign signed to unsigned or vice versa only using the explicit conversion.
Refer to Types Conversions for more information.
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ARRAYS

An array represents an indexed collection of elements of the same type (called the
base type). Because each element has a unique index, arrays, unlike sets, can
meaningfully contain the same value more than once.

Array Declaration

Array types are denoted by constructions in the following form:

arrayl index start .. index end] of type

Each of the elements of an array is numbered from index start through
index end. The specifier index start can be omitted along with dots, in which

case it defaults to zero.

Every element of an array is of - ype and can be accessed by specifying array name
followed by element’s index within brackets.

Here are a few examples of array declaration:

var
weekdays : array[ 1..7] of byte;
samples : array| 50] of word;
begin
// Now we can access elements of array variables, for example:
samples[ 0] := 1;
if samples[ 377 = 0 then ...

Constant Arrays

Constant array is initialized by assigning it a comma-delimited sequence of values
within parentheses. For example:

// Declare a constant array which holds number of days in each month:
const MONTHS : array[ 1..12] of byte =
(31,28,31,30,31,30,31,31,30,31,30,31);

The number of assigned values must not exceed the specified length. The opposite
is possible, when the trailing “excess” elements are assigned zeroes.

For more information on arrays of char, refer to Strings.
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Multi-dimensional Arrays

Multidimensional arrays are constructed by declaring arrays of array type. These
arrays are stored in memory in such way that the right most subscript changes
fastest, i.e. arrays are stored “in rows”. Here is a sample 2-dimensional array:

m : arrayl 5] of arrayl 10] of byte; // 2-dimensional array of size
5x10

Avariable m is an array of 5 elements, which in turn are arrays of 10 byte each. Thus,
we have a matrix of 5x10 elements where the first element is [ 01[ 0] and last one
is ml 4] 9] . The first element of the 4th row would be n[ 31[ 0] .

STRINGS

A string represents a sequence of characters equivalent to an array of char. It is
declared like this:

string name : string] length]

The specifier 1ength is a number of characters the string consists of. String is stored
internally as the given sequence of characters plus a final null character which is
introduced to terminate the string. It does not count against the string’s total length.

A null string (' ') is stored as a single null character.

You can assign string literals or other strings to string variables. String on the right
side of an assignment operator has to be shorter or of equal length than the one on
the right side. For example:

var
msgl : stringl 20]
msg2 : stringl 19]

begin
msgl := 'This is some message';
msg2 := 'Yet another message';
msgl := msg2; // this is ok, but vice versa would be illegal

Alternately, you can handle strings element-by—element. For example:
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var s : string] 5] ;
s := 'mik';
{
s[ 0] is char literal 'm'
s[ 1] is char literal 'i'
s[ 2] is char literal 'k'
s[ 3] is zero
s[ 4] is undefined
s[ 5] 1is undefined

—

Be careful when handling strings in this way, since overwriting the end of a string will
cause an unpredictable behavior.

String Concatenating

mikroPascal PRO for PIC allows you to concatenate strings by means of plus oper-
ator. This kind of concatenation is applicable to string variables/literals, character
variables/literals. For control characters, use the non-quoted hash sign and a
numeral (e.g. #13 for CR).

Here is an example:

var msg : stringf 20] ;
res txt : stringl 5] ;
res, channel : word;
begin
/).
// Get result of ADC
res := Adc Read(channel);

// Create string out of numeric result
WordToStr (res, res txt);

// Prepare message for output
msg := 'Result is ' + // Text "Result is"
res_txt ; // Result of ADC

/]

Note: In current version plus operator for concatenating strings will accept at most
two operands.

Note

mikroPascal PRO for PIC includes a String Library which automatizes string related tasks.
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POINTERS

A pointer is a data type which holds a memory address. While a variable accesses
that memory address directly, a pointer can be thought of as a reference to that
memory address.

To declare a pointer data type, add a carat prefix (*) before type. For example, in
order to create a pointer to an integer, write:

Ainteger;In order to access data at the pointer’'s memory location, add a carat after
the variable name. For example, let’s declare variable p which points to a word, and
then assign value 5 to the pointed memory location:

var p : “word;

A pointer can be assigned to another pointer. However, note that only the address,
not the value, is copied. Once you modify the data located at one pointer, the other
pointer, when dereferenced, also yields modified data.

Pointers to program memory space are declared using the keyword const:
program const ptr;

// constant array will be stored in program memory

const b array: arrayl 5] of byte = (1,2,3,4,5);
const ptr: “byte; // ptr 1is pointer to program memory space
begin
ptr := @b_array; // ptr now points to b _arrayl 0]
PO := ptr”";
ptr 1= ptr + 3; // ptr now points to b array| 3]
PO := ptr”";
end.

Function Pointers

Function pointers are allowed in mikroPascal PRO for PIC. The example shows how
to define and use a function pointer:

Example:

Example demonstrates the usage of function pointers. It is shown how to declare a
procedural type, a pointer to function and finally how to call a function via pointer.
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program Example;

type TMyFunctionType = function (paraml, param2:
word; // First, define the procedural type
var MyPtr: "TMyFunctionType;
// This 1is a pointer to previously defined type
Sample: word;

byte; param3: word)

function Funcl (pl, p2: byte; p3: word): word; // Now,
define few functions which will be pointed to.

Make sure that param-
eters match the type definition

begin
result := pl and p2 or p3; // return something
end;
function Func?2 (abc: byte; def: byte; ghi: word): word; // Another
function of the same kind. Make sure that parameters match the type
definition
begin
result := abc * def + ghi; // return something
end;

function Func3(first, yellow: byte; monday: word) :
another function.
tion

begin

word; // Yet
Make sure that parameters match the type defini-

result := monday - yellow - first; // return something
end;

// main program:

begin
MyPtr := Q@Funcl; // MyPtr now points to Funcl
Sample := MyPtr~ (1, 2, 3); // Perform function call via
pointer, call Funcl, the return value 1is 3
MyPtr := @Func2; // MyPtr now points to Func2
Sample := MyPtr~ (1, 2, 3); // Perform function call via
pointer, call Func2, the return value 1is 5
MyPtr := QFunc3; // MyPtr now points to Func3
Sample := MyPtr~ (1, 2, 3); // Perform function call via
pointer, call Func3, the return value 1is 0
end.
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@ Operator

The @ operator constructs a pointer to its operand. The following rules are applied
to e:

- If x is a variable, ¢x returns a pointer to x.

Note: If variable x is of array type, the ¢ operator will return pointer to it's first basic
element, except when the left side of the statement in which x is used is an array
pointer.

In this case, the @ operator will return pointer to array, not to it's first basic element.

program example;

var w : word;
ptr b : "byte;
ptr arr : "“arrayl 10] of byte;
arr : arrayl 10] of byte;
begin
ptr b := Qarr; // @ operator will return “byte
w := Qarr; // @ operator will return “byte
ptr arr := Qarr; // @ operator will return “arrayl 10] of byte
end.

- If F is a routine (a function or procedure), @r returns a pointer to .

Related topics: Pointer Arithmetic
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RECORDS

A record (analogous to a structure in some languages) represents a heterogeneous
set of elements. Each element is called a field. The declaration of the record type
specifies a name and type for each field. The syntax of a record type declaration is

type recordTypeName = record
fieldListl : typel;

fieldListn : typen;
end;

where recordTypename is a valid identifier, each type denotes a type, and each
fieldList is a valid identifier or a comma-delimited list of identifiers. The scope of
a field identifier is limited to the record in which it occurs, so you don’t have to worry
about naming conflicts between field identifiers and other variables.

Note: In mikroPascal PRO for PIC, you cannot use the record construction direct-
ly in variable declarations, i.e. without type.

For example, the following declaration creates a record type called Tpot:

type
TDot = record
X, y : real;

end;

Each TDot contains two fields: x and vy coordinates. Memory is allocated when you
declare the record, like this:

var m, n: TDot;
This variable declaration creates two instances of Tpot, called m and n.

A field can be of previously defined record type. For example:

// Structure defining a circle:

type
TCircle = record
radius : real;
center : TDot;

end;
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Accessing Fields

You can access the fields of a record by means of dot (.) as a direct field selector. If
we have declared variables circlel and circle2 of previously defined type
TCircle:

var circlel, circle2 : TCircle;

we could access their individual fields like this:

circlel.radius := 3.7;
circlel.center.x := 0;
circlel.center.y := 0;

Accessing the fields is possible via the with statement as well.

You can also commit assignments between complex variables, if they are of the
same type:

circle2 := circlel; // This will copy values of all fields
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TYPES CONVERSIONS

Conversion of variable of one type to a variable of another type is typecasting. mikroPas-
cal PRO for PIC supports both implicit and explicit conversions for built-in types.

Implicit Conversion
Compiler will provide an automatic implicit conversion in the following situations:

- statement requires an expression of particular type (according to language
definition), and we use an expression of different type,

- operator requires an operand of particular type, and we use an operand of
different type,

- function requires a formal parameter of particular type, and we pass it an object of
different type,

- result does not match the declared function return type.

Promotion

When operands are of different types, implicit conversion promotes the less com-
plex type to more complex type taking the following steps:

byte/char =~ word
short ~* integer
short -+ longint
integer =+ longint
integer =~ real

Higher bytes of extended unsigned operand are filled with zeroes. Higher bytes of
extended signed operand are filled with bit sign (if number is negative, fill higher
bytes with one, otherwise with zeroes). For example:

var a : byte; b : word;

a := SFF;

b := a; // a is promoted to word, b becomes S$00FF
Clipping

In assignments and statements that require an expression of particular type, desti-
nation will store the correct value only if it can properly represent the result of
expression, i.e. if the result fits in destination range.

If expression evaluates to a more complex type than expected, excess of data will
be simply clipped (higher bytes are lost).
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var i : byte; J : word;
j := SFFOF;
i = 73 // 1 becomes $0F, higher byte S$FF is lost

EXPLICIT CONVERSION

Explicit conversion can be executed at any point by inserting type keyword (byte,
word, short, integer, longint Of real) ahead of an expression to be converted.
The expression must be enclosed in parentheses. Explicit conversion can be per-
formed only on the operand right of the assignment operator.

Special case is conversion between signed and unsigned types. Explicit conversion
between signed and unsigned data does not change binary representation of data
— it merely allows copying of source to destination.

For example:

var a : byte; b : short;

b := -1;
a := byte(b); // a is 255, not 1

// This 1is because binary representation remains
// 11111111; it's Jjust interpreted differently now

You can’t execute explicit conversion on the operand left of the assignment operator:

word (b) := a; // Compiler will report an error
Conversions Examples

Here is an example of conversion:

var a, b, c : byte;

d : word;
a := 241;
b := 128;
c := a + b; // equals 113
c := word(a + b); // equals 113
d :=a + b; // equals 369
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OPERATORS

Operators are tokens that trigger some computation when being applied to variables
and other objects in an expression.

There are four types of operators in mikroPascal PRO for PIC:

- Arithmetic Operators
- Bitwise Operators

- Boolean Operators

- Relational Operators

OPERATORS PRECEDENCE AND ASSOCIATIVITY

There are 4 precedence categories in mikroPascal PRO for PIC. Operators in the
same category have equal precedence with each other.

Each category has an associativity rule: left-to-right (-9, or right-to-left («). In the
absence of parentheses, these rules resolve the grouping of expressions with oper-
ators of equal precedence.

Precedence | Operands Operators Associativity

4 1 @ not + - =

3 2 +
shl shr

2 2 + - or XOr +

1 2 = <> < > <= >= >
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ARITHMETIC OPERATORS

Arithmetic operators are used to perform mathematical computations. They have
numerical operands and return numerical results. Since the char operators are tech-
nically bytes, they can be also used as unsigned operands in arithmetic operations.

All arithmetic operators associate from left to right.

Operator Operation Operands Result
byte, short, word, |byte, short, word,
+ addition integer, longint, integer, longint,
dword, real dword, real

byte, short, word, |byte, short, word,

- subtraction integer, longint, integer, longint,
dword, real dword, real
byte, short, word, |[word, integer,
* multiplication integer, longint, longint, dword,
dword, real real

L i —n -
division, floating- byte, short, word

/ int integer, longint, real

poin dword, real

division, rounds byte, short, word, |byte, short, word,
div down to nearest integer, longint, integer, longint,

integer dword dword

modulus, returns

the remainder of byte, short, word, |byte, short, word,
mod integerdivision integer, longint, integer, longint,

(cannot be used dword dword
with floating points)

Division by Zero

If O (zero) is used explicitly as the second operand (i.e. x div 0), the compiler will
report an error and will not generate code.

But in case of implicit division by zero: x div v, where y is 0 (zero), the result will be the
maximum integer (i.e 255, if the result is byte type; 65536, if the result is word type, etc.).

Unary Arithmetic Operators

Operator - can be used as a prefix unary operator to change sign of a signed value.
Unary prefix operator + can be used, but it doesn’t affect data.

For example:

b := -a;
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Relational Operators

Use relational operators to test equality or inequality of expressions. All relational
operators return TRUE Or FALSE.

Operator Operation
= equal
<> not equal
> greater than
< less than
>= greater than or equal
<= less than or equal

All relational operators associate from left to right.
Relational Operators in Expressions

Precedence of arithmetic and relational operators is designated in such a way to
allow complex expressions without parentheses to have expected meaning:

a+ 5> c¢c-1.0/ e // 2?2 (a + 5) >= (c - (1.0 / e))
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BITWISE OPERATORS

Use bitwise operators to modify individual bits of numerical operands. Operands
need to be either both signed or both unsigned.

Bitwise operators associate from left to right. The only exception is the bitwise com-
plement operator not which associates from right to left.

Bitwise Operators Overview

Operator Operation

bitwise AND; compares pairs of bits and generates a 1 result if both

and bits are 1, otherwise it returns 0

bitwise (inclusive) OR; compares pairs of bits and generates a 1
result if either or both bits are 1, otherwise it returns 0

bitwise exclusive OR (XOR); compares pairs of bits and generates a

wor 1 result if the bits are complementary, otherwise it returns 0

not bitwise complement (unary); inverts each bit

bitwise shift left; moves the bits to the left, discards the far left bit and

o assigns 0 to the right most bit.

bitwise shift right; moves the bits to the right, discards the far right bit

s and if unsigned assigns 0 to the left most bit, otherwise sign extends

Logical Operations on Bit Level

and| 0 | 1 or{ 0|1 xor| O | 1 not| 0 | 1
0(0]O o0 1 o0 1 o(11]0
11011 1 1 1 1 1710

Bitwise operators znd, or, and xor perform logical operations on the appropriate
pairs of bits of their operands. not operator complements each bit of its operand. For
example:
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$1234 and $5678 // equals $1230
{ because

$1234 : 0001 0010 0011 0100
$5678 : 0101 0110 0111 1000

and : 0001 0010 0011 0000

. that is, $1230 }// Similarly:

$1234 or $5678 // equals $567C
$1234 xor $5678 // equals $444C
not $1234 // equals SEDCB

Unsigned and Conversions

If a number is converted from less complex to more complex data type, the upper
bytes are filled with zeroes. If a number is converted from more complex to less
complex data type, the data is simply truncated (the upper bytes are lost).

For example:
var a : byte; b : word;
a := SAA;
b := SFOFO;
b := b and a;
{

a is extended with zeroes; b becomes $00A0 }
Signed and Conversions

If number is converted from less complex data type to more complex, upper bytes
are filled with ones if sign bit is 1 (number is negative); upper bytes are filled with
zeroes if sign bit is 0 (number is positive). If number is converted from more com-
plex data type to less complex, data is simply truncated (upper bytes are lost).

For example:

var a : byte; b : word;
a := -12;
b := S$T0FF;
b := b and a;

{ a is sign extended, with the upper byte equal to S$FF;
b becomes $70F4 }
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Bitwise Shift Operators

Binary operators sh1 and shr move the bits of the left operand by a number of posi-
tions specified by the right operand, to the left or right, respectively. Right operand
has to be positive and less than 255.

With shift left (sh1), left most bits are discarded, and “new” bits on the right are
assigned zeroes. Thus, shifting unsigned operand to the left by n positions is equiv-
alent to multiplying it by 2n if all discarded bits are zero. This is also true for signed
operands if all discarded bits are equal to the sign bit.

With shift right (shr), right most bits are discarded, and the “freed” bits on the left
are assigned zeroes (in case of unsigned operand) or the value of the sign bit (in
case of signed operand). Shifting operand to the right by n positions is equivalent to

dividing it by 2N.

Boolean Operators

Although mikroPascal PRO for PIC does not support boolean type, you have
Boolean operators at your disposal for building complex conditional expressions.
These operators conform to standard Boolean logic and return either TrUE (all ones)
or FALSE (zero):

Operator Operation

and logical AND

or logical OR

XOor logical exclusive OR (XOR)
not logical negation

Boolean operators associate from left to right. Negation operator not associates
from right to left.
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EXPRESSIONS

An expression is a sequence of operators, operands and punctuators that returns a
value.

The primary expressions include: literals, constants, variables and function calls.
More complex expressions can be created from primary expressions by using oper-
ators. Formally, expressions are defined recursively: subexpressions can be nested
up to the limits of memory.

Expressions are evaluated according to certain conversion, grouping, associativity
and precedence rules which depend on the operators in use, presence of parenthe-
ses and data types of the operands. The precedence and associativity of the oper-
ators are summarized in Operator Precedence and Associativity. The way operands
and subexpressions are grouped does not necessarily specify the actual order in
which they are evaluated by mikroPascal PRO for PIC.

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD 181



CHAPTER 6
Language Reference mikroPASCAL PRO for PIC

STATEMENTS

Statements define algorithmic actions within a program. Each statement needs to
be terminated with a semicolon (;). In the absence of specific jump and selection
statements, statements are executed sequentially in the order of appearance in the
source code.

The most simple statements are assignments, procedure calls and jump state-
ments. These can be combined to form loops, branches and other structured state-
ments.

Refer to:

- Assignment Statements

- Compound Statements (Blocks)
- Conditional Statements

- lteration Statements (Loops)

- Jump Statements

- asm Statement

ASSIGNMENT STATEMENTS

Assignment statements have the form:
variable := expression;

The statement evaluates expression and assigns its value to variable. All the rules
of implicit conversion are applied. variable can be any declared variable or array
element, and expression can be any expression.

Do not confuse the assignment with relational operator = which tests for equality.
Also note that, although similar, the construction is not related to the declaration of
constants.
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COMPOUND STATEMENTS (BLOCKS)

Compound statement, or block, is a list of statements enclosed by keywords begin
and end:

begin
statements
end;

Syntactically, a block is considered to be a single statement which is allowed to be
used when Pascal syntax requires a single statement. Blocks can be nested up to
the limits of memory.

For example, the while loop expects one statement in its body, so we can pass it a
compound statement:

while i < n do

begin
temp := a[ i] ;
al i] := bl 1]
bl 1] := temp;
i :=1 + 1;
end;

Conditional Statements

Conditional or selection statements select one of alternative courses of action by
testing certain values. There are two types of selection statements:

- if

- case
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IF STATEMENT

Use if to implement a conditional statement. The syntax of if statement has the form:

if expression then statementl [ else statement?2]

If expression evaluates to true then statement1 executes. If expression is false
then statement?2 executes. The expression must convert to a boolean type; other-
wise, the condition is ill-formed. The else keyword with an alternate statement
(statement?) is optional.

There should never be a semicolon before the keyword else.
Nested if statements

Nested if statements require additional attention. A general rule is that the nested
conditionals are parsed starting from the innermost conditional, with each eise
bound to the nearest available if on its left:

if expressionl then
if expression2 then statementl

else statement?2

The compiler treats the construction in this way:

if expressionl then

begin
if expression2 then statementl
else statement2

end

In order to force the compiler to interpret our example the other way around, we
have to write it explicitly:

if expressionl then
begin
if expression2 then statementl
end
else statement2

184 MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



CHAPTER 6
mikroPASCAL PRO for PIC Language Reference

CASE STATEMENT

Use the case statement to pass control to a specific program branch, based on a
certain condition. The case statement consists of a selector expression (a condition)
and a list of possible values. The syntax of the case statement is:

case selector of
value 1 : statement 1

value n : statement n
[ else default statement]
end;

selector is an expression which should evaluate as integral value. values can be
literals, constants, or expressions, and statements can be any statements.

The e1se clause is optional. If using the c1se branch, note that there should never
be a semicolon before the keyword c1se.

First, the se1ector expression (condition) is evaluated. Afterwards the case state-
ment compares it against all available vz1ues. If the match is found, the statement
following the match evaluates, and the case statement terminates. In case there are
multiple matches, the first matching statement will be executed. If none of values
matches selector, then default statement in the else clause (if there is some)
is executed.

Here’s a simple example of the case statement:

case operator of

'*' : result := nl * n2;
'/'" : result := nl / n2;
'+' : result := nl + n2;
'-'" : result := nl - n2

else result := 0;
end;

Also, you can group values together for a match. Simply separate the items by commas:

case reg of

0: opmode := 0;

1,2,3,4: opmode := 1;

5,6,7 opmode := 2;
end;
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In mikroPascal PRO for PIC, values in the case statement can be variables too:

case byte variable of

byte varl: opmode := 0; // this will be compiled correctly
byte var2:
opmode := 1; // avoid this case, compiler will parse
// a variable followed by colon sign as
label
byte var3: // adding a comment solves the parsing
problem
opmode := 2;
end;

Nested Case statement

Note that the case statements can be nested — values are then assigned to the
innermost enclosing case statement.
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ITERATION STATEMENTS

Iteration statements let you loop a set of statements. There are three forms of iter-
ation statements in mikroPascal PRO for PIC:

- for
- while
- repeat

You can use the statements break and continue to control the flow of a loop state-
ment. break terminates the statement in which it occurs, while continue begins exe-
cuting the next iteration of the sequence.

For Statement

The for statement implements an iterative loop and requires you to specify the num-
ber of iterations. The syntax of the for statement is:

for counter := initial value to final value do statement
// or
for counter := initial value downto final value do statement

counter is a variable which increments (or decrements if you use downto) with each
iteration of the loop. Before the first iteration, counter is setto initial value and
will increment (or decrement) until it reaches final value. With each iteration,
statement Will be executed.

initial value and final value should be expressions compatible with counter;
statement can be any statement that does not change the value of counter.

Here is an example of calculating scalar product of two vectors, a and b, of length
n, using the for statement:

for i := 0 to n-1 do
s := s + al i] * p[ 1] ;
Endless Loop

The for statement results in an endless loop if final value equals or exceeds the
range of the counter’s type.

More legible way to create an endless loop in Pascal is to use the statement while
TRUE do.
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WHILE STATEMENT

Use the while keyword to conditionally iterate a statement. The syntax of the while
statement is:

while expression do statement

statement is executed repeatedly as long as expression evaluates true. The test
takes place before the statement is executed. Thus, if expression evaluates false
on the first pass, the loop does not execute.

Here is an example of calculating scalar product of two vectors, using the while

statement:

s = 0; 1 := 0;

while i < n do

begin
s := s + a[i] * bl 1i];
i =1 + 1;

end;

Probably the easiest way to create an endless loop is to use the statement:

while TRUE do ...;

REPEAT STATEMENT

The repeat statement executes until the condition becomes false. The syntax of the
repeat statement is:

repeat statement until expression

statement is executed repeatedly as long as expression evaluates true. The
expression is evaluated after each iteration, so the loop will execute statement at
least once.

Here is an example of calculating scalar product of two vectors, using the repeat
statement:

repeat
begin
s := s + ai] * [ i];
i =1 + 1;
end;
until 1 = n;
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JUMP STATEMENTS

A jump statement, when executed, transfers control unconditionally. There are four
such statements in mikroPascal PRO for PIC:

- break

- continue
- exit

- goto

BREAK AND CONTINUE STATEMENTS
Break Statement

Sometimes, you might need to stop the loop from within its body. Use the break
statement within loops to pass control to the first statement following the innermost
loop (for, while, or repeat block).

For example:

Lcd Out (1,1, 'Insert CF card');

// Wait for CF card to be plugged; refresh every second
while TRUE do
begin
if Cf Detect() = 1 then break;
Delay ms (1000) ;
end;

// Now we can work with CF card ...
Lcd Out (1,1, 'Card detected )

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD 189



CHAPTER 6
Language Reference mikroPASCAL PRO for PIC

Continue Statement
You can use the continue statement within loops to “skip the cycle”™

- continue statement in for loop moves program counter to the line with keyword for

- continue statement in while loop moves program counter to the line with loop
condition (top of the loop),

- continue statement in repeat loop moves program counter to the line with loop
condition (bottom of the loop).

// continue jumps // continue jumps repeat
here here begin
for i := ... do while condition do .
begin begin continue;
continue; continue; // continue Jjumps
here
end; end; until condition;

EXIT STATEMENT

The exit statement allows you to break out of a routine (function or procedure). It
passes the control to the first statement following the routine call.

Here is a simple example:

procedure Procl();
var error: byte;
begin
// we're doing something here
if error = TRUE then exit;
// some code, which won't be executed if error is true

end;

Note: If breaking out of a function, return value will be the value of the local variable
result at the moment of exit.
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GOTO STATEMENT

Use the goto statement to unconditionally jump to a local label — for more informa-
tion, refer to Labels. Syntax of goto statement is:

goto label name;

This will transfer control to the location of a local label specified by 1abe1l name. The
goto line can come before or after the label.

The label declaration, marked statement and goto statement must belong to the
same block. Hence it is not possible to jump into or out of a procedure or function.

You can use goto to break out from any level of nested control structures. Never
jump into a loop or other structured statement, since this can have unpredictable
effects.

Use of goto statement is generally discouraged as practically every algorithm can
be realized without it, resulting in legible structured programs. One possible appli-
cation of goto statement is breaking out from deeply nested control structures:

for (...) do
begin
for (...) do
begin

if (disaster) then goto Error;

end;
end;

Error: // error handling code
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asm Statement

mikroPascal PRO for PIC allows embedding assembly in the source code by means
of the asm statement. Note that you cannot use numerals as absolute addresses for
register variables in assembly instructions. You may use symbolic nhames instead
(listing will display these names as well as addresses).

You can group assembly instructions with the =sm keyword:
asm
block of assembly instructions

end;

Pascal comments are not allowed in embedded assembly code. Instead, you may
use one-line assembly comments starting with semicolon.

Note: Compiler doesn't expect memory banks to be changed inside the assembly
code. If the user wants to do this, then he must restore the previous bank selection.

DIRECTIVES

Directives are words of special significance which provide additional functionality
regarding compilation and output.

The following directives are available for use:

- Compiler directives for conditional compilation,
- Linker directives for object distribution in memory.

192 MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



CHAPTER 6
mikroPASCAL PRO for PIC Language Reference

COMPILER DIRECTIVES

mikroPascal PRO for PIC treats comments beginning with a » s~ immediately follow-
ing an opening brace as a compiler directive; for example, { sE1.sE) . The compiler
directives are not case sensitive.

You can use a conditional compilation to select particular sections of code to com-
pile, while excluding other sections. All compiler directives must be completed in the
source file in which they have begun.

Directives $DEFINE and SUNDEFINE

Use directive $DEFINE to define a conditional compiler constant (“flag”). You can
use any identifier for a flag, with no limitations. No conflicts with program identifiers
are possible because the flags have a separate name space. Only one flag can be
set per directive.

For example:

{ SDEFINE Extended format}
Use sunperINE to undefine (“clear”) previously defined flag.

Note: Pascal does not support macros; directives sper1NE and SUNDEFTNE do not cre-
ate/destroy macros. They only provide flags for directive s1rpEF to check against.

Directives $IFDEF, $IFNDEF, $ELSE

Conditional compilation is carried out by the s1rDEF and s1FNDEF directives. STFDEF
tests whether a flag is currently defined, and stenpEF if the flag is not defined, i.e.
whether a previous sper1NE directive has been processed for that flag and is still in
force.

Directives s1rDEF and S1FNDEF are terminated with the sEnDIF directive, and can
have an optional $E1.sE clause:

{ SIFDEF flag}

<block of code>
{ SELSE}

<alternate block of code>
{ SENDIF}
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First, s1rDEF checks if flag is defined by means of sperINE. If sO, only <block of
code> will be compiled. Otherwise, <alternate block of code> will be compiled.
sENDTE ends the conditional sequence. The result of the preceding scenario is that
only one section of code (possibly empty) is passed on for further processing.

The processed section can contain further conditional clauses, nested to any depth;
each s1rpEr must be matched with a closing $ENDIF.

Unlike strpEF, sTENDEF checks if flag is not defined by means of sper1NE, thus pro-
ducing the opposite results.

// Uncomment the appropriate flag for your application:
//{ $SDEFINE resolutionl0}
//{ SDEFINE resolutionl?2}

{ SIFDEF resolutionl0}
// <code specific to 10-bit resolution>
{ SELSE}
{ SIFDEF resolutionl?2}
// <code specific to 12-bit resolution>
{ SELSE}
// <default code>
{ SENDIF}
{ SENDIF}

Include Directive $I

The s1 parameter directive instructs mikroPascal PRO for PIC to include the named
text file in the compilation. In effect, the file is inserted in the compiled text right after
the { 1 filename} directive. If flename does not specify a directory path, then, in
addition to searching for the file in the same directory as the current unit, mikroPas-
cal PRO for PIC will search for file in order specified by the search paths.

To specify a filename that includes a space, surround the file name with quotation
marks: { ST "My file"}.

There is one restriction to the use of include files: An include file can't be specified
in the middle of a statement part. In fact, all statements between the begin and end
of a statement part must exist in the same source file.

Predefined Flags
The compiler sets directives upon completion of project settings, so the user does-

n't need to define certain flags.
Here is an example:
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{ SIFDEF 16F887} // If 16F887 MCU is selected
{ SIFNDEF 18F4550} // IF 18F4550 MCU is selected

See also predefined project level defines.

LINKER DIRECTIVES

mikroPascal PRO for PIC uses internal algorithm to distribute objects within memo-
ry. If you need to have a variable or a routine at the specific predefined address, use
the linker directives absolute and org.

Note: You must specify an even address when using the linker directives.
Directive absolute

Directive absolute specifies the starting address in RAM for a variable. If the vari-
able spans more than 1 word (16-bit), the higher words will be stored at the consec-
utive locations.

Directive absolute is appended to the declaration of a variable:

var x : word; absolute $32;
// Variable x will occupy 1 word (16 bits) at address $32

y : longint; absolute $34;
// Variable y will occupy 2 words at addresses $34 and $36

Be careful when using the =bsolute directive because you may overlap two vari-
ables by accident. For example:

var 1 : word; absolute $42;
// Variable 1 will occupy 1 word at address $42;

j3j : longint; absolute $40;

// Variable will occupy 2 words at $40 and $42; thus,

// changing 1 changes jj at the same time and vice versa
Note: You must specify an even address when using the absolute directive.
Directive org

Directive org specifies the starting address of a routine in ROM. It is appended to
the declaration of a routine. For example:
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procedure proc(par : byte); org $200;
begin
// Procedure will start at address $200;

end;

org directive can be used with main routine too. For example:
program Led Blinking;

procedure some proc();
begin

end;
org 0x800; // main procedure starts at 0x800
begin

TRISB := 0;

while TRUE do

begin
PORTB := 0x00;
Delay ms (500) ;
PORTB := OXxFF;
Delay ms (500);
end;

end.
Note: You must specify an even address when using the org directive.
Directive orgall

Use the orgall directive to specify the address above which all routines, constants
will be placed. Example:

begin

orgall (0x200) // All the routines, constants in main program will
be above the address 0x200

end.

196 MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



CHAPTER

mikroPascal PRO for PIC
Libraries

mikroPascal PRO for PIC provides a set of libraries which simplify the initialization
and use of PIC compliant MCUs and their modules:

Use Library manager to include mikroPascal PRO for PIC Libraries in you project.
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Hardware PIC-specific Libraries

- ADC Library

- CAN Library

- CANSPI Library

- Compact Flash Library

- EEPROM Library

- Ethernet PIC18FxxJ60 Library
- Flash Memory Library

- Graphic Lcd Library

- 1. C Library

- Keypad Library

- Led Library

- Manchester Code Library
- Multi Media Card library
- OneWire Library

- Port Expander Library

- PS/2 Library

- PWM Library

- RS-485 Library

- Software | C Library

- Software SPI Library

- Software UART Library

- Sound Library

- SPI Library

- SPI Ethernet Library

- SPI Graphic Lcd Library
- SPI Lcd Library

- SPI LCDS8 Library

- SPI1 T6963C Graphic Lcd Library
- T6963C Graphic Lcd Library
- UART Library

- USB HID Library

Miscellaneous Libraries

- Button Library

- Conversions Library
- Math Library

- String Library

- Time Library

- Trigonometry Library

See also Built-in Routines.
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LIBRARY DEPENDENCIES

Certain libraries use (depend on) function and/or variables, constants defined in

other libraries.

Image below shows clear representation about these dependencies.

[ cansPi J——+[sP1 ]
~[C_Type ]
-
CF_FAT16
“
*| Compact_Flash

[ Conversions |—[ string ]
[ Glcd || Gled_Fonts ]
[Led —+[Led_Constants ]
ety |
MMC_FAT16
I [T
[Mmc J—sp1 ]
[Port_Expander  |—[sPI ]
[ Rs-485 |—+[uART |
_~[spPi
SPI_Ethernet i
.
_~[Port_Expander ] —[sPI
SPI_Glcd
" Glcd_Fonts
o [Port_Expander :| FESPI
[sPiied |
T Lcd_Constants ]
Port_Expander |—[sPI
A
SPI_Lcd8 .
_~[ Port_Expander | ——[sPI
SPI_T6963C g
\\ —
“[ Trigonometry
| Tea63C |—[ Trigonemetry ]

For example, SPIl_Glcd uses
Glcd_Fonts and Port_Expander
library which uses SPI library.

This means that if you check
SPI_Gilcd library in Library man-
ager, all libraries on which it
depends will be checked too.

Related topics: Library manager,
PIC Libraries
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HARDWARE LIBRARIES

- ADC Library

- CAN Library

- CANSPI Library

- Compact Flash Library

- EEPROM Library

- Ethernet PIC18FxxJ60 Library
- Flash Memory Library

- Graphic Lcd Library

- 1. C Library

- Keypad Library

- Led Library

- Manchester Code Library
- Multi Media Card library
- OneWire Library

- Port Expander Library

- PS/2 Library

- PWM Library

- RS-485 Library

- Software | C Library

- Software SPI Library

- Software UART Library

- Sound Library

- SPI Library

- SPI Ethernet Library

- SPI Graphic Lcd Library
- SPI Lcd Library

- SPI LCDS8 Library

- SPI1 T6963C Graphic Lcd Library
- T6963C Graphic Lcd Library
- UART Library

- USB HID Library

200 MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



CHAPTER 7
mikroPASCAL PRO for PIC Libraries

ADC LIBRARY

ADC (Analog to Digital Converter) module is available with a number of PIC MCUs. Library func-
tion ADC_Read is included to provide you comfortable work with the module.

ADC_Read

Prototype function ADC Read(channel : byte) : word;
Initializes PIC’s internal ADC module to work with RC clock. Clock determines
the time period necessary for performing AD conversion (min 12TAD).

Returns
Parameter channel represents the channel from which the analog value is to be
acquired. Refer to the appropriate datasheet for channel-to-pin mapping.
Initializes PIC ’s internal ADC module to work with XTAL frequency prescaled by
128. Clock determines the time period necessary for performing A/D conversion.

Description

Parameter channel represents the channel from which the analog value is to be
acquired. Refer to the appropriate datasheet for channel-to-pin mapping.

Requires Nothing.

var tmp : word;
Example

tmp := ADC Read(2); // Read analog value from channel 2
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Library Example

This example code reads analog value from channel 2 and displays it on PORTB
and PORTC.

program ADC on LEDs;

var temp res : word;
begin

ANSEL := 0x04; // Configure AN2 pin as analog
TRISA := OxFF; // PORTA is input
ANSELH := 0; // Configure other AN pins as dig-

ital I/0
TRISC := 0x3F; // Pins RC7, RC6 are outputs
TRISB := 0; // PORTB is output

while (TRUE) do

begin
temp res := Adc Read(2); // Get 10-bit results of AD con-
version
PORTB := temp res; // Send lower 8 bits to PORTB
PORTC := word(temp res shr 2); // Send 2 most significant
bits to RC7, RC6
end;

end;

HW Connection

330 LDO =
i = rer ]
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i 1]

ADC HW connection
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CAN LIBRARY

mikroPascal PRO for PIC provides a library (driver) for working with the CAN mod-
ule.

CAN is a very robust protocol that has error detection and signalling, self—checking
and fault confinement. Faulty CAN data and remote frames are re-transmitted auto-
matically, similar to the Ethernet.

Data transfer rates vary from up to 1 Mbit/s at network lengths below 40m to 250
Kbit/s at 250m cables, and can go even lower at greater network distances, down
to 200Kbit/s, which is the minimum bitrate defined by the standard. Cables used are
shielded twisted pairs, and maximum cable length is 1000m.

CAN supports two message formats:

- Standard format, with 11 identifier bits, and
- Extended format, with 29 identifier bits

Note: Microcontroller must be connected to CAN transceiver (MCP2551 or similar)
which is connected to CAN bus.

Library Routines

- CANSetOperationMode
- CANGetOperationMode
- CANInitialize

- CANSetBaudRate

- CANSetMask

- CANSetFilter

- CANRead

- CANWrite

Following routines are for the internal use by compiler only:

- RegsToCANID
- CANIDToRegs

Be sure to check CAN constants necessary for using some of the functions.
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CANSetOperationMode
Prototype procedure CANSetOperationMode (mode : byte, wait flag : byte);
Returns Nothing.

Sets CAN to requested mode, i.e. copies mode to CANSTAT. Parameter mode

needs to be one of can op MODE constants (see CAN constants).

Parameter wait f1ag needs to be either 0 or $FF:

Description - If set to $FF, this is a blocking call — the function won’t “return” until the
requested mode is set.

- If 0, this is a non-blocking call. It does not verify if CAN module is switched to
requested mode or not. Caller must use CANGetOperationMode to verify
correct operation mode before performing mode specific operation.

Requires Microcontroller must be connected to CAN transceiver (MCP2551 or similar)
q which is connected to CAN bus.

Example CANSetOperationMode ( CAN MODE CONFIG, SFF);

CANGetOperationMode

Prototype function CANGetOperationMode : byte;

Returns Current opmode.

Description |Function returns current operational mode of CAN module.

Requires Microcontroller must be connected to CAN transceiver (MCP2551 or similar)
q which is connected to CAN bus.

if (CANGetOperationMode = CAN MODE NORMAL) then
Example - = -
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CANInitialize

Prototype

procedure CANInitialize (SJW, BRP, PHSEGl, PHSEG2, PROPSEG,
CAN CONFIG FLAGS : byte);

Returns

Nothing.

Description

Initializes CAN. All pending transmissions are aborted. Sets all mask registers
to O to allow all messages.

Filter registers are set according to flag value:

if ( CAN CONFIG FLAGS and CAN CONFIG VALID XTD MSG) <> 0
// Set all filters to XTD _MSG

else if (config and CONFIG VALID STD MSG) <> 0
// Set all filters to STD _MSG

else

// Set half of the filters to STD, and the rest to XTD MSG.
Parameters:

- sJgu as defined in 18XXX8 datasheet (1-4)

- BrP as defined in 18XXX8 datasheet (1-64)

- PHSEG1 as defined in 18XXX8 datasheet (1-8)

- PHSEG2 as defined in 18XXX8 datasheet (1-8)

- PROPSEG as defined in 18XXX8 datasheet (1-8)

- caN conFic FLAGS is formed from predefined constants (see CAN constants)

Requires

CAN must be in Config mode; otherwise the function will be ignored.

Microcontroller must be connected to CAN transceiver (MCP2551 or similar)
which is connected to CAN bus.

Example

init := CAN CONFIG SAMPLE THRICE and
_CAN_CONFIG_PHSEG2 PRG ON and
_CAN_CONFIG_STD MSG and
_CAN_CONFIG DBL BUFFER ON and
_CAN_CONFIG VALID XTD MSG and
_CAN CONFIG LINE FILTER OFF;

CANInitialize(1l, 1, 3, 3, 1, init); // initialize CAN
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CANSetBaudRate
Proknype procedure CANSetBaudRate (SJW, BRP, PHSEG1l, PHSEG2, PROPSEG,

CAN CONFIG FLAGS : byte);

Returns Nothing.

Sets CAN baud rate. Due to complexity of CAN protocol, you cannot simply
force a bps value. Instead, use this function when CAN is in Config mode. Refer
to datasheet for details.

Parameters:

Description |- suw as defined in 18XXX8 datasheet (1-4)

- BRP as defined in 18XXX8 datasheet (1-64)

- pHSEG] as defined in 18XXX8 datasheet (1-8)

- PHSEG2 as defined in 18XXX8 datasheet (1-8)

- PROPSEG as defined in 18XXX8 datasheet (1-8)

- CAN CONFIG FLAGS is formed from predefined constants (see CAN constants)

CAN must be in Config mode; otherwise the function will be ignored.

Requires Microcontroller must be connected to CAN transceiver (MCP2551 or similar)
which is connected to CAN bus.
init := CAN CONFIG SAMPLE THRICE and
_CAN CONFIG_PHSEG2 PRG ON and
_CAN_CONFIG_STD MSG and
CAN CONFIG DBL BUFFER ON and
Example - R =

_CAN_CONFIG_VALID XTD MSG and
_CAN CONFIG_LINE FILTER OFF;

CANSetBaudRate (1, 1, 3, 3, 1, init);
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CANSetMask

procedure CANSetMask (CAN MASK : byte; wvalue : longint; CAN CON-

Prototype FIG _FLAGS : byte);

Returns Nothing.

Function sets mask for advanced filtering of messages. Given value is bit
adjusted to appropriate buffer mask registers.

Parameters:
Description
- caN MASK is one of predefined constant values (see CAN constants)
- value is the mask register value

- CAN CONFIG FLAGS Selects type of message to filter, either

_CAN CONFIG _XTD MSG OF _CAN CONFIG STD MSG

CAN must be in Config mode; otherwise the function will be ignored.

Requires . . -
q Microcontroller must be connected to CAN transceiver (MCP2551 or similar)
which is connected to CAN bus.
// Set all mask bits to 1, i.e. all filtered bits are relevant:
CANSetMask (_CAN MASK B1l, -1, CAN CONFIG XTD MSG) ;
Example

// Note that -1 is Jjust a cheaper way to write S$FFFFFFFF.
Complement will do the trick and fill it up with ones.
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CANSetFilter
Protot procedure CANSetFilter (CAN FILTER : byte; value : longint;
rototype CAN CONFIG FLAGS : byte);
Returns Nothing.
Function sets message filter. Given value is bit adjusted to appropriate buffer
mask registers.
Parameters:
Description
- caN FILTER is one of predefined constant values (see CAN constants)
- value is the filter register value
- CAN CONFIG FLAGS selects type of message to filter, either
_CAN CONFIG XTD MSG Or CAN CONFIG STD MSG
CAN must be in Config mode; otherwise the function will be ignored.
Requires Microcontroller must be connected to CAN transceiver (MCP2551 or similar)
which is connected to CAN bus.
E I // Set id of filter Bl F1 to 3:
xample CANSetFilter ( CAN FILTER Bl F1, 3, CAN CONFIG XTD MSG);
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CANRead
function CANRead(var id : longint; wvar data : arrayl 8] of byte;
Prototype =
var datalen: byte; wvar CAN RX MSG FLAGS : byte) : byte;
Returns Message from receive buffer or zero if no message found.

Function reads message from receive buffer. If at least one full receive buffer is
found, it is extracted and returned. If none found, function returns zero.

Parameters:
Description
- id is message identifier

- data is an array of bytes up to 8 bytes in length

- datalen is data length, from 1-8.

- CAN RX MSG FLAGS is value formed from constants (see CAN constants)

CAN must be in mode in which receiving is possible.

Requires Microcontroller must be connected to CAN transceiver (MCP2551 or similar)
which is connected to CAN bus.
var
rcv, rx, len : byte;
data : arrayl[ 8] of byte;
id : longint;
Example
//
rx := 0;
//
rcv := CANRead(id, data, len, rx);
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CANWrite
function CANWrite(id : longint; war data : arrayl 8] of byte;
Prototype datalen, CAN TX MSG FLAGS : byte) : byte;
Returns Returns zero if message cannot be queued (buffer full).

If at least one empty transmit buffer is found, function sends message on queue
for transmission. If buffer is full, function returns 0.

Parameters:

Description |_ id is CAN message identifier. Only 11 or 29 bits may be used depending on
message type (standard or extended)

- data is array of bytes up to 8 bytes in length

- datalen is data length from 1-8

- CAN TX MSG FLAGS is value formed from constants (see CAN constants)

CAN must be in Normal mode.

Requires Microcontroller must be connected to CAN transceiver (MCP2551 or similar)

which is connected to CAN bus.

var
tx, data : byte;
id : longint;

Example //

tx := CAN TX PRIORITY 0 and
_CAN TX XTD FRAME;

/7

CANWrite (id, data, 2, tx);

CAN Constants

There is a number of constants predefined in CAN library. To be able to use the library effectively, you
need to be familiar with these. You might want to check the example at the end of the chapter.

CAN_OP_MODE

can op MODE constants define CAN operation mode. Function caNsetOperationMode expects
one of these as its argument:

const CAN MODE BITS = SEO; // Use it to access mode bits
const CAN MODE NORMAL = 0;

const CAN MODE SLEEP = $20;

const CAN MODE LOOP = $40;

const CAN MODE LISTEN = $60;

const CAN MODE_CONFIG = $80;
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CAN_CONFIG_FLAGS

caN CoNFIG FLAGS constants define flags related to CAN module configuration.
Functions canTnitialize and CANSetBaudRate expect one of these (or a bitwise
combination) as their argument:

const CAN CONFIG DEFAULT = $FF; // 11111111
const CAN CONFIG PHSEG2 PRG BIT = $01;

const CAN CONFIG PHSEG2 PRG ON = S$FF; // XXXXXXX1
const CAN CONFIG PHSEG2 PRG OFF = S$FE; // XXXXXXXO

const CAN CONFIG LINE FILTER BIT = $02;
const CAN CONFIG LINE FILTER ON = $FF; // XXXXXX1X
const CAN CONFIG LINE FILTER OFF = $FD; // XXXXXX0X

const CAN CONFIG SAMPLE BIT = $04;

const CAN CONFIG SAMPLE ONCE = SFF; // XXXXX1XX
const CAN CONFIG SAMPLE THRICE = SFB; // XXXXX0XX
const CAN CONFIG MSG TYPE BIT = $08;

const CAN CONFIG STD MSG = SFF; // XXXX1XXX
const CAN CONFIG XTD MSG = SF7; // XXXXOXXX
const CAN CONFIG DBL BUFFER BIT = $10;

const CAN CONFIG DBL BUFFER ON = SFF; // XXX1XXXX
const CAN CONFIG DBL BUFFER OFF = $EF; // XXX0XXXX
const CAN CONFIG MSG BITS = $60;

const CAN CONFIG ALL MSG = SFF; // X11XXXXX
const CAN CONFIG VALID XTD MSG = $DF; // X10XXXXX
const CAN CONFIG VALID STD MSG = $BF; // XO01XXXXX
const CAN CONFIG ALL VALID MSG = $9F; // XOOXXXXX

You may use bitwise and to form config byte out of these values. For example:

init := CAN CONFIG SAMPLE THRICE and
_CAN CONFIG PHSEG2 PRG ON and
_CAN_CONFIG_STD MSG and
_CAN CONFIG DBL BUFFER ON and
_CAN_CONFIG VALID XTD MSG and
_CAN CONFIG LINE FILTER OFF;

CANInitialize(1, 1, 3, 3, 1, init); // Initialize CAN
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CAN_TX_MSG_FLAGS

caN Tx MsG rFLAGS are flags related to transmission of a CAN message:

const CAN TX PRIORITY BITS = $03;

const CAN TX PRIORITY O = SFC; // XXXXXX00
const CAN TX PRIORITY 1 = SFD; // XXXXXX01
const CAN TX PRIORITY 2 = SFE; // XXXXXX10
const CAN TX PRIORITY 3 = SFF; // XXXXXX11
const CAN TX FRAME BIT = $08;

const CAN TX STD FRAME = SFF; // XXXXX1XX
const CAN TX XTD FRAME = SF7; // XXXXX0XX
const CAN TX RTR BIT = $40;

const CAN TX NO RTR FRAME = SFF; // X1XXXXXX
const CAN TX RTR FRAME = $BF; // XOXXXXXX

You may use bitwise and to adjust the appropriate flags. For example:
// form value to be used with CANSendMessage:
send config := CAN TX PRIORITY 0 and

_CAN TX XTD FRAME and

_CAN TX NO RTR FRAME;

éAﬁSendMessage(id, data, 1, send config);
CAN_RX_MSG_FLAGS

CAN Rx MsG FLAGS are flags related to reception of CAN message. If a particular bit
is set; corresponding meaning is TRUE or else it will be FALSE.

const _CAN_RX_FILTER _BITS = $07; // Use it to access filter bits
const CAN RX FILTER 1 = $00;

const CAN RX FILTER 2 = $501;

const CAN RX FILTER 3 = $502;

const CAN RX FILTER 4 = $03;

const CAN RX FILTER 5 = 504;

const CAN RX FILTER 6 = $505;

const CAN RX OVERFLOW = $08; // Set if Overflowed; else clear
const CAN RX INVALID MSG = $10; // Set if invalid; else clear
const CAN RX XTD FRAME = $20; // Set if XTD message; else clear
const CAN RX RTR FRAME = $40; // Set if RTR message; else clear

const CAN RX DBL BUFFERED = $80; // Set if message was
// hardware double-buffered

You may use bitwise and to adjust the appropriate flags. For example:
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if (MsgFlag and CAN RX OVERFLOW) = 0 then

// Receiver overflow has occurred.
// We have lost our previous message.

CAN_MASK

CAN_MASK constants define mask codes. Function CANSetMask expects one of
these as its argument:

const CAN MASK Bl = 0;
const CAN MASK B2 = 1;
CAN_FILTER

can FILTER constants define filter codes. Function cansetrilter expects one of
these as its argument:

const CAN FILTER Bl F1 =
const CAN FILTER Bl F2 =
const CAN FILTER B2 Fl1 =
const CAN FILTER B2 F2 =
const CAN FILTER B2 F3 =
const CAN FILTER B2 F4 =

g W N PO

Ne Ne Ne Ne Ne N

Library Example

This is a simple demonstration of CAN Library routines usage. First node initiates
the communication with the second node by sending some data to its address. The
second node responds by sending back the data incremented by 1. First node then
does the same and sends incremented data back to second node, etc.

Code for the first CAN node:

program Can 1st;

var Can Init Flags, Can Send Flags, Can Rcv Flags, Rx Data Len
byte; // can flags

RxTx Data : arrayf 8] of byte; /7
CAN rx/tx data buffer

Rx ID : longint;

Msg Rcvd : byte;

12111;
3; // node IDs

const ID Ist : longint
const ID 2nd : longint

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD 213



CHAPTER 7

Libraries mikroPASCAL PRO for PIC
begin

PORTC := 0; // clear PORTC

TRISC := 0; // set PORTC as output

Can_Init Flags := 0; //

Can_Send Flags := 0; // clear flags

Can Rcv_Flags = 0; //

Can_Send Flags := CAN TX PRIORITY 0 and // form value to be used
_CAN TX XTD FRAME and // with CANWrite
_CAN TX NO RTR FRAME;

Can Init Flags := CAN CONFIG SAMPLE THRICE and 1/

form value to be used
_CAN CONFIG _PHSEG2 PRG ON and // with CANInit
_CAN CONFIG XTD MSG and
CAN CONFIG DBL BUFFER ON and
_CAN _CONFIG VALID XTD MSG;

CANInitialize(1,3,3,3,1,Can Init Flags);// Initialize CAN module

CANSetOperationMode (_ CAN MODE CONFIG, OXFF) ; // set
CONFIGURATION mode

CANSetMask (_CAN MASK Bl,-1, CAN CONFIG XTD MSG); // set
all maskl bits to ones

CANSetMask (_CAN MASK B2,-1, CAN CONFIG XTD MSG); // set

all mask2 bits to ones
CANSetFilter ( CAN FILTER B2 F4,ID 2nd, CAN CONFIG XTD MSG);// set
id of filter B2 F4 to 2nd node ID
CANSetOperationMode (_CAN MODE NORMAL, OxFF); // set NORMAL mode
RxTx Datal 0] := 9; // set initial data to be sent

CANWrite (ID 1st, RxTx Data, 1, Can Send Flags);// send initial message

while ( TRUE ) do
// endless loop
begin
Msg Rcvd := CANRead(Rx ID , RxTx Data , Rx Data Len,
Can_Rcv_Flags); // receive message
if (((Rx_ID = 1ID 2nd) and Msg Rcvd) <> 0 ) then
// if message received check id
begin
PORTC c = RxTx Datal 0] ;

// id correct, output data at PORTC
Inc (RxTx Datal 0] );
// increment received data
Delay ms (10);

CANWrite (ID 1st, RxTx Data, 1, Can Send Flags);

// send incremented data back
end;
end;

end.
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Code for the second CAN node:

program Can 2nd;

var Can Init Flags,

Can Send Flags,

Can Rcv_Flags,

Rx Data Len

byte; // can flags
RxTx_Data arrayl 8] of byte; // can rx/tx data buffer
Rx ID longint;
Msg Rcvd byte; // reception flag
const ID 1lst longint = 12111;
const ID 2nd longint = 3; // node IDs
begin
PORTC := 0; // clear PORTC
TRISC := 0; // set PORTC as output
Can_Init Flags := 0; //
Can_Send Flags := 0; // clear flags
Can_Rcv_Flags = 0; //

Can Send Flags

Can Init Flags
form value to be

with CANInit

CANInitialize(1,3,3,3,1,Can Init Flags);

nal CAN module

:= CAN TX PRIORITY 0 and // form value to be used

_CAN TX XTD FRAME and
_CAN TX NO RTR FRAME;

//

:= CAN CONFIG SAMPLE THRICE and
used
_CAN_CONFIG_PHSEGZ_PRG_ON and

_CAN CONFIG_XTD MSG and

_CAN CONFIG DBL BUFFER ON and
_CAN CONFIG VALID XTD MSG and
_CAN CONFIG LINE FILTER OFF;

CANSetOperationMode (_ CAN MODE CONFIG, OxFF) ;
CONFIGURATION mode

CANSetMask ( CAN MASK B1l,-1, CAN CONFIG XTD MSG);
all maskl bits to ones

CANSetMask ( CAN MASK B2,-1, CAN CONFIG XTD MSG);
all mask2 bits to ones

CANSetFilter ( CAN FILTER B2 F3,ID lst, CAN CONFIG XTD MSG);//

id of filter B2 F3 to 1lst node ID

CANSetOperationMode(_CAN_MODE_NORMAL,OxFF);

with CANWrite

//

//

// initialize exter-

//

set

//

set
//

set

set

// set NORMAL mode
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while (TRUE) do
// endless loop
begin
Msg Rcvd := CANRead(Rx ID , RxTx Data , Rx Data Len,
Can_Rcv_Flags); // receive message
if (((Rx ID = 1ID 1st) and Msg Rcvd) <> 0 ) then
// if message received check id
begin
PORTC 1= RxTx Datal 0] ;

// id correct, output data at PORTC
inc (RxTx Datal 0] ) ;

// increment received data

CANWrite (ID 2nd, RxTx Data, 1, Can_ Send Flags);
// send incremented data back

end;
end;

end.

HW Connection

» CAN RX of MCU

—— CAN TX of MCU

10R

1 =7
TX-CAN RS

L =
I”—;[ GND CANH ];—
]5
]_

vee p——{| veec canu

RXD el

|

MCP2551

twisted pair

Example of interfacing CAN transceiver with MCU and bus

216 MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



CHAPTER 7
mikroPASCAL PRO for PIC Libraries

CANSPI LIBRARY

The SPI module is available with a number of the PIC compliant MCUs. The
mikroPascal PRO for PIC provides a library (driver) for working with mikroElektron-
ika's CANSPI Add-on boards (with MCP2515 or MCP2510) via SPI interface.

The CAN is a very robust protocol that has error detection and signalization,
self-checking and fault confinement. Faulty CAN data and remote frames are re-
transmitted automatically, similar to the Ethernet.

Data transfer rates depend on distance. For example, 1 Mbit/s can be achieved at
network lengths below 40m while 250 Kbit/s can be achieved at network lengths
below 250m. The greater distance the lower maximum bitrate that can be achieved.
The lowest bitrate defined by the standard is 200Kbit/s. Cables used are shielded
twisted pairs.

CAN supports two message formats:

- Standard format, with 11 identifier bits and
- Extended format, with 29 identifier bits

Note:

- Consult the CAN standard about CAN bus termination resistance.

- An effective CANSPI communication speed depends on SPI and certainly is
slower than “real” CAN.

- The library uses the SPI module for communication. User must initialize SPI
module before using the SPI Graphic Lcd Library.
For MCUs with two SPI modules it is possible to initialize both of them and then
switch by using the SPI_Set_Active() routine.

- CANSPI module refers to mikroElektronika's CANSPI Add-on board connected to
SPI module of MCU.
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External dependencies of CANSPI Library

The following variables
must be defined in all

- - Description: Example :
projects using CANSPI P P
Library:
var CanSpi CS : sbit; var CanSpi CS : sbit

sfr; external; Chu)semCt“ne' at RCO bit;

var CanSpi Rst : var CanSpi Rst : sbit

Reset line.

sbit; sfr; external; at RC2 bit;
var . . . var
Direction of the Chi

CanSpi CS Direction : Select pi P CanSpi CS Direction :
sbit; sfr; external; elect pin. sbit at TRISCO bit;
var

. . . var
CanSpi Rst Direction

. Direction of the Reset pin. [CanSpi Rst Direction
: sbit; sfr; . .
: sbit at TRISC2 bit;

external;

Library Routines

- CANSPISetOperationMode
- CANSPIGetOperationMode
- CANSPIInitialize

- CANSPISetBaudRate

- CANSPISetMask

- CANSPISetFilter

- CANSPIread

- CANSPIWrite

The following routines are for an internal use by the library only:

- RegsToCANSPIID
- CANSPIIDToRegs

Be sure to check CANSPI constants necessary for using some of the functions.
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CANSPISetOperationMode

Prokﬂype procedure CANSPISetOperationMode (mode: byte; WAIT: byte);

Returns Nothing.

Sets the CANSPI module to requested mode.
Parameters :

- mode: CANSPI module operation mode. Valid values: canspI op MODE con-

stants (see CANSPI constants).

-wa1T: CANSPI mode switching verification request. If watT = 0, the call is
non-blocking. The function does not verify if the CANSPI module is switched to
requested mode or not. Caller must use CANSPTGetOperationMode to verify
correct operation mode before performing mode specific operation. If
waTT != 0, the call is blocking — the function won’t “return” until the requested
mode is set.

Description

The CANSPI routines are supported only by MCUs with the SPI module.

Requires MCU has to be properly connected to mikroElektronika's CANSPI Extra Board

or similar hardware. See connection example at the bottom of this page.

// set the CANSPI module into configuration mode (wait inside
Example CANSPISetOperationMode until this mode is set)
CANSPISetOperationMode<7CANSPIAMODE7CONFIG, OxFF) ;
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CANSPIGetOperationMode

Prokﬂype function CANSPIGetOperationMode (): byte;

Returns Current operation mode.

The function returns current operation mode of the CANSPI module. Check
Description |canspr op mMODE constants (see CANSPI constants) or device datasheet for
operation mode codes.

The CANSPI routines are supported only by MCUs with the SPI module.

Requires . o
q MCU has to be properly connected to mikroElektronika's CANSPI Extra Board

or similar hardware. See connection example at the bottom of this page.
// check whether the CANSPI module is in Normal mode and if it
is do something.
if (CANSPIGetOperationMode () = CANSPI MODE NORMAL) then

Example . g - - -
begin
end;

CANSPIInitialize

procedure CANSPIInitialize (SJW: byte; BRP: byte; PHSEGl: byte;

Prokﬂype PHSEG2: byte; PROPSEG: byte; CANSPI CONFIG FLAGS: byte);
Returns Nothing.
Initializes the CANSPI module.
Stand-Alone CAN controller in the CANSPI module is set to:
- Disable CAN capture
- Continue CAN operation in Idle mode
- Do not abort pending transmissions
- Fcan clock: 4*Tey (Fosc)
. - Baud rate is set according to given parameters
Description

- CAN mode: Normal

- Filter and mask registers IDs are set to zero

- Filter and mask message frame type is set according to -
CANSPI CONFIG FLAGS value

SAM, SEG2PHTS, WAKFIL and DBEN bits are set according to
CANSPI CONFIG FLAGS value.
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Parameters:

- sgw as defined in CAN controller's datasheet

- Brp as defined in CAN controller's datasheet

Description |- pusrec1 as defined in CAN controller's datasheet

- pHSEG2 as defined in CAN controller's datasheet

- proPSEG as defined in CAN controller's datasheet

- canspI conNrFIG FLAGS is formed from predefined constants (see CANSPI
constants)

Global variables :

- canspi cs: Chip Select line

- Canspi Rrst: Reset line

- CanSpi Cs Bit Direction: Direction of the Chip Select pin
- CanSpi Rst Bit Direction: Direction of the Reset pin

must be defined before using this function.

Requires
The CANSPI routines are supported only by MCUs with the SPI module.
The SPI module needs to be initialized. See the SPI1_Init and
SPI1_Init_Advanced routines.
MCU has to be properly connected to mikroElektronika's CANSPI Extra Board
or similar hardware. See connection example at the bottom of this page.
// CANSPI module connections
var CanSpi CS : sbit at RCO bit;
CanSpi CS Direction : sbit at TRISCO bit;
CanSpi Rst : sbit at RC2 bit;
CanSpi Rst Direction : sbit at TRISC2Z bit;
// End CANSPI module connections
var Can Init Flags: byte;
Can Init Flags := CANCONFIG SAMPLE THRICE and // form value
Example - - - - -
to be used
_CANCONFIG PHSEG2 PRG ON and // with
CANSPIInitialize
_CANCONFIG XTD MSG and
_CANCONFIG DBL BUFFER ON and
_CANCONFIG VALID XTD MSG;
SPI1 Init(); // initialize SPI module
CANSPIInitialize(1,3,3,3,1,Can Init Flags); // initialize

external CANSPI module
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CANSPISetBaudRate

procedure CANSPISetBaudRate (SJW: byte; BRP: byte; PHSEGl: byte;

Prokﬂype PHSEG2Z: byte; PROPSEG: byte; CANSPI CONFIG FLAGS: byte);

Returns Nothing.

Sets the CANSPI module baud rate. Due to complexity of the CAN protocol,
you can not simply force a bps value. Instead, use this function when the
CANSPI module is in Config mode.

saM, seEG2PHTS and WakrFIL bits are set according to CANSPT CONFIG FLAGS
value. Refer to datasheet for details.

. Parameters:

Description

- saw as defined in CAN controller's datasheet

- Brp as defined in CAN controller's datasheet

- pHsEG1 as defined in CAN controller's datasheet

- pHsEG2 as defined in CAN controller's datasheet

- proPSEG as defined in CAN controller's datasheet

- CANSPI CONFIG FLAGS is formed from predefined constants (see CANSPI
constants)

The CANSPI module must be in Config mode, otherwise the function will be
ignored. See CANSPISetOperationMode.

Requires The CANSPI routines are supported only by MCUs with the SPI module.

MCU has to be properly connected to mikroElektronika's CANSPI Extra Board
or similar hardware. See connection example at the bottom of this page.

// set required baud rate and sampling rules
var can config flags: byte;

CANSPISetOperationMode ( CANSPI MODE CONFIG, 0xFF) ;
// set CONFIGURATION mode (CANSPI module mast be in config mode
for baud rate settings)
Example can config flags := CANSPI CONFIG SAMPLE THRICE and

_CANSPI CONFIG PHSEG2 PRG ON and

_CANSPI CONFIG STD MSG and

_CANSPI CONFIG DBL BUFFER ON and

_CANSPI CONFIG VALID XTD MSG and

_CANSPI CONFIG LINE FILTER OFF;
CANSPISetBaudRate(l, 1, 3, 3, 1, can config flags);
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CANSPISetMask

Prototype

procedure CANSPISetMask (CANSPI MASK: byte; wval: longint;
CANSPI CONFIG FLAGS: byte);

Returns

Nothing.

Description

Configures mask for advanced filtering of messages. The parameter value is
bit-adjusted to the appropriate mask registers.

Parameters:

- canspI Mask: CANSPI module mask number. Valid values: canspr mMask con-
stants (see CANSPI constants)

- val: mask register value

- CANSPI CONFIG FLAGS: selects type of message to filter. Valid values:

CANSPI CONFIG ALL VALID MSG,
_CANSPI CONFIG MATCH MSG TYPE and CANSPI CONFIG STD MSG,
_CANSPI CONFIG MATCH MSG TYPE and CANSPI CONFIG XTD MSG.

(see CANSPI constants)

Requires

The CANSPI module must be in Config mode, otherwise the function will be
ignored. See CANSPISetOperationMode.

The CANSPI routines are supported only by MCUs with the SPI module.

MCU has to be properly connected to mikroElektronika's CANSPI Extra Board
or similar hardware. See connection example at the bottom of this page.

Example

// set the appropriate filter mask and message type value
CANSPISetOperationMode (_CANSPI MODE CONFIG, OxFF) ;

// set CONFIGURATION mode (CANSPI module must be in config mode
for mask settings)

// Set all Bl mask bits to 1 (all filtered bits are relevant):
// Note that -1 is just a cheaper way to write OxFFFFFFFF.

// Complement will do the trick and fill it up with ones.
CANSPISetMask ( CANSPI MASK B1, -1, CANSPI CONFIG MATCH MSG TYPE
and CANSPI CONFIG _XTD MSG) ;
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CANSPISetFilter

procedure CANSPISetFilter (CANSPI FILTER: byte; val: longint; CAN-

Prototype SPI_CONFIG _FLAGS: byte);

Returns Nothing.

Configures message filter. The parameter value is bit-adjusted to the appropri-
ate filter registers.

Parameters:

- canseI rrLTER: CANSPI module filter number. Valid values: canspr FILTER
constants (see CANSPI constants)

Description | .. 1: filter register value

- CANSPI CONFIG FLAGS: selects type of message to filter. Valid values:

_CANSPI_CONFIG ALL VALID MSG,

_CANSPI CONFIG MATCH MSG TYPE and CANSPI CONFIG_STD MSG,
_CANSPI CONFIG MATCH MSG TYPE and CANSPI CONFIG XTD MSG.

(see CANSPI constants)

The CANSPI module must be in Config mode, otherwise the function will be
ignored. See CANSPISetOperationMode.

Requires The CANSPI routines are supported only by MCUs with the SPI module.

MCU has to be properly connected to mikroElektronika's CANSPI Extra Board
or similar hardware. See connection example at the bottom of this page.

// set the appropriate filter value and message type
CANSPISetOperationMode ( CANSPI MODE CONFIG, OxFF) ;

// set CONFIGURATION mode (CANSPI module must be in config mode
Example for filter settings)

// Set id of filter Bl F1l to 3:
CANSPISetFilter ( CANSPI FILTER Bl F1, 3, CANSPI CONFIG XTD MSG) ;
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CANSPIRead
Prototvpe function CANSPIRead(var id: longint; wvar rd data: array[ 8] of
ypP byte; data len: byte; wvar CANSPI RX MSG FLAGS: byte): byte;
- 0 if nothing is received
Returns . . . .
- 0xrr if one of the Receive Buffers is full (message received)
If at least one full Receive Buffer is found, it will be processed in the following way:
- Message ID is retrieved and stored to location provided by the i d parameter
- Message data is retrieved and stored to a buffer provided by the rd data -
parameter
- Message length is retrieved and stored to location provided by the data len
parameter
Description |- Message flags are retrieved and stored to location provided by the
CANSPI RX MSG FLAGS parameter
Parameters:
- id: message identifier storage address
- rd data: data buffer (an array of bytes up to 8 bytes in length)
- data len: data length storage address.
- CANSPI RX MSG FLAGS: message flags storage address
The CANSPI module must be in a mode in which receiving is possible. See
CANSPISetOperationMode.

Requires The CANSPI routines are supported only by MCUs with the SPI module.
MCU has to be properly connected to mikroElektronika's CANSPI Extra Board
or similar hardware. See connection example at the bottom of this page.

// check the CANSPI module for received messages. If any was
received do something.
var msg rcvd, rx flags, data len: byte;
rd data: arrayl 8] of byte;
msg_id: longint;
CANSPISetOperationMode ( CANSPI MODE NORMAL, OxFF) ;
// set NORMAL mode (CANSPI module must be in mode in which

Example . . .
receive 1s possible)
rx flags := 0;

// clear message flags

if (msg rcvd = CANSPIRead(msg id, rd data, data len, rx flags)
begin

end;
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CANSPIWrite
Prokﬂype function CANSPIWrite(id: longint; war wr data: array| 8] of byte;

data len: byte; CANSPI TX MSG FLAGS: byte): byte;

- 0 if all Transmit Buffers are busy

Returns - 0xrr if at least one Transmit Buffer is available
If at least one empty Transmit Buffer is found, the function sends message in
the queue for transmission.
Parameters:

Description

- id: CAN message identifier. Valid values: 11 or 29 bit values, depending on
message type (standard or extended)

-wr data: data to be sent (an array of bytes up to 8 bytes in length)

- data len: data length. Valid values: 1 to 8

- CANSPT RX MSG FLAGS: message flags

The CANSPI module must be in mode in which transmission is possible. See
CANSPISetOperationMode.

Requires The CANSPI routines are supported only by MCUs with the SPI module.

MCU has to be properly connected to mikroElektronika's CANSPI Extra Board
or similar hardware. See connection example at the bottom of this page.

// send message extended CAN message with the appropriate ID and
data
var tx flags: byte;

rd data: arrayl 8] of byte;

msg_id: longint;

Example CANSPISetOperationMode ( CANSPI MODE NORMAL, OxFF);
// set NORMAL mode (CANSPI must be in mode in which transmission
is possible)

tx_flags := CANSPI TX PRIORITY 0 ands CANSPI TX XTD FRAME;
// set message flags
CANSPIWrite (msg id, rd data, 2, tx flags);

CANSPI Constants

There is a number of constants predefined in the CANSPI library. You need to be familiar with them in
order to be able to use the library effectively. Check the example at the end of the chapter.
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CANSPI_OP_MODE

The cansp1 orp moDE constants define CANSPI operation mode. Function
CANSPISetOperationMode expects one of these as it's argument:

const
_CANSPI MODE BITS = O0xE0; // Use this to access opmode bits
_CANSPI MODE NORMAL = 0x00;
_CANSPI MODE SLEEP = 0x20;
_CANSPI MODE_LOOP = 0x40;

_CANSPI MODE LISTEN = 0x60;
_CANSPI MODE_CONFIG = 0x80;

CANSPI_CONFIG_FLAGS

The canspI conrIG FLAGS constants define flags related to the CANSPI module
configuration. The functions  CANSPIInitialize, ¥ CANSPISetBaudRate,
CANSPISetMask and CANSPISetFilter expect one of these (or a bitwise combina-
tion) as their argument:

const
_CANSPI CONFIG DEFAULT = OxFF; // 11111111
_CANSPI CONFIG PHSEG2 PRG BIT = 0x01;
_CANSPI CONFIG PHSEG2 PRG ON = OxFF; // XXXXXXX1
_CANSPI CONFIG PHSEG2 PRG OFF = 0OxFE; // XXXXXXX0

_CANSPI_CONFIG LINE FILTER BIT = 0x02;
_CANSPI_CONFIG LINE FILTER ON = OxFF;
_CANSPI_CONFIG LINE FILTER OFF = OxFD;

// XXXXXX1X
// XXXXXX0X

_CANSPI CONFIG SAMPLE BIT = 0x04;

_CANSPI CONFIG SAMPLE ONCE = OxFF; // XXXXX1XX
_CANSPI CONFIG SAMPLE THRICE = 0xFB; // XXXXXO0XX
_CANSPI CONFIG MSG TYPE BIT = 0x08;

_CANSPI CONFIG STD MSG = OxFF; // XXXXLXXX
_CANSPI CONFIG XTD MSG = 0xF7; // XXXXOXXX
_CANSPI CONFIG DBL BUFFER BIT = 0x10;

_CANSPI CONFIG DBL BUFFER ON = OxFF; // XXX1XXXX
_CANSPI CONFIG DBL BUFFER OFF = OxEF; // XKXXOXXXX
_CANSPI CONFIG MSG BITS = 0x60;

_CANSPI CONFIG ALL MSG = OxFF; // XK11XXXXX
_CANSPI CONFIG VALID XTD MSG = O0xDF; // XLOXXXXX
_CANSPI CONFIG VALID STD MSG = OxBF; // XO1XXXXX
_CANSPI CONFIG ALL VALID MSG = 0x9F; // XOOXXXXX

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD 227



CHAPTER 7
Libraries

mikroPASCAL PRO for PIC

You may use bitwise =nd to form config byte out of these values. For example:

init := CANSPI CONFIG SAMPLE THRICE and
_CANSPI_CONFIG PHSEG2 PRG ON and
_CANSPI_CONFIG STD MSG and
_CANSPI_CONFIG DBL BUFFER ON and
_CANSPI_CONFIG VALID XTD MSG and

_CANSPI CONFIG LINE FILTER OFF;
CANSPIInitialize(1l, 1, 3, 3, 1, init); // initialize CANSPI

CANSPI_TX_MSG_FLAGS

CANSPI Tx MsG FLAGS are flags related to transmission of a CAN message:

const
_CANSPI TX PRIORITY BITS = 0x03;
_CANSPI TX PRIORITY O = 0xFC; // XXXXXX00
_CANSPI TX PRIORITY 1 = O0xFD; // XXXXXX01
_CANSPI TX PRIORITY 2 = OxFE; // XXXXXX10
_CANSPI TX PRIORITY 3 = OxFF; // XXXXXX11
_CANSPI TX FRAME BIT = 0x08;
_CANSPI TX STD FRAME = OxFF; // XXXXX1XX
_CANSPI TX XTD FRAME = OxF7; // XXXXXOXX
_CANSPI TX RTR BIT = 0x40;
_CANSPI TX NO RTR FRAME = OxFF; // XLXXXXXX
_CANSPI TX RTR FRAME = O0xBF; // XOXXXXXX

You may use bitwise and to adjust the appropriate flags. For example:

// form value to be used as sending message flag:

send config _CANSPI_TX PRIORITY 0 and
_CANSPI_TX XTD_ FRAME and
_CANSPI_TX NO RTR FRAME;

éAﬁSPIWrite(id, data, 1, send config);
CANSPI_RX_MSG_FLAGS

CANSPI Rx MsG FLAGS are flags related to reception of CAN message. If a particu-
lar bit is set then corresponding meaning is TRUE or else it will be FALSE.
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const
_CANSPI_RX FILTER BITS = 0x07;// Use this to access filter bits
_CANSPI_RX FILTER 1 = 0x00;
_CANSPI_RX FILTER 2 = 0x01;
_CANSPI_RX FILTER 3 = 0x02;
_CANSPI_RX FILTER 4 = 0x03;
_CANSPI_RX FILTER 5 = 0x04;
_CANSPI_RX FILTER 6 = 0x05;

_CANSPI RX OVERFLOW 0x08; // Set if Overflowed else cleared
_CANSPI_RX INVALID MSG = 0x10; // Set if invalid else cleared
CANSPI RX XTD FRAME = 0x20; // Set if XTD message else cleared
_CANSPI RX RTR FRAME 0x40; // Set if RTR message else cleared

_CANSPI_RX DBL_BUFFERED = 0x80; // Set if this message was hard-
ware double-buffered

You may use bitwise =nd to adjust the appropriate flags. For example:

if (MsgFlag and CANSPI RX OVERFLOW <> 0) then
begin
// Receiver overflow has occurred.
// We have lost our previous message.
end;

CANSPI_MASK

The CANSPI_MASK constants define mask codes. Function CANSPISetMask
expects one of these as it's argument:

const
_CANSPI MASK Bl = 0;
_CANSPI MASK B2 1;

CANSPI_FILTER

The canspr rILTER constants define filter codes. Functions CANSPISetFilter
expects one of these as it's argument:

const
_CANSPI FILTER Bl F1 =
_CANSPI FILTER Bl F2 =
_CANSPI FILTER B2 F1 =
_CANSPI FILTER B2 F2 =
_CANSPI FILTER B2 F3 =
_CANSPI FILTER B2 F4 =

g w N PO
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Library Example

This is a simple demonstration of CANSPI Library routines usage. First node initi-
ates the communication with the second node by sending some data to its address.
The second node responds by sending back the data incremented by 1. First node
then does the same and sends incremented data back to second node, etc.

Code for the first CANSPI node:

program Can Spi 1st;

var Can Init Flags, Can Send Flags, Can Rcv Flags : byte; // can
flags
Rx Data Len : byte; // received data length in bytes
RxTx Data : array{ 8] of byte; // can rx/tx data buffer
Msg Rcvd : byte; // reception flag
Tx_ID, Rx ID : longint; // can rx and tx ID

// CANSPI module connections

var CanSpi CS : sbit at RCO bit;
CanSpi CS Direction : sbit at TRISCO bit;
CanSpi Rst : sbit at RC2 bit;
CanSpi Rst Direction : sbit at TRISC2Z bit;

// End CANSPI module connections

begin

ANSEL := O0; // Configure AN pins as digital I/0O

ANSELH := 0;

PORTB := 0;

TRISB := 0;

Can_Init Flags := 0; /7

Can_Send Flags := 0; // clear flags

Can Rcv Flags := 0; //

Can_Send Flags := CANSPI TX PRIORITY 0 and //form value to be used
_CANSPI TX XTD FRAME and // with CANSPIWrite

_CANSPI_TX NO_RTR_FRAME;

Can Init Flags := CANSPI CONFIG SAMPLE THRICE and // form
value to be used
_CANSPI CONFIG PHSEG2 PRG ON and // with
CANSPIInit
_CANSPI CONFIG XTD MSG and
_CANSPI CONFIG DBL BUFFER ON and
_CANSPI CONFIG VALID XTD MSG;
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SPI1 Init(); /7
initialize SPI module
CANSPIInitialize(1,3,3,3,1,Can_Init Flags); //
Initialize external CANSPI module
CANSPISetOperationMode ( CANSPI MODE CONFIG, OxFF) ; /7

set CONFIGURATION mode
CANSPISetMask ( CANSPI MASK Bl,-1, CANSPI CONFIG XTD MSG);
// set all maskl bits to ones
CANSPISetMask ( CANSPI MASK B2,-1, CANSPI CONFIG XTD MSG);
// set all mask2 bits to ones
CANSPISetFilter (_CANSPI_FILTER_B2_F4 , 3, _CANSPI_CONFIG_XTD_MSG) ;
// set id of filter Bl F1 to 3

CANSPISetOperationMode ( CANSPI MODE NORMAL, OxFF) ; //
set NORMAL mode

RxTx Datal 0] := 9; // set initial data to be sent
Tx ID := 12111; // set transmit ID
CANSPIWrite (Tx ID, RxTx Data, 1, Can_ Send Flags); //

send initial message
while (TRUE) do

begin // endless loop
Msg Rcvd := CANSPIRead(Rx ID , RxTx Data , Rx Data Len,
Can_Rcv_Flags); // receive message
if ((Rx_ID = 3) and Msg Rcvd) then
// if message received check id
begin
PORTB := RxTx Datal 0] ;

// id correct, output data at PORTB
Inc (RxTx Datal 0] ) ;
// increment received data
Delay ms (10);

CANSPIWrite (Tx ID, RxTx Data, 1, Can Send Flags);

// send incremented data back
end;
end;

end.
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Code for the second CANSPI node:

program Can Spi 2nd;

var Can Init Flags, Can_Send Flags, Can Rcv Flags : byte; // can
flags
Rx Data Len : byte; // received data length in bytes
RxTx_Data : arrayl 8] of byte; // CAN rx/tx data buffer
Msg Rcvd : byte; // reception flag
Tx_ID, Rx ID : longint; // can rx and tx ID

// CANSPI module connections

var CanSpi CS : sbit at RCO bit;
CanSpi CS Direction : sbit at TRISCO bit;
CanSpi Rst : sbit at RC2 bit;
CanSpi Rst Direction : sbit at TRISC2 bit;

// End CANSPI module connections

begin

ANSEL := 0; //
Configure AN pins as digital I/O

ANSELH := 0;

PORTB := 0; //
clear PORTC

TRISB := 0; //
set PORTC as output

Can_Init Flags := 0; //

Can_Send Flags := 0; //
clear flags

Can _Rcv_Flags := 0; //

Can Send Flags := CANSPI TX PRIORITY 0 and //

form value to be used

_CANSPI TX XTD FRAME and //
with CANSPIWrite

_CANSPI TX NO RTR FRAME;

Can Init Flags := CANSPI CONFIG SAMPLE THRICE and //

Form value to be used

_CANSPI CONFIG PHSEG2 PRG ON and //
with CANSPIInit

_CANSPI CONFIG XTD MSG and

_CANSPI CONFIG DBL BUFFER ON and

_CANSPI CONFIG VALID XTD MSG and

_CANSPI CONFIG LINE FILTER OFF;
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SPI1 Init(); // initialize SPI1 module
CANSPIInitialize(1,3,3,3,1,Can _Init Flags); // initialize
external CANSPI module
CANSPISetOperationMode (_ CANSPI MODE CONFIG, 0xFF); // set
CONFIGURATION mode
CANSPISetMask ( CANSPI MASK B1,-1, CANSPI CONFIG XTD MSG) ; //
set all maskl bits to ones
CANSPISetMask ( CANSPI MASK B2,-1, CANSPI CONFIG XTD MSG); //

set all mask2 bits to ones

CANSPISetFilter ( CANSPI FILTER B2 F3,12111, CANSPI CONFIG_XTD MSG);
// set id of filter Bl F1 to 3

CANSPISetOperationMode(_CANSPI_MODE_NORMAL,OXFF); //
set NORMAL mode
Tx ID := 3; // set tx ID
while (TRUE) do // endless loop
begin
Msg Rcvd := CANSPIRead(Rx ID , RxTx Data , Rx Data Len,
Can Rcv_Flags); // receive message
if ((Rx_ID = 12111) and Msg Rcvd) then
// if message received check id
begin
PORTB := RxTx Datal 0] ;// id correct, output data at PORTB
Inc (RxTx Datal 0] ) // increment received data

CANSPIWrite (Tx_ID, RxTx Data, 1, Can_Send Flags);
// send incremented data back
end;
end;
end.
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Example of interfacing CAN transceiver MCP2510 with MCU via SPI interface

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD 233



CHAPTER 7
Libraries mikroPASCAL PRO for PIC

COMPACT FLASH LIBRARY

The Compact Flash Library provides routines for accessing data on Compact Flash
card (abbr. CF further in text). CF cards are widely used memory elements, com-
monly used with digital cameras. Great capacity and excellent access time of only
a few microseconds make them very attractive for the microcontroller applications.

In CF card, data is divided into sectors. One sector usually comprises 512 bytes.
Routines for file handling, the Cf_Fat routines, are not performed directly but suc-
cessively through 512B buffer.

Note: Routines for file handling can be used only with FAT16 file system.
Note: Library functions create and read files from the root directory only.

Note: Library functions populate both FAT1 and FAT2 tables when writing to files,
but the file data is being read from the FAT1 table only; i.e. there is no recovery if
the FAT1 table gets corrupted.

Note: If MMC/SD card has Master Boot Record (MBR), the library will work with the
first available primary (logical) partition that has non-zero size. If MMC/SD card has
Volume Boot Record (i.e. there is only one logical partition and no MBRs), the library
works with entire card as a single partition. For more information on MBR, physical
and logical drives, primary/secondary partitions and partition tables, please consult
other resources, e.g. Wikipedia and similar.

Note: Before writing operation, make sure not to overwrite boot or FAT sector as it
could make your card on PC or digital camera unreadable. Drive mapping tools,
such as Winhex, can be of great assistance.
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External dependencies of Compact Flash Library

The following variables
must be defined in all
projects using Compact
Flash Library:

Description: Example :

var CF Data Port
byte; sfr; external;

var CF RDY : sbit;

var CF Data Port
byte at PORTD;

var CF RDY : sbit at

Compact Flash Data Port.

Ready signal line.

sfr; external; RB7 bit;

var CF WE : sbit; . . . var CF WE : sbit at

Sfr: external; Write Enable signal line. RB6 bit;

var CF OE : sbit; . . var CF OE : sbit at

sfr; external; Output Enable signal line. RES5 bil;

var CF CDl : sbit; Chib Detect signal line var CF CDl1 : sbit at
sfr; external; P 9 ’ RB4 bit;

var CF CEl : sbit; Chio Enable sianal line var CF CE1 : sbit at
sfr; external; P 9 ’ RB3 bit;

var CF A2 : sbit; . var CF A2 : sbit at

sfr; external; Address pin 2. RB2 bit;

var CF Al : sbit; Address pin 1 var CF Al : sbit at

sfr; external; pi : RB1 bit;

var CF A0 : sbit; . var CF A0 : sbit at

sfr; external; Address pin 0. RBO bit;

var CF RDY direction
sbit; sfr; external;

var CF RDY direction

Direction of the Ready pin. sbit at TRISB7 bit;

var CF WE direction :|Direction of the Write var CF WE direction
sbit; sfr; external; EnaMe[ﬁn_ sbit at TRISB6 bit;
var CF OE direction : [Direction of the Output var CF OE direction
sbit; sfr; external; [Enable pin. sbit at TRISB5 bit;
var CF CD1 direction : |Direction of the Chip var CF CDl direction
sbit; sfr; external; |Detect pin. : sbit at TRISB4 bit;
var CF CEl direction : |Direction of the Chip var CF CEl direction
sbit; sfr; external; EnaMe[ﬁn_ : sbit at TRISB3 bit;

var CF A2 direction :|Direction of the Address 2 [var cF A2 direction
sbit; sfr; external; Mn_ sbit at TRISB2 bit;

var CF Al direction :|Direction of the Address 1 |[var cF Al direction
sbit; sfr; external; mn_ sbit at TRISB1 bit;

var CF A0 direction :|Direction of the Address 0 [var CF A0 direction
sbit; sfr; external; mn, sbit at TRISBO bit;
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Library Routines

- Cf_Init

- Cf_Detect

- Cf_Enable

- Cf_Disable

- Cf_Read_lInit

- Cf_Read_Byte

- Cf_Write_Init

- Cf_Write_Byte

- Cf_Read_Sector
- Cf_Write_Sector

Routines for file handling:

- Cf_Fat_Init

- Cf_Fat_QuickFormat

- Cf_Fat_Assign

- Cf_Fat_Reset

- Cf_Fat_Read

- Cf_Fat_Rewrite

- Cf_Fat_Append

- Cf_Fat_Delete

- Cf_Fat_Write

- Cf_Fat_Set _File_Date
- Cf_Fat_Get_File_Date
- Cf_Fat_Get_File_Size
- Cf_Fat_Get_Swap_File
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Cf_Init

Prototype |procedure Cf Init();

Returns Nothing.

Description |Initializes ports appropriately for communication with CF card.

Global variables :

- CF Data port : Compact Flash data port

- cr rDY : Ready signal line

- cr we : Write enable signal line

- cr or : Output enable signal line

- cr cpl : Chip detect signal line

- cr cel : Enable signal line

- cr a2 : Address pin 2

- cr Al :Address pin 1

Requires - CF 20 : Address pin 0

- CF RDY direction : Direction of the Ready pin

- CF WE direction : Direction of the Write enable pin
- CF OE direction : Direction of the Output enable pin
- CF CD1 direction : Direction of the Chip detect pin
- CF CEl direction : Direction of the Chip enable pin
- CF A2 direction : Direction of the Address 2 pin

- CF Al direction : Direction of the Address 1 pin

- CF A0 direction : Direction of the Address 0 pin

must be defined before using this function.

// set compact flash pinout
var CF Data Port : byte at PORTD;

var CF RDY : sbit at RB7 bit;
var CF_ WE : sbit at RB6 bit;
var CF OE : sbit at RB5 bit;
var CF _CDl : sbit at RB4 bit;
var CF CE1l : sbit at RB3 bit;

var CF A2 : sbit at RB2 bit;
var CF Al : sbit at RB1l bit;
var CF A0 : sbit at RBO bit;
E I var CF RDY direction : sbit at TRISB7 bit;
xample var CF WE direction : sbit at TRISB6 bit;
var CF OE direction : sbit at TRISB5 bit;

var CF CD1 direction : sbit at TRISB4 bit;
var CF CEl direction : sbit at TRISB3 bit;

var CF A2 direction : sbit at TRISB2 bit;
var CF Al direction : sbit at TRISB1l bit;
var CF A0 direction : sbit at TRISBO bit;

// end of cf pinout

// Init CF
begin

Cf Init();
end;
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Cf_Detect
Prototype function CF_Detect() : byte;
- 1 - if CF card was detected
Returns .
- 0 - otherwise
Description |Checks for presence of CF card by reading the chip detect pin.
Requires The c_orrespondlng MCU ports must be appropriately initialized for CF card. See
Cf_Init.
// Wait until CF card is inserted:
Example while (Cf Detect() = 0) do
nop;
Cf_Enable
Prototype procedure Cf Enable();
Returns Nothing.
Enables the device. Routine needs to be called only if you have disabled the
Description |device by means of the Cf_Disable routine. These two routines in conjunction
allow you to free/occupy data line when working with multiple devices.
Requires The c_orrespondlng MCU ports must be appropriately initialized for CF card. See
Cf_Init.
// enable compact flash
Example Cf Enable();
Cf_Disable
Prototype |procedure Cf Disable();
Returns Nothing.
Routine disables the device and frees the data lines for other devices. To
Description [enable the device again, call Cf_Enable. These two routines in conjunction
allow you to free/occupy data line when working with multiple devices.
Requires The cprrespondmg MCU ports must be appropriately initialized for CF card. See
Cf_Init.
Example // disable compact flash

Cf Disable();
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Cf_Read_lInit

Prototype

procedure CfﬁReadiThit(add*ess : dword; sector count : byte);

Returns

Nothing.

Description

Initializes CF card for reading.
Parameters :

- address: the first sector to be prepared for reading operation.
- sector count: number of sectors to be prepared for reading operation.

Requires

The corresponding MCU ports must be appropriately initialized for CF card. See
Cf_Init.

Example

// initialize compact flash for reading from sector 590
Cf Read Init (590, 1);

Cf_Read_Byte

Prototype |function CF Read Byte() : byte;
Returns a byte read from Compact Flash sector buffer.
Returns
Note: Higher byte of the unsigned return value is cleared.
o . Reads one byte from Compact Flash sector buffer location currently pointed to
Description . . . . . .
by internal read pointers. These pointers will be autoicremented upon reading.
The corresponding MCU ports must be appropriately initialized for CF card. See
. Cf_Init.
Requires
CF card must be initialized for reading operation. See Cf_Read_Init.
// Read a byte from compact flash:
Exanuﬂe var data : byte;
a;ia := Cf Read Byte();
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Cf_Write_Init

Prototype procedure Cf Write Init (address : dword; sectcnt : byte);

Returns Nothing.

Initializes CF card for writing.

. Parameters :
Description

- address: the first sector to be prepared for writing operation.
- sectent: number of sectors to be prepared for writing operation.

The corresponding MCU ports must be appropriately initialized for CF card. See
Cf_Init.

// initialize compact flash for writing to sector 590
Cf Write Init (590, 1);

Requires

Example

Cf_Write_Byte

Prototype procedure Cf Write Byte(data_ : byte);

Returns Nothing.

Writes a byte to Compact Flash sector buffer location currently pointed to by
writing pointers. These pointers will be autoicremented upon reading. When
sector buffer is full, its content will be transfered to appropriate flash memory
. sector.

Description

Parameters :

- data : byte to be written.

The corresponding MCU ports must be appropriately initialized for CF card. See

Requires Cf_Init.
CF card must be initialized for writing operation. See Cf_Write_Init.
var data : byte;

Example data 1= 0OxAA;

Cf Write Byte (data);
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Cf_Read_Sector

Prototype procedure Cf Read Sector (sector number : dword; var buffer :
yp arrayl 512] of byte);
Returns Nothing.

Reads one sector (512 bytes). Read data is stored into buffer provided by the
buffer parameter.

Description |[Parameters :

- sector number: sector to be read.
- buffer: data buffer of at least 512 bytes in length.

The corresponding MCU ports must be appropriately initialized for CF card. See

Requires .
q Cf_Init.
// read sector 22
var data : arrayl 512] of byte;
Example v o1z] Y

Cf Read Sector (22, data);

Cf_Write_Sector

Protot procedure Cf Write Sector (sector number : dword; var buffer :
rototype arrayl 512] of byte);
Returns Nothing.
Writes 512 bytes of data provided by the buffer parameter to one CF sector.
Description Parameters :
- sector number: sector to be written to.
-buffer: data buffer of 512 bytes in length.
Requires The corresponding MCU ports must be appropriately initialized for CF card. See
q Cf_Init.
// write to sector 22
Exannﬂe var data : arrayl 512] of byte;

Cf Write Sector (22, data);
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Cf_Fat_Init

Prototype function Cf Fat Init(): byte;

- 0 - if CF card was detected and successfully initialized
Returns - 1 - if FAT16 boot sector was not found
- 255 - if card was not detected

Initializes CF card, reads CF FAT16 boot sector and extracts data needed by

Description the library.

Requires Nothing.

//init the FAT library
if (Cf Fat Init() = 0) then
Example begin

end

Cf_Fat_QuickFormat

Prototype function Cf Fat QuickFormat (var cf fat label : stringl 11]) : byte;

- 0 - if CF card was detected, successfully formated and initialized
Returns - 1 - if FAT16 format was unseccessful
- 255 - if card was not detected

Formats to FAT16 and initializes CF card.

Parameters :

-cf fat label: volume label (11 characters in length). If less than 11
characters are provided, the label will be padded with spaces. If an empty

. string is passed, the volume will not be labeled.

Description

Note: This routine can be used instead or in conjunction with the Cf_Fat_lInit

routine.

Note: If CF card already contains a valid boot sector, it will remain unchanged
(except volume label field) and only FAT and ROOT tables will be erased. Also,
the new volume label will be set.

Requires Nothing.

// format and initialize the FAT library
if (CffFatiQuickForwat('mikroF’) = 0) then
Example begin

end;
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Cf_Fat_Assign

Prototype

function Cf Fat Assign(var filename: arrayl 12] of char;
file cre attr: byte): byte;

Returns

- 0 if file does not exist and no new file is created.
- 1 if file already exists or file does not exist but a new file is created.

Description

Assigns file for file operations (read, write, delete...). All subsequent file opera-
tions will be applied to the assigned file.

Parameters :

- filename: name of the file that should be assigned for file operations. The file
name should be in DOS 8.3 (file_name.extension) format. The file name and
extension will be automatically padded with spaces by the library if they have
less than length required (i.e. "mikro.tx" -> "mikro .tx "), so the user does not
have to take care of that. The file name and extension are case insensitive.
The library will convert them to the proper case automatically, so the user does
not have to take care of that.

Also, in order to keep backward compatibility with the first version of this
library, file names can be entered as UPPERCASE string of 11 bytes in length
with no dot character between the file name and extension (i.e.
"MIKROELETXT" -> MIKROELE.TXT). In this case the last 3 characters of the

string are considered to be file extension.
- file cre attr: file creation and attributs flags. Each bit corresponds to the
appropriate file attribut:

Bit | Mask Description
0x01 [Read Only

0x02 |Hidden

0x04 [System

0x08 [Volume Label

0x10 |[Subdirectory

0x20 [Archive

0x40 [Device (internal use only, never found on disk)

ol h~h|lwW|IN| ]| O

File creation flag. If the file does not exist and this flag is set,

! 0x80 a new file with specified name will be created.

Note: Long File Names (LFN) are not supported.

Requires

CF card and CF library must be initialized for file operations. See Cf_Fat_lInit.

Example

// create file with archive attribut if it does not already exist
Cf Fat Assign ('MIKROOO7.TXT',0xAQ);
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Cf_Fat_Reset

Prototype procedure Cf Fat Reset (var size: dword);

Returns Nothing.

Opens currently assigned file for reading.

o Parameters :
Description

- size: buffer to store file size to. After file has been open for reading its size is
returned through this parameter.

CF card and CF library must be initialized for file operations. See Cf_Fat_|Init.

Requires
File must be previously assigned. See Cf Fat_Assign.
var size : dword;

Example -
Cf Fat Reset(size);

Cf_Fat_Read

Prototype procedure Cf Fat Read(var bdata: byte);

Returns Nothing.

Reads a byte from currently assigned file opened for reading. Upon function
execution file pointers will be set to the next character in the file.

Description |Parameters :

- bdata: buffer to store read byte to. Upon this function execution read byte is
returned through this parameter.

CF card and CF library must be initialized for file operations. See Cf_Fat_|Init.
Requires File must be previously assigned. See Cf _Fat_Assign.

File must be open for reading. See Cf_Fat_Reset.

var character : byte;
Example

Cf Fat Read(character);
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Cf_Fat_Rewrite

Prototype |procedure Cf Fat Rewrite();
Returns Nothing.
Description Opens currently assigned file for writing. If the file is not empty its content will
be erased.
CF card and CF library must be initialized for file operations. See Cf_Fat_|Init.
Requires
The file must be previously assigned. See Cf_Fat_Assign.
Example // open file for writing

Cf Fat Rewrite();

Cf_Fat_Append

Prototype procedure Cf Fat Append();
Returns Nothing.
Opens currently assigned file for appending. Upon this function execution file
Description |pointers will be positioned after the last byte in the file, so any subsequent file
writing operation will start from there.
CF card and CF library must be initialized for file operations. See Cf_Fat_|Init.
Requires
File must be previously assigned. See Cf Fat_Assign.
Example // open file for appending

Cf Fat Append();

Cf_Fat_Delete

Prototype |procedure Cf Fat Delete();
Returns Nothing.
Description |Deletes currently assigned file from CF card.
CF card and CF library must be initialized for file operations. See Cf_Fat_Init.
Requires
File must be previously assigned. See Cf_Fat_Assign.
// delete current file
Example

Cf Fat Delete();
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Cf_Fat_Write
procedure Cf Fat Write(var fdata: arrayl 512] of byte; data len:
Prototype word) ;
Returns Nothing.

Writes requested number of bytes to currently assigned file opened for writing.

. Parameters :
Description

- fdata: data to be written.
- data len: number of bytes to be written.

CF card and CF library must be initialized for file operations. See Cf_Fat_|Init.
Requires File must be previously assigned. See Cf Fat_Assign.

File must be open for writing. See Cf_Fat_Rewrite or Cf_Fat_Append.

var file contents : array| 42] of byte;
Example S
Cf Fat Write(file contents, 42); // write data to the assigned file

Cf_Fat_Set_File_Date

procedure Cf Fat Set File Date(year: word; month: byte; day:
byte; hours: byte; mins: byte; seconds: byte);

Prototype

Returns Nothing.

Sets the date/time stamp. Any subsequent file writing operation will write this
stamp to currently assigned file's time/date attributs.

Parameters :

- year: year attribute. Valid values: 1980-2107
- month: month attribute. Valid values: 1-12

- day: day attribute. Valid values: 1-31

- hours: hours attribute. Valid values: 0-23

- mins: minutes attribute. Valid values: 0-59

- seconds: seconds attribute. Valid values: 0-59

Description

CF card and CF library must be initialized for file operations. See Cf_Fat_lInit.
Requires File must be previously assigned. See Cf_Fat_Assign.

File must be open for writing. See Cf_Fat_Rewrite or Cf_Fat_Append.

Example Cf Fat Set File Date (2005,9,30,17,41,0);
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Cf_Fat_Get_File_Date

procedure Cf Fat Get File Date(var year:
byte; wvar hours: byte; var mins:

word; wvar month:
byte);

Prototype byte;

var day:

Returns Nothing.

Reads time/date attributes of currently assigned file.
Parameters :

- year: buffer to store year attribute to. Upon function execution year attribute is
returned through this parameter.

- month: buffer to store month attribute to. Upon function execution month
attribute is returned through this parameter.

- day: buffer to store day attribute to. Upon function execution day attribute is
returned through this parameter.

- hours: buffer to store hours attribute to. Upon function execution hours
attribute is returned through this parameter.

- mins: buffer to store minutes attribute to. Upon function execution minutes
attribute is returned through this parameter.

Description

CF card and CF library must be initialized for file operations. See Cf_Fat_lInit.
Requires
File must be previously assigned. See Cf_Fat_Assign.

var year : word;

month, day, hours, mins : byte;

Example

Cf Fat Get File Date(year, month, day, hours, mins);

Cf_Fat_Get_

File_Size

Prototype

function Cf Fat Get File Size(): dword;

Returns

Size of the currently assigned file in bytes.

Description

This function reads size of currently assigned file in bytes.

Requires

CF card and CF library must be initialized for file operations. See Cf_Fat_Init.

File must be previously assigned. See Cf _Fat_Assign.

Example

var my file size : dword;

my file size := Cf Fat Get File Size();
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Cf_Fat_Get_Swap_File

function Cf Fat Get Swap File(sectors cnt: longint; wvar filename

Prototype : stringf 11]; file attr : byte): dword;

- Number of the start sector for the newly created swap file, if there was enough
Returns free space on CF card to create file of required size.
- 0 - otherwise.

This function is used to create a swap file of predefined name and size on the
CF media. If a file with specified name already exists on the media, search for
consecutive sectors will ignore sectors occupied by this file. Therefore, it is rec-
ommended to erase such file if it exists before calling this function. If it is not
erased and there is still enough space for a new swap file, this function will
delete it after allocating new memory space for a new swap file.

The purpose of the swap file is to make reading and writing to CF media as fast
as possible, by using the Cf _Read_Sector() and Cf_Write_Sector() functions
directly, without potentially damaging the FAT system. The swap file can be con-
sidered as a "window" on the media where the user can freely write/read data.
Its main purpose in the mikroPascal's library is to be used for fast data acquisi-
tion; when the time-critical acquisition has finished, the data can be re-written
into a "normal" file, and formatted in the most suitable way.

Parameters:

Description | sectors cnt: number of consecutive sectors that user wants the swap file to
have.

- filename: name of the file that should be assigned for file operations. The file
name should be in DOS 8.3 (file_name.extension) format. The file name and
extension will be automatically padded with spaces by the library if they have
less than length required (i.e. "mikro.tx" -> "mikro .tx "), so the user does not
have to take care of that. The file name and extension are case insensitive.
The library will convert them to the proper case automatically, so the user does
not have to take care of that.

Also, in order to keep backward compatibility with the first version of this
library, file names can be entered as UPPERCASE string of 11 bytes in length
with no dot character between the file name and extension (i.e.
"MIKROELETXT" -> MIKROELE.TXT). In this case the last 3 characters of the
string are considered to be file extension.

- file attr: file creation and attributs flags. Each bit corresponds to the
appropriate file attribut:

248 MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



CHAPTER 7

mikroPASCAL PRO for PIC Libraries

Bit | Mask Description
0 0x01 |Read Only
1 0x02 [Hidden
2 0x04 [System
3 0x08 [Volume Label

Description 4 0x10 |[Subdirectory
5 0x20 [Archive
6 0x40 |Device (internal use only, never found on disk)
7 0x80 [Not used

Note: Long File Names (LFN) are not supported.

Requires CF card and CF library must be initialized for file operations. See Cf_Fat_Init.

// Try to create a swap file with archive atribute, whose size
will be at least 1000 sectors.

// If it succeeds, it sends the No. of start sec-
tor over UART

var size : dword;

size := Cf Fat Get Swap File (1000, "mikroE.txt", 0x20);

if (size <> 0) then

begin
UART1 Write
UART1 Write
UART1 Write
UART1 Write
UART1 Write
UART1 Write

end

Example 0xAR) ;

Lo (size));
Hi(size));
Higher (size));
Highest (size));
OxAR) ;
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Library Example

The following example demonstrates various aspects of the Cf_Fat16 library :
Creation of new file and writing down to it; Opening existing file and re-writing it (writ-
ing from start-of-file); Opening existing file and appending data to it (writing from
end-of-file); Opening a file and reading data from it (sending it to USART terminal);
Creating and modifying several files at once;

program CF Fatl6 Test;

var
// set compact flash pinout
Cf Data Port : byte at PORTD;

CF RDY : sbit at RB7 bit;
CF _WE : sbit at RB6 bit;
CF OE : sbit at RBS bit;
CF CDl : sbit at RB4 bit;
CF CEl : sbit at RB3 bit;

CF A2 : sbit at RB2 bit;
CF Al : sbit at RB1 bit;
CF A0 : sbit at RBO bit;

CF RDY direction : sbit at TRISB7 bit;
CF WE direction : sbit at TRISB6 bit;
CF OE direction : sbit at TRISB5 bit;
CF CD1 direction : sbit at TRISB4 bit;
CF CEl direction : sbit at TRISB3 bit;

CF A2 direction : sbit at TRISB2Z bit;
CF Al direction : sbit at TRISBI1 bit;
CF AQ direction : sbit at TRISBO bit;

// end of cf pinout

const LINE LEN = 39;
var
err txt : stringl 20] ;
file contents : string{ LINE LEN] ;

filename : stringf 14] ; // File names
character : byte;

loop, loop2 : byte;

i, size : longint;

Buffer : arrayl 512] of byte;

// UART write text and new line (carriage return + line feed)
procedure UART1l Write Line( wvar uart text : byte );
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begin
UART1 Write Text (uart text);

UART1 Write(13);
UART1 Write (10);

end;
[/———————————— Creates new file and writes some data to it
procedure M Create New File();
begin
filename[ 7] := 'A';
Cf Fat Assign(filename, OxAO); // Will not find file and then
create file
Cf Fat Rewrite(); // To clear file and start with new data
for loop:=1 to 90 do // We want 5 files on the MMC card
begin
UART1 Write('.');
file contents[ 0] := loop div 10 + 48;
file contents[ 1] := loop mod 10 + 48;
Cf Fat Write(file contents, LINE LEN-1); // write data to
the assigned file
end;
end;
[/ ——mmm—m——————— Creates many new files and writes data to them
procedure M Create Multiple Files();
begin
for loop2 := 'B' to 'Z' do
begin
UART1 Write(loop2); // this line can slow down the performance
filename[ 7] := loop2; // set filename
Cf Fat Assign(filename, O0xA0Q); // find existing file

or create a new one
Cf Fat Rewrite(); // To clear file and start with new data

for loop := 1 to 44 do
begin
file contents[ 0] := loop div 10 + 48;
file contents[ 1] := loop mod 10 + 48;

Cf Fat Write(file contents, LINE LEN-1); // write data to
the assigned file

end;
end;
end;
[/ ——mmm—m——————— Opens an existing file and rewrites it
procedure M Open File Rewrite();
begin
filename[ 7] := 'C'; // Set filename for single-file tests

Cf_Fat_Assign(filename, 0);
Cf Fat Rewrite();
for loop := 1 to 55 do
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begin

file contents[ 0] byte (loop div 10 + 48);

file contents[ 1] := byte(loop mod 10 + 48);

Cf Fat Write(file contents, LINE LEN-1); // write data to the
assigned file

end;
end;
[/ =—mmmm Opens an existing file and appends data to it
// (and alters the date/time stamp)
procedure M Open File Append();
begin
filename[ 7] := 'B';

Cf_Fat_Assign(filename, 0);
Cf Fat Set File Date(2005,6,21,10,35,0);
Cf Fat Append();

file contents := ' for mikroElektronika 2005'; // Prepare file
for append
end;
[/ —mmm Opens an existing file, reads data from it and puts

it to USART
procedure M Open File Read();

begin
filename[ 7] := 'B';
Cf_Fat_Assign(filename, 0);
Cf Fat Reset (size); // To read file, procedure returns

size of file
while size > 0 do

begin
Cf Fat Read(character);
UART1 Write (character); // Write data to USART
Dec (size);
end;
end;
/) == ———————— Deletes a file. If file doesn't exist, it will first
be created
// and then deleted.
procedure M Delete File();
begin
filename[ 7] := 'F';

Cf Fat Assign

(
Cf Fat Delete(

filename, 0);
)

’

end;

/) == ———————— Tests whether file exists, and if so sends its cre-
ation date

// and file size via USART
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procedure M Test File Exist();
var
fsize : longint;
year : word;
month, day, hour, minute : byte;
outstr : arrayl 12] of byte;
begin
filename[ 7] := 'B'; //uncomment this line to search for file
that DOES exists
// filename[ 7] := 'F'; //uncomment this line to search for

file that DOES NOT exist
if Cf Fat Assign(filename, 0) <> 0 then
begin
//--- file has been found - get its date
Cf Fat Get File Date (year,month,day,hour,minute);
WordToStr (year, outstr);
UARTI_Write_Text(outstr);
ByteToStr (month, outstr);
UART1 Write Text (outstr)
WordToStr (day, outstr);
UARTI_Write_Text(outstr);
WordToStr (hour, outstr);
UARTI_Write_Text(outstr);
WordToStr (minute, outstr);
UARTI_Write_Text(outstr);
//--- get file size
fsize := Cf Fat Get File Size;
LongIntToStr (fsize, outstr);
UARTI_Write_Text(outstr);

’

end
else begin
//--- file was not found - signal it

UART1 Write (0x55);
Delay ms(1000) ;
UART1 Write (0x55);

end;
end;
/)= —————— Tries to create a swap file, whose size will be at
least 100
// sectors (see Help for details)
procedure M Create Swap File();
var i1 : word;
begin
for i:=0 to 511 do
Buffer{ 1] := 1i;
size := Cf Fat Get Swap File (5000, 'mikroE.txt', 0x20); // see

help on this function for details
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if (size <> 0) then
begin
LongIntToStr (size, err txt);
UART1 Write Line(err txt);

for 1:=0 to 4999 do
begin
Cf Write Sector(size, Buffer);
Inc (size);

UART1 Write('.');
end;
end;
end;

/) ———————————— Main. Uncomment the function(s) to test the desired
operation (s)
begin

err txt := 'FAT16 not found';

file contents := 'XX CF FAT16 library by Anton Rieckert';

filename := 'MIKROOOXTXT';

// we will use PORTC to signal test end

ADCON1 := ADCON1 or O0xOF; // Configure AN pins as digital
CMCON := CMCON or 7; // Turn off comparators
UART1 Init(19200); // Set up USART for file reading
Delay ms (10);
UART1 Write Line('PIC-Started'); // PIC present report
// —--- Init the FAT library
// --- use Cf Fat QuickFormat instead of init routine if a for-
mat is needed
if Cf Fat Init() = 0 then
begin
Delay ms (2000) ; // wait for a while until the card is
stabilized

// period depends on used CF card
//--- Test start
UART1 Write Line('Test Start.');
M Create New File();
M Create Multiple Files();
M Open File Rewrite();
M Open File Append();
M Open File Read();
M Delete File();
M Test File Exist();
M Create Swap File();
UART1 Write Line('Test End.');

end
else
begin
UART1 Write Line(err txt); // Note: Cf Fat Init tries to
initialize a card more than once.
// If card is not
present, initialization may last longer (depending on clock speed)

end;
end.
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HW Connection
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EEPROM LIBRARY

EEPROM data memory is available with a number of PIC MCUs. mikroPascal PRO for PIC
includes library for comfortable work with EEPROM.

Library Routines

- EEPROM_Read
- EEPROM_Write

EEPROM_Read

Prototype function EEPROM Read (Address: word): byte;

Returns Returns byte from specified address.

Reads data from specified address. Parameter address is of byte type, which
means it can address only 256 locations. For PIC18 MCUs with more EEPROM
data locations, it is programmer’s responsibility to set SFR EEADRH register
appropriately.

Requires EEPROM module.

Description

Requires Ensure minimum 20ms delay between successive use of routines
EEPROM_Write and EEPROM_Read. Although PIC will write the correct value,
EEPROM_Read might return an undefined result.

Example tmp := EEPROM Read ($3F);

EEPROM_Write

Prototype procedure EEPROM Write (Address : word; Data : byte);

Returns Nothing.

Writes data to specified address. Parameter address is of byte type, which
means it can address only 256 locations. For PIC18 MCUs with more EEPROM
data locations, it is programmer’s responsibility to set SFR EEADRH register
Description |appropriately.

Be aware that all interrupts will be disabled during execution of EEproM Write rou-
tine (GIE bit of INTCON register will be cleared). Routine will set this bit on exit.

Requires EEPROM module.

Requires Ensure minimum 20ms delay between successive use of routines
EEPROM Write and eEPrOM Read. Although PIC will write the correct value,
EEPROM Read might return an undefined result.

Example EEPROM Write ($32);
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Library Example

The example demonstrates using EEPROM Library.

program Eeprom;

var counter : byte; // loop variable
begin
ANSEL := 0; // Configure AN pins as digital I/O
ANSELH := 0;
PORTB := O0;
PORTC := O0;
PORTD := O0;
TRISB := 0;
TRISC := 0;
TRISD := 0;
for counter := 0 to 31 do // Fill data buffer
EEPROM Write (0x80+counter, counter); // Write data to address
0x80+ii
EEPROM Write (0x02,0xAR) ; // Write some data at address 2
EEPROM Write (0x50,0x55) ; // Write some data at address 0150
Delay ms (1000); // Blink PORTB and PORTC diodes
PORTB := OxFF; // to indicate reading start
PORTC := OxFF;
Delay ms (1000);
PORTB := 0x00;
PORTC := 0x00;

Delay ms (1000);

PORTB := EEPROM Read (0x02); // Read data from address
2 and display it on PORTB
PORTC := EEPROM Read (0x50); // Read data from address

0x50 and display it on PORTC

Delay ms (1000);

for counter := 0 to 31 do // Read 32 bytes block
from address 0x100
begin
PORTD := EEPROM Read(0x80+counter); // and display data on
PORTC
Delay ms(300);
end;
end.
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ETHERNET PIC18FXXJ60 LIBRARY

p1C18FxxJ60 family of microcontrollers feature an embedded Ethernet controller
module. This is a complete connectivity solution, including full implementations of
both Media Access Control (MAC) and Physical Layer transceiver (PHY) modules.
Two pulse transformers and a few passive components are all that are required to
connect the microcontroller directly to an Ethernet network.

The Ethernet module meets all of the IEEE 802.3 specifications for 10-BaseT con-
nectivity to a twisted-pair network. It incorporates a number of packet filtering
schemes to limit incoming packets. It also provides an internal DMA module for fast
data throughput and hardware assisted IP checksum calculations. Provisions are
also made for two LED outputs to indicate link and network activity

This library provides the posibility to easily utilize ethernet feature of the above men-
tioned MCUs.

Ethernet PIC18FxxJ60 library supports:

- IPv4 protocol.

- ARP requests.

- ICMP echo requests.

- UDP requests.

- TCP requests (no stack, no packet reconstruction).
- ARP client with cache.

- DNS client.

- UDP client.

- DHCP client.

- packet fragmentation is NOT supported.

Note: Global library variable Ethernet userTimersec is used to keep track of time
for all client implementations (ARP, DNS, UDP and DHCP). It is user responsibility
to increment this variable each second in it's code if any of the clients is used.

Note: For advanced users there are header files ("eth j60LibDef.h" and
"eth j60Libprivate.h")in Uses\P18 folder of the compiler with description of all
routines and global variables, relevant to the user, implemented in the Ethernet
PIC18FxxJ60 Library.
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Library Routines

- Ethernet_Init

- Ethernet_Enable

- Ethernet_Disable

- Ethernet_doPacket

- Ethernet_putByte

- Ethernet_putBytes

- Ethernet_putString

- Ethernet_putConstString

- Ethernet_putConstBytes

- Ethernet_getByte

- Ethernet_getBytes

- Ethernet_UserTCP

- Ethernet_UserUDP

- Ethernet_getlpAddress

- Ethernet_getGwlpAddress
- Ethernet_getDnsIpAddress
- Ethernet_getlpMask

- Ethernet_confNetwork

- Ethernet_arpResolve

- Ethernet_sendUDP

- Ethernet_dnsResolve

- Ethernet_initDHCP

- Ethernet_doDHCPLeaseTime
- Ethernet_renewDHCP
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Ethernet_Init

procedure Ethernet Init(var mac : arrayl 6] of byte; var ip :
Prototype =

arrayl 4] of byte; fullDuplex : byte);
Returns Nothing.

This is MAC module routine. It initializes Ethernet controller. This function is
internaly splited into 2 parts to help linker when coming short of memory.

Ethernet controller settings (parameters not mentioned here are set to default):

- receive buffer start address : 0x0000.

- receive buffer end address : 0x192D.

- transmit buffer start address: 0x192E.

- transmit buffer end address : 0x1FFF.

- RAM buffer read/write pointers in auto-increment mode.

- receive filters set to default: CRC + MAC Unicast + MAC Broadcast in OR mode.

- flow control with TX and RX pause frames in full duplex mode.

- frames are padded to 60 bytes + CRC.

- maximum packet size is set to 1518.

Description |- Back-to-Back Inter-Packet Gap: 0x15 in full duplex mode; 0x12 in half duplex mode.

- Non-Back-to-Back Inter-Packet Gap: 0x0012 in full duplex mode; 0x0c12 in
half duplex mode.

- half duplex loopback disabled.

- LED configuration: default (LEDA-link status, LEDB-link activity).

Parameters:

- mac: RAM buffer containing valid MAC address.

- ip: RAM buffer containing valid IP address.

- fullbuplex: ethernet duplex mode switch. Valid values: 0 (half duplex mode,
predefined library const Ethernet HALFDUPLEX) and 1 (full duplex mode,
predefined library const Ethernet FULLDUPLEX).

Note: If a DHCP server is to be used, IP address should be setto 0.0.0.0.

Requires Nothing.

var
myMacAddr : arrayl 6] of byte; // my MAC address
myIpAddr : arrayl 4] of byte; // my IP addr
myMacAddzr] 0] = 0x00;
myMacAddr[ 1] = 0x14;
myMacAddr| 2] = 0xA5;
myMacAddr] 3] = 0x76;
Example myMacAddr] 4] = 0x19;
myMacAddx[ 5] = 0x3F;
myIpAddr[ 0] = 192;
myIpAddr| 1] = 168;
myIpAddr[ 2] = 20;
myIpAddr[ 3] = 60;

Ethernet Init (myMacAddr, myIpAddr, Ethernet FULLDUPLEX) ;
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Ethernet_Enable

Prototype procedure Ethernet Enable (enFlt : byte);

Returns Nothing.

This is MAC module routine. This routine enables appropriate network traffic on
the MCU's internal Ethernet module by the means of it's receive filters (unicast,
multicast, broadcast, crc). Specific type of network traffic will be enabled if a
corresponding bit of this routine's input parameter is set. Therefore, more than
one type of network traffic can be enabled at the same time. For this purpose,
predefined library constants (see the table below) can be ORed to form appro-
priate input value.

Parameters:

- enFl1t: network traffic/receive filter flags. Each bit corresponds to the
appropriate network traffic/receive filter:

Bit | Mask Description Predefined library const

MAC Broadcast traffic/receive filter
0 0x01 |flag. When set, MAC broadcast _Ethernet BROADCAST
traffic will be enabled.

MAC Multicast traffic/receive filter
1 0x02 |flag. When set, MAC multicast traf-| Ethernet MULTICAST

Description fic will be enabled.
2 0x04 [not used none
0x08 |not used none

4 0x10 |not used none
CRC check flag. When set, pack-

5 0x20 |ets with invalid CRC field will be _Ethernet CRC
discarded.

6 0x40 [not used none

MAC Unicast traffic/receive filter
7 0x80 |flag. When set, MAC unicast traffic | Ethernet UNICAST
will be enabled.

Note: Advance filtering available in the MCU's internal Ethernet module such as
Pattern Match, Magic Packet and Hash Table can not be enabled by this rou-
tine. Additionaly, all filters, except CRC, enabled with this routine will work in OR
mode, which means that packet will be received if any of the enabled filters
accepts it.
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Note: This routine will change receive filter configuration on-the-fly. It will not, in
any way, mess with enabling/disabling receive/transmit logic or any other part of
the MCU's internal Ethernet module. The MCU's internal Ethernet module
should be properly cofigured by the means of Ethernet_|Init routine.

Description

Requires Ethernet module has to be initialized. See Ethernet_Init.

Ethernet Enable( Ethernet CRC or Ethernet UNICAST); // enable

Example CRC checking and Unicast traffic

Ethernet_Disable

Prototype procedure Ethernet Disable (disFlt : byte);

Returns Nothing.

This is MAC module routine. This routine disables appropriate network traffic on
the MCU's internal Ethernet module by the means of it's receive filters (unicast,
multicast, broadcast, crc). Specific type of network traffic will be disabled if a
corresponding bit of this routine's input parameter is set. Therefore, more than
one type of network traffic can be disabled at the same time. For this purpose,
predefined library constants (see the table below) can be ORed to form appro-
priate input value.

Parameters:

- disrlt: network traffic/receive filter flags. Each bit corresponds to the
appropriate network traffic/receive filter:

Bit | Mask Description Predefined library const

MAC Broadcast traffic/receive filter
0 | Ox01 |flag. When set, MAC broadcast traffic| Ethernet BROADCAST
will be disabled.

Description MAC Multicast traffic/receive filter
1 | 0x02 |flag. When set, MAC multicast traffic | Ethernet MULTICAST
will be disabled.

0x04 |not used none
0x08 |not used none
0x10 |not used none

CRC check flag. When set, CRC check
5 | 0x20 |will be disabled and packets with invalid | Ethernet CRC
CRC field will be accepted.

6 | 0x40 |not used none

MAC Unicast traffic/receive filter flag.
7 | 0x80 |When set, MAC unicast traffic will be | Ethernet UNICAST
disabled.
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Note: Advance filtering available in the MCU's internal Ethernet module such as
Pattern Match, Magic Packet and Hash Table can not be disabled by this routine.

Description |Note: This routine will change receive filter configuration on-the-fly. It will not, in
any way, mess with enabling/disabling receive/transmit logic or any other part of
the MCU's internal Ethernet module. The MCU's internal Ethernet module
should be properly cofigured by the means of Ethernet_|Init routine.

Requires Ethernet module has to be initialized. See Ethernet_Init.

Ethernet Disable( Ethernet CRC or _Ethernet UNICAST); // disable

Example CRC checking and Unicast traffic

Ethernet_doPacket

Prototype function Ethernet doPacket () : byte;

- 0 - upon successful packet processing (zero packets received or received
packet processed successfully).

- 1 - upon reception error or receive buffer corruption. Ethernet controller needs

Returns to be restarted.

- 2 - received packet was not sent to us (not our IP, nor IP broadcast address).

- 3 - received IP packet was not IPv4.

- 4 - received packet was of type unknown to the library.

This is MAC module routine. It processes next received packet if such exists.
Packets are processed in the following manner:

- ARP & ICMP requests are replied automatically.
- upon TCP request the Ethernet_UserTCP function is called for further processing.
- upon UDP request the Ethernet_UserUDP function is called for further processing.

Description

Note: Ethernet_doPacket must be called as often as possible in user's code.

Requires Ethernet module has to be initialized. See Ethernet_Init.

while true do
begin

Exan“ﬂe Ethernet doPacket(); // process received packets

end;
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Ethernet_putByte

Prototype procedure Ethernet putByte (v : byte);

Returns Nothing.

This is MAC module routine. It stores one byte to address pointed by the cur-
rent Ethernet controller's write pointer (EwrpT).

Description Parameters:
- v: value to store

Requires Ethernet module has to be initialized. See Ethernet_|Init.
var

Example data : byte;

Ethernet putByte (data); // put an byte into ethernet buffer

Ethernet_putBytes

Prokﬂype procedure Ethernet putBytes(ptr : "“byte; n : byte);

Returns Nothing.

This is MAC module routine. It stores requested number of bytes into Ethernet
controller's RAM starting from current Ethernet controller's write pointer (EwrpT)
location.

Description o o meters:

- ptr: RAM buffer containing bytes to be written into Ethernet controller's RAM.
- n: number of bytes to be written.

Requires Ethernet module has to be initialized. See Ethernet_Init.

var
buffer : arrayl 17] of byte;

Example buffer := 'mikroElektronika';

Ethernet putBytes (buffer, 16); // put an RAM array into ether-
net buffer
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Ethernet_putConstBytes

Prototype procedure Ethernet putConstBytes(const ptr : “byte; n : byte);

Returns Nothing.

This is MAC module routine. It stores requested number of const bytes into Eth-
ernet controller's RAM starting from current Ethernet controller's write pointer
(ewrPT) location.

Description Parameters:

- ptr: const buffer containing bytes to be written into Ethernet controller's RAM.
- n: number of bytes to be written.

Requires Ethernet module has to be initialized. See Ethernet_Init.

const
buffer : array| 17] of byte;

Example buffer := 'mikroElektronika';

Ethernet putConstBytes (buffer, 16); // put a const array into
ethernet buffer

Ethernet_putString

Prototype function Ethernet putString(ptr : “byte) : word;

Returns Number of bytes written into Ethernet controller's RAM.

This is MAC module routine. It stores whole string (excluding null termination)
into Ethernet controller's RAM starting from current Ethernet controller's write
pointer (EWRPT) location.

Description
Parameters:

- ptr: string to be written into Ethernet controller's RAM.

Requires Ethernet module has to be initialized. See Ethernet_Init.

var
buffer : string] 16] ;

Example buffer := 'mikroElektronika';

Ethernet putString(buffer); // put a RAM string into ethernet
buffer
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Ethernet_putConstString

Prokﬂype function Ethernet putConstString(const ptr : “byte) : word;

Returns Number of bytes written into Ethernet controller's RAM.

This is MAC module routine. It stores whole const string (excluding null termina-
tion) into Ethernet controller's RAM starting from current Ethernet controller's
write pointer (EwrpT) location.

Description
Parameters:
- ptr: const string to be written into Ethernet controller's RAM.
Requires Ethernet module has to be initialized. See Ethernet_Init.
const
buffer : string] 16] ;
Example 5;£fer := 'mikroElektronika';

Ethernet putConstString(buffer); // put a const string into
ethernet buffer

Ethernet_getByte

Prokﬂype function Ethernet getByte() : byte;

Returns Byte read from Ethernet controller's RAM.

This is MAC module routine. It fetches a byte from address pointed to by cur-

Description | .+ Ethernet controller's read pointer (ERDPT).

Requires Ethernet module has to be initialized. See Ethernet_Init.

var

buffer : byte;
Example v

buffer := Ethernet getByte(); // read a byte from ethernet buffer
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Ethernet_getBytes

Prokﬂype procedure Ethernet getBytes(ptr : “byte; addr : word; n : byte);

Returns Nothing.

This is MAC module routine. It fetches equested number of bytes from Ethernet
controller's RAM starting from given address. If value of 0xrrrF is passed as
the address parameter, the reading will start from current Ethernet controller's
read pointer (ErDPT) location.

Description Parameters:
- ptr: buffer for storing bytes read from Ethernet controller's RAM.
- addr: Ethernet controller's RAM start address. Valid values: 0. .8192.
- n: number of bytes to be read.
Requires Ethernet module has to be initialized. See Ethernet_|Init.
var
buffer: arrayl 16] of byte;
Example

Ethernet getBytes (buffer, 0x100, 16); // read 16 bytes, start-
ing from address 0x100
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Ethernet_UserTCP

Protot function Ethernet UserTCP(var remoteHost : arrayl 4] of byte;
rototype remotePort, localPort, reqlLength : word) : word;

Returns - 0 - there should not be a reply to the request.
- Length of TCP/HTTP reply data field - otherwise.
This is TCP module routine. It is internally called by the library. The user
accesses to the TCP/HTTP request by using some of the Ethernet_get routines.
The user puts data in the transmit buffer by using some of the Ethernet_put rou-
tines. The function must return the length in bytes of the TCP/HTTP reply, or O if
there is nothing to transmit. If there is no need to reply to the TCP/HTTP
requests, just define this function with return(0) as a single statement.

e Parameters:

Description
- remoteHost : client's IP address.
- remotePort: client's TCP port.
- localport: port to which the request is sent.
- reglLength: TCP/HTTP request data field length.
Note: The function source code is provided with appropriate example projects.
The code should be adjusted by the user to achieve desired reply.

Requires Ethernet module has to be initialized. See Ethernet_Init.
This function is internally called by the library and should not be called by the

Example .
user's code.
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Ethernet_UserUDP

function Ethernet UserUDP (var remoteHost : arrayl 4] of byte;
remotePort, destPort, reglLength : word) : word;

Prototype

- 0 - there should not be a reply to the request.

Returns - Length of UDP reply data field - otherwise.

This is UDP module routine. It is internally called by the library. The user
accesses to the UDP request by using some of the Ethernet_get routines. The
user puts data in the transmit buffer by using some of the Ethernet_put routines.
The function must return the length in bytes of the UDP reply, or 0 if nothing to
transmit. If you don't need to reply to the UDP requests, just define this function
with a return(0) as single statement.

. Parameters:
Description
- remoteHost: client's IP address.

- remotePort: client's port.

- destport: port to which the request is sent.
- reqLength: UDP request data field length.

Note: The function source code is provided with appropriate example projects.
The code should be adjusted by the user to achieve desired reply.

Requires Ethernet module has to be initialized. See Ethernet_Init.

This function is internally called by the library and should not be called by the

Example
P user's code.
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Ethernet_getlpAddress

Prokﬂype function Ethernet getIpAddress() : word;

Returns Ponter to the global variable holding IP address.

This routine should be used when DHCP server is present on the network to
fetch assigned IP address.

Description Note: User should always copy the IP address from the RAM location returned
by this routine into it's own IP address buffer. These locations should not be
altered by the user in any case!

Requires Ethernet module has to be initialized. See Ethernet_Init.

var

ipAddr : array| 4] of byte; // user IP address buffer
Example 1% yi 4] Y /

memcpy (ipAddr, Ethernet getIpAddress(), 4); // fetch IP address

Ethernet_getGwlpAddress

Prototype function Ethernet getGwIpAddress() : word;
Returns Ponter to the global variable holding gateway IP address.

This routine should be used when DHCP server is present on the network to
fetch assigned gateway IP address.
Description Note: User should always copy the IP address from the RAM location returned
by this routine into it's own gateway IP address buffer. These locations should
not be altered by the user in any case!

Requires Ethernet module has to be initialized. See Ethernet_Init.

var
gwIpAddr : arrayl 4] of byte; // user gateway IP address buffer
Example -
memcpy (gwIpAddr, Ethernet getGwIpAddress(), 4); // fetch gate-
way IP address
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Ethernet_getDnslpAddress

PrOtOtype function Ethernet getDnsIpAddress() : word;

Returns Ponter to the global variable holding DNS IP address.

This routine should be used when DHCP server is present on the network to
fetch assigned DNS IP address.

Description Note: User should always copy the IP address from the RAM location returned
by this routine into it's own DNS IP address buffer. These locations should not
be altered by the user in any case!

Requires Ethernet module has to be initialized. See Ethernet_|Init.
var

dnsIpAddr : arrayl 4] of byte; // user DNS IP address buffer
Example -
memcpy (dnsIpAddr, Ethernet getDnsIpAddress(), 4); // fetch DNS
server address

Ethernet_getlpMask

Prototype function Ethernet getIpMask() : word;

Returns Ponter to the global variable holding IP subnet mask.

This routine should be used when DHCP server is present on the network to
fetch assigned IP subnet mask.

Description Note: User should always copy the IP address from the RAM location returned
by this routine into it's own IP subnet mask buffer. These locations should not
be altered by the user in any case!

Requires Ethernet module has to be initialized. See Ethernet_Init.
var

IpMask : arrayl 4] of byte; // user IP subnet mask buffer

Example -

memcpy (IpMask, Ethernet getIpMask(), 4); // fetch IP subnet
mask
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Ethernet_confNetwork

rocedure Ethernet confNetwork (var ipMask, gwIpAddr, dnsIpAddr
Prototype |° - ( P gwIp p
arrayl 4] of byte);
Returns Nothing.

Configures network parameters (IP subnet mask, gateway IP address, DNS IP
address) when DHCP is not used.

Parameters:
Description |- ipMask: IP subnet mask.
- gwIpAddr gateway IP address.

- dnsIpAddr: DNS IP address.

Note: The above mentioned network parameters should be set by this routine
only if DHCP module is not used. Otherwise DHCP will override these settings.

Requires Ethernet module has to be initialized. See Ethernet_Init.

var

ipMask : array| 4] of byte; // network mask (for example
255.255.255.0)

gwIpAddr : arrayl 4] of byte; // gateway (router) IP address

dnsIpAddr : arrayl 4] of byte; // DNS server IP address

gwIpAddr

[ 0] = 192;
gwIpAddr[ 1] := 168;
gwIpAddr[ 2] = 20;
gwIpAddr[ 3] = 67

Example dnsIpAddr] 0] := 192;
dnsIpAddr[ 1] := 168;
dnsIpAddr[ 2] := 20;
dnsIpAddr[ 3] := 100;
ipMask[ 0] .= 255;
ipMask[ 1] .= 255;
ipMask[ 2] .= 255;
ipMask[ 3] = 0

Ethernet confNetwork (ipMask, gwIpAddr, dnsIpAddr); // set net-
work configuration parameters
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Ethernet_arpResolve

function Ethernet arpResolve (var i : arrayl 4] of byte; tmax :
Prototype _arp ve ( ip vyl 4] y %
byte) : word;
Returns - MAC address behind the IP address - the requested IP address was resolved.

- 0 - otherwise.

This is ARP module routine. It sends an ARP request for given IP address and
waits for ARP reply. If the requested IP address was resolved, an ARP cash
entry is used for storing the configuration. ARP cash can store up to 3 entries.
For ARP cash structure refer to "eth j60LibDef.h" header file in the compil-
er's Uses/P18 folder.

Description |Parameters:

- ip: IP address to be resolved.
- tmax: time in seconds to wait for an reply.

Note: The Ethernet services are not stopped while this routine waits for ARP
reply. The incoming packets will be processed normaly during this time.

Requires Ethernet module has to be initialized. See Ethernet_Init.

var
IpAddr : arrayl 4] of byte; // IP address

[0] := 192;
IpAddr{ 0] := 168;

Example TpAddr( 0] := 1;
IpAddr[ 0] := 1;

Ethernet arpResolve (IpAddr, 5); // get MAC address behind the
above IP address, wait 5 secs for the response
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Ethernet_sendUDP

function Ethernet sendUDP(var destIP : arrayl 4] of byte;

Prokﬂype sourcePort, destPort : word; pkt : "byte; pktlLen : word) : byte;

1 - UDP packet was sent successfully.

Returns 0 - otherwise.

This is UDP module routine. It sends an UDP packet on the network.
Parameters:

Description |- dest1P: remote host IP address.

- sourcePort : local UDP source port number.
- destport: destination UDP port number.

- pkt: packet to transmit.

- pktLen: length in bytes of packet to transmit.

Requires Ethernet module has to be initialized. See Ethernet_Init.

var
IpAddr : arrayl 4] of byte; // remote IP address

IpAddr]

[0] := 192;
IpAddr[ 0] := 168;
Example IpAddr[ 0] := 1;
IpAddr[ 0] := 1;
Ethernet sendUDP(IpAddr, 10001, 10001, 'Hello', 5); // send

Hello message to the above IP address, from UDP port 10001 to
UDP port 10001
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Ethernet_dnsResolve
Prokﬂype ;unctl?n ELhérnetidnsResolve(var host : arrayl 4] of byte; tmax :
yte) : word;
- pointer to the location holding the IP address - the requested host name was
Returns resolved.
- 0 - otherwise.
This is DNS module routine. It sends an DNS request for given host name and
waits for DNS reply. If the requested host name was resolved, it's IP address is
stored in library global variable and a pointer containing this address is returned
by the routine. UDP port 53 is used as DNS port.
Parameters:
e - host : host name to be resolved.
Description o .
- tmax: time in seconds to wait for an reply.
Note: The Ethernet services are not stopped while this routine waits for DNS
reply. The incoming packets will be processed normaly during this time.
Note: User should always copy the IP address from the RAM location returned
by this routine into it's own resolved host IP address buffer. These locations
should not be altered by the user in any case!
Requires Ethernet module has to be initialized. See Ethernet_Init.
var
remoteHostIpAddr : arrayl 4] of byte; // user host IP address
buffer
// SNTP server:
Example // Zurich, Switzerland: Integrated Systems Lab, Swiss Fed.
Inst. of Technology
// 129.132.2.21: swisstime.ethz.ch
// Service Area: Switzerland and Europe
memcpy (remoteHostIpAddr,
Ethernet dnsResolve('swisstime.ethz.ch', 5), 4);
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Ethernet_initDHCP

Prototype function Ethernet initDHCP (tmax : byte) : byte;

- 1 - network parameters were obtained successfully.

Returns .
- 0 - otherwise.

This is DHCP module routine. It sends an DHCP request for network parame-
ters (IP, gateway, DNS addresses and IP subnet mask) and waits for DHCP
reply. If the requested parameters were obtained successfully, their values are
stored into the library global variables.

These parameters can be fetched by using appropriate library IP get routines:

- Ethernet_getlpAddress - fetch IP address.

- Ethernet_getGwlpAddress - fetch gateway IP address.
- Ethernet_getDnslpAddress - fetch DNS IP address.

- Ethernet_getlpMask - fetch IP subnet mask.

UDP port 68 is used as DHCP client port and UDP port ¢7 is used as DHCP

Description server port

Parameters:
- tmax: time in seconds to wait for an reply.

Note: The Ethernet services are not stopped while this routine waits for DNS
reply. The incoming packets will be processed normaly during this time.

Note: When DHCP module is used, global library variable
Ethernet userTimerSec is used to keep track of time. It is user responsibility
to increment this variable each second in it's code.

Requires Ethernet module has to be initialized. See Ethernet_Init.

Ethernet initDHCP(5); // get network configuration from DHCP

C

Example server, wait 5 sec for the response
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Ethernet_doDHCPLeaseTime

Prokﬂype function Ethernet doDHCPLeaseTime () : byte;
- 0 - lease time has not expired yet.
Returns . . T .
- 1 - lease time has expired, it's time to renew it.
This is DHCP module routine. It takes care of IP address lease time by decre-
Description |menting the global lease time library counter. When this time expires, it's time to
contact DHCP server and renew the lease.
Requires Ethernet module has to be initialized. See Ethernet_Init.
while true do
begin
if (Ethernet doDHCPLeaseTime () <> 0) then
Example . -
begin
// it's time to renew the IP address lease
end;
end;

Ethernet_renewDHCP

Prototype

function Ethernet renewDHCP (tmax : byte) : byte;

Returns

- 1 - upon success (lease time was renewed).
- 0 - otherwise (renewal request timed out).

Description

This is DHCP module routine. It sends IP address lease time renewal request to
DHCP server.

Parameters:

- tmax: time in seconds to wait for an reply.

Requires

Ethernet module has to be initialized. See Ethernet_Init.

Example

while true do
begin

if (Ethernet doDHCPLeaseTime () <> 0) then
begin
Ethernet renewDHCP(5); // it's time to renew the IP
address lease, with 5 secs for a reply
end;

end;
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Library Example
This code shows how to use the PIC18FxxJ60 Ethernet library :

- the board will reply to ARP & ICMP echo requests

- the board will reply to UDP requests on any port :
returns the request in upper char with a header made of remote host IP &
port number

- the board will reply to HTTP requests on port 80, GET method with pathnames :

/ will return the HTML main page

/s will return board status as text string

/t0 ... t7 will toggle RDO to RD7 bit and return HTML main page
all other requests return also HTML main page.

program enc_ethernet;

{*****~)<*~)<***************************
* RAM variables
*}

var myMacAddr : array[ 6] of byte ; // my MAC address
myIpAddr : arrayl 4] of byte ; // my IP address
gwIpAddr : arrayl 4] of byte ; // gateway (router) IP address
ipMask : arrayl 4] of byte ; // network mask (for example
255.255.255.0)
dnsIpAddr : arrayl 4] of byte ; // DNS server IP address

{*******************************‘k*‘k*‘k************************

* ROM constant strings
*}

const httpHeader : stringf 30] = 'HTTP/1.1 200 OK'+#10+'Content-type:
' ; // HTTP header

const httpMimeTypeHTML : string] 11] = 'text/html'+#10+#10 ;
// HTML MIME type

const httpMimeTypeScript : stringl 12] = 'text/plain'+#10+#10 ;
// TEXT MIME type

const httpMethod : string[ 5] = 'GET /';

{ *

* web page, splited into 2 parts

* when coming short of ROM, fragmented data is handled more effi-
ciently by linker

*

* this HTML page calls the boards to get its status, and builds
itself with javascript

*}
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const indexPage : stringl 759] =
'<meta http-equiv="refresh"
content="3;url=http://192.168.20.60">" +
'<HTML><HEAD></HEAD><BODY> '+
'<h1>PIC18FxxJ60 Mini Web Server</hl>'+
'<a href=/>Reload</a>"+
'<script src=/s></script>'+
'<table><tr><td valign=top><table border=1
style="font-size:20px ;font-family: terminal ;">'+
'<tr><th colspan=2>ADC</th></tr>"'+

'<Er><td>AN2</td><td><script>document.write (AN2)</script></td></tr>"'
+

'<tr><td>AN3</td><td><script>document.write (AN3)</script></td></tr>"
+

'</table></td><td><table border=1 style="font-
size:20px ;font-family: terminal ;">'+

'<tr><th colspan=2>PORTB</th></tr>"'+

'<script>"'+

'var str,i; '+

'str=""; "+

'for (1=0;1<8;1i++) "+

"{ str+="<tr><td bgcolor=pink>BUTTON #"+i+"</td>"; "'+

'if (PORTB& (1<<1i) ){ str+="<td bgcolor=red>ON";} '+

'else { str+="<td bgcolor=#cccccc>OFF";} "+

'str+="</td></tr>";} '+

'document.write (str) ;'+

'</script>"';

const indexPage2 : string] 466] =
'</table></td><td>'+
'<table border=1 style="font-size:20px ;font-
family: terminal ;">'+
'<tr><th colspan=3>PORTD</th></tr>"'+
'<script>"'+
'var str,i; '+
'str=""; "'+
'for (1=0;1<3;1i++) "+
"{ str+="<tr><td bgcolor=yellow>LED #"+i+"</td>";'+
'if (PORTD& (1<<1i) ){ str+="<td bgcolor=red>ON";} '+
'else { str+="<td bgcolor=#cccccc>OFF";} "+
'str+="</td><td><a
href=/t"+i+">Toggle</a></td></tr>";} '+
'document.write (str) ;'+
'</script>'+
'</table></td></tr></table>'+
'This is HTTP request
#<script>document.write (REQ)</script></BODY></HTML>';
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var getRequest : array| 15] of byte; // HTTP request buffer
dyna : arrayl 30] of byte; // buffer for dynamic response
httpCounter : word ; // counter of HTTP requests

{*******************************************
* user defined functions
*}
{*
* this function is called by the library
* the user accesses to the HTTP request by successive calls to

Ethernet getByte ()

* the user puts data in the transmit buffer by successive calls to
Ethernet putByte ()

* the function must return the length in bytes of the HTTP reply,
or 0 if nothing to transmit

*

* if you don't need to reply to HTTP requests,

* just define this function with a return(0) as single statement

*

*}

function Ethernet UserTCP(var remoteHost : array| 4] of byte;
remotePort, localPort, reglength
word) : word;
var 1 : word ; // my reply length

bitMask : byte ; // for bit mask
tmp: stringl 11]; // to copy const array to ram for memcmp
begin
result := 0;
if (localPort <> 80) then // I listen only to web request on port 80
begin
result := 0;
exit;
end;

// get 10 first bytes only of the request, the rest does not mat-

ter here
for i := 0 to 9 do
getRequest[ i] = Ethernet getByte() ;
getRequest[ i] := 0 ;

// copy httpMethod to ram for use in memcmp routine
for i := 0 to 4 do
tmp[ 1] := httpMethod i] ;

if (memcmp (@getRequest, @tmp, 5) <> 0) then // only GET method
is supported here
begin
result := 0 ;
exit;
end;
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Inc (httpCounter) ; // one more request done
if (getRequest[ 5] = 's') then // if request path
name starts with s, store dynamic data in transmit buffer
begin

// the text string replied by this request can be interpret-
ed as javascript statements
// by browsers

result := Ethernet putConstString(@httpHeader) ;// HTTP header
result = result +
Ethernet putConstString(@httpMimeTypeScript) ; // with text MIME type

// add AN2 value to reply

WordToStr (ADC_Read(2), dyna) ;

tmp := 'var AN2=';

result result + Ethernet putString(Qtmp) ;

result := result + Ethernet putString(@dyna) ;
tmp = ';';
result := result + Ethernet putString(@tmp) ;

// add AN3 value to reply
WordToStr (ADC_Read (3), dyna) ;

tmp := 'var AN3=';

result := result + Ethernet putString(@tmp) ;
result := result + Ethernet putString(@dyna) ;
tmp = ';';

result := result + Ethernet putString(@tmp) ;
// add PORTB value (buttons) to reply

tmp := 'var PORTB= ';

result := result + Ethernet putString(@tmp) ;
WordToStr (PORTB, dyna) ;

result := result + Ethernet putString(@dyna) ;
tmp = ';';

result := result + Ethernet putString(@tmp) ;
// add PORTD value (LEDs) to reply

tmp := 'var PORTD= ';

result := result + Ethernet putString(@tmp) ;
WordToStr (PORTD, dyna) ;

result := result + Ethernet putString(@dyna) ;
tmp = ';"';

result := result + Ethernet putString(@tmp) ;

// add HTTP requests counter to reply
WordToStr (httpCounter, dyna) ;

tmp := 'var REQ= '

result := result + Ethernet putString(Ctmp) ;

result := result + Ethernet putString(€dyna) ;

tmp = ';';

result := result + Ethernet putString(Ctmp) ;
end
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else
if (getRequest[ 5] = 't') then // if request path
name starts with t, toggle PORTD (LED) bit number that comes after
begin
bitMask := 0;
if (isdigit (getRequest[ 6] ) <> 0) then // 1f O
<= bit number <= 9, bits 8 & 9 does not exist but does not matter
begin
bitMask := getRequest[ 6] - '0' ; // con-
vert ASCII to integer
bitMask := 1 shl bitMask ; // cre-
ate bit mask
PORTD := PORTD xor bitMask ; // tog-
gle PORTD with xor operator
end;

end;

if (result = 0) then // what do to by default

begin
result := Ethernet putConstString(€httpHeader) ;
// HTTP header
result := result + Ethernet putConstString(fhttpMimeTypeHTML)
; // with HTML MIME type
result := result + Ethernet putConstString(@indexPage) ;
// HTML page first part
result := result + Ethernet putConstString(@indexPage2) ;
// HTML page second part
end;
// return to the library with the number of bytes to transmit

end;

{*

* this function is called by the library

* the wuser accesses to the UDP request by successive calls to
Ethernet getByte /()

* the user puts data in the transmit buffer by successive calls to
Ethernet putByte ()

* the function must return the length in bytes of the UDP reply, or
0 if nothing to transmit

if you don't need to reply to UDP requests,
just define this function with a return(0) as single statement

* % Xk ok o

}

function Ethernet UserUDP(var remoteHost : arrayl 4] of byte;
remotePort, destPort, reglLength

word) : word;

var tmp : string] 5] ;
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begin
result := 0;
// reply is made of the remote host IP address in human readable
format
byteToStr (remoteHost[ 0] , dyna) ; // first IP address
byte
dynal 3] := '.' ;
byteToStr (remoteHost[ 1] , tmp) ; // second
dynal 4] := tmp[ 0] ;
dyna[ 5] = tmp[ 1] ;
dyna[ 6] = tmp[ 2] ;
dynal 7] = "'.' ;
byteToStr (remoteHost[ 2] , tmp) // second
dyna[ 8] = tmp[ 0] ;
dynal 9] := tmp[ 1] ;
dynal 10] := tmpl 2] ;
dynal[ 11] == "'.' ;
byteToStr (remoteHost[ 3] , tmp) // second
dynal 12] := tmp[ 0] ;
dyna[ 13] = tmp[ 1] ;
dyna[ 14] = tmp[ 2] ;
dynal 15] := ':' ; // add separator

// then remote host port number
WordToStr (remotePort, tmp) ;

dyna[ 16] tmp[ 0] ;
dynal 17] = tmp[ 1] ;
dyna[ 18] = tmp[ 2] ;
dynal 19] = tmp[ 3] ;
dynal 20] := tmp[ 4] ;
dynal 21] := '[ ' ;
WordToStr (destPort, tmp) ;
dynal 22] := tmp[ 0] ;
dynal 23] := tmp[ 1] ;
dynal 24] := tmpl 2] ;
dynal 25] := tmp[ 3] ;
dynal 26] := tmp[ 4] ;
dynal 27] := ']"' ;
dynal 28] := 0 ;

// the total length of the request is the length of the dynamic
string plus the text of the request
result := 28 + reglength ;

// puts the dynamic string into the transmit buffer
Ethernet putBytes (@dyna, 28) ;
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// then puts the request string converted into upper char into the

transmit buffer

while (regLength <> 0) do

’

; // ADC convertors will be used with AN2

analog inputs
- ethernet LEDA:LEDB

input for buttons

output

begin
Ethernet putByte (Ethernet getByte())
reglength := reglLength - 1;
end;
// back to the library with the length of the UDP reply
end;
begin
ADCON1 := 0xO0OB
and AN3
CMCON  := 0x07 ; // turn off comparators
PORTA = 0 ;
TRISA := 0x0C ; // RA2:RA3 -
// RA1:RA0
PORTB = 0 ;
TRISB := Oxff ; // set PORTB as
PORTD = 0 ;
TRISD := 0 ; // set PORID as
httpCounter := 0;

// set mac address

myMacAddr{
myMacAddr{
myMacAddr{
myMacAddr{
myMacAddr{
myMacAddr{

0x00;
0x14;
0xAS5;
0x76;
0x19;
0x3F;

// set IP address

myIpAddr]
myIpAddr]
myIpAddr]
myIpAddr]

[ 0]
[ 1]
[ 2]
[ 3]
// set gateway
gwIpAddr{ 0]
gwIpAddr] 1]
gwIpAddr] 2]
gwIpAddr] 3]

192;
168;
20;
60;

address
192;
168;

= 20;

6;
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// set dns address
dnsIpAddr[ 0] := 192;
dnsIpAddr[ 1] := 168;
dnsIpAddr[ 2] := 20;
dnsIpAddr[ 3] := 1;
// set subnet mask
ipMask[ 0] := 255;
ipMask[ 1] := 255;
ipMask[ 2] := 255;
ipMask[ 3] = 0;
{ *
* starts ENC28J60 with
* reset bit on PORTC.BO
* CS bit on PORTC.B1
* my MAC & IP address
* full duplex
*}
Ethernet Init (myMacAddr, myIpAddr, Ethernet FULLDUPLEX) ; // init

ethernet module

Ethernet setUserHandlers (@Ethernet UserTCP, @Ethernet UserUDP); //
set user handlers

// dhcp will not be used here, so use preconfigured addresses
Ethernet confNetwork (ipMask, gwIpAddr, dnsIpAddr) ;
while true do // do forever
begin
Ethernet doPacket () ; // process incoming Ethernet packets

{
add your stuff here if needed

Ethernet doPacket () must be called as often as possible
otherwise packets could be lost

}

* % % ok X

end;
end.
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FLASH MEMORY LIBRARY

This library provides routines for accessing microcontroller Flash memory. Note that
prototypes differ for PIC16 and PIC18 families.

Note: Due to the P16/P18 family flash specifics, flash library is MCU dependent.
Since the P18 family differ significantlly in number of bytes that can be erased
and/or written to specific MCUs, the appropirate suffix is added to the names of
functions in order to make it easier to use them. Flash memory operations are MCU
dependent :

1. Read operation supported. For this group of MCU's only read function is
implemented.

2. Read and Write operations supported (write is executed as erase-and-write). For
this group of MCU's read and write functions are implemented. Note that write
operation which is executed as erase-and-write, may write less bytes than it erases.

3. Read, Write and Erase operations supported. For this group of MCU's read, write
and erase functions are implemented. Further more, flash memory block has to
be erased prior to writting (write operation is not executed as erase-and-write).

Please refer to MCU datasheet before using flash library.
Library Routines

- FLASH_Read

- FLASH_Read_N_Bytes
- FLASH_Write

- FLASH_Write_8

- FLASH_Write_16

- FLASH_Write_32

- FLASH_Write_64

- FLASH_Erase

- FLASH_Erase 64

- FLASH_Erase 1024

- FLASH_Erase_Write

- FLASH_Erase Write 64
- FLASH_Erase Write 1024

286
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FLASH_Read

// for PIC16

function FLASH Read (Address: word): word;
Prototype

// for PIC18

function FLASH Read(address : dword) : byte;
Returns Returns data byte from Flash memory.
Description |Reads data from the specified address in Flash memory.
Requires Nothing.

// for PIC18

var tmp : byte;
Example begin

tmp := FLASH Read (0x0DO0O0) ;
end.

FLASH_Read_N_Bytes

// for PIC18

Prototype procedure FLASH Read N Bytes (address : longint; wvar data : byte;
N : word);

Returns Nothing.

. Reads N data from the specified address in Flash memory to varibale pointed

Description
by data

Requires Nothing.

Example FLASH Read N (0x0D00, data buffer, sizeof (data buffer));
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FLASH_Write
// for PIC16
procedure FLASH Write (Address : word; var Data : arrayl 4] of word);

// for PIC18

procedure FLASH Write 8 (address : dword; wvar data: arrayl 8] of
byte);

Prototype
procedure FLASH Write 16 (address : dword; wvar data: arrayl 16] of
byte);

procedure FLASH Write 32 (address : dword; wvar data: array| 32] of
byte);

procedure FLASH Write 64 (address : dword; wvar data: array| 64] of
byte);

Returns Nothing.

Writes block of data to Flash memory. Block size is MCU dependent.

P16: This function may erase memory segment before writing block of data to it
(MCU dependent). Furthermore, memory segment which will be erased may be
greater than the size of the data block that will be written (MCU dependent).
Description |Therefore it is recommended to write as many bytes as you erase.
FLASH_Write writes 4 flash memory locations in a row, so it needs to be called
as many times as it is necessary to meet the size of the data block that will be
written.

P18: This function does not perform erase prior to write.

Flash memory that will be written may have to be erased before this function is

Requires called (MCU dependent). Refer to MCU datasheet for details.
Write consecutive values in 64 consecutive locations, starting from 0x0DO0O:
var toWrite : arrayl 64] of byte;
begin
// initialize array:
Example for i := 0 to 63 do
toWrite[ 1] := 1i;

// write contents of the array to the address 0x0DO0O:
FLASH Write 64(0x0D00, toWrite);

end.
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FLASH_Erase
// for PICL6

procedure FLASH Erase (address : word);
Prototype // for PIC18
procedure FLASH Erase 64 (address : dword);

procedure FLASH Erase 1024 (address : dword);

Returns Nothing.

Erases memory block starting from a given address. For P16 familly is imple-
Description |mented only for those MCU's whose flash memory does not support erase-and-
write operations (refer to datasheet for details).

Requires Nothing.

Erase 64 byte memory memory block, starting from address $0D00:
Example
FLASH Erase 64 ($0D00) ;

FLASH_Erase_Write

// for PIC18

procedure FLASHiﬁra567Writei64(address : dword; wvar data
Prototype arrayl 64] of byte);

procedure FLASHiﬁra567Writ671O?4(address : dword; wvar data
arrayl 1024] of byte);

Returns None.

Description |Erase then write memory block starting from a given address.

Requires None.

var toWrite : array| 64] of byte;

begin

// initialize array:

for i := 0 to 63 do

Example toWrite[ i] := 1i;

// erase block of memory at address O0x0DO0 then write contents of
the array to the address 0x0D0O:

FLASH Erase Write 64 (0x0D00, toWrite);

end.
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Library Example

This is a simple demonstration how to use to PIC16 internal flash memory to store
data. The data is being written starting from the given location; then, the same loca-
tions are read and the data is displayed on PORTB and PORTC.

var counter : byte;
addr, data_ : word;
dataAR: arrayl[ 5] of arrayl 4] of word;

begin

ANSEL := O0; // configure AN pins as dig-
ital I/0

ANSELH := 0;

PORTB := 0; // initial PORTB value

0
TRISB := 0; // set PORTB as output
PORTC := 0; // initial PORTC value
0; // set PORTC as output
5

dataAR] 0][ 0] := SFFAA+O0;
dataAR] 0][ 1] := SFFAA+1;
dataAR] 0][ 2] := SFFAA+2;
dataAR[ 0][ 3] := SFFAA+3;
dataAR[ 1][ 0] := SFFAA+4;
dataAR[ 1][ 1] := SFFAA+5;
dataAR[ 1][ 2] := SFFAA+6;
dataAR[ 1][ 3] := SFFAA+7;
dataAR[ 2][ 0] := SFFAA+8;
dataAR] 2][ 1] := SFFAA+9;
dataAR[ 2][ 2] := SFFAA+10;
dataAR[ 2][ 3] := SFFAA+11;
dataAR[ 3][ 0] := SFFAA+12;
dataAR[ 3][ 1] := SFFAA+13;
dataAR[ 3][ 2] := SFFAA+14;
dataAR[ 3][ 3] := SFFAA+15;
dataAR[ 4][ 0] := SFFAA+16;
dataAR[ 4][ 1] := SFFAA+17;
dataAR[ 4][ 2] := SFFAA+18;
dataAR[ 4][ 3] := SFFAA+19;
addr := 0x0430; // starting Flash address,
valid for P16F887
for counter := 0 to 4 do
begin // write some data to Flash

Delay ms (100);
Flash Write (addr+counter*4, dataAR[ counter]);
end;
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Delay ms (500) ;

addr := 0x0430;
for counter := 0 to 19 do
begin
data := Flash Read(addr); // Plé6's FLASH is 14-bit
wide, so
Inc (addr) ;
Delay us (10); // two MSB's will always
be '00'
PORTB := data ; // display data on PORTB
LS Byte
PORTC := word(data_ shr 8); // and PORTC MS Byte
Delay ms (500);
end;
end.
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GRAPHIC LCD LIBRARY

The mikroPascal PRO for PIC provides a library for operating Graphic Lcd 128x64
(with commonly used Samsung KS108/KS107 controller).

For creating a custom set of Glcd images use Glcd Bitmap Editor Tool.

External dependencies of Graphic Lcd Library

The following variables
must be defined in all

\ . . Description: Example :
projects using Graphic P P
Lcd Library:
var GLCD DataPort var GLCD DataPort
byte; sfr; external; Gled Data Port. byte at PORTD;

var GLCD CS1 : sbit;
sfr; external;
var GLCD CS2 : sbit;
sfr; external;
var GLCD RS : sbit;
sfr; external;
var GLCD RW : sbit;

var GLCD CS1 : sbit
at RBO bit;

var GLCD CS2 : sbit
at RB1 bit;

var GLCD RS : sbit at
RB2 bit;

var GLCD RW : sbit at

Chip Select 1 line.

Chip Select 2 line.

Register select line.

Read/Write line.

sfr; external; RB3 bit;

var GLCD EN : sbit; Enable line var GLCD EN : sbit at
sfr; external; ' RB4_bit;

var GLCD RST : sbit; Reset line var GLCD RST : sbit
sfr; external; ’ at RB5 bit;

var
GLCD CS1 Direction
sbit; sfr; external;

var
GLCD CS1 Direction
sbit at TRISBO bit;

Direction of the Chip
Select 1 pin.

var
GLCD _CS2 Direction
sbit; sfr; external;

var
GLCD CS2 Direction
sbit at TRISB1 bit;

Direction of the Chip
Select 2 pin.

var GLCD Rs Direction |Direction of the Register |var GLCD RS Direction

sbit; sfr; external; semctpm_ : sbit at TRISB2 bit;
var GLCD RW Direction |Direction of the var GLCD RW Direction
sbit; sfr; external;|Read/Write pin. : sbit at TRISB3 bit;
var GLCD EN Direction |Direction of the Enable var GLCD EN Direction
sbit; sfr; external; mn_ : sbit at TRISB4 bit;
var var
GLCD_RST Direction : |Direction of the Reset pin. |GLCD_RST Direction
sbit; sfr; external; sbit at TRISBS5 bit;
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Library Routines
Basic routines:

- Gled_Init

- Glcd_Set_Side

- Gled_Set X

- Glcd_Set_Page
- Glcd_Read_Data
- Glcd_Write_Data

Advanced routines:

- Glcd_Fill

- Glcd_Dot

- Gled_Line

- Gled_V_Line

- Gled_H_Line

- Glcd_Rectangle
- Gled_Box

- Glecd_Circle

- Glcd_Set_Font
- Glcd_Write_Char
- Glcd_Write_Text
- Glcd_Image
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Glcd_Init

Prototype |procedure Glcd Init();

Returns Nothing.

Initializes the Glcd module. Each of the control lines is both port and pin config-

Description urable, while data lines must be on a single port (pins <0:7>).

Global variables :

- GLcD cs1 : Chip select 1 signal pin

- GLcD cs2 : Chip select 2 signal pin

- GLCD RS : Register select signal pin

- gLcp rw @ Read/Write Signal pin

- cLcp EN : Enable signal pin

- GLCD RsST : Reset signal pin

Requires - GLCD DataPort : Data port

- GLCD CS1 Direction : Direction of the Chip select 1 pin

- GLCD €S2 Direction : Direction of the Chip select 2 pin

- GLCD RS Direction : Direction of the Register select signal pin
- GLCD RW Direction : Direction of the Read/Write signal pin
- GLCD EN Direction : Direction of the Enable signal pin

- GLCD RST Direction : Direction of the Reset signal pin

must be defined before using this function.

// Glcd module connections
var GLCD DataPort : byte at PORTD;

var GLCD CSsl : sbit at RBO bit;
GLCD CS2 : sbit at RB1 bit;

GLCD RS : sbit at RB2 bit;
GLCD RW : sbit at RB3 bit;
GLCD EN : sbit at RB4 bit;

GLCD RST : sbit at RB5 bit;

E I var GLCD CSl Direction : sbit at TRISBO bit;
xample GLCD CS2 Direction : sbit at TRISB1 bit;
GLCD RS Direction : sbit at TRISB2 bit;
GLCD RW Direction : sbit at TRISB3 bit;
GLCD EN Direction : sbit at TRISB4 bit;

GLCD RST Direction : sbit at TRISBS5 bit;
// End Glcd module connections

ANSEL = 0

ANSELH = 0;
Glcd Init();
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Glcd_Set_Side

Prototype procedure Glcd Set Side(x_pos: byte);

Returns Nothing.

Selects Glcd side. Refer to the Glcd datasheet for detailed explaination.
Parameters :

- x_pos: position on x-axis. Valid values: 0..127
Description
The parameter = pos specifies the Glcd side: values from 0 to 63 specify the
left side, values from 64 to 127 specify the right side.

Note: For side, x axis and page layout explanation see schematic at the bottom
of this page.

Requires Glcd needs to be initialized, see Glcd_Init routine.

The following two lines are equivalent, and both of them select the left side of Glcd:

Example Glcd Select Side(0);
Glcd Select Side(10);
Glcd_Set_X
Prototype procedure Glcd Set X(x pos: byte);
Returns Nothing.
Sets x-axis position to = pos dots from the left border of Glcd within the select-
ed side.
Parameters :

Description
- x_pos: position on x-axis. Valid values: 0. .63

Note: For side, x axis and page layout explanation see schematic at the bottom
of this page.

Requires Glcd needs to be initialized, see Glcd_Init routine.

Example Glcd Set X(25);
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Glcd_Set_Page

Prototype procedure Glcd Set Page (page: byte);
Returns Nothing.
Selects page of the Glcd.
Parameters :
Description | page: page number. Valid values: 0..7
Note: For side, x axis and page layout explanation see schematic at the bottom
of this page.
Requires Glcd needs to be initialized, see Glcd_Init routine.
Example Glcd Set Page(5);
Glcd_Read_Data
Prototype function Glcd Read Data(): byte;
Returns One byte from Glcd memory.
. Reads data from from the current location of Glcd memory and moves to the
Description .
next location.
Glcd needs to be initialized, see Glcd_Init routine.
Requires Glcd side, x-axis position and page should be set first. See functions
Glcd_Set_Side, Glcd_Set_X, and Glcd_Set_Page.
var data: byte;
Example

data := Glcd Read Data();
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Glcd_Write_Data

Prototype procedure Glcd Write Data(ddata: byte);

Returns Nothing.
Writes one byte to the current location in Glcd memory and moves to the next
location.

Description Parameters :

- ddata: data to be written

Glcd needs to be initialized, see Glcd_Init routine.

Requires Glcd side, x-axis position and page should be set first. See functions
Glcd_Set_Side, Glcd_Set_X, and Glcd_Set_Page.
var data: byte;

Example S
Glcd Write Data(data);

Glcd_Fill

Prototype procedure Glcd Fill (pattern: byte);

Returns Nothing.

Fills Glcd memory with the byte pattern.
Parameters :

Description |- pattern: byte to fill Glcd memory with
To clear the Glcd screen, use Glcd_Fill(0).

To fill the screen completely, use Glcd_Fill(OxFF).

Requires Glcd needs to be initialized, see Glcd_Init routine.

' Clear screen

Example Gled Fill(0);
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Glcd_Dot
Prototype procedure Glcd Dot (x pos: byte; y pos: byte; color: byte);
Returns Nothing.
Draws a dot on Glcd at coordinates (x_pos, y_pos).
Parameters :
- x_pos: X position. Valid values: 0..127
.. - v pos: y position. Valid values: 0..63
Description |_ color: color parameter. Valid values: 0..2
The parameter color determines a dot state: O clears dot, 1 puts a dot, and 2
inverts dot state.
Note: For x and y axis layout explanation see schematic at the bottom of this page.
Requires Glcd needs to be initialized, see Glcd_Init routine.
' Invert the dot in the upper left corner
Example Gled Dot (0, 0, 2);
Glcd_Line
procedure Glcd Line(x start: integer; y start: integer; x end:
Prokﬂype integer; y end: integer; color: byte);
Returns Nothing.
Draws a line on Glcd.
Parameters :
- x_start: X coordinate of the line start. Valid values: 0..127
Describtion |~ v start: y coordinate of the line start. Valid values: 0..63
P -« end: x coordinate of the line end. Valid values: 0..127
- v end: y coordinate of the line end. Valid values: 0..63
- color: color parameter. Valid values: 0..2
The parameter color determines the line color: 0 white, 1 black, and 2 inverts
each dot.
Requires Glcd needs to be initialized, see Glcd_Init routine.
' Draw a line between dots (0,0) and (20,30)
Example

Glcd Line(0, 0, 20, 30, 1);
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Glcd_V_Line
Prototvpe procedure Glcd V Line(y start: byte; y end: byte; x pos: byte;
yP color: byte);
Returns Nothing.
Draws a vertical line on Glcd.
Parameters :
- v start:y coordinate of the line start. Valid values: 0..63
Description |- v end: y coordinate of the line end. Valid values: 0..63
- x_pos: X coordinate of vertical line. Valid values: 0..127
- color: color parameter. Valid values: 0..2
The parameter color determines the line color: 0 white, 1 black, and 2 inverts
each dot.
Requires Glcd needs to be initialized, see Glcd_Init routine.
Exambl ' Draw a vertical line between dots (10,5) and (10,25)
xample Gled V Line(5, 25, 10, 1);
Glcd_H_Line
procedure Glcd V Line(x start: byte; x end: byte; y pos: byte;
Prototype color: byte);
Returns Nothing.
Draws a horizontal line on Glcd.
Parameters :
- x_start: X coordinate of the line start. Valid values: 0..127
Description |- x end: x coordinate of the line end. Valid values: 0..127
- v pos: y coordinate of horizontal line. Valid values: 0..63
- color: color parameter. Valid values: 0..2
The parameter color determines the line color: 0 white, 1 black, and 2 inverts
each dot.
Requires Glcd needs to be initialized, see Glcd_Init routine.
Examol ' Draw a horizontal line between dots (10,20) and (50,20)
xample Gled H Line(10, 50, 20, 1);
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Glcd_Rectangle

procedure Glcd Rectangle (x upper left: byte; y upper left: byte;

PrOtOtype x _bottom right: byte; y bottom right: byte; color: byte);
Returns Nothing.
Draws a rectangle on Glcd.
Parameters :
- x upper left: X coordinate of the upper left rectangle corner. Valid values: 0..127
-y upper left: y coordinate of the upper left rectangle corner. Valid values: 0..63
Description |~ *- 0t tom rioht: X coordinate of the lower right rectangle corner. Valid
P values: 0..127
- v bottom right: y coordinate of the lower right rectangle corner. Valid
values: 0..63
- color: color parameter. Valid values: 0..2
The parameter color determines the color of the rectangle border: 0 white, 1
black, and 2 inverts each dot.
Requires Glcd needs to be initialized, see Glcd_Init routine.
Examble ' Draw a rectangle between dots (5,5) and (40,40)
P Glcd Rectangle(5, 5, 40, 40, 1);
Glcd_Box
procedure Glcd Box(x upper left: byte; y upper left: byte; x bot-
PrOtOtype tom right: byte; y bottom right: byte; color: byte);
Returns Nothing.
Draws a box on Glcd.
Parameters :
- x upper left: x coordinate of the upper left box corner. Valid values: 0..127
b L. - v upper left: y coordinate of the upper left box corner. Valid values: 0..63
escription |_ % bottom right: X coordinate of the lower right box corner. Valid values: 0..127
-y bottom right: y coordinate of the lower right box corner. Valid values: 0..63
- color: color parameter. Valid values: 0..2
The parameter color determines the color of the box fill: 0 white, 1 black, and 2
inverts each dot.
Requires Glcd needs to be initialized, see Glcd_Init routine.
Exambple ' Draw a box between dots (5,15) and (20,40)
P Glcd Box (5, 15, 20, 40, 1);

300

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD




CHAPTER 7
mikroPASCAL PRO for PIC Libraries

Glcd_Circle

Prokﬂype procedure Glcd Circle(x center: integer; y center: integer;

radius: integer; color: byte);

Returns Nothing.

Draws a circle on Glcd.
Parameters :

- x _center: X coordinate of the circle center. Valid values: 0..127
Description |- v center: y coordinate of the circle center. Valid values: 0..63
- radius: radius size

- color: color parameter. Valid values: 0..2

The parameter color determines the color of the circle line: 0 white, 1 black,
and 2 inverts each dot.

Requires Glcd needs to be initialized, see Glcd_Init routine.

' Draw a circle with center in (50,50) and radius=10

Example Gled Circle(50, 50, 10, 1);

Glcd_Set_Font

procedure Glcd Set Font (const ActiveFont: “byte; FontWidth: byte;

Prokﬂype FontHeight: byte; FontOffs: word);

Returns Nothing.
Sets font that will be used with Glcd_Write_Char and Glcd_Write_Text routines.

Parameters :

- activeFont: font to be set. Needs to be formatted as an array of byte

- aFontwidth: width of the font characters in dots.

- aFontHeight : height of the font characters in dots.

Description |- arontoffs: number that represents difference between the mikroPascal PRO
for PIC character set and regular ASCII set (eg. if 'A" is 65 in ASCII character,
and 'A' is 45 in the mikroPascal PRO for PIC character set, aFontOffs is 20).
Demo fonts supplied with the library have an offset of 32, which means that
they start with space.

The user can use fonts given in the file “__Lib_ GLCDFonts.mpas” file located in
the Uses folder or create his own fonts.

Requires Glcd needs to be initialized, see Glcd_Init routine.

' Use the custom 5x7 font "myfont" which starts with space (32):

Example Glcd_Set Font (myfont, 5, 7, 32);
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Glcd_Write_Char

procedure Glcd Write Char(chr: byte; x pos: byte; page num: byte;

Prototype color: byte);

Returns Nothing.

Prints character on the Glcd.
Parameters :

- chr: character to be written

- x_pos: character starting position on x-axis. Valid values: 0..(127-FontWidth)
- page num: the number of the page on which character will be written. Valid
Description | values: 0..7

- color: color parameter. Valid values: 0..2

The parameter color determines the color of the character: 0 white, 1 black, and
2 inverts each dot.

Note: For x axis and page layout explanation see schematic at the bottom of
this page.

Glcd needs to be initialized, see Glcd_Init routine. Use Glcd_Set_Font to speci-
Requires fy the font for display; if no font is specified, then default 5x8 font supplied with
the library will be used.

' Write character 'C' on the position 10 inside the page 2:

Example Glcd Write Char('cCc', 10, 2, 1);
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Glcd_Write_Text

procedure Glcd Write Text (var text: arrayl 20] of char; x pos:

PrOtOtype byte; page num: byte; color: byte);
Returns Nothing.
Prints text on Glcd.
Parameters :
- text : text to be written
- x_pos: text starting position on x-axis.
.. - page_num: the number of the page on which text will be written. Valid values: 0..7
Description —

- color: color parameter. Valid values: 0..2

The parameter color determines the color of the text: 0 white, 1 black, and 2
inverts each dot.

Note: For x axis and page layout explanation see schematic at the bottom of
this page.

Glcd needs to be initialized, see Glcd_Init routine. Use Glcd_Set_Font to speci-
Requires fy the font for display; if no font is specified, then default 5x8 font supplied with
the library will be used.

' Write text "Hello world!" on the position 10 inside the page 2:

Example Glcd Write Text("Hello world!", 10, 2, 1);

Glcd_Image

Prototype procedure Glcd Image (const image: “byte);

Returns Nothing.

Displays bitmap on Glcd.

Parameters :

Description | image: image to be displayed. Bitmap array must be located in code memory.

Use the mikroPascal PRO for PIC integrated Glcd Bitmap Editor to convert
image to a constant array suitable for displaying on Glcd.

Requires Glcd needs to be initialized, see Glcd_Init routine.

' Draw image my image on Glcd

Example GlcdiImage (myiimage) ’
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Library Example

The following example demonstrates routines of the Glcd library: initialization,

clear(pattern fill), image displaying, drawing lines, circles, boxes and rectangles, text
displaying and handling.

program GLCD Test;
uses bitmap;

// Glcd module connections
var GLCD DataPort : byte at PORTD;

var GLCD CS1 : sbit at RBO bit;
GLCD CS2 : sbit at RB1 bit;

GLCD_RS : sbit at RB2 bit;
GLCD_RW : sbit at RB3 bit;
GLCD_EN : sbit at RB4 bit;

GLCD RST : sbit at RB5 bit;

var GLCD CS1 Direction : sbit at TRISBO bit;
GLCD CS2 Direction : sbit at TRISB1 bit;

GLCD_RS Direction : sbit at TRISB2 bit;
GLCD _RW Direction : sbit at TRISB3 bit;
GLCD_EN Direction : sbit at TRISB4 bit;

GLCD RST Direction : sbit at TRISBS5 bit;
// End Glcd module connections

var counter : byte;
someText : arrayl 18] of char;

procedure Delay2S();
begin
Delay ms (2000) ;
end;

// 2 seconds delay function

begin

ANSEL
ANSELH :=

0; // Configure AN pins as digital I/O
0

’

Gled Init();

// Initialize Glcd
Glcd Fill(0x00);

// Clear Glcd

while TRUE do

begin
Glcd Image (€truck bmp) ; // Draw image
Delay2S(); delay2S();
Glcd Fill (0x00); // Clear Glcd
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Glcd Box(62,40,124,63,1); // Draw box
Glcd Rectangle(5,5,84,35,1); // Draw rectangle
Glcd Line (0, 0, 127, 63, 1); // Draw line
Delay2S();
counter := 5;

while (counter <= 59) do // Draw horizontal and vertical lines
begin
Delay ms (250);
Glcd V Line (2, 54, counter, 1);
Glcd H Line(2, 120, counter, 1);
Counter := counter + 5;
end;

Delay2S () ;

Glcd Fill(0x00); // Clear Glcd

Glcd Set Font (QCharacter8x7, 8, 7, 32); // Choose font

"Character8x7"
Glcd Write Text ('mikroE', 1, 7, 2); // Write string
for counter := 1 to 10 do // Draw circles
Glcd Circle (63,32, 3*counter, 1);
Delay2S();
Glcd Box (10,20, 70,63, 2); // Draw box}
Delay2S () ;
Glcd Fill (OxFF); // Fill Glcd
Glcd Set Font (QCharacter8x7, 8, 7, 32); // Change font
someText := '8x7 Font';
Glcd Write Text (someText, 5, 0, 2); // Write string
delay2S();
Glcd Set Font (€System3x6, 3, 5, 32); // Change font
someText := '3X5 CAPITALS ONLY';
Glcd Write Text (someText, 60, 2, 2); // Write string
delay2S();
Glcd Set Font (€fontbx7, 5, 7, 32); // Change font
someText := '5x7 Font';
Glcd Write Text (someText, 5, 4, 2); // Write string
delay2S();
Glcd_Set Font (@FontSystembx7 v2, 5, 7, 32); // Change font
someText := '5x7 Font (v2)';
Glcd Write Text (someText, 50, 6, 2); // Write string
delay2S();
end;
end.
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HW Connection
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I*C Library

12C full master MSSP module is available with a number of PIC MCU models. mikroPascal PRO

for PIC provides library which supports the master 12C mode.

Note: Some MCUs have multiple I2C modules. In order to use the desired | .C library routine, sim-

ply change the number 1 in the prototype with the appropriate module number, i.e.

I2C1 Init(100000);

Library Routines

- 12C1_Init
- 12C1_Start
- 12C1_Repeated_Start
- 12C1_Is_Idle
-12C1_Rd
-12C1_Wr
- 12C1_Stop
12C1_Init
Prototype |procedure 12C1 Init(clock : dword);
Returns Nothing.
Initializes 12C with desired clock (refer to device data sheet for correct values in
L respect with Fosc). Needs to be called before using other functions of 12C Library.
Description
You don’t need to configure ports manually for using the module; library will take
care of the initialization.
Library requires MSSP module on PORTB or PORTC.
Requi Note: Calculation of the 12C clock value is carried out by the compiler, as it
quires , . i
would produce a relatively large code if performed on the libary level.
Therefore, compiler needs to know the value of the parameter in the compile
time. That is why this parameter needs to be a constant, and not a variable.
Example I2C1_Init(100000);
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12C1_Start
Prototype function I2C1 Start() : byte;
Returns If there is no error, function returns 0.
Description |Determines if I12C bus is free and issues START signal.
Requires I.C must be configured before using this function. See 12C1_Init.
Example if (I2C1 Start() = 0) then

12C1_Repeated_Start

Prototype procedure I2C1 Repeated Start();
Returns Nothing.
Description |Issues repeated START signal.
Requires 12C must be configured before using this function. See 12C1_Init.
Example I2C1 Repeated Start();
12C1_Is_lIdle
Prototype function I2C1 Is Idle() : byte;
Returns Returns TruE if I2C bus is free, otherwise returns FALSE.
Description |Tests if 12C bus is free.
Requires 12C must be configured before using this function. See 12C1_Init.
Example if (I2Cl1 Is Idle) then
12C1_Rd
Prototype function I2Cl1 Rd(ack : byte) : byte;
Returns Returns one byte from the slave.
e Reads one byte from the slave, and sends not acknowledge signal if parameter
Description ) o
ack is 0, otherwise it sends acknowledge.
12C must be configured before using this function. See 12C1_Init.
Requires
Also, START signal needs to be issued in order to use this function. See 12C1_Start.
Read data and send not acknowledge signal:
Example

tmp := I2C1 Rd(O0);
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12C1_Wr
Prototype function I2C1 Wr(data : byte) : byte;
Returns Returns 0 if there were no errors.
Description |Sends data byte (parameter =) via I2C bus.
12C must be configured before using this function. See 12C1_Init.
Requires Also, START signal needs to be issued in order to use this function. See
12C1_Start.
Example I2C1 _Write ($A3);
12C1_Stop
Prototype |procedure I2C1 Stop();
Returns Nothing.
Description [Issues STOP signal.
Requires 12C must be configured before using this function. See 12C1_Init.
Example I2C1 Stop();

Library Example

This code demonstrates use of | C Library procedures and functions. PIC MCU is connected
(SCL, SDA pins ) to 24c02 EEPROM. Program sends data to EEPROM (data is written at address
2). Then, we read data via 12C from EEPROM and send its value to PORTD, to check if the cycle
was successful. Check the figure below.
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program I2C Simple;
begin
ANSEL := O0; // Configure AN pins as digital I/O
ANSELH := 0;
PORTB = 0;
TRISB := 0; // Configure PORTB as output
I2C1 Init(100000); // initialize I2C communication
I2C1 Start(); // issue I2C start signal
I2C1 Wr (OxAZ2); // send byte via I2C (device address + W)
I2C1 Wr(2); // send byte (address of EEPROM location)
I2C1 Wr (0xFO) ; // send data (data to be written)
I2C1 Stop(); // issue I2C stop signal

Delay 100ms () ;

I2C1 Start(); // issue I2C start signal

I2C1 Wr (0xA2); // send byte via I2C (device address + W)
I2C1 Wr(2); // send byte (data address)

I2Cl Repeated Start(); // 1issue I2C signal repeated start
I2C1 Wr (0xA3); // send byte (device address + R)
PORTB := I2C1l Rd(0); // Read the data (NO acknowledge)
I2C1 Stop(); // issue I2C stop signal

end.

HW Connection
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310 MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



mikroPASCAL PRO for PIC

CHAPTER 7
Libraries

Keypad Library

The mikroPascal PRO for PIC provides a library for working with 4x4 keypad. The library routines
can also be used with 4x1, 4x2, or 4x3 keypad. For connections explanation see schematic at the

bottom of this

page.

External dependencies of Keypad Library

The following variable
must be defined in all ..
. . Description: Example :
projects using Keypad
Library:
var keypadPort : var keypadPort : byte
byte; sfr; external; Keypad Port. at PORTD;

Library Routines

- Keypad_Init

- Keypad_Key Press
- Keypad_Key_Click

Keypad_Init
Prototype procedure Keypad Init();
Returns Nothing.
Description |[Initializes port for working with keypad.
Global variables :
Requires - keypadport Reg - Keypad port
must be defined before using this function.
// Initialize PORTB for communication with keypad
Exanuﬂe var keypadPort : byte at PORTD;
%é?padilnit();
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Keypad_Key_Press

Proknype function Keypad Key Press(): byte;

The code of a pressed key (1..16).
Returns
If no key is pressed, returns 0.

Description [Reads the key from keypad when key gets pressed.

Requires Port needs to be initialized for working with the Keypad library, see Keypad_Init.

var kp : byte;
Example S
kp := Keypad Key Press();

Keypad_Key_Click

Prototype function Keypad Key Click(): byte;

The code of a clicked key (1..16).

Returns
If no key is clicked, returns 0.

Call to xeypad Key Click is a blocking call: the function waits until some key is
pressed and released. When released, the function returns 1 to 16, depending
Description |on the key. If more than one key is pressed simultaneously the function will wait
until all pressed keys are released. After that the function will return the code of
the first pressed key.

Requires Port needs to be initialized for working with the Keypad library, see Keypad_Init.

var kp : byte;
Example e
kp := Keypad Key Click();

Library Example

This is a simple example of using the Keypad Library. It supports keypads with 1..4 rows and 1..4
columns. The code being returned by Keypad_Key_Click() function is in range from 1..16. In this
example, the code returned is transformed into ASCII codes [0..9,A..F] and displayed on Lcd. In
addition, a small single-byte counter displays in the second Lcd row number of key presses.
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program Keypad Test;
var kp, cnt, oldstate : byte;
txt : arrayl 6] of byte;
// Keypad module connections
var keypadPort : byte at PORTD;
// End Keypad module connections
// Lcd module connections
var LCD RS : sbit at RB4 bit;
LCD EN : sbit at RB5 bit;
LCD D4 : sbit at RBO bit;
LCD_D5 : sbit at RBl_bit;
LCD_D6 : sbit at RBZ_bit;
LCD D7 : sbit at RB3 bit;
var LCD RS Direction : sbit at TRISB4 bit;
LCD _EN Direction : sbit at TRISBS bit;
LCD D4 Direction : sbit at TRISBO bit;
LCD D5 Direction : sbit at TRISB1 bit;
LCD D6 Direction : sbit at TRISB2 bit;
LCD D7 Direction : sbit at TRISB3 bit;
// End Lcd module connections
begin
oldstate := 0;
cnt := 0; // Reset counter
Keypad Init(); // Initialize Keypad
ANSEL := 0; // Configure AN pins as digital I/O
ANSELH := 0;
Led Init () // Initialize Lcd
Led Cmd( LCD CLEAR) ; // Clear display
Led Cmd (_LCD _CURSOR_OFF) ; // Cursor off
Led Out(l, 1, 'Key :'); // Write message text on Lcd
Lcd Out (2, 1, 'Times:');
while TRUE do
begin
kp := 0; // Reset key code variable

// Wait for key to be pressed and released
while ( kp = 0 ) do
kp := Keypad Key Click(); // Store key code in
kp variable

// Prepare value for output, transform key to it's ASCII
value
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case kp of

//case 10: kp = 42; /)t // Uncomment this block
for keypaddx3

//case 11: kp = 48; // 0!

//case 12: kp = 35; /] T#!

//default: kp += 48;

1: kp := 49; // 1 // Uncomment this
block for keypadidxi4
2: kp := 50; // 2
3: kp := 51; // 3
4: kp := 65; // A
5: kp := 52; // 4
6: kp := 53; // 5
7: kp := 54; // 6
8: kp := 66; // B
9: kp := 55; // 7
10: kp := 56; // 8
11: kp := 57; // 9
12: kp := 67; // C
13: kp := 42; // *
14: kp := 48; // O
15: kp := 35; // #
16: kp := 68; // D

end;

if (kp <> oldstate) then // Pressed key differs from previous

begin
cnt = 1;
oldstate := kp;
end
else // Pressed key 1s same as previous

Inc(cnt);

Lcd Chr (1, 10, kp); // Print key ASCII value on Lcd
if (cnt = 255) then // If counter varialble overflow
begin
cnt := 0;
Lcd Out (2, 10, ' ")
end;

WordToStr (cnt, txt); // Transform counter value to string

Lcd Out (2, 10, txt); // Display counter value on Lcd
end;
end.
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HW Connection

1 " b
(] 1
(] REs [——————
E RB4 [———
RrEs [J——
(] -U RBZ [F———
i — RE{ [
(] O mofl—
E e ﬁ\'c:c:
GND I
OECLLATDR 120—[ WCC % ROT ]
H |||—[ GND ROG [}
CLKIN Qo ROG [1
i 00 ros I}
(] ~J 1]
[] [
[ 1]
[} [l
RDD RO3
L L) ROD1 RD2 ﬂ

~“BhEE
SEEE
LSS

. EEEEEEEEEEREREEEE

LCD 2X16

4x4 Keypad connection scheme

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD 315



CHAPTER 7

Libraries mikroPASCAL PRO for PIC

LCD LIBRARY

The mikroPascal PRO for PIC provides a library for communication with Lcds (with
HD44780 compliant controllers) through the 4-bit interface. An example of Lcd con-

nections is given on the schematic at the bottom of this page.

For creating a set of custom Lcd characters use Lcd Custom Character Tool.

External dependencies of Lcd Library

The following variables
must be defined in all

. . Description: Example :
projects using Lcd P P
Library :
var LCD RS sbit; Reqister Select line var LCD RS sbit at
sfr; external; g ’ RB4 Dbit;
var LCD _EN sbit; Enable line var LCD EN sbit at
sfr; external; ' RB5 bit;
var LCD D7 sbit; Data 7 line var LCD D7 sbit at
sfr; external; ’ RB3 bit;
var LCD D6 sbit; Data 6 line var LCD D6 sbit at
sfr; external; ) RB2 bit;
var LCD D5 sbit; Data 5 line var LCD D5 sbit at
sfr; external; ) RBlibit;
var LCD D4 sbit; Data 4 lin var LCD D4 sbit at
sfr; external; ata e. RBO bit;

var LCD RS Direction
sbit; sfr; external;

Register Select direction pin.

var LCD RS Direction
sbit at TRISB4 bit;

var LCD EN Direction
sbit; sfr; external;

Enable direction pin.

var LCD EN Direction
sbit at TRI SB57bit;

var LCD D7 Direction
sbit; sfr; external;

Data 7 direction pin.

var LCD D7 Direction
sbit at TRISB3 bit;

var LCD D6 Direction

sbit; sfr; external;

Data 6 direction pin.

var LCD D6 Direction
sbit at TRISB2 bit;

var LCD D5 Direction

sbit; sfr; external;

Data 5 direction pin.

var LCD D5 Direction
sbit at TRISB1 bit;

var LCD D4 Direction
sbit; sfr; external;

Data 4 direction pin.

var LCD D4 Direction
sbit at TRISBO bit;
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Library Routines

Led_Init

Lcd Out

Lcd Out CP
Lcd _Chr

Lcd Chr_Cp
Lcd Cmd

Lcd_Init

Prototype procedure Lcd Init();

Returns Nothing.

Description |Initializes Lcd module.

Global variables:

- Lcp D7: Data bit 7

- LcD D6: Data bit 6

- LcD D5: Data bit 5

- LcD D4: Data bit 4

- .cp Rs: Register Select (data/instruction) signal pin

- Lcp EN: Enable signal pin

- LCD D7 Direction: Direction of the Data 7 pin

- LCD D6 Direction: Direction of the Data 6 pin

- LCD D5 Direction: Direction of the Data 5 pin

- LCD D4 Direction: Direction of the Data 4 pin

- LCD RS Direction: Direction of the Register Select pin
- LCD EN Direction: Direction of the Enable signal pin

Requires

must be defined before using this function.

// Lcd module connections

var LCD RS : sbit at RB4 bit;
var LCD EN : sbit at RBS5 bit;
var LCD D4 : sbit at RB3 bit;
var LCD D5 : sbit at RB2 bit;
var LCD D6 : sbit at RB1 bit;
var LCD D7 : sbit at RBO bit;

var LCD RS Direction : sbit at TRISB4 bit;
var LCD EN Direction : sbit at TRISBS5 bit;
var LCD D4 Direction : sbit at TRISB3 bit;
var LCD D5 Direction : sbit at TRISB2 bit;
var LCD D6 Direction : sbit at TRISB1 bit;
var LCD D7 Direction : sbit at TRISBO bit;
// End Lcd module connectlons

Example

Led Init ()
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Lcd_Out
Prototype ziozijtT? Lcd Out (row: byte; column: byte; var text: array [ 20]
Returns Nothing.

Prints text on Lcd starting from specified position. Both string variables and liter-
als can be passed as a text.

e Parameters :
Description
- row: starting position row number

- column: starting position column number
- text: text to be written

Requires The Lcd module needs to be initialized. See Lcd_Init routine.

// Write text "Hello!"™ on Lcd starting from row 1, column 3:

Example Lcd Out (1, 3, "Hellol!™);

Lcd _Out CP

Prototype procedure Lcd Out CP(var text: array [ 20] of char);

Returns Nothing.

Prints text on Lcd at current cursor position. Both string variables and literals
can be passed as a text.

Description Parameters :

- text: text to be written

Requires The Lcd module needs to be initialized. See Lcd_Init routine.

// Write text "Here!" at current cursor position:
Lcd Out CP("Here!");

Example
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Lcd_Chr
Prototype procedure Lcd Chr(row: byte; column: byte; out char: byte);
Returns Nothing.

Prints character on Lcd at specified position. Both variables and literals can be
passed as a character.

e Parameters :
Description
- row: writing position row number
- column: writing position column number
- out char: character to be written
Requires The Lcd module needs to be initialized. See Lcd_Init routine.
Example // Write character "i" at row 2, column 3:
P Led Chr(2, 3, 'i');
Lcd_Chr_CP
Prototype |procedure Lcd Chr CP(out char: byte);
Returns Nothing.
Prints character on Lcd at current cursor position. Both variables and literals
can be passed as a character.
Description
P Parameters :
-out char: character to be written
Requires The Lcd module needs to be initialized. See Lcd_Init routine.
// Write character "e" at current cursor position:
Example

Lcd Chr CP('e'");
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Lcd_Cmd

Prototype |procedure Lcd Cmd(out char: byte);

Returns Nothing.

Sends command to Lcd.

Parameters :

Description
P - out char: command to be sent

Note: Predefined constants can be passed to the function, see Available Lcd
Commands.

Requires The Lcd module needs to be initialized. See Lcd_Init table.

// Clear Lcd display:

Example Led Cmd ( LCD CLEAR) ;

Available Lcd Commands

Lcd Command Purpose
_LCD_FIRST ROW Move cursor to the 1st row
_LCD_SECOND ROW Move cursor to the 2nd row
_LCD_THIRD ROW Move cursor to the 3rd row
_LCD_FOURTH ROW Move cursor to the 4th row
_LCD_CLEAR Clear display

Return cursor to home position, returns a shifted display to its original

~LCD_RETURN_HOME position. Display data RAM is unaffected.

_LCD_CURSOR_OFF Turn off cursor

_LCD_UNDERLINE ON Underline cursor on

_LCD_BLINK CURSOR ON Blink cursor on

_LCD_MOVE_CURSOR_LEFT |Move cursor left without changing display data RAM

_LCD_MOVE_CURSOR_RIGHT |Move cursor right without changing display data RAM

_LCD_TURN_ON Turn Lcd display on

_LCD_TURN_OFF Turn Lcd display off

_LCD_SHIFT LEFT Shift display left without changing display data RAM
_LCD_SHIFT RIGHT Shift display right without changing display data RAM
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Library Example

The following code demonstrates usage of the Lcd Library routines:

program

Lcd;

// LCD module connections

var
var
var
var
var
var

LCD RS
LCD_EN
LCD D4
LCD D5
LCD D6
LCD D7

sbit
sbit
sbit
sbit
sbit
sbit

at
at
at
at
at
at

RB4 bit;
RB5 bit;
RBO bit;
RB1 bit;
RB2 bit;
RB3 bit;

var
var
var
var
var
var

LCD RS Direction
LCD EN Direction
LCD D4 Direction
LCD D5 Direction
LCD D6 Direction
LCD D7 Direction

sbit
sbit
sbit
sbit
: sbit
: sbit

at
at
at
at
at
at

// End LCD module connections

var

procedure Move Delay () ;

txtl arrayl 16]
txt2 arrayl 9]
txt3 arrayl 8]
txt4d : arrayl 7]
i : byte;

of char;

of char;
of char;
of char;

TRISB4 bit;
TRISB5 bit;
TRISBO bit;
TRISB1 bit;
TRISB2 bit;
TRISB3 bit;

// Loop variable

// Function used for text moving

// You can change the moving speed here

// Configure AN pins as digital I/O

begin
Delay ms(500);

end;

begin
TRISB : 0;
PORTB := OxFF;
TRISB : OxFF;
ANSEL := 0;
ANSELH := 0;
txtl := 'mikroElektronika';
txt2 := 'EasyPICS5';
txt3 := 'Lcd4bit';
txtd := 'example';
Led Init();

Led Cmd (_LCD_CLEAR) ;
Led Cmd ( LCD_CURSOR_OFF) ;

// Initialize LCD
// Clear display
// Cursor off

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD

321



CHAPTER 7

Libraries mikroPASCAL PRO for PIC
LCD Out(1l,6,txt3); // Write text in first row
LCD Out (2,6,txt4); // Write text in second row
Delay ms (2000) ;

Lcd Cmd( LCD _CLEAR) ; // Clear display
LCD Out(1,1,txtl); // Write text in first row
Lcd Out (2,5,txt2); // Write text in second row
Delay ms (500);
// Moving text
for 1:=0 to 3 do // Move text to the right 4 times
begin
Lcd7Cmd (7LCD75HIFT7RIGHT) ;
Move Delay () ;
end;
while TRUE do // Endless loop
begin
for i:=0 to 6 do // Move text to the left 7 times
begin
Led Cmd ( LCD_SHIFT LEFT) ;
Move Delay () ;
end;
for 1:=0 to 6 do // Move text to the right 7 times
begin
Lcdicmd (7LCD75HIFT7RIGHT) ;
Move Delay () ;
end;
end;

end.
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HW connection
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Lcd HW connection
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MANCHESTER CODE LIBRARY

The mikroPascal PRO for PIC provides a library for handling Manchester coded sig-
nals. The Manchester code is a code in which data and clock signals are combined
to form a single self-synchronizing data stream; each encoded bit contains a transi-
tion at the midpoint of a bit period, the direction of transition determines whether the
bit is 0 or 1; the second half is the true bit value and the first half is the complement
of the true bit value (as shown in the figure below).

Manchester RF_Send_Byte format

St1|St2|Ctr |B7 | B6(B5|B4 | B3| B2|B1|BO

Bi-phase coding

AR

1 0

2ms Example of transmission

11000100011
Notes: The Manchester receive routines are blocking calls (Man Receive Init and
Man Synchro). This means that MCU will wait until the task has been performed

(e.g. byte is received, synchronization achieved, etc).

Note: Manchester code library implements time-based activities, so interrupts need
to be disabled when using it.

External dependencies of Manchester Code Library

The following variables
must be defined in all
projects using Man-
chester Code Library:

Description: Example :

var MANRXPIN : sbit; Receive line var MANRXPIN : sbit
sfr; external; ’ at RBO bit;

var MANTXPIN : sbit; Transmit line var MANTXPIN : sbit
sfr; external; ’ at RB1 bit;
var . . . var

Direction of the Receiv
MANRXPINiDireCtiOD : . ection o € Receive MANRXPINiDirection :
sbit; sfr; external; pin. sbit at TRISBO bit;
var . . . var

Direction of the Transmit
MANTXPIN Direction : R ection o e Irans MANTXPIN Direction :
sbit; sfr; external; pin. sbit at TRISB1 bit;

324 MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



mikroPASCAL PRO for PIC

CHAPTER 7

Libraries

Library Routines

- Man_Receive_|Init

- Man_Receive

- Man_Send_Init

- Man_Send

- Man_Synchro

- Man_Break

The following routines are for the internal use by compiler only:

- Manchester_0
- Manchester_1
- Manchester_Out

Man_Receive_Init

Prototype

function Man Receive Init(): word;

Returns

- 0 - if initialization and synchronization were successful.
- 1 - upon unsuccessful synchronization.
- 255 - upon user abort.

Description

The function configures Receiver pin and performs synchronization procedure in
order to retrieve baud rate out of the incoming signal.

Note: In case of multiple persistent errors on reception, the user should call this
routine once again or Man_Synchro routine to enable synchronization.

Requires

Global variables :

- MANRXPIN : Receive line
- MANRXPIN Direction : Direction of the receive pin

must be defined before using this function.

Example

// Initialize Receiver
var MANRXPIN : sbit at RBO bit;
var MANRXPIN Direction : sbit at TRISBO bit;

Man Receive Init();
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Man_Receive

Prokﬁype function Man Receive (var error: byte): byte;
Returns A byte read from the incoming signal.
The function extracts one byte from incoming signal.
i Parameters :
Description
- error: error flag. If signal format does not match the expected, the error flag
will be set to non-zero.
. To use this function, the user must prepare the MCU for receiving. See
Requires . .
Man_Receive_|Init.
var data, error : byte
data := 0
error := 0
data := Man Receive (&error);
Example -
if (error <> 0) then
begin
// error handling
end;
Man_Send_lInit
Prototype |procedure Man Send Init();
Returns Nothing.
Description |The function configures Transmitter pin.
Global variables :
. - MANRXPIN : Receive line
Requires ‘ i . .
- MANRXPIN Direction : Direction of the receive pin
must be defined before using this function.
// Initialize Transmitter:
var MANTXPIN : sbit at RB1 bit;
Example var MANTXPIN Direction : sbit at TRISB1 bit;
Man Send Init();
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Man_Send
Prototype procedure Man Send(tr data: byte);
Returns Nothing.
Sends one byte.
Parameters :
Description
- tr data: data to be sent
Note: Baud rate used is 500 bps.
Reaqui To use this function, the user must prepare the MCU for sending. See
equires .
Man_Send_Init.
var msg : byte;
Example S
Man Send (msg) ;

Man_Synchro

Prototype function Man Synchro(): byte;
- 0 - if synchronization was not successful.
Returns - Half of the manchester bit length, given in multiples of 10us - upon successful
synchronization.
Description |Measures half of the manchester bit length with 10us resolution.
. To use this function, you must first prepare the MCU for receiving. See
Requires . ,
Man_Receive_|Init.
var man_half bit len : word;
Example S
maniiﬁanibit71en := Man Synchro();
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Man_Break

Prototype procedure Man Break();

Returns Nothing.

Man_Receive is blocking routine and it can block the program flow. Call this
routine from interrupt to unblock the program execution. This mechanism is sim-

i ilar to WDT.
Description

Note: Interrupts should be disabled before using Manchester routines again
(see note at the top of this page).

Requires Nothing.

var datal, error, counter : byte;

procedure interrupt();
begin
if (INTCON.TOIF <> 0) then
if (counter >= 20) then
begin
Man Break() ;
counter := 0; // reset counter
end
else
Inc (counter) ; // increment counter
INTCON.TOIF := 0; // Clear Timer0Q overflow inter-
rupt flag
end;

Example begin

counter := 0;
OPTION REG :=

0x04; // TMRO prescaler set to 1:32

Man Receive Init();

// try Man Receive with blocking prevention mechanism

INTCON.GIE := 1; // Global interrupt enable
INTCON.TOIE := 1; // Enable Timer0O overflow inter-
rupt
datal := Man Receive (error);
INTCON.GIE := 0; // Global interrupt disable
end.
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Library Example

The following code is code for the Manchester receiver, it shows how to use the
Manchester Library for receiving data:

program Manchester Receiver;

// LCD module connections

var LCD RS : sbit at RB4 bit;
LCD EN : sbit at RB5 bit;
LCD D4 : sbit at RBO bit;
LCD_D5 : sbit at RBl_bit;
LCD_D6 : sbit at RBZ_bit;
LCD D7 : sbit at RB3 bit;

var LCD RS Direction : sbit at TRISB4 bit;
LCD EN Direction : sbit at TRISBS bit;
LCD D4 Direction : sbit at TRISBO bit;
LCD D5 Direction : sbit at TRISB1 bit;
LCD D6 Direction : sbit at TRISB2 bit;
LCD D7 Direction : sbit at TRISB3 bit;
// End LCD module connections

// Manchester module connections
var MANRXPIN : sbit at RBO_bit;
MANRXPIN Direction : sbit at TRISBO bit;
MANTXPIN : sbit at RBl_bit;
MANTXPIN Direction : sbit at TRISB1 bit;
// End Manchester module connections

var error, ErrorCount, temp : byte;
begin

ErrorCount := 0;

ANSEL 0; // Configure AN pins as digital I/O

ANSELH := 0;

CION bit := 0; // Disable comparators

C20N bit := 0;

Led Init(); // Initialize LCD

Led Cmd (_LCD _CLEAR) ; // Clear LCD display

Man Receive Init(); // Initialize Receiver

while TRUE do // Endless loop

begin
Lcd Cmd( LCD _FIRST ROW); // Move cursor to the 1lst row
while TRUE do // Wait for the "start" byte
begin

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD 329



CHAPTER 7

Libraries mikroPASCAL PRO for PIC
temp := Man Receive (error); // Attempt byte receive
if (temp = 0x0B) then // "Start" byte, see

Transmitter example
break; // We got the starting sequence
if (error <> 0) then // Exit so we do not loop forever
break;
end;
repeat
begin
temp := Man Receive (error); // Attempt byte receive
if (error <> 0) then // 1If error occured
begin
Led Chr CP('?1'); // Write question mark on LCD
Inc (ErrorCount) ; // Update error counter
if (ErrorCount > 20) then // In case of multi-
ple errors
begin
temp := Man Synchro(); // Try to synchronize
again
//Man Receive Init(); // Alternative, try to
Initialize Receiver again
ErrorCount := 0; // Reset error counter
end;
end
else // No error occured
begin
if (temp <> O0xOE) then // If "End" byte was
received(see Transmitter example)
Lcd Chr CP(temp); // do not write received
byte on LCD
end;
Delay ms (25);
end;
until ( temp = O0x0E );
end; // If "End" byte was received exit do loop

end.

The following code is code for the Manchester transmitter, it shows how to use the
Manchester Library for transmitting data:
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program Manchester Transmitter;

// Manchester module connections
var MANRXPIN : sbit at RBO_bit;
MANRXPIN Direction : sbit at TRISBO bit;
MANTXPIN : sbit at RBl_bit;
MANTXPIN Direction : sbit at TRISB1 bit;
// End Manchester module connections

var index, character : byte;
sl : array| 17] of char;
begin
sl := 'mikroElektronika';
ANSEL := O0; // Configure AN pins as digital I/O
ANSELH = 0;
CION bit := 0; // Disable comparators
C20N bit := 0;
Man Send Init(); // Initialize transmitter
while TRUE do // Endless loop
begin
Man Send (0x0B) ; // Send "start" byte
Delay ms (100); // Wait for a while
character := s1[ 0] ; // Take first char from string
index := 0; // Initialize index variable
while (character <> 0) do // String ends with zero
begin
Man_ Send(character); // Send character
Delay ms (90) ; // Wait for a while
Inc (index) ; // Increment index variable
character := sl[ index] ; // Take next char from string
end;
Man Send (0x0E) ; // Send "end" byte
Delay ms (1000) ;
end;
end.
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Connection Example
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MULTI MEDIA CARD LIBRARY

The Multi Media Card (MMC) is a flash memory card standard. MMC cards are cur-
rently available in sizes up to and including 1 GB, and are used in cell phones, mp3
players, digital cameras, and PDA’s.

mikroPascal PRO for PIC provides a library for accessing data on Multi Media Card
via SPI communication.This library also supports SD(Secure Digital) memory cards.

Secure Digital Card

Secure Digital (SD) is a flash memory card standard, based on the older Multi Media
Card (MMC) format.

SD cards are currently available in sizes of up to and including 2 GB, and are used
in cell phones, mp3 players, digital cameras, and PDAs.

Notes:

- Library works with PIC18 family only;

- The library uses the SPI module for communication. User must initialize SPI
module before using the SPI Graphic Lcd Library.
For MCUs with two SPI modules it is possible to initialize both of them and then
switch by using the sp1 set active () routine.

- Routines for file handling can be used only with FAT16 file system.

- Library functions create and read files from the root directory only;

- Library functions populate both FAT1 and FAT2 tables when writing to files, but the
file data is being read from the FAT1 table only; i.e. there is no recovery if FAT1
table is corrupted.

Note: The SPI module has to be initialized through SPI1_lInit_Advanced routine with
the following parameters:

- SPI Master

- 8bit mode

- primary prescaler 16

- Slave Select disabled

- data sampled in the middle of data output time

- clock idle low

- Serial output data changes on transition from idle clock state to active clock state

SPI1 TInit Advanced( SPI_MASTER OSC DIV16, _SPI DATA SAMPLE MIDDLE,
_SPI CLK IDLE LOW, _SPI LOW 2 HIGH); must be called before initializing
Mmc_lInit.

Note: Once the MMC/SD card is initialized, the user can reinitialize SPI at higher
speed. See the Mmc_Init and Mmc_Fat_Init routines.
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External dependencies of MMC Library

The following variable
must be defined in all
projects using MMC
library:

Description: Example :

var Mmc Chip Select :
sbit; sfr; external;

var Mmc Chip Select :

Chip select pin. sbit at RC2 bit;

var var

Mmc Chip Select Direc [Direction of the chip select |Mmc Chip Select Direc
tion : sbit; sfr; Mn_ tion : sbit at
external; TRISCO bit;

Library Routines

- Mmc_Init

- Mmc_Read_Sector
- Mmc_Write_Sector
- Mmc_Read_Cid

- Mmc_Read_Csd

Routines for file handling:

- Mmc_Fat_Init

- Mmc_Fat_QuickFormat

- Mmc_Fat_Assign

- Mmc_Fat_Reset

- Mmc_Fat_Read

- Mmc_Fat_Rewrite

- Mmc_Fat_Append

- Mmc_Fat_Delete

- Mmc_Fat_Write

- Mmc_Fat_Set File_Date
- Mmc_Fat_Get File_Date
- Mmc_Fat_Get_File_Size
- Mmc_Fat_Get Swap_File
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Mmc_Init

Prototype function Mmc_Init(): byte;
- 0 - if MMC/SD card was detected and successfully initialized

Returns .
- 1 - otherwise
Initializes MMC through hardware SPI interface.

e Parameters:

Description
- port: chip select signal port address.
- cspin: chip select pin.
Global variables :
-Mmc Chip select: Chip Select line

. -Mmc Chip Select Direction: Direction of the Chip Select pin

Requires - - -
must be defined before using this function.
The appropriate hardware SPI module must be previously initialized. See the
SPI1_Init, SPI1_Init_Advanced routines.
// MMC module connections
var Mmc Chip Select : sbit at RC2 bit;
var Mmc Chip Select Direction : sbit at TRISC2 bit;
// MMC module connections

Example error = Mmc_Init(); // Init with CS line at RC.2
var i : byte;
SPI1 Init();
i = Mmc Init();
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Mmc_Read_Sector

function Mmc Read Sector (sector: longint; var dbuff: arrayl 512]

PrOtOtype of byte): byte;
- 0 - if reading was successful
Returns .
- 1 - if an error occurred
The function reads one sector (512 bytes) from MMC card.
e Parameters:
Description

- sector: MMC/SD card sector to be read.
- data: buffer of minimum 512 bytes in length for data storage.

Requires MMC/SD card must be initialized. See Mmc_Init.

// read sector 510 of the MMC/SD card

var error : byte;
sectorNo : longint;
Example dataBuffer : arrayl 512] of byte;
sectorNo := 510;
error := Mmc Read Sector (sectorNo, dataBuffer);

Mmc_Write_Sector

function Mmc Write Sector(sector: longint; var data : array| 512]

PrOtOtype of byte): byte;

- 0 - if writing was successful
Returns - 1 - if there was an error in sending write command
- 2 - if there was an error in writing (data rejected)

The function writes 512 bytes of data to one MMC card sector.

o Parameters:
Description

- sector: MMC/SD card sector to be written to.
- data: data to be written (buffer of minimum 512 bytes in length).

Requires MMC/SD card must be initialized. See Mmc_Init.

// write to sector 510 of the MMC/SD card

var error : byte;
sectorNo : longint;
Example dataBuffer : arrayl 512] of byte;
sectorNo := 510;
error := Mmc Write Sector (sectorNo, dataBuffer);
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Mmc_Read_Cid

Prototype function Mmc Read Cid(var data cid: arrayl 16] of byte): byte;

- 0 - if CID register was read successfully

Returns . . :
- 1 - if there was an error while reading

The function reads 16-byte CID register.
Description |[Parameters:

- data cid: buffer of minimum 16 bytes in length for storing CID register content.

Requires MMC/SD card must be initialized. See Mmc_Init.

var error : byte;

dataBuffer : arrayl 16] of byte;
Example yi 16l v

error := MmciReadgCid(dataBuffer);

Mmc_Read_Csd

function Mmc Read Csd(var data for registers: array[ 16] of byte):

Prototype byte;
- 0 - if CSD register was read successfully
Returns . . :
- 1 - if there was an error while reading
The function reads 16-byte CSD register.
e Parameters:
Description

-data for registers: buffer of minimum 16 bytes in length for storing CSD
register content.

Requires MMC/SD card must be initialized. See Mmc_Init.

var error : word;
data for registers : arrayl 16] of byte;
Example —ror_reg v v
error := MmciReadiCsd(dataiforiregisters);
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Mmc_Fat_Init
Prototype function Mmc Fat Init(): byte;

- 0 - if MMC/SD card was detected and successfully initialized
Returns - 1 - if FAT16 boot sector was not found
- 255 - if MMC/SD card was not detected

Initializes MMC/SD card, reads MMC/SD FAT16 boot sector and extracts neces-
sary data needed by the library.

Description
Note: MMC/SD card has to be formatted to FAT16 file system.

Global variables :

-Mmc Chip Select: Chip Select line

. -Mmc Chip Select Direction: Direction of the Chip Select pin
Requires - - -
must be defined before using this function.

The appropriate hardware SPI module must be previously initialized. See the
SPI1_Init, SPI1_Init_Advanced routines.

// MMC module connections

var Mmc Chip Select : sbit at RC2 bit;

var Mmc Chip Select Direction : sbit at TRISC2 bit;
// MMC module connections

SPI1 Init();
Example
// init the FAT library
if (Mmc Fat Init() = 0) then
begin
SPI1 Init();

end
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Mmc_Fat_QuickFormat

Prototype function Mmc Fat QuickFormat (var mmc fat label : string 11]) : byte;

- 0 - if MMC/SD card was detected, successfully formated and initialized
Returns - 1 - if FAT16 format was unseccessful
- 255 - if MMC/SD card was not detected

Formats to FAT16 and initializes MMC/SD card.
Parameters:

- port: chip select signal port address.

- pin: chip select pin.

-mmc fat label: volume label (11 characters in length). If less than 11

D e characters are provided, the label will be padded with spaces. If an empty

escription o )
string is passed, the volume will not be labeled.

Note: This routine can be used instead or in conjunction with the Mmc_Fat_Init

routine.

Note: If MMC/SD card already contains a valid boot sector, it will remain
unchanged (except volume label field) and only FAT and ROOT tables will be
erased. Also, the new volume label will be set.

Requires The appropriate hardware SPI module must be previously initialized.

// format and initialize the FAT library
if (Mmc Fat QuickFormat ('mikroE') = 0) then
Example begin

end;
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Mmc_Fat_Assign

function Mmc Fat Assign(var filename: arrayl 12] of char;

PrOtOtype file cre attr: byte): byte;

- 1 - if file already exists or file does not exist but a new file is created.
- 0 - if file does not exist and no new file is created.

Assigns file for file operations (read, write, delete...). All subsequent file opera-
tions will be applied on an assigned file.

Returns

Parameters:

- filename: name of the file that should be assigned for file operations. File
name should be in DOS 8.3 (file_name.extension) format. The file name and
extension will be automatically padded with spaces by the library if they have
less than length required (i.e. "mikro.tx" -> "mikro .tx "), so the user does not
have to take care of that. The file name and extension are case insensitive.
The library will convert them to proper case automatically, so the user does not
have to take care of that.

Also, in order to keep backward compatibility with the first version of this
library, file names can be entered as UPPERCASE string of 11 bytes in length
with no dot character between file name and extension (i.e. "MIKROELETXT"
-> MIKROELE.TXT). In this case last 3 characters of the string are considered
to be file extension.

L. - file cre attr: file creation and attributs flags. Each bit corresponds to the

Description | ,55r0priate file attribut:

Bit | Mask Description

0 0x01 |Read Only

1 0x02 [|Hidden

2 0x04 [System

3 0x08 [Volume Label

4 0x10 |[Subdirectory

5 0x20 |Archive

6 0x40 |Device (internal use only, never found on disk)

7 0x80 File cre_atioq flag. If _tlje file does .not exist and this flag is set,
a new file with specified name will be created.

Note: Long File Names (LFN) are not supported.

MMC/SD card and MMC library must be initialized for file operations. See

Requires Mmc_Fat_Init.

// create file with archive attribut if it does not already exist

Example Mmc Fat Assign ('MIKRO007.TXT',O0xAO0);
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Mmc_Fat_Reset

Prototype procedure Mmc Fat Reset (var size: dword);

Returns Nothing.

Opens currently assigned file for reading.

A Parameters:
Description

- size: buffer to store file size to. After file has been open for reading, its size is
returned through this parameter.

MMC/SD card and MMC library must be initialized for file operations. See

. Mmc_Fat_Init.
Requires - =
The file must be previously assigned. See Mmc_Fat_Assign.
var size : dword;
Example

Mmc Fat Reset(size);

Mmc_Fat_Read

Prototype procedure Mmc Fat Read(var bdata: byte);

Returns Nothing.

Reads a byte from the currently assigned file opened for reading. Upon function
execution, file pointers will be set to the next character in the file.

Description |Parameters:

- bdata: buffer to store read byte to. Upon this function execution read byte is
returned through this parameter.

MMC/SD card and MMC library must be initialized for file operations. See

Mmc_Fat_Init.

Requires The file must be previously assigned. See Mmc_Fat_Assign.
The file must be opened for reading. See Mmc_Fat_Reset.
var character : byte;

Example

Mmc Fat Read(character);
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Mmc_Fat_Rewrite

Prototype procedure Mmc Fat Rewrite();

Returns Nothing.

Description Opens the currently assigned file for writing. If the file is not empty its content
will be erased.
MMC/SD card and MMC library must be initialized for file operations. See

. Mmc_Fat_Init.

Requires - -
The file must be previously assigned. See Mmc_Fat_Assign.

E I // open file for writing

xample Mmc Fat Rewrite();

Mmc_Fat_Append

Prototype procedure Mmc Fat Append() ;
Returns Nothing.
Opens the currently assigned file for appending. Upon this function execution
Description [file pointers will be positioned after the last byte in the file, so any subsequent
file writing operation will start from there.
MMC/SD card and MMC library must be initialized for file operations. See
. Mmc_Fat_Init.
Requires - -
The file must be previously assigned. See Mmc_Fat_Assign.
Example // open file for appending

Mmc Fat Append();

Mmc_Fat_Delete

Prototype procedure Mmc Fat Delete();
Returns Nothing.
Description [Deletes currently assigned file from MMC/SD card.
MMC/SD card and MMC library must be initialized for file operations. See
. Mmc_Fat_Init.
Requires - -
The file must be previously assigned. See Mmc_Fat_Assign.
Example // delete current file

Mmc Fat Delete();
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Mmc_Fat_Write

Prototype proce(flure Mmc Fat Write(wvar fdata: array[ 512] of byte; data len:
word) ;
Returns Nothing.
Writes requested number of bytes to the currently assigned file opened for writing.
e Parameters:
Description
- fdata: data to be written.
- data len: number of bytes to be written.
MMC/SD card and MMC library must be initialized for file operations. See
Mmc_Fat_Init.
Requires The file must be previously assigned. See Mmc_Fat_Assign.
The file must be opened for writing. See Mmc_Fat_Rewrite or
Mmc_Fat_Append.
var file contents : arrayl 42] of byte;
Example ce.
Mmc Fat Write(file contents, 42); // write data to the assigned file
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Mmc_Fat_Set_File_Date

procedure Mmc Fat Set File Date(year: word; month: byte; day:
byte; hours: byte; mins: byte; seconds: byte);

Prototype

Returns Nothing.

Sets the date/time stamp. Any subsequent file writing operation will write this
stamp to the currently assigned file's time/date attributs.

Parameters:

- year: year attribute. Valid values: 1980-2107
- month: month attribute. Valid values: 1-12

- day: day attribute. Valid values: 1-31

- hours: hours attribute. Valid values: 0-23

- mins: minutes attribute. Valid values: 0-59

- seconds: seconds attribute. Valid values: 0-59

Description

MMC/SD card and MMC library must be initialized for file operations. See
Mmc_Fat_Init.

Requires The file must be previously assigned. See Mmc_Fat_Assign.

The file must be opened for writing. See Mmc_Fat_Rewrite or
Mmc_Fat_Append.

Example Mmc Fat Set File Date(2005,9,30,17,41,0);
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Mmc_Fat_Get_File_Date

Protot procedure Mmc Fat Get File Date(var year: word; var month: byte;
rototype var day: byte; wvar hours: byte; var mins: byte);
Returns Nothing.
Reads time/date attributes of the currently assigned file.
Parameters:
- year: buffer to store year attribute to. Upon function execution year attribute is
returned through this parameter.
Descriotion |- month: buffer to store month attribute to. Upon function execution month
P attribute is returned through this parameter.
- day: buffer to store day attribute to. Upon function execution day attribute is
returned through this parameter.
- hours: buffer to store hours attribute to. Upon function execution hours
attribute is returned through this parameter.
- mins: buffer to store minutes attribute to. Upon function execution minutes
attribute is returned through this parameter.
MMC/SD card and MMC library must be initialized for file operations. See
. Mmc_Fat_Init.
Requires
The file must be previously assigned. See Mmc_Fat_Assign.
var vyear WOId,‘
Exanuﬂe month, day, hours, mins : byte;
MméikatiGetikileiDate(year, month, day, hours, mins);

Mmc_Fat_Get_File_Size

Prototype function Mmc Fat Get File Size(): dword;

Returns Size of the currently assigned file in bytes.

Description |This function reads size of the currently assigned file in bytes.

MMC/SD card and MMC library must be initialized for file operations. See

. Mmc_Fat_Init.
Requires - =
The file must be previously assigned. See Mmc_Fat_Assign.
var my file size : dword;
Example S
my file size := Mmc Fat Get File Size();
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Mmc_Fat_Get_Swap_File

function Mmc Fat Get Swap File(sectors cnt: dword; var filename :

Prototype stringl 11]; file attr : byte) : dword;

- Number of the start sector for the newly created swap file, if there was enough
Returns free space on the MMC/SD card to create file of required size.
- 0 - otherwise.

This function is used to create a swap file of predefined name and size on the
MMC/SD media. If a file with specified name already exists on the media,
search for consecutive sectors will ignore sectors occupied by this file. There-
fore, it is recommended to erase such file if it already exists before calling this
function. If it is not erased and there is still enough space for a new swap file,
this function will delete it after allocating new memory space for a new swap file.

The purpose of the swap file is to make reading and writing to MMC/SD media
as fast as possible, by using the Mmc_Read_Sector() and Mmc_Write_Sector()
functions directly, without potentially damaging the FAT system. The swap file
can be considered as a "window" on the media where the user can freely
write/read data. Its main purpose in the mikroPascal's library is to be used for
fast data acquisition; when the time-critical acquisition has finished, the data
can be re-written into a "normal” file, and formatted in the most suitable way.

Parameters:

Description |- sectors_cnt:number of consecutive sectors that user wants the swap file to
have.

- filename: name of the file that should be assigned for file operations. File
name should be in DOS 8.3 (file_name.extension) format. The file name and
extension will be automatically padded with spaces by the library if they have
less than length required (i.e. "mikro.tx" -> "mikro .tx "), so the user does not
have to take care of that. The file name and extension are case insensitive.
The library will convert them to proper case automatically, so the user does not
have to take care of that.

Also, in order to keep backward compatibility with the first version of this
library, file names can be entered as UPPERCASE string of 11 bytes in length
with no dot character between file name and extension (i.e. "MIKROELETXT" -
> MIKROELE.TXT). In this case the last 3 characters of the string are
considered to be file extension.

- file attr: file creation and attributs flags. Each bit corresponds to the appro-
priate file attribut:
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Bit | Mask Description
0 0x01 [Read Only
1 0x02 |Hidden
2 0x04 [System
3 0x08 [Volume Label

Description | ™5™17.90 |Subdirectory
5 0x20 [Archive
6 0x40 |Device (internal use only, never found on disk)
7 0x80 [Not used

Note: Long File Names (LFN) are not supported.

MMC/SD card and MMC library must be initialized for file operations. See

Requires Mmc_Fat_Init.

/)= Try to create a swap file with archive atribute,
whose size will be at least 1000 sectors.

// If it succeeds, it sends No. of start sector
over USART

var size : dword;

size := Mmc Fat Get Swap File (1000, 'mikroE.txt', 0x20);

if (size <> 0) then

begin
UART1 Write
UART1 Write
UART1 Write
UART1 Write
UART1 Write
UART1 Write

end;

Example

0xARD) ;

Lo (size));
Hi(size)):;
Higher (size));
Highest (size));
0xAR) ;

Library Example

The following example demonstrates MMC library test. Upon flashing, insert a MMC/SD card into
the module, when you should receive the "Init-OK" message. Then, you can experiment with
MMC read and write functions, and observe the results through the Usart Terminal.
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program MMC Test;
{ SDEFINE RS232 debug}

var MMC chip select

const FILL CHAR = 'm';
var i, SectorNo word;
var mmc_error byte;
var data ok : bit;

// Variables for MMC routines

SectorData arrayl 512]
reading/writing
data for registers
registers

sbit at RC2 bit;
var MMC chip select direction

sbit at TRISC2 bit;

// Buffer for MMC

of Dbyte; sector

arrayl 16] of byte; // buffer for CID and CSD

// UART write text and new line (carriage return + line feed)
procedure UART Write Line( var uart text : byte );

begin

UARTl_Write Text (uart text);

UART1 Write(13);
UART1 Write (10);
end;

// Display byte in hex
// Display byte in hex

procedure printhex( i : byte

var high, low byte;
begin

high := i and O0xFO;

high := high shr 4;

high := high + '0';

if ( high > '9' ) then
high := high + 7;

low := (i and O0xO0F) +

if ( low > '9' ) then
low := low + 7 ;

UART1 Write (high);
UART1 Write (low);

end;

begin

ADCON1 := ADCON1 or O0xO0F;
CMCON := CMCON or 7;

);

// High nibble

'0'; // Low nibble

// Configure AN pins as digital
// Turn off comparators
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// Initialize UART1 module
UART1 Init(19200);
Delay ms (10);

UART Write Line('PIC-Started'); // PIC present report
// Initialize SPI1 module
SPI1 Init Advanced( SPI MASTER OSC DIV64, SPI DATA SAMPLE MIDDLE,

_SPI_CLK IDLE LOW, SPI LOW 2 HIGH);

// initialise a MMC card

mmc_error := Mmc Init();
if ( mmc _error = 0 ) then

UART Write Line ('MMC Init-OK') // If MMC present report
else

UART Write Line('MMC Init-error'); // If error report

// Fill MMC buffer with same characters
for i := 0 to 511 do
SectorDatal i] := FILL CHAR;

// Write sector
mmc _error := Mmc_Write_Sector(SectorNo, SectorData) ;
if ( mmc error = 0 ) then
UART Write Line ('Write-OK'")
else // if there are errors.....
UART_Write_Line('Write—Error');

// Reading of CID register
mmc_error := Mmc Read Cid(data for registers);
if ( mmc error = 0 ) then
begin
UART1 Write Text ('CID : '");
for i := 0 to 15 do
printhex (data for registers[ i]);
UART Write Line (' ")
end
else
UART Write Line ('CID-error');

// Reading of CSD register
mmc_error := Mmc Read Csd(data for registers);
if ( mmc error = 0 ) then
begin
UART1 Write Text('CSD : '");
for i := 0 to 15 do
printhex (data for registers[ i]);
UART Write Line (' ")
end
else
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UART Write Line('CSD-error');
// Read sector
mmc_error := Mmc Read Sector (SectorNo, SectorData);
if ( mmc error = 0 ) then

UART Write Line ('Read-OK')
else // if there are errors.....
UART Write Line('Read-Error');

// Chech data match
data ok := 1;
for i := 0 to 511 do
begin
UART1 Write (SectorDatal i]);
if (SectorDatal i] <> FILL CHAR)
begin
data ok := 0;
break;
end;
end;

if ( data ok <> 0 ) then

UART Write Line('Content-OK'")
else

UART Write Line('Content-Error');

// Signal test end

UART Write Line('Test End.');
end.

HW Connection

then

1~
I I
I ]
j ]
I 8 |
| 2.0
Voo W i)
O_E m GND Elr_h, MC.C58
,QﬁllLA‘m_. VOO Yoo SPI-M051
1] eno E i SPLECK H] H]
—— — CLKIN m 1] R13 RIT
i Ny i 2k2 24z
I I
1 © |
RC2 RCS
RC3 Red []
i i mg Q,.(
I I I I 1
[

Pin diagram of MMC memory card

MMC/SD
CARD
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ONEWIRE LIBRARY

The OneWire library provides routines for communication via the Dallas OneWire
protocol, for example with DS18x20 digital thermometer. OneWire is a Master/Slave
protocol, and all communication cabling required is a single wire. OneWire enabled
devices should have open collector drivers (with single pull-up resistor) on the
shared data line.

Slave devices on the OneWire bus can even get their power supply from data line.
For detailed schematic see device datasheet.

Some basic characteristics of this protocol are:

- single master system,

- low cost,

- low transfer rates (up to 16 kbps),

- fairly long distances (up to 300 meters),
- small data transfer packages.

Each OneWire device has also a unique 64-bit registration number (8-bit device
type, 48-bit serial number and 8-bit CRC), so multiple slaves can co-exist on the
same bus.

Note: Oscillator frequency Fosc needs to be at least 8MHz in order to use the rou-
tines with Dallas digital thermometers.

Note: This library implements time-based activities, so interrupts need to be dis-
abled when using OneWire library.

Library Routines
- Ow_Reset

- Ow_Read
- Ow_Write
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Ow_Reset
Prototype function Ow Reset (var port : byte; pin : byte) : byte;

Returns 0 if DS1820 is present, and 1 if not present.

Issues OneWire reset signal for DS1820. Parameters port and pin specify the

Description | ation of DS1820.
Requires Works with Dallas DS1820 temperature sensor only.
To reset the DS1820 that is connected to the RA5 pin:
Example
Ow_Reset (PORTA, 5);
Ow_Read
Prototype function Ow Read(var port : byte; pin : byte) : byte;
Returns Data read from an external device over the OneWire bus.

Description |Reads one byte of data via the OneWire bus.

Requires Works with Dallas DS1820 temperature sensor only.

Example tmp := Ow_Read (PORTA, 5);

Ow_Write

Prototype procedure Ow Write(var port : byte; pin, par : byte);

Returns Nothing.

Description |Writes one byte of data (argument par) via OneWire bus.

Requires Works with Dallas DS1820 temperature sensor only.

Example Ow_Write (PORTA, 5, $CC);

Library Example

This example reads the temperature using DS18x20 connected to pin PORTA.5. After reset, MCU
obtains temperature from the sensor and prints it on the Lcd. Make sure to pull-up PORTA.5 line
and to turn off the PORTA LEDs.
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program OneWire;

// LCD module connections

var LCD RS :
LCD _EN
LCD D4
LCD D5
LCD D6
LCD D7

sb
sb
sb
sb
sb

LCD_RS Dlrectlon
LCD_EN_DlIeCthD
LCD D4 Direction
LCD D5 Direction
LCD D6 Direction
LCD D7 Direction

sbit

at RB4 bit;
at RBS bit;
at RBO bit;
at RB1 bit;
at RB2 bit;
at RB3 blt
sbit
sbit
sbit
sbit
sbit
sbit

it
it
it
it
it
at
at
at
at
at
at

TRISB4 bit;
TRISB5 bit;
TRISBO bit;
TRISB1 bit;
TRISB2 bit;
TRISB3 bit;

// End LCD "module connections

// ~ Set TEMP_R
DS18x20 sensor:

ESOLUTION to the

corresponding resolution of

// 18S20: 9 (default setting; can be 9,10,11,or 12)
// 18B20: 12
const TEMP RESOLUTION byte = 9;
var text arrayl 9] of byte;
temp word;
procedure Display Temperature( tempZwrite word

const RES SHIFT

var temp whole

8;

TEMP_ RESOLUTION

byte;

temp fraction word;
begin
text := '000.0000"';
// check if temperature is negative
if (temp2write and 0x8000) then
begin
text[ 0] := '-=-';
temp2write := not temp2write + 1;
end;

// extract
temp whole

// convert

temp whole

temp whole to characters

if ( temp whole div 100 ) then
text[ 0] := temp whole div 100 + 48
else
text[ 0] = '0";

word (temp2write shr RES SHIFT);

);

used
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text[ 1] := (temp whole div 10)mod 10 + 48; // Extract tens digit
text[ 2] := temp whole mod 10 + 48; // Extract ones digit

// extract temp fraction and convert it to unsigned int

temp fraction := word(temp2write shl (4-RES SHIFT));
temp fraction := temp fraction and 0x000F;
temp fraction := temp fraction * 625;

// convert temp fraction to characters

text[ 4] := word(temp fraction diwv 1000) + 48; //
Extract thousands digit

text[ 5] := word((temp fraction div 100)mod 10 + 48); //
Extract hundreds digit

text[ 6] := word((temp fraction div 10)mod 10 + 48); //
Extract tens digit

text[ 7] := word(temp fraction mod 10) + 48; //

Extract ones digit

// print temperature on LCD
Lcd Out (2, 5, text);

end;
begin

ANSEL = 0; // Configure AN pins as digital I/O

ANSELH := 0;

text := '000.0000"';

Led Init () // Initialize Lcd

Lcd Cmd (_LCD _CLEAR) ; // Clear Lcd

Lcd Cmd ( LCD _CURSOR _OFF) ; // Turn cursor off

Led Out(l, 1, ' Temperature: L

Lcd Chr(2,13,223); // Print degree character, 'C' for Centigrades
// different Lcd displays have different char code for degree

Led Chr(2,14,'C'); // if you see greek alpha letter try typing

178 instead of 223

//--- main loop
while (TRUE) do
begin
//--- perform temperature reading
Ow_Reset (PORTA, 5); // Onewire reset signal
Ow Write (PORTA, 5, 0xCC); // Issue command SKIP ROM
Ow Write (PORTA, 5, 0x44); // Issue command CONVERT T
(

Delay us(120);
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Ow_Reset (PORTA, 5);

Ow _Write (PORTA, 5, 0xCC); // Issue command SKIP ROM

Ow _Write (PORTA, 5, OxBE); // Issue command READ SCRATCHPAD
temp := Ow_Read(PORTA, 5);

temp := (Ow_Read(PORTA, 5) shl 8) + temp;

//--- Format and display result on Lcd

Display Temperature (temp) ;
Delay ms (520);

end;
end.

HW Connection

125°C

q

RBS
RB4
RE3
RB2Z
RB1
RBO

GND [

r-lo-u—u—u—u——u—u—u—n—u—u—u

_CSCILLATOR gt

N & §
,884910lId

9IND

LCD 2X16

Example of DS1820 connection
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PORT EXPANDER LIBRARY

The mikroPascal PRO for PIC provides a library for communication with the
Microchip’s Port Expander MCP23S17 via SPI interface. Connections of the PIC
compliant MCU and MCP23S17 is given on the schematic at the bottom of this

page.

Note: Library uses the SPI module for communication. The user must initialize SPI

module before using the Port Expander Library.

Note: Library does not use Port Expander interrupts.

External dependencies of Port Expander Library

The following variables
must be defined in all

sbit; sfr; external;

. . Description: Example :
projects using Port P P
Expander Library:

var SPExpanderRST : . var SPExpanderRST :
e e Reset line. o -

sbit at RCO bit;

var SPExpanderCS :
sbit; sfr; external;

Chip Select line.

var SPExpanderCS
sbit at RC1 bit;

Direction of the Chip

SPExpanderCS Direction .
- Select pin.

: sbit; sfr; external;

var var

SPExpanderRST Directi . . . SPExpanderRST Directi
SrEnpanderist Direction of the Reset pin. |~ 77" =

on : sbit; sfr; on : sbit at
external; TRISCO bit;

var var

SPExpanderCS Direction
: sbit at TRISCI bit;

Library Routines

- Expander_Init

- Expander_Read_Byte

- Expander_Write_Byte

- Expander_Read_PortA

- Expander_Read_PortB

- Expander_Read_PortAB

- Expander_Write_PortA

- Expander_Write_PortB

- Expander_Write_PortAB

- Expander_Set DirectionPortA
- Expander_Set DirectionPortB
- Expander_Set DirectionPortAB
- Expander_Set PullUpsPortA
- Expander_Set PullUpsPortB
- Expander_Set PullUpsPortAB
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Expander_lInit

Prototype procedure Expander Init (ModuleAddress : byte);

Returns Nothing.

Initializes Port Expander using SPI communication.

Port Expander module settings :

- hardware addressing enabled

- automatic address pointer incrementing disabled (byte mode)
Description |- BANK_O register adressing

- slew rate enabled

Parameters :

- ModuleAddress: Port Expander hardware address, see schematic at the
bottom of this page

Global variables :

- sPExpandercs: Chip Select line
- sPExpanderRST: Reset line
- SPExpanderCS Direction: Direction of the Chip Select pin

Requires T ;
9 - SPExpanderRST Direction: Direction of the Reset pin
must be defined before using this function.
SPI module needs to be initialized. See SPI1_Init and SPI1_Init Advanced routines.
// Port Expander module connections
var SPExpanderRST : sbit at RCO bit;
SPExpanderCS : sbit at RC1 bit;
SPExpanderRST Direction : sbit at TRISCO bit;
SPExpanderCS Direction : sbit at TRISCl bit;
Example = -

// End of Port Expander module connections

SPI Init(); // initialize SPI module
Expander Init (0); // 1initialize port expander
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Expander_Read_Byte

function Expander Read Byte (ModuleAddress : byte; RegAddress

PrOtOtype byte) : byte;

Returns Byte read.
The function reads byte from Port Expander.
Parameters :

Description

- ModuleAddress: Port Expander hardware address, see schematic at the
bottom of this page
- Regiddress: Port Expander's internal register address

Requires Port Expander must be initialized. See Expander_|Init.

// Read a byte from Port Expander's register

var read data : byte;
Example - ’

read data := Expander Read Byte(0,1);

Expander_Write_Byte

procedure Expander Write Byte (ModuleAddress: byte; RegAddress:

PrOtOtype byte; Data : byte);
Returns Nothing.
Routine writes a byte to Port Expander.
Parameters :
Description |_ ModuleAddress: Port Expander hardware address, see schematic at the
bottom of this page
- Regiddress: Port Expander's internal register address
- Data : data to be written
Requires Port Expander must be initialized. See Expander_Init.
Example // Write a byte to the Port Expander's register

Expander Write Byte(0,1,0xFF);
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Expander_Read_PortA

Prototype

function Expander Read PortA (ModuleAddress: byte): byte;

Returns

Byte read.

Description

The function reads byte from Port Expander's PortA.
Parameters :

- ModuleAddress: Port Expander hardware address, see schematic at the
bottom of this page

Requires

Port Expander must be initialized. See Expander_|nit.

Port Expander's PortA should be configured as input. See Expander_Set_Direc-
tionPortA and Expander_Set_DirectionPortAB routines.

Example

// Read a byte from Port Expander's PORTA
var read data : byte;

Expander Set DirectionPortA(0,0xFF); // set expander's
porta to be input

read data := Expander Read PortA(0);
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Expander_Read_PortB

Prototype function Expander Read PortB (ModuleAddress: byte): byte;

Returns Byte read.

The function reads byte from Port Expander's PortB.

. Parameters :
Description

- ModuleAddress: Port Expander hardware address, see schematic at the
bottom of this page

Port Expander must be initialized. See Expander_Init.

Requires ) . .
q Port Expander's PortB should be configured as input. See Expander_Set_Direc-
tionPortB and Expander_Set_DirectionPortAB routines.
// Read a byte from Port Expander's PORTB
var read data : byte;
Exanuﬂe Expander Set DirectionPortB (0, 0xFF); // set expander's

portb to be input

read data := Expander Read PortB(0);
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Expander_Read_PortAB

Prokﬂype function Expander Read PortAB (ModuleAddress: byte): word;

Returns Word read.

The function reads word from Port Expander's ports. PortA readings are in the
higher byte of the result. PortB readings are in the lower byte of the result.

Description |Parameters :

- ModuleAddress: Port Expander hardware address, see schematic at the
bottom of this page

Port Expander must be initialized. See Expander_Init.

Requires Port Expander's PortA and PortB should be configured as inputs. See
Expander_Set_DirectionPortA, Expander_Set_DirectionPortB and
Expander_Set_DirectionPortAB routines.

// Read a byte from Port Expander's PORTA and PORTB
var read data : word;

Exan“ﬂe Expander Set DirectionPortAB (0, OxFFFF); // set expander's
porta and portb to be input

read data := Expander Read PortAB(O0);
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Expander_Write_PortA

Prokﬂype procedure Expander Write PortA(ModuleAddress: byte; Data : byte);

Returns Nothing.

The function writes byte to Port Expander's PortA.

Parameters :

Description

- ModuleAddress: Port Expander hardware address, see schematic at the
bottom of this page

- Data : data to be written

Port Expander must be initialized. See Expander_Init.

R ir )
equires Port Expander's PortA should be configured as output. See
Expander_Set_DirectionPortA and Expander_Set_DirectionPortAB routines.
// Write a byte to Port Expander's PORTA
Example Expander Set DirectionPortA(0,0x00); // set expander's

porta to be output

Expander Write PortA (0, OxAA);
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Expander_Write_PortB

Prototype procedure Expander Write PortB(ModuleAddress: byte; Data : byte);
Returns Nothing.
The function writes byte to Port Expander's PortB.
Parameters :
Description
- Moduleaddress: Port Expander hardware address, see schematic at the
bottom of this page
- Data : data to be written
Port Expander must be initialized. See Expander_|Init.
Requires Port Expander's PortB should be configured as output. See
Expander_Set_DirectionPortB and Expander_Set_DirectionPortAB routines.
// Write a byte to Port Expander's PORTB
Example Expander Set DirectionPortB(0,0x00); // set expander's
portb to be output
Expanderiwﬁ te PortB (0, 0x595);
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Expander_Write_PortAB

Prototype procedure Expander Write PortAB (ModuleAddress: byte; Data : word);

Returns Nothing.

The function writes word to Port Expander's ports.

Parameters :

Description | Moduleaddress: Port Expander hardware address, see schematic at the
bottom of this page

- bata : data to be written. Data to be written to PortA are passed in Data's
higher byte. Data to be written to PortB are passed in Data's lower byte

Port Expander must be initialized. See Expander_|nit.

Requires Port Expander's PortA and PortB should be configured as outputs. See
Expander_Set_DirectionPortA, Expander_Set_DirectionPortB and
Expander_Set_DirectionPortAB routines.

// Write a byte to Port Expander's PORTA and PORTB

Example Expander Set DirectionPortAB(0,0x0000) ; // set expander's
porta and portb to be output

Expander Write PortAB(0, OxAA55);
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Expander_Set_DirectionPortA

procedure Expander Set DirectionPortA (ModuleAddress: byte; Data :

Prototype byte) ;

Returns Nothing.

The function sets Port Expander's PortA direction.
Parameters :

Description |- Moduleaddress: Port Expander hardware address, see schematic at the
bottom of this page

- bata : data to be written to the PortA direction register. Each bit corresponds
to the appropriate pin of the PortA register. Set bit designates corresponding
pin as input. Cleared bit designates corresponding pin as output.

Requires Port Expander must be initialized. See Expander_Init.

// Set Port Expander's PORTA to be output

Example Expander Set DirectionPortA(0,0x00);

Expander_Set_DirectionPortB

procedure Expander Set DirectionPortB(ModuleAddress: byte; Data :

Prototype byte) ;

Returns Nothing.

The function sets Port Expander's PortB direction.
Parameters :

Description |- Moduleaddress: Port Expander hardware address, see schematic at the
bottom of this page

- pata : data to be written to the PortB direction register. Each bit corresponds
to the appropriate pin of the PortB register. Set bit designates corresponding
pin as input. Cleared bit designates corresponding pin as output.

Requires Port Expander must be initialized. See Expander_lnit.

// Set Port Expander's PORTB to be input

Exan“ﬂe Expander Set DirectionPortB(0,0xFF);
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Expander_Set_DirectionPortAB

procedure Expander Set DirectionPortAB (ModuleAddress: byte;
Direction: word);

Prototype

Returns Nothing.

The function sets Port Expander's PortA and PortB direction.
Parameters :

- Moduleaddress: Port Expander hardware address, see schematic at the
bottom of this page

- Direction: data to be written to direction registers. Data to be written to the
PortA direction register are passed in Direction's higher byte. Data to be
written to the PortB direction register are passed in pirection's lower byte.
Each bit corresponds to the appropriate pin of the PortA/PortB register. Set bit
designates corresponding pin as input. Cleared bit designates corresponding
pin as output.

Description

Requires Port Expander must be initialized. See Expander_Init.

// Set Port Expander's PORTA to be output and PORTB to be input

Exan“ﬂe Expander Set DirectionPortAB (0, 0x00FF);

Expander_Set_PullUpsPortA

procedure Expander Set PullUpsPortA(ModuleAddress: byte; Data :

Prototype byte) ;

Returns Nothing.

The function sets Port Expander's PortA pull up/down resistors.
Parameters :

Description |- Moduleaddress: Port Expander hardware address, see schematic at the
bottom of this page

- pata : data for choosing pull up/down resistors configuration. Each bit
corresponds to the appropriate pin of the PortA register. Set bit enables pull-up
for corresponding pin.

Requires Port Expander must be initialized. See Expander_Init.

// Set Port Expander's PORTA pull-up resistors

Example Expander Set PullUpsPortA (0, OxFF);
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Expander_Set_PullUpsPortB

procedure Expander Set PullUpsPortB (ModuleAddress: byte; Data :

Prototype byte) ;

Returns Nothing.

The function sets Port Expander's PortB pull up/down resistors.
Parameters :

Description |- ModuleAddress: Port Expander hardware address, see schematic at the
bottom of this page

- bData : data for choosing pull up/down resistors configuration. Each bit
corresponds to the appropriate pin of the PortB register. Set bit enables
pull-up for corresponding pin.

Requires Port Expander must be initialized. See Expander_Init.

// Set Port Expander's PORTB pull-up resistors

Example Expander Set PullUpsPortB(0, OxFF);

Expander_Set_PullUpsPortAB

procedure Expander Set PullUpsPortAB (ModuleAddress: byte;

Prototype PullUps: word);

Returns Nothing.

The function sets Port Expander's PortA and PortB pull up/down resistors.
Parameters :

- Moduleaddress: Port Expander hardware address, see schematic at the

Description | bottom of this page

- pullups: data for choosing pull up/down resistors configuration. PortA pull
up/down resistors configuration is passed in PullUps's higher byte. PortB pull
up/down resistors configuration is passed in PullUps's lower byte. Each bit
corresponds to the appropriate pin of the PortA/PortB register. Set bit enables
pull-up for corresponding pin.

Requires Port Expander must be initialized. See Expander_Init.

// Set Port Expander's PORTA and PORTB pull-up resistors

Example Expander Set PullUpsPortAB (0, OxFFFF);
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Library Example
The example demonstrates how to communicate with Port Expander MCP23S17.

Note that Port Expander pins A2 A1 A0 are connected to GND so Port Expander
Hardware Address is 0.

program PortExpander;

// Port Expander module connections
var SPExpanderRST : sbit at RCO bit;

SPExpanderCS : sbit at RC1l bit;
SPExpanderRST Direction : sbit at TRISCO bit;
SPExpanderCS Direction : sbit at TRISC1 bit;

// End Port Expander module connections

var counter : byte;// = 0;
begin
counter 0;
ANSEL := O0; // Configure AN pins as digital I/O
ANSELH := 0;
TRISB := 0; // Set PORTB as output
PORTB := 0xFF;

// If Port Expander Library uses SPI1 module

SPI1 Init(); // Initialize SPI module used with PortExpander

Expander Init (0); // Initialize Port Expander

Expander Set DirectionPortA (0, 0x00); // Set Expander's PORTA to
be output

Expander Set DirectionPortB(0,0xFF); // Set Expander's PORTB to
be input

Expander Set PullUpsPortB (0, 0xFF); // Set pull-ups to all of

the Expander's PORTB pins

while ( TRUE ) do // Endless loop
begin
Expander Write PortA(0, counter); // Write i to expander's
PORTA

Inc (counter) ;
PORTB := Expander Read PortB(0); // Read expander's PORTB
and write it to LEDs
Delay ms (100);
end;

end.
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PS/2 LIBRARY
The mikroPascal PRO for PIC provides a library for communication with the com-
mon PS/2 keyboard.
Note: The library does not utilize interrupts for data retrieval, and requires the oscil-
lator clock to be at least 6MHz.
Note: The pins to which a PS/2 keyboard is attached should be connected to the
pull-up resistors.
Note: Although PS/2 is a two-way communication bus, this library does not provide
MCU-to-keyboard communication; e.g. pressing the Caps Lock key will not turn on
the Caps Lock LED.
External dependencies of PS/2 Library

The following variables

must be defined in all Description: Example :

projects using PS/2 P ) ple -
Library:
var PS2 Data : sbit; . var PS2 Data : sbit
sfr; external; PS/2 Data line. at RCO bit;
var PS2 Clock : sbit; . var PS2 Clock : sbit
sfr; eerrnal; PS/2 Clock line. at RC1 bit;
var . . Direction of the PS/2 Data |'°* . |
PS2 Data Direction : \ PS2 Data Direction :
sbit; sfr; external; pin. sbit at TRISCO bit;
var . . var
PS2 Clock Direction : DII’GCtIO!’] of the PS/2 PS2 Clock Direction :
sbit; sfr; external; Clock pin. sbit at TRISCl bit;
Library Routines
- Ps2_Config
- Ps2_Key_Read
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Ps2_Config
Prototype procedure Ps2 Config();
Returns Nothing.
Description |[Initializes the MCU for work with the PS/2 keyboard.
Global variables :
- ps2 Dpata: Data signal line
. - Ps2 Clock: Clock signal line
Requires - ‘ , L .
- Ps2 Data Direction: Direction of the Data pin
- PS2 Clock Direction: Direction of the Clock pin
must be defined before using this function.
// PS2 pinout definition
var PS2 Data : sbit at RCO bit;
var PS2 Clock : sbit at RC1l bit;
var PS2 Data Direction : sbit at TRISCO bit;
Example var PS2 Clock Direction : sbit at TRISCI1 bit;
// End of PS2 pinout definition
Ps2 Config(); // Init PS/2 Keyboard
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Ps2_Key_Read

function Ps2 Key Read(var value: byte; wvar special: byte; var

Prototype pressed: byte): byte;

- 1 if reading of a key from the keyboard was successful

Returns - 0 if no key was pressed

The function retrieves information on key pressed.
Parameters :

- value: holds the value of the key pressed. For characters, numerals,

Description | punctuation marks, and space vz1ue will store the appropriate ASCII code.
Routine “recognizes” the function of Shift and Caps Lock, and behaves
appropriately. For special function keys see Special Function Keys Table.

- special: is a flag for special function keys (F1, Enter, Esc, etc). If key
pressed is one of these, special will be set to 1, otherwise 0.

- pressed: is set to 1 if the key is pressed, and 0 if it is released.

Requires PS/2 keyboard needs to be initialized. See Ps2_Config routine.

var value, special, pressed: byte;

// Press Enter to continue:

Example repeat
if (Ps2 Key Read(value, special, pressed)) then
if ((value = 13) and (special = 1)) then break;
until (0=1);
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Special Function Keys

Key Value returned Num Lock 29
F1 1 Left Arrow 30
F2 2 Right Arrow 31
F3 3 Up Arrow 32
F4 4 Down Arrow 33
F5 5 Escape 34
F6 6 Tab 35
F7 7

F8 8

F9 9

F10 10

F11 11

F12 12

Enter 13

Page Up 14

Page Down 15

Backspace 16

Insert 17
Delete 18
Windows 19
Ctrl 20
Shift 21
Alt 22
Print Screen (23
Pause 24
Caps Lock 25
End 26
Home 27

Scroll Lock 28
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Library Example

This simple example reads values of the pressed keys on the PS/2 keyboard and
sends them via UART.

program PS2 Example;
var keydata, special, down : byte;

var PS2 Data : sbit at RCO bit;
PS2 Clock : sbit at RC1 bit;

PS2 Data Direction : sbit at TRISCO bit;
PS2 Clock Direction : sbit at TRISC1 bit;

begin
ANSEL := 0; // Configure AN pins as digital I/O
ANSELH := 0;
keydata := 0;
special := 0;
down := 0;
UART1 Init(19200); // Initialize UART module at 19200 bps
Ps2 Config(); // Init PS/2 Keyboard
Delay ms (100); // Wait for keyboard to finish
UART1 Write Text ('Ready');
while TRUE do // Endless loop
begin
if Ps2 Key Read(keydata, special, down) then // If data
was read from PS/2
begin
if (down <> 0) and (keydata = 16) then // Backspace read
begin
UART1 Write(0x08); //Send Backspace to usart terminal
end
else if (down <> 0) and (keydata = 13) then // Enter read
begin
UART1 Write(10); // Send
carriage return to usart terminal
UART1 Write(13); // Uncomment this line
if usart terminal also expects line feed
// for new line transition
end
else if (down <> 0) and (special = 0) and (keydata <>
0) then // Common key read
begin
UART1 Write (keydata); // Send key to usart terminal
end;
end;
Delay ms(1); // Debounce period
end;

end.

374 MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



CHAPTER 7
mikroPASCAL PRO for PIC Libraries

HW Connection
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PWM LIBRARY

CCP module is available with a number of PIC MCUs. provides library which simplifies using PWM
HW Module.

Note: Some MCUs have multiple CCP modules. In order to use the desired CCP library routine,
simply change the number 1 in the prototype with the appropriate module number, i.e.
PWM2 Start();

Library Routines

- PWM1_Init

- PWM1_Set_Duty
- PWM1_Start

- PWM1_Stop

PWM1_Init

Prototype procedure PWMl Init (freg : longint);

Returns Nothing.

Initializes the PWM module with duty ratio 0. Parameter freq is a desired PWM
frequency in Hz (refer to device data sheet for correct values in respect with
Description [Fosc).

This routine needs to be called before using other functions from PWM Library.

MCU must have CCP module.

Note: Calculation of the PWM frequency value is carried out by the compiler, as

Requires it would produce a relatively large code if performed on the libary level.
Therefore, compiler needs to know the value of the parameter in the compile
time. That is why this parameter needs to be a constant, and not a variable.
Initialize PWM module at 5KHz:

Example

PWM1 TInit (5000);
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PWM1_Set_Duty

Prototype procedure PWM1 Set Duty(duty ratio : byte);

Returns Nothing.

sets PWM duty ratio. Parameter duty takes values from 0 to 255, where 0 is
Description |0%, 127 is 50%, and 255 is 100% duty ratio. Other specific values for duty ratio
can be calculated as (percent*255)/100.

Requires MCU must have CCP module. PWM1_Init must be called before using this routine.

Set duty ratio to 75%:

Example
PWM1 Set Duty(192);

PWM1_Start

Prototype |[procedure puMl Start();

Returns Nothing.
Description |Starts PWM.

Requires MCU must have CCP module. PWM1_Init must be called before using this routine.

Example PWML Start();

PWM1_Stop

Prototype |procedure PWMI1 Stop();

Returns Nothing.

Description |Stops PWM.

MCU must have CCP module. PWM1_Init must be called before using this rou-
Requires tine. PWM1_Start should be called before using this routine, otherwise it will
have no effect as the PWM module is not running.

Example PWM1 Stop () ;

Library Example

The example changes PWM duty ratio on RC1 and RC2 pins continually. If LED is connected to
these pins, you can observe the gradual change of emitted light.
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program PWM Test;
var current duty, current dutyl, old duty, old dutyl : byte;

procedure InitMain();

begin
ANSEL := 0; // Configure AN pins as digital I/0O
ANSELH := 0;
PORTA := 255;
TRISA := 255; // configure PORTA pins as input
PORTB := 0; // set PORTB to O
TRISB := 0; // designate PORTB pins as output
PORTC := 0; // set PORTIC to O
TRISC := 0; // designate PORTC pins as output
PWM1 Init (5000); // Initialize PWMl module at 5KHz
PWM2 Init (5000); // Initialize PWM2 module at 5KHz
end;
begin
InitMain () ;
current duty := 16; // initial value for current duty
current dutyl := 16; // initial value for current dutyl
PWM1 Start(); // start PWM1
PWM2 Start(); // start PWM2
PWM1 Set Duty(current duty); // Set current duty for PWMI
PWM2 Set Duty(current dutyl); // Set current duty for PWM2
while (TRUE) do // endless loop
begin
if (RAO bit <> 0) then // button on RAO pressed
begin
Delay ms (40);
Inc (current duty); // increment current duty
PWM1 Set Duty(current duty);
end;
if (RALl bit <> 0) then // button on RAl pressed
begin
Delay ms (40) ;
Dec (current duty); // decrement current duty
PWM1 Set Duty(current duty);
end;
if (RA2 bit <> 0) then // button on RA2 pressed
begin
Delay ms (40);
Inc (current dutyl); // increment current dutyl
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PWM2 Set Duty(current dutyl);
end;
if (RA3 bit <> 0) then // button on RA3 pressed
begin
Delay ms (40);
Dec (current dutyl); // decrement current dutyl
PWM2 Set Duty(current dutyl);
end;
Delay ms(5); // slow down change pace a little
end;

end.

HW Connection
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RS-485 LIBRARY

RS-485 is a multipoint communication which allows multiple devices to be connect-
ed to a single bus. The mikroPascal PRO for PIC provides a set of library routines
for comfortable work with RS485 system using Master/Slave architecture. Master
and Slave devices interchange packets of information. Each of these packets con-
tains synchronization bytes, CRC byte, address byte and the data. Each Slave has
unique address and receives only packets addressed to it. The Slave can never ini-
tiate communication.

It is the user’s responsibility to ensure that only one device transmits via 485 bus at
a time.

The RS-485 routines require the UART module. Pins of UART need to be attached
to RS-485 interface transceiver, such as LTC485 or similar (see schematic at the
bottom of this page).

Note: The library uses the UART module for communication. The user must initial-
ize the appropriate UART module before using the RS-485 Library. For MCUs with
two UART modules it is possible to initialize both of them and then switch by using
the UART_Set_Active function. See the UART Library functions.

Library constants:
- START byte value = 150
- STOP byte value = 169

- Address 50 is the broadcast address for all Slaves (packets containing address 50
will be received by all Slaves except the Slaves with addresses 150 and 169).

External dependencies of RS-485 Library

The following variable

must be defined in all

projects using RS-485
Library:

Description: Example :

Control RS-485 Trans-

var RS485 rxtx pin : . . .
T P mit/Receive operation

sbit; sfr; external;

var RS485 rxtx pin :
sbit at RC2 bit;

mode
var var
RS485 rxtx pin direc- |Direction of the RS-485 RS485 rxtx pin direc-
tion : sbit; sfr; TTansnﬂUReceNe[jn tion : sbit at
external; TRISC2 bit;
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Library Routines

- RS485Master_Init

- RS485Master_Receive
- RS485Master_Send

- RS485Slave_Init

- RS485Slave Receive
- RS485Slave_Send

RS485Master_Init

Prototype |procedure RS485Master Init();

Returns Nothing.

Description |[Initializes MCU as a Master for RS-485 communication.

Global variables :

- RS485 rxtx pin - this pin is connected to RE/DE input of RS-485
transceiver(see schematic at the bottom of this page). RE/DE signal controls
RS-485 transceiver operation mode.

Requires
- RS485 rxtx pin direction - direction of the RS-485 Transmit/Receive pin
must be defined before using this function.
UART HW module needs to be initialized. See UARTX_Init.
// RS485 module pinout
var RS485 rxtx pin : sbit at RC2 bit;
var RS485 rxtx pin direction : sbit at TRISC2Z bit;
// End of RS485 module pinout
Example
UART1 Init(9600); // initialize UART module
RS485Master Init(); // intialize MCU as a

Master for RS-485 communication
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RS485Master_Receive

Prototype procedure RS485Master Receive (var data buffer: arrayl 5] of byte);

Returns Nothing.

Receives messages from Slaves. Messages are multi-byte, so this routine must
be called for each byte received.

Parameters :

- data buffer: 7 byte buffer for storing received data, in the following manner:

Description datal 0..2] : message content '
datal 3] : number of message bytes received, 1-3
- data[ 4] : is set to 255 when message is received
- datal 5] : is set to 255 if error has occurred
- data[ 6] : address of the Slave which sent the message

The function automatically adjusts datal 41 and datal 5] upon every received
message. These flags need to be cleared by software.

MCU must be initialized as a Master for RS-485 communication. See
RS485Master_Init.

var msg : arrayl 20] of byte;

Requires

Example

RS485Master Receive (msg);
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RS485Master_Send

Prototype procedure RS485Master Send(var data buffer: arrayl 20] of byte;
yp datalen: byte; slave address: byte);
Returns Nothing.
Sends message to Slave(s). Message format can be found at the bottom of this
page.
i Parameters :
Description
- data buffer: data to be sent
- datalen: number of bytes for transmition. Valid values: 0...3.
- slave address: Slave(s) address
MCU must be initialized as a Master for RS-485 communication. See
RS485Master_Init.
Requires
It is the user’s responsibility to ensure (by protocol) that only one device sends
data via 485 bus at a time.
var msg : arrayl 20] of byte;
Example // send 3 bytes of data to Slave with address 0x12
RS485Master Send(msg, 3, 0x12);
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RS485Slave_Init

Prokﬂype procedure RS485Slave Init(slave address: byte);

Returns Nothing.

Initializes MCU as a Slave for RS-485 communication.
Description |Parameters :

- slave address: Slave address

Global variables :

- RS485 rxtx pin - this pin is connected to RE/DE input of RS-485
transceiver(see schematic at the bottom of this page). RE/DE signal controls
RS-485 transceiver operation mode. Valid values: 1 (for transmitting) and 0
(for receiving)

Requires
- RS485 rxtx pin direction - direction of the RS-485 Transmit/Receive pin
must be defined before using this function.
UART HW module needs to be initialized. See UARTX_Init.
// RS485 module pinout
var RS485 rxtx pin : sbit at RC2 bit;
var RS485 rxtx pin direction : sbit at TRISC2 bit;
// End of RS485 module pinout
Example / "
UART1 Init(9600); // initialize UART module
RS485Slave Init (160); // intialize MCU as a

Slave for RS-485 communication with address 160
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RS485slave_Receive

Prototype

procedure RS485Slave Receive (var data buffer: array[ 20] of byte);

Returns

Nothing.

Description

Receives messages from Master. If Slave address and Message address field
don't match then the message will be discarded. Messages are multi-byte, so
this routine must be called for each byte received.

Parameters :

data_buffer: 6 byte buffer for storing received data, in the following manner:
2] : message content

]: number of message bytes received, 1-3

0.
3
4] : is set to 255 when message is received
5] : is set to 255 if error has occurred

- datal
- datal
- datal
[

- data

The function automatically adjusts data[4] and data[5] upon every received mes-
sage. These flags need to be cleared by software.

Requires

MCU must be initialized as a Slave for RS-485 communication. See
RS485Slave_Init.

Example

var msg : arrayl 20] of byte;

RS485S1lave Read (msq) ;
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RS485Slave_Send

procedure RS485Slave Send(var data buffer: arrayl 20] of byte;

Prototype datalen : byte);

Returns Nothing.

Sends message to Master. Message format can be found at the bottom of this
page.

Description |Parameters :

- data buffer: data to be sent
- datalen: number of bytes for transmition. Valid values: 0...3.

MCU must be initialized as a Slave for RS-485 communication. See
Requires RS485Slave_|Init. It is the user’s responsibility to ensure (by protocol) that only
one device sends data via 485 bus at a time.

var msg : arrayl 8] of byte;

Exa"“ﬂe // send 2 bytes of data to the Master

RS485Slave Send(msg, 2);

Library Example
This is a simple demonstration of RS485 Library routines usage.

Master sends message to Slave with address 160 and waits for a response. The Slave accepts
data, increments it and sends it back to the Master. Master then does the same and sends incre-
mented data back to Slave, etc.

Master displays received data on PORTB, while error on receive (0xAA) and number of consec-
utive unsuccessful retries are displayed on PORTD. Slave displays received data on PORTB,
while error on receive (0xAA) is displayed on PORTD. Hardware configurations in this example
are made for the EasyPIC5 board and 16F887.

RS485 Master code:
program RS485 Master Example;

var dat : arrayl 10] of byte ; // buffer for receving/send-
ing messages

i, J : byte;

cnt : longint;
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var rs485 rxtx pin : sbit at RC2 bit; // set transcieve pin
rs485 rxtx pin direction : sbit at TRISC2 bit; // set tran-

scieve pin direction

// Interrupt routine
procedure interrupt(); org 0xl1l6;
begin
RS485Master Receive (dat);
end;

begin
cnt := 0
ANSEL
ANSELH :=

I~

0; // Configure AN pins as digital I/O

o
~.

PORTB =
PORTD =
TRISB i=
TRISD i=

~. . N

O O O O
~

~.

UART1 Init (9600); // initialize UART1 module
Delay ms (100);

RS485Master Init(); // initialize MCU as Master
dat[ 0] := OxAA;

dat[ 1] := OxFO;

dat[ 2] := O0xO0F;

dat[ 4] := 0; // ensure that message received flag is 0
dat[ 5] := 0; // ensure that error flag is O

dat[ 6] := 0;

RS485Master Send(dat,1,160);

PIE1.RCIE := 1; // enable interrupt on UART1 receive
PIE2.TXIE := 0; // disable interrupt on UART1 transmit
INTCON.PEIE := 1; // enable peripheral interrupts
INTCON.GIE := 1; // enable all interrupts

while (TRUE) do
begin // upon completed valid message receiving
// datal 4] is set to 255

Inc(cnt);
if (dat[ 5] <> 0) then // if an error detected, signal it

PORTD := OxAA; // by setting portd to O0xAA
if (dat[ 4] <> 0) then // if message received successfully
begin
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cnt := 0;
dat[ 4] := 0; // clear message received flag
3 = dat[ 3] ;
for i := 1 to dat[ 3] do // show data on PORTB
PORTB := dat[ i-1];
dat[ 0] := dat[ 0] +1; // send back to master

Delay_ms(l);
RS485Master Send(dat,1,160);
end;

if (cnt > 100000) then // if in 100000 poll-cycles the answer

begin
Inc (PORTD) ; // was not detected, signal
cnt := 0; // failure of send-message
RS485Master Send(dat,1,160);
if (PORTD > 10) then // if sending failed 10 times
begin
RS485Master Send(dat,1,50); // send message on
broadcast address
end;
end;
end; // function to be properly linked.

end.

RS485 Slave code:
program RS485 Slave Example;

var dat : arrayl 20] of byte; // buffer for receving/send-
ing messages
i, J : byte;

var rs485 rxtx pin : sbit at RC2 bit; // set transcieve pin
rs485 rxtx pin direction : sbit at TRISC2 bit; // set tran-
scieve pin direction

// Interrupt routine
procedure interrupt();

begin
RS485Slave Receive (dat);
end;
begin
ANSEL := 0; // Configure AN pins as digital I/0
ANSELH := 0;
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PORTB := O0;
PORTD := O0;
TRISB := 0;
TRISD := O0;
UART1 Init (9600); // initialize UART1 module
Delay ms (100);
RS485Slave Init (160); // Intialize MCU as slave, address 160
dat[ 4] := 0; // ensure that message received flag is 0
dat[ 5] := 0; // ensure that message received flag is 0
dat[ 6] := 0; // ensure that error flag is 0
PIE1.RCIE := 1; // enable interrupt on UART1 receive
PIE2.TXIE := 0; // disable interrupt on UART1 transmit
INTCON.PEIE := 1; // enable peripheral interrupts
INTCON.GIE := 1; // enable all interrupts
while (TRUE) do
begin
if (dat[ 5] <> 0) then // if an error detected, signal it by
begin
PORTD := OxAA; // setting portd to OxAA
dat[ 5] := 0;
end;
if (dat[ 4] <> 0) then // upon completed valid message receive
begin
dat[ 4] := 0; // datal 4] is set to OxFF
3 = dat[ 3],
for i := 1 to dat[ 3] do // show data on PORTB
PORTB := dat[ i-1];
dat[ 0] := dat[ 0] +1; // increment received dat[ 0]
Delay ms(1);
RS485Slave Send(dat,1); // and send it back to master
end;
end;

end.
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HW Connection

Shielded pair
; no lenger than 300m
O j_— i ~ I
= = I i
— f ]
WCC = DJ ﬁ? E %
1 = 8
it el 3
nE ek ] O whow
i[ ol GHD L] [ b GND HII
AT OSCILLATOR 47 O—[ VOO m ]
LTC485 ! s I
1 CLKIN [
— — E E [l
RET
3
RC2 ]
i I
i I
i [

VOO O
UAI(? BER SER

Example of interfacing PC to PIC MCU via RS485 bus with LTC485 as RS-485
transceiver
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Message format and CRC calculations

Q: How is CRC checksum calculated on RS485 master side?

START BYTE := 0x96; // 10010110
STOP BYTE := O0xA9; // 10101001
PACKAGE :

START BYTE 0x96

ADDRESS

DATALEN

[ DATA1] // if exists
[ DATAZ] // if exists
[ DATA3] // if exists
CRC

STOP BYTE 0xA9

DATALEN bits

bit7 := 1 MASTER SENDS
0 SLAVE SENDS
bité := 1 ADDRESS WAS XORed with 1, IT WAS EQUAL TO START BYTE or
STOP_BYTE
0 ADDRESS UNCHANGED
bit5 := 0 FIXED
bitd4 := 1 DATA3 (if exists) WAS XORed with 1, IT WAS EQUAL TO

START BYTE or STOP BYTE

0 DATA3 (if exists) UNCHANGED
bit3 = 1 DATA2 (if exists) WAS XORed with 1, IT WAS EQUAL TO
START BYTE or STOP BYTE

0 DATA2 (if exists) UNCHANGED
bit2 := 1 DATAl (if exists) WAS XORed with 1, IT WAS EQUAL TO
START BYTE or STOP BYTE

0 DATAl (if exists) UNCHANGED
bitlbit0 := 0 to 3 NUMBER OF DATA BYTES SEND

CRC generation

crc_send := datalen xor address;

crc_send := crc_send xor data[ 0] ; // 1if exists
crc_send := crc_send xor data[ 1] ; // 1if exists
crc_send := crc_send xor data[ 2] ; // 1if exists
crc_send := not crc_ send;

if ((crc_send = START BYTE) or (crc send = STOP BYTE)) then
Inc(crc_send);

NOTE : DATALEN<4..0> can not take the START BYTE<4..0> or
STOP BYTE<4..0> values.
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SOFTWARE I’C LIBRARY

The mikroPascal PRO for PIC provides routines for implementing Software 12c
communication. These routines are hardware independent and can be used with

any MCU. The Software 12C library enables you to use MCU as Master in 12C com-
munication. Multi-master mode is not supported.

Note: This library implements time-based activities, so interrupts need to be dis-
abled when using Software 12C.

Note: All Software 12C Library functions are blocking-call functions (they are waiting
for 12C clock line to become logical one).

Note: The pins used for the Software I2C communication should be connected to
the pull-up resistors. Turning off the LEDs connected to these pins may also be
required.

External dependencies of Software I°C Library

The following variables
must be defined in all
projects using Software
12C Library:

Description: Example :

var Soft I2C Scl
sbit; sfr; external;

Soft 12C Clock line.

var Soft I2C Scl :
sbit at RC3 bit;

var Soft I2C Sda :
sbit; sfr; external;

Soft 12C Data line.

var Soft I2C Sda :
sbit at RC4 bit;

var var
Soft I2C scl Directio |Direction of the Soft |ZC Soft I2C Scl Directio
n : sbit; sfr; CHOCkaL n : sbit at
external; TRISC3 bit;

var var

Soft I2C sda Directio |Direction of the Soﬁ|2C) Soft I2C Sda Directio
n : sbit; sfr; Data pin. n : sbit at
external; TRISC4 bit;

Library Routines

- Soft_I2C_Init

- Soft_12C_Start
- Soft_12C_Read
- Soft_12C_Write
- Soft_12C_Stop
- Soft_12C_Break
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Soft_I2C_Init

Prototype |procedure Soft I2C Init();

Returns Nothing.

Description |Configures the software 12C module.
Global variables :
-soft 120 scl: Soft 12C clock line

. - Soft 12 sda: Soft 12C data line

Requires - o > )
- Soft I2C scl Direction: Direction of the Soft 14C clock pin
- Soft I2C sda Direction: Direction of the Soft 12C data pin
must be defined before using this function.
// Soft I2C pinout definition
var Soft I2C Scl : sbit at RC3 bit;
var Soft I2C Sda : sbit at RC4 bit;
var Soft I2C Scl Direction : sbit at TRISC3 bit;

Example - . . . .
var Soft I2C Sda Direction : sbit at TRISC4 bit;
// End of Soft I2C pinout definition
Soft I2C Init();

Soft_I2C_Start

Prototype |procedure soft I2C Start();

Returns Nothing.

Description |Determines if the 12C bus is free and issues START signal.

Requires Softyvare 12C must be configured before using this function. See Soft_I2C_Init
routine.
// Issue START signal

Example Soft I2C Start();
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Soft_I12C_Read

Prokﬂype function Soft I2C Read(ack: word): byte;

Returns One byte from the Slave.

Reads one byte from the slave.

o Parameters :
Description

- ack: acknowledge signal parameter. If the =ck==0 not acknowledge signal will
be sent after reading, otherwise the acknowledge signal will be sent.

Soft I12C must be configured before using this function. See Soft_I2C _Init routine.

Requires ) . . ) .
Also, START signal needs to be issued in order to use this function. See
Soft_12C_Start routine.
var take : word;
Exan“ﬂe // Read data and send the not acknowledge signal
take := Soft I2C Read(0);
Soft_I12C_Write

Prototype function Soft I2C Write( data: byte): byte;

- 0 if there were no errors.

Returns - 1 if write collision was detected on the I.C bus.

Sends data byte via the | C bus.
Description |Parameters :

- Data: data to be sent

Soft I2C must be configured before using this function. See Soft_I2C _Init routine.

Requires , ) ) . i
Also, START signal needs to be issued in order to use this function. See
Soft_[2C_Start routine.
var data, error : byte;

Exan“ﬂe error := Soft I2C Write (data);

error := SoftiTQCAWrite(OxAB);
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Soft_I2C_Stop
Prototype procedure Soft I2C Stop();
Returns Nothing.
Description |Issues STOP signal.
Requires Soft 12C must be configured before using this function. See Soft_I2C _Init routine.
E I // Issue STOP signal
Xxample Soft I2C Stop();

Soft_I2C_Break

Prototype procedure Soft I2C Break();
Returns Nothing.
All Software 12C Library functions can block the program flow (see note at the
top of this page). Calling this routine from interrupt will unblock the program
Description execution. This mechanism is similar to WDT.
Note: Interrupts should be disabled before using Software 12C routines again
(see note at the top of this page).
Requires Nothing.
var datal, error, counter : byte;
procedure interrupt() ;
begin
if (INTCON.TOIF <> 0) then
if (counter >= 20) then
begin
Soft I2C Break();
counter := 0; // reset counter
end
else
Inc (counter) ; // increment counter
INTCON.TOIF := O; // Clear Timer(O overflow inter-
rupt flag
Example end;
begin

counter := 0;

OPTION REG := 0x04; // TMRO prescaler set to 1:32

// try Soft I2C Init with blocking prevention mechanism

INTCON.GIE := 1; // Global interrupt enable
INTCON.TOIE := 1; // Enable Timer0O overflow inter-
rupt
Soft _I2C_Init();
INTCON.GIE := 0; // Global interrupt disable
end.
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Library Example

The example demonstrates Software | C Library routines usage. The PIC MCU is
connected (SCL, SDA pins) to PCF8583 RTC (real-time clock). Program reads date
and time are read from the RTC and prints it on Lcd.

program RTC Read;

var seconds, minutes, hours, day, month, year : byte; // Global
date/time variables

// Software I2C connections
var Soft I2C Scl : sbit at RC3 bit;
Soft I2C sda : sbit at RC4 bit;
Soft I2C Scl Direction : sbit at TRISC3 bit;
Soft I2C Sda Direction : sbit at TRISC4 bit;
// End Software I2C connections

// LCD module connections
var LCD RS : sbit at RB4 bit;
LCD EN : sbit at RB5 bit;
LCD D4 : sbit at RBO bit;
LCD_D5 : sbit at RBl_bit;
LCD D6 : sbit at RB2 bit'
LCD D7 : sbit at RB3 bit;
LCD RS Direction : sbit at TRISB4 bit;
LCD EN Direction : sbit at TRISBS bit;
LCD D4 Direction : sbit at TRISBO bit;
LCD D5 Direction : sbit at TRISB1 bit;
LCD D6 Direction : sbit at TRISB2 bit;
LCD D7 Direction : sbit at TRISB3 bit;
// End LCD module connections

[ = — Reads time and date information from RTC

(PCF8583)

procedure Read Time();

begin
Soft I2C Start(); // Issue start signal
Soft TI2C Write(0xAQ); // Address PCF8583, see PCF8583 datasheet
Soft I2C Write(2); // Start from address 2
Soft I2C Start(); // Issue repeated start signal
Soft I2C Write(OxAl); // Address PCF8583 for reading R/W=1
seconds := Soft I2C Read(l); // Read seconds byte
minutes := Soft I2C Read(1l); // Read minutes byte
hours := Soft I2C Read(l); // Read hours byte
day := Soft I2C Read(l); // Read year/day byte
month := Soft I2C Read(0); // Read weekday/month byte)
Soft I2C Stop(); // Issue stop signal}

end;
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[/ —mmm e —— Formats date and time
procedure Transform Time () ;
begin
seconds := ((seconds and 0xF0) shr 4)*10 + (seconds and 0xO0F);
// Transform seconds
minutes := ((minutes and 0xFO0) shr 4)*10 + (minutes and O0xO0F);
// Transform months
hours 1= ((hours and 0xFO0) shr 4)*10 + (hours and O0xO0F);
// Transform hours
year 1= (day and 0xCO) shr 6; // Transform year
day = ((day and 0x30) shr 4)*10 + (day and O0xOF);
// Transform day
month = ((month and 0x10) shr 4)*10 + (month and O0xO0OF);
// Transform month
end;
[/ —mmm e —— Output values to LCD

procedure Display Time () ;

begin

Led Chr (1, 6,

variable

Led Chr(1, 7,

day variable

Led Chr (1, 9,
Lcd Chr (1,10,
Lcd Chr (1,15,
8 (start from year

Lcd Chr
Lcd Chr
Lcd Chr
Lcd Chr
Lcd Chr
Lcd Chr

end;

(day / 10) + 48); // Print tens digit of day
(day mod 10) + 48); // Print oness digit of
(month / 10) + 48);
(month mod 10) + 48);
year + 56); // Print year vaiable +
2008)
(2, 6, (hours / 10) + 48);
(2, 7, (hours mod 10) + 48);
(2, 9, (minutes / 10) + 48);
(2, (minutes mod 10) + 48);
(2, 12 (seconds / 10) + 48);
(2,13, (seconds mod 10) + 48);

Performs project-wide init

procedure Init Main();

begin

TRISB
PORTB
TRISB
ANSEL
ANSELH

Soft I2C Init();

Led Init();
Lcd Cmd (
Lcd Cmd (

_LCD_CLEAR) ;
_LCD_CURSOR_OFF) ;

0;
OxFF;
Oxff;
0; // Configure AN pins as digital I/O
0;

// Initialize Soft I2C communication

// Initialize LCD
// Clear LCD display
// Turn cursor off
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LCDAQut(l,l,'Date ') // Prepare and output static text on LCD
LCD Chr(1,8,"

LCD Chr(1,11,':");
LCD Out (2,1, 'Tlme '),
LCD Chr (2,8,

LCD Chr (2,11

LCD Out (1,12

end;

Delay ms (1000) ;

Init Main(); // Perform initialization
while TRUE do // Endless loop
begin
Read Time () ; // Read time from RTC (PCF8583)
Transform Time () ; // Format date and time
Display Time () ; // Prepare and display on LCD
end;
end.
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SOFTWARE SPI LIBRARY

The mikroPacal PRO for PIC provides routines for implementing Software SPI com-
munication. These routines are hardware independent and can be used with any
MCU. The Software SPI Library provides easy communication with other devices via
SPI: A/D converters, D/A converters, MAX7219, LTC1290, etc.

Library configuration:

- SPI to Master mode

- Clock value = 20 kHz.

- Data sampled at the middle of interval.
- Clock idle state low.

- Data sampled at the middle of interval.
- Data transmitted at low to high edge.

Note: The Software SPI library implements time-based activities, so interrupts need
to be disabled when using it.

External dependencies of Software SPI Library

The following variables
must be defined in all
projects using Software
SPI Library:

var SoftSpi SDI Data In line var SoftSpi SDI
sbit; sfr; external; ’ sbit at RC4 bit;

var SoftSpi SDO : Data Out line var SoftSpi SDO :
sbit; sfr; external; ) sbit at RC5 bit;

var SoftSpi CLK :

Description: Example :

var SoftSpi CLK :

sbit; sfr; external; Clock line. sbit at RC3 bit;
var . . var

Direction of the Data In
SoftSpi SDI Direction . SoftSpi SDI Direction
: sbit; sfr; external; pn. : sbit at TRISC4 bit;
var var

Direction of the Data Out

SoftSpi SDO Direction SoftSpi SDO Direction

: sbit; sfr; external; pin : sbit at TRISCS bit;
var var

Softspi CLK Direction |Direction of the Clock pin. |softspi CLK Direction
: sbit; sfr; external; : sbit at TRISC3 bit;

Library Routines

- Soft_SPI_Init
- Soft_ SPI_Read
- Soft_SPI_Write
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Soft_SPI_Init

Prototype |procedure Soft SPI Init();

Returns Nothing.

Description |Configures and initializes the software SPI module.

Global variables:

- Chip select: Chip select line

Softspi spi: Datain line

- softspi spo: Data out line

- softspi crLk: Data clock line

Chip Select Direction: Direction of the Chip select pin
- SoftSpi SDI Direction: Direction of the Data in pin
SoftSpi SDO Direction: Direction of the Data out pin
SoftSpi CLK Direction: Direction of the Data clock pin

Requires

must be defined before using this function.

// Software SPI module connections
var Chip Select : sbit at RC1;

var SoftSpi SDI : sbit at RC4 bit;
var SoftSpi SDO : sbit at RC5 bit;
var SoftSpi CLK : sbit at RC3 bit;

Example var Chip Select Direction : sbit at TRISCl bit;
var SoftSpi SDI Direction : sbit at TRISC4 bit;
var SoftSpi SDO Direction : sbit at TRISCS bit;
var SoftSpi CLK Direction : sbit at TRISC3 bit;
// End Software SPI module connections

Soft SPI Init(); // Init Soft SPI
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Soft_SPI_Read
Prototype function Soft SPI Read(sdata: byte): word;

Returns Byte received via the SPI bus.

This routine performs 3 operations simultaneously. It provides clock for the Soft-
ware SPI bus, reads a byte and sends a byte.

Description Parameters :

- sdata: data to be sent.

Requires Soft SPI must be initialized before using this function. See Soft_SPI_Init routine.

var data read : word;
data send : byte;

Example // Read a byte and assign it to data read variable
// (data_send byte will be sent via SPI during the Read opera-
tion)
data read := Soft SPI Read(data send);

Soft_SPI_Write

Prototype |procedure Soft SPI Write(sdata: byte);

Returns Nothing.

This routine sends one byte via the Software SPI bus.
Description |Parameters :

- sdata: data to be sent.

Requires Soft SPI must be initialized before using this function. See Soft_SPI_lInit routine.

// Write a byte to the Soft SPI bus

Example Soft SPI Write (0xAR);

Library Example

This code demonstrates using library routines for Soft_SPI communication. Also, this example
demonstrates working with Microchip's MCP4921 12-bit D/A converter.
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program Soft SPI;

// DAC module connections

var Chip Select sbit at
SoftSpi CLK : sbit at
SoftSpi SDI : sbit at
SoftSpi SDO : sbit at

var Chip Select Direction
SoftSpi CLK Direction
SoftSpi SDI Direction
SoftSpi SDO Direction

// End DAC module connections

var value word;
procedure InitMain();
begin
TRISAO bit :=
TRISALl bit :=
Chip Select 1;
Chip Select Direction
Soft Spi Init();
end;

1;
1;

// DAC increments

= 0;

(0..4095)

RC1 bit;
RC3 bit;
RC4 bit;
RC5 bit;

// Note: Input signal

sbit at TRISCIl bit;
sbit at TRISC3 bit;
sbit at TRISC4 bit;
sbit at TRISC5 bit;

// Set RAO pin as
// Set RAl pin as
// Deselect DAC
// Set CS# pin as Output
// Initialize Soft SPI

input
input

--> output voltage (0..Vref)

procedure DAC Output ( valueDAC word) ;
var temp byte; volatile;
begin

Chip Select := 0; // Select DAC chip

// Send High Byte

temp := word(valueDAC shr 8) and 0xO0F; // Store valueDAC[ 11..8]
to temp[ 3..0]

temp := temp or 0x30; // Define DAC setting, see MCP4921 datasheet

Soft SPI Write (temp);

// Send Low Byte
temp := valueDAC;
Soft SPI Write (temp);

Chip Select := 1;
end;

begin

ANSEL := 0;
ANSELH := 0;
CION bit := 0;
C20N_bit := 0;

// Send high byte via Soft SPI
// Store valueDAC[ 7..0] to temp[ 7..0]
// Send low byte via Soft SPI

// Deselect DAC chip

// Disable comparators
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InitMain () ; // Perform main initialization
value := 2048; // When program starts, DAC gives
// the output in the mid-range
while (TRUE) do // Endless loop
begin

if ((RAO bit) and (value < 4095)) then // If PAO button
is pressed
Inc (value) // increment value
else
begin
if ((RAl bit) and (value > 0)) then // If PAl button
is pressed

Dec (value) ; // decrement value
end;
DAC Output (value) ; // Send value to DAC chip
Delay ms(1); // Slow down key repeat pace

end;
end.
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SOFTWARE UART LIBRARY

The mikroPascal PRO for PIC provides routines for implementing Software UART
communication. These routines are hardware independent and can be used with
any MCU. The Software UART Library provides easy communication with other
devices via the RS232 protocol.

Note: The Software UART library implements time-based activities, so interrupts
need to be disabled when using it.

Library Routines

- Soft UART _Init

- Soft UART_Read
- Soft UART_Write
- Soft UART_Break
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Soft_UART_Init

function Soft Uart Init(var port : byte; rx pin, tx pin,
Prototype - - - i - -
baud rate : dword, inverted : byte): byte;

- 2 - error, requested baud rate is too low
Returns - 1 - error, requested baud rate is too high
- 0 - successfull initialization

Configures and initializes the software UART module.
Parameters :

- port: port to be used.

- rx pin: sets rx_pin to be used.

- tx pin: sets tx_pin to be used.

- baud rate: baud rate to be set. Maximum baud rate depends on the MCU's -
clock and working conditions.

- inverted: inverted output flag. When set to a non-zero value, inverted logic
on output is used.

Description

Software UART routines use Delay_Cyc routine. If requested baud rate is too
low then calculated parameter for calling Delay_Cyc exceeeds Delay_Cyc argu-
ment range.

If requested baud rate is too high then rounding error of Delay_Cyc argument
corrupts Software UART timings.

Requires Nothing.

var error : byte;

Exarnple // Initialize Software UART communication on pins Rx, Tx, at 9600 bps

error := Soft UART Init (PORTC, 7, 6, 14400, 0);
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Soft_UART_Read

Prokﬂype function Soft UART Read(var error: byte): byte;

Returns Byte received via UART.

The function receives a byte via software UART.

This is a blocking function call (waits for start bit). Programmer can unblock it by
calling Soft_ UART_Break routine.

Description Parameters :

- error: Error flag. Error code is returned through this variable.

0 - no error
1 - stop bit error
255 - user abort, Soft UART_Break called

Software UART must be initialized before using this function. See the
Soft_ UART _Init routine.

var data : byte;
error : byte;

Requires

// wait until data is received

repeat
data := Soft UART Read(error);
Example until (error=0);

// Now we can work with data:
if ( data ) then
begin

end
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Soft_UART_Write

Prototype procedure Soft UART Write (udata: byte);

Returns Nothing.

This routine sends one byte via the Software UART bus.

Description |Parameters :

- udata: data to be sent.

Software UART must be initialized before using this function. See the
Soft UART _Init routine.

Requires
Be aware that during transmission, software UART is incapable of receiving data —
data transfer protocol must be set in such a way to prevent loss of information.
var some byte : byte;

Example // Write a byte via Soft UART

some byte := 0x0A;
Soft UART Write(some byte);
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Soft_ UART_Break
Prototype |procedure Soft UART Break();

Returns Nothing.

Soft UART_Read is blocking routine and it can block the program flow. Call this
routine from interrupt to unblock the program execution. This mechanism is sim-

ilar to WDT.

Description
Note: Interrupts should be disabled before using Software UART routines again
(see note at the top of this page).

Requires Nothing.

var datal, error, counter : byte;

procedure interrupt();

begin

if (INTCON.TOIF <> 0) then
if (counter >= 20) then

begin
Soft UART Break();
counter := 0; // reset counter
end
else
Inc (counter) ; // increment counter
INTCON.TOIF := 0; // Clear Timer0O overflow inter-
rupt flag
end;
begin
Example counter := 0;
OPTION REG := 0x04; // TMRO prescaler set to 1:32
if (Soft UART Init (PORTC, 7, 6, 9600, 0) = 0) then

Soft UART Write (0x55);

// try Soft UART Read with blocking prevention mechanism

INTCON.GIE := 1; // Global interrupt enable
INTCON.TOIE := 1; // Enable Timer0O overflow inter-
rupt
datal := Soft UART Read(error);
INTCON.GIE := 0; // Global interrupt disable
end.
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Library Example

This example demonstrates simple data exchange via software UART. If MCU is
connected to the PC, you can test the example from the mikroPascal PRO for PIC
USART Terminal Tool.

program Soft UART;

var error : byte;
counter, byte read : byte; // RAuxiliary variables
begin
ANSEL := O0; // Configure AN pins as digital I/O
ANSELH := 0;
TRISB := 0x00; // Set PORTB as output (error signalization)
PORTB := 0; // No error
error := Soft UART Init (PORTC, 7, 6, 14400, 0); // Initialize Soft

UART at 14400 bps
if (error > 0) then

begin
PORTB := error; // Signalize Init error
while (TRUE) do nop; // Stop program

end;

Delay ms (100);

for counter := 'z' downto 'A' do // Send bytes from 'z'
downto 'A'
begin
Soft UART Write (counter);
Delay ms (100);

end;
while TRUE do // Endless loop
begin
byte read := Soft UART Read(error); // Read byte, then test
error flag
if (error <> 0) then // If error was detected
PORTB := error // signal it on PORTB
else
Soft UART Write (byte read); // 1f error was not detect-
ed, return byte read
end;

end.
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SOUND LIBRARY

The mikroPascal PRO for PIC provides a Sound Library to supply users with routines necessary
for sound signalization in their applications. Sound generation needs additional hardware, such
as piezo-speaker (example of piezo-speaker interface is given on the schematic at the bottom of
this page).

Library Routines

- Sound_Init
- Sound_Play

Sound_Init

Prototype procedure Sound Init(var snd port : byte; snd pin : byte);

Returns Nothing.

Configures the appropriate MCU pin for sound generation.

. Parameters :
Description

- snd port: sound output port address
- snd pin: sound output pin

Requires Nothing.

Example Sound Init (PORTD, 3); // Initialize sound at RD3
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Sound_Play

Prokﬂype procedure Sound Play(freq in hz, duration ms : word);

Returns Nothing.

Generates the square wave signal on the appropriate pin.
Parameters :

- freq in hz: signal frequency in Hertz (Hz)
Description |- duration ms: signal duration in miliseconds (ms)

Note: frequency range is limited by Delay Cyc parameter. Maximum frequency
that can be produced by this function is Freq max = Fosc/ (80*3). Minimum
frequency is Freq min = Fosc/ (80*255). Generated frequency may differ
from the freq in hz parameter due to integer arithmetics.

In order to hear the sound, you need a piezo speaker (or other hardware) on
Requires designated port. Also, you must call Sound_Init to prepare hardware for output
before using this function.

// Play sound of 1KHz in duration of 100ms

Exan“ﬂe Sound Play (1000, 100);

Library Example

The example is a simple demonstration of how to use the Sound Library for playing tones on a
piezo speaker.

program Sound;

procedure Tonel ()
begin
Sound Play (659, 250); // Frequency = 659Hz, duration = 250ms
end;

procedure Tone2();
begin
Sound Play (698, 250); // Frequency = 698Hz, duration = 250ms
end;

procedure Tone3();
begin
Sound Play (784, 250); // Frequency = 784Hz, duration = 250ms
end;
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procedure Melody () ; // Plays the melody "Yellow house"
begin
Tonel (); Tone2(); Tone3(); Tone3();
Tonel (); Tone2(); Tone3(); Tone3();
Tonel (); Tone2(); Tone3();
Tonel (); Tone2(); Tone3(); Tone3();
Tonel (); Tone2(); Tone3();
Tone3(); Tone3(); Tone2(); Tone2(); Tonel();
end;
procedure ToneA() ; // Tones used in Melody2 function
begin
Sound Play( 880, 50);
end;
procedure ToneC () ;
begin
Sound Play (1046, 50);
end;
procedure ToneE () ;
begin
Sound Play (1318, 50);
end;
procedure Melody?2 () ; // Plays Melody?2
var counter : byte;
begin
for counter := 9 downto 1 do
begin
ToneA() ;
ToneC () ;
ToneE () ;
end;
end;
begin
ANSEL = 0; // Configure AN pins as digital I/O
ANSELH := 0;
CION bit := 0; // Disable comparators
C20N bit := 0;
TRISB := O0xFO; // Configure RB7..RB4 as input
TRISD := 0xF7 // Configure RD3 as output

Sound Init (PORTD, 3);
Sound Play (880, 5000);
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while TRUE do // endless loop
begin

if (Button (PORTB,7,1,1)) then // If PORTB.7 is pressed play Tonel

begin
Tonel () ;

while (RB7 bit <> 0) do nop; // Wait for button to be released
end;

if (Button (PORTB,6,1,1)) then // If PORTB.6 is pressed play Tonel
begin
Tone2 () ;
while (RB6 bit <> 0) do nop; // Wait for button to be released
end;

if (Button (PORTB,5,1,1)) then // If PORTB.5 is pressed play Tonel

begin

Melody2 () ;
while (RB5 bit <> 0) do nop; // Wait for button to be released
end;

if (Button (PORTB,4,1,1)) then // If PORTB.4 is pressed play Tonel
begin
Melody () ;
while (RB4 bit <> 0) do nop;// Wait for button to be released
end;
end;
end.
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HW Connection
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SPI LIBRARY

SPI module is available with a number of PIC MCU models. mikroPascal PRO for PIC provides
a library for initializing Slave mode and comfortable work with Master mode. PIC can easily com-
municate with other devices via SPI: A/D converters, D/A converters, MAX7219, LTC1290, etc.
You need PIC MCU with hardware integrated SPI (for example, PIC16F877).

Note: Some PIC18 MCUs have multiple SPI modules. Switching between the SPI modules in the
SPI library is done by the SPI_Set_Active function (SPI module has to be previously initialized).

Note: In order to use the desired SPI library routine, simply change the number 1 in the prototype
with the appropriate module number, i.e. SPI2_lInit();

Library Routines

- SPI1_Init

- SPI1_Init_Advanced
- SPI1_Read

- SPI1_Write

- SPI_Set_Active

SPI1_lInit
Prototype procedure SPI1 Init();

Returns Nothing.

Configures and initializes SPI with default settings. SPI1_Init_Advanced or
SPI1_Init needs to be called before using other functions from SPI Library.

Default settings are:
Description |_ master mode

- clock Fosc/4

- clock idle state low

- data transimtted on low to high edge

- input data sampled at the middle of interval

Requires You need PIC MCU with hardware integrated SPI.

Example SPI1 Init(); // Initialize the SPI module with default settings
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SPI1_Init_Advanced

procedure SPI1 Init Advanced (master, data sample, clock idle,
Prototype . = - - -
transmit edge : byte);
Returns Nothing.
Configures and initializes SPI. SPI1_Init_Advanced or SPI1_Init needs to be
called before using other functions of SPI Library.
Parameters mode, data sample and clock idle configure the SPI module, and
can have the following values:
Description Predefined library const
SPI work mode:
Master clock = Fosc/4 ~SPI MASTER OSC DIV4
Master clock = Fosc/16 _SPI MASTER OSC DIV16
Master clock = Fosc/64 _SPI _MASTER _OSC DIV64
Master clock source TMR2 _SPI MASTER TMR2
L. Slave select enabled _SPI SLAVE SS ENABLE
Description
Slave select disabled _SPI_SLAVE SS DIS
Data sampling interval:
Input data sampled in middle of interval | SPI DATA SAMPLE MIDDLE
Input data sampled at the end of interval| SPI DATA SAMPLE END
SPI clock idle state:
Clock idle HIGH _SPI CLK IDLE HIGH
Clock idle LOW _SPI CLK IDLE LOW
Transmit edge:
Data transmit on low to high edge ~SPI LOW 2 HIGH
Data transmit on high to low edge _SPI HIGH 2 LOW
Requires You need PIC MCU with hardware integrated SPI.
// Set SPI to master mode, clock = Fosc/4, data sampled at the
middle of interval, clock idle state low and data transmitted at
Example low to high edge:
SPI1 Init Advanced( SPI MASTER OSC DIV4, SPI DATA SAMPLE MIDDLE,
SPI CLK IDLE LOW, SPI LOW 2 HIGH);
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Prototype procedure SPI Set Active (read ptr : "TSpi Rd Ptr);
Returns Nothing.
Sets the active SPI module which will be used by the SPI routines.
Description |Parameters :
- read ptr: SPI1_Read handler
Routine is available only for MCUs with two SPI modules.
Requires Used SPI module must be initialized before using this function. See the
SPI1_Init, SPI1_Init_Advanced
Example SPI_Set Active (@SPI2 Read); // Sets the SPI2 module active

mikroPASCAL PRO for PIC Libraries
SPI1_Read
Pl'OtOtype function SPI1 Read(buffer : byte) : byte;
Returns Returns the received data.
Description |Provides clock by sending buffer and receives data at the end of period.
You need PIC MCU with hardware integrated SPI.
Requires SPI must be initialized and communication established before using this func-
tion. See SPI1_Init_Advanced or SPI1_Init.
var buffer, take : byte;
Example begin
take := SPI1 Read(buffer);
end.
SPI1_Write
Prototype procedure SPI1 Write(data : byte);
Returns Nothing.
Description |Writes byte data to SSPBUF, and immediately starts the transmission.
You need PIC MCU with hardware integrated SPI.
Requires SPI must be initialized and communication established before using this func-
tion. See SPI1_Init_Advanced or SPI1_Init.
Example SPI1 Write(1);
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Library Example

The code demonstrates how to use SPI library functions for communication between
SPI module of the MCU and Microchip's MCP4921 12-bit D/A converter

program SPI;
// DAC module connections
var Chip Select : sbit at RC1 bit;
Chip Select Direction : sbit at TRISC1 bit;
// End DAC module connections

var value : word;

procedure InitMain();

begin
TRISBO bit := 1; // Set RAO pin as input
TRISB1 bit := 1; // Set RAl pin as input
Chip Select := 1; // Deselect DAC
Chip Select Direction := 0; // Set CS# pin as Output
SPI1 Init(); // Initialize SPI module

end;

// DAC increments (0..4095) --> output voltage (0..Vref)

procedure DAC Output( valueDAC : word);
var temp : byte;
begin
Chip_Select := 0; // Select DAC chip

// Send High Byte

temp := word(valueDAC shr 8) and O0xO0F; // Store
valueDAC[ 11..8] to temp[ 3..0]
temp := temp or 0x30; // Define DAC setting, see MCP4921 datasheet
SPI1 _Write (temp); // Send high byte via SPI

// Send Low Byte

temp := valueDAC; // Store wvalueDAC[ 7..0] to temp[ 7..0]
SPI1 Write (temp); // Send low byte via SPI
Chip Select := 1; // Deselect DAC chip

end;

begin

ANSEL := 0;

ANSELH := 0;

InitMain () ; // Perform main initialization
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value := 2048; // When program starts, DAC gives
// the output in the mid-range

while ( TRUE ) do // Endless loop
begin
if ((RAO bit) and (value < 4095)) then // If PAO button
is pressed
Inc (value) // increment value
else
begin
if ((RAl bit) and (value > 0)) then // If PAl button
is pressed
Dec (value) ; // decrement value
end;
DAC Output (value) ; // Send value to DAC chip
Delay ms(1); // Slow down key repeat pace

end;
end.

HW Connection

All lines are disconnected

Vref line is connected
Vee line is connected
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SPI ETHERNET LIBRARY

The ENC28J60 is a stand-alone Ethernet controller with an industry standard Seri-
al Peripheral Interface (SPI™). It is designed to serve as an Ethernet network inter-
face for any controller equipped with SPI.

The enc28J60 meets all of the IEEE 802.3 specifications. It incorporates a number
of packet filtering schemes to limit incoming packets. It also provides an internal
DMA module for fast data throughput and hardware assisted IP checksum calcula-
tions. Communication with the host controller is implemented via two interrupt pins
and the SPI, with data rates of up to 10 Mb/s. Two dedicated pins are used for LED
link and network activity indication.

This library is designed to simplify handling of the underlying hardware (Enc28J60).
It works with any PIC with integrated SPI and more than 4 Kb ROM memory. 38 to
40 MHz clock is recommended to get from 8 to 10 Mhz SPI clock, otherwise PIC
should be clocked by enc28760 clock output due to its silicon bug in SPI hardware.
If you try lower PIC clock speed, there might be board hang or miss some requests.

SPI Ethernet library supports:

- IPv4 protocol.

- ARP requests.

- ICMP echo requests.

- UDP requests.

- TCP requests (no stack, no packet reconstruction).
- ARP client with cache.

- DNS client.

- UDP client.

- DHCP client.

- packet fragmentation is NOT supported.

Note: Due to PIC16 RAM/Flash limitations PIC16 library does NOT have ARP, DNS,
UDP and DHCP client support implemented.

Note: Global library variable spT Ethernet userTimersec is used to keep track of
time for all client implementations (ARP, DNS, UDP and DHCP). It is user responsi-
bility to increment this variable each second in it's code if any of the clients is used.

Note: For advanced users there are header files ("eth enc28j60Libbef.h" and
"eth enc28j60LibPrivate.h")in Uses\P16 and Uses\P18 folders of the compiler
with description of all routines and global variables, relevant to the user, implement-
ed in the SPI Ethernet Library.

Note: The appropriate hardware SPI module must be initialized before using any of
the SPI Ethernet library routines. Refer to SPI Library.

For MCUs with two SPI modules it is possible to initialize both of them and then
switch by using the sp1 set active () routine.
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External dependencies of SPI Ethernet Library

The following variables
must be defined in all
projects using SPI Eth-
ernet Library:

Description:

Example :

var SPI Ethernet CS
sbit; sfr; external;

" |[ENC28J60 chip select pin.

var SPI Ethernet CS :
sbit at RC1 bit;

var SPI Ethernet RST :
sbit; sfr; external;

" |ENC28J60 reset pin.

var SPI Ethernet RST

: sbit at RCO bit;

var var
SPI Ethernet CS Direc [Direction of the ENC28J60 [spI Ethernet CS Direc
tion : sbit; sfr; chu)sebctphm tion : sbit at
external; TRISCL bit;
var var
SPI Ethernet RST Dire [Direction of the ENC28J60 [sPI Ethernet RST Dire
ction : sbit; sfr; resetpkL ction : sbit at
external; TRISCO bit;
The following routines must be defined in all project oy
. . Description: Example :
using SPI Ethernet Library:
; _ , . Refer to the library
unction SPI Ethernet UserTCP (remoteHost : byte, exanuﬂe at the
remotePort : word, TCP request .
bottom of this
localPort : word, handler.
reqLength : word): word; Pageforcoqe
implementation.
. ) . Refer to the library
unction SPI Ethernet UserUDP (remoteHost : byte, exanuﬂe at the
remotePort : word, UDP request .
bottom of this
destPort : word, handler. f
regLength : word): word; Page Orcoqe
implementation.
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Library Routines
PIC16 and PIC18:

- SPI_Ethernet_Init

- SPI_Ethernet_Enable

- SPI_Ethernet_Disable

- SPI_Ethernet_doPacket

- SPI_Ethernet_putByte

- SPI_Ethernet_putBytes

- SPI_Ethernet_putString

- SPI_Ethernet_putConstString
- SPI_Ethernet_putConstBytes
- SPI_Ethernet_getByte

- SPI_Ethernet_getBytes

- SPI_Ethernet_UserTCP

- SPI_Ethernet_UserUDP

PIC18 Only:

- SPI_Ethernet_getlpAddress

- SPI_Ethernet_getGwlpAddress
- SPI_Ethernet_getDnsIpAddress
- SPI_Ethernet_getlpMask

- SPI_Ethernet_confNetwork

- SPI_Ethernet_arpResolve

- SPI_Ethernet_sendUDP

- SPI_Ethernet_dnsResolve

- SPI_Ethernet_initDHCP

- SPI_Ethernet_doDHCPLeaseTime
- SPI_Ethernet_renewDHCP
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SPI_Ethernet_Init

Prototype

procedure SPI Ethernet Init (mac: “byte; ip: “byte; fullDuplex:
byte);

Returns

Nothing.

Description

This is MAC module routine. It initializes Enc28760 controller. This function is
internaly splited into 2 parts to help linker when coming short of memory.

ENC28J60 controller settings (parameters not mentioned here are set to default):

- receive buffer start address : 0x0000.

- receive buffer end address : 0x19aD.

- transmit buffer start address: 0x19aE.

- transmit buffer end address : 0x1FFF.

- RAM buffer read/write pointers in auto-increment mode.

- receive filters set to default: CRC + MAC Unicast + MAC Broadcast in OR mode.

- flow control with TX and RX pause frames in full duplex mode.

- frames are padded to 60 bytes + CRC.

- maximum packet size is set to 1518.

- Back-to-Back Inter-Packet Gap: 0x15 in full duplex mode; 0x12 in half duplex mode.

- Non-Back-to-Back Inter-Packet Gap: 0x0012 in full duplex mode; 0x0C12 in
half duplex mode.

- Collision window is set to 63 in half duplex mode to accomodate some
ENC28J60 revisions silicon bugs.

- CLKOUT output is disabled to reduce EMI generation.

- half duplex loopback disabled.

- LED configuration: default (LEDA-link status, LEDB-link activity).

Parameters:

- mac: RAM buffer containing valid MAC address.

- ip: RAM buffer containing valid IP address.

- fullpuplex: ethernet duplex mode switch. Valid values: 0 (half duplex mode)
and 1 (full duplex mode).

Requires

Global variables :

- spI Ethernet Cs: Chip Select line

- SPI Ethernet CS Direction: Direction of the Chip Select pin
- spI Ethernet RST: Resetline

- SPI Ethernet RST Direction: Direction of the Reset pin

must be defined before using this function.

The SPI module needs to be initialized. See the SPI1_Init and
SPI1_Init_Advanced routines.
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// SPI Ethernet module connections
var SPI Ethernet RST sbit at RCO bit;
var SPI Ethernet CS : sbit at RC1 bit;
var SPI Ethernet RST Direction sbit at TRISCO bit;
var SPI Ethernet CS Direction sbit at TRISCl bit;
const SPI Ethernet HALFDUPLEX = 0;
const SPI Ethernet FULLDUPLEX = 1;
var
myMacAddr arrayl 6] of byte; // my MAC address
myIpAddr arrayl 4] of byte; // my IP addr
Example myMacAddr[ 0] := 0x00;
myMacAddr[ 1] := 0x14;
myMacAddr[ 2] := O0xA5;
myMacAddr[ 3] := 0x76;
myMacAddr[ 4] := 0x19;
myMacAddr[ 5] := O0x3F;
myIpAddr[ 0] = 192;
myIpAddr 1] = 168;
myIpAddr| 2] = 1;
myIpAddr[ 3] = 60;
SPI Init();

SPI Ethernet

Init (myMacAddr, myIpAddr,

SPI Ethernet FULLDUPLEX) ;
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SPI_Ethernet_Enable

Prototype procedure SPI Ethernet Enable(enFlt : byte);

Returns Nothing.

This is MAC module routine. This routine enables appropriate network traffic on
the ENC28J60 module by the means of it's receive filters (unicast, multicast,
broadcast, crc). Specific type of network traffic will be enabled if a correspon-
ding bit of this routine's input parameter is set. Therefore, more than one type of
network traffic can be enabled at the same time. For this purpose, predefined
library constants (see the table below) can be ORed to form appropriate input
value.

Parameters:

- enF1t: network traffic/receive filter flags. Each bit corresponds to the
appropriate network traffic/receive filter:

Bit | Mask Description Predefined library const

MAC Broadcast traffic/receive fil-
0 0x01 [ter flag. When set, MAC broad- | SPI Ethernet BROADCAST
cast traffic will be enabled.

MAC Multicast traffic/receive filter
1 0x02 [flag. When set, MAC multicast _SPI Ethernet MULTICAST

Description traffic will be enabled.
2 0x04 [not used none
0x08 [not used none
4 0x10 |not used none

CRC check flag. When set, pack-
5 0x20 [ets with invalid CRC field willbe | SPI Ethernet CRC
discarded.

6 0x40 [not used none

MAC Unicast traffic/receive filter
7 0x80 [flag. When set, MAC unicast traf- | SPI Ethernet UNICAST
fic will be enabled.

Note: Advance filtering available in the Enc28760 module such as pattern
Match, Magic Packet and Hash Table can not be enabled by this routine. Addi-
tionaly, all filters, except CRC, enabled with this routine will work in OR mode,
which means that packet will be received if any of the enabled filters accepts it.
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Note: This routine will change receive filter configuration on-the-fly. It will not, in
any way, mess with enabling/disabling receive/transmit logic or any other part of
the EnC28760 module. The £nc28760 module should be properly cofigured by
the means of SPI_Ethernet_Init routine.

Description

Requires Ethernet module has to be initialized. See SPI_Ethernet_Init.

SPI Ethernet Enable( SPI Ethernet CRC or SPI Ethernet UNICAST);

Example // enable CRC checki;q and Unicast traffic

SPI_Ethernet_Disable

Prototype procedure SPI Ethernet Disable(disFlt : byte);

Returns Nothing.

This is MAC module routine. This routine disables appropriate network traffic on the
ENC28J60 module by the means of it's receive filters (unicast, multicast, broadcast,
crc). Specific type of network traffic will be disabled if a corresponding bit of this rou-
tine's input parameter is set. Therefore, more than one type of network traffic can be
disabled at the same time. For this purpose, predefined library constants (see the
table below) can be ORed to form appropriate input value.

Parameters:

- disF1t: network traffic/receive filter flags. Each bit corresponds to the
appropriate network traffic/receive filter:

Bit | Mask Description Predefined library const

MAC Broadcast traffic/receive filter
0 [ 0x01 |flag. When set, MAC broadcast traf- | SPI Ethernet BROADCAST
fic will be disabled.

Description MAC Multicast traffic/receive filter
1 [ 0x02 |flag. When set, MAC multicast traf- | sPI_Ethernet MULTICAST
fic will be disabled.

0x04 [not used none
0x08 [not used none
0x10 |not used none
CRC check flag. When set, CRC
5 | 0x20 |check will be disabled and packets _SPI Ethernet CRC
with invalid CRC field will be accepted.
6 | 0x40 |not used none

MAC Unicast traffic/receive filter
7 | 0x80 |flag. When set, MAC unicast traffic | SPI_Ethernet UNICAST
will be disabled.
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Note: Advance filtering available in the Enc28760 module such as pattern
Match, Magic Packet and Hash Table can not be disabled by this routine.

Description |[Note: This routine will change receive filter configuration on-the-fly. It will not, in
any way, mess with enabling/disabling receive/transmit logic or any other part of
the Enc28360 module. The enc28J60 module should be properly cofigured by
the means of SPI_Ethernet_Init routine.

Requires Ethernet module has to be initialized. See SPI_Ethernet_|Init.

SPIiEthernetiDisable(7SP17Ethernet7CRC or SPI Ethernet UNICAST);
// disable CRC checking and Unicast traffic

Example

SPI_Ethernet_doPacket

Prototype function SPI Ethernet doPacket() : byte;

- 0 - upon successful packet processing (zero packets received or received
packet processed successfully).

- 1 - upon reception error or receive buffer corruption. Enc28760 controller

Returns needs to be restarted.

- 2 - received packet was not sent to us (not our IP, nor IP broadcast address).

- 3 - received IP packet was not IPv4.

- 4 - received packet was of type unknown to the library.

This is MAC module routine. It processes next received packet if such exists.
Packets are processed in the following manner:

- ARP & ICMP requests are replied automatically.

- upon TCP request the SPI_Ethernet_UserTCP function is called for further
processing.

- upon UDP request the SPI_Ethernet_UserUDP function is called for further
processing.

Description

Note: sPT Ethernet doPacket must be called as often as possible in user's code.

Requires Ethernet module has to be initialized. See SPI_Ethernet_Init.

while true do
begin

Example SPI Ethernet doPacket(); // process received packets

end;
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SPI_Ethernet_putByte

Prototype procedure SPI Ethernet putByte(v : byte);

Returns Nothing.

This is MAC module routine. It stores one byte to address pointed by the cur-
rent ENC28760 write pointer (EWRPT).

Description Parameters:

- v: value to store

Requires Ethernet module has to be initialized. See SPI_Ethernet_Init.

var
data : byte;
Example .
SPI Ethernet putByte(data); // put an byte into ENC28J60
buffer

SPI_Ethernet_putBytes

Prototype procedure SPI Ethernet putBytes(ptr : “byte; n : byte);

Returns Nothing.

This is MAC module routine. It stores requested number of bytes into
ENC28J60 RAM starting from current snc28J60 write pointer (2wrpT) location.

Description |Parameters:

- ptr: RAM buffer containing bytes to be written into ENC28J60 RAM.
- n: number of bytes to be written.

Requires Ethernet module has to be initialized. See SPI_Ethernet_Init.

var
buffer : array| 17] of byte;

Example buffer := 'mikroElektronika';

SPI Ethernet putBytes (buffer, 16); // put an RAM array into
ENC28J60 buffer
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SPI_Ethernet_putConstBytes
Prototype procedure SPI Ethernet putConstBytes(const ptr : “byte; n : byte);
Returns Nothing.
This is MAC module routine. It stores requested number of const bytes into
ENC28J60 RAM starting from current Enc28J60 write pointer (EwrpT) location.
Description |Parameters:
- ptr: const buffer containing bytes to be written into Enc28760 RAM.
- n: number of bytes to be written.
Requires Ethernet module has to be initialized. See SPI_Ethernet_Init.
const
buffer : array 17] of byte;
Example gg%fer := 'mikroElektronika';
ééigEthernetgputConstByteS(buffer, 16); // put a const array
into ENC28J60 buffer
SPI_Ethernet_putString
Prototype function SPI Ethernet putString(ptr : “byte) : word;
Returns Number of bytes written into ENC28J60 RAM.
This is MAC module routine. It stores whole string (excluding null termination) into
ENC28760 RAM starting from current Enc28760 write pointer (ewrpT) location.
Description Parameters:
- ptr: string to be written into ENC28J60 RAM.
Requires Ethernet module has to be initialized. See SPI_Ethernet_Init.
var
buffer : string] 16] ;
Example g;ifer := 'mikroElektronika';
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SPI_Ethernet_putConstString

Prototype function SPI Ethernet putConstString(const ptr : “byte) : word;

Returns Number of bytes written into enc28760 RAM.

This is MAC module routine. It stores whole const string (excluding null termination)
into Enc28760 RAM starting from current Enc28J60 write pointer (EwrPT) location.

Description Parameters:
- ptr: const string to be written into ENC28J60 RAM.
Requires Ethernet module has to be initialized. See SPI_Ethernet_Init.
const
buffer : stringl 16] ;
Example k'n;%fer := 'mikroElektronika';

SPI Ethernet putConstString(buffer); // put a const string into
ENC28J60 buffer

SPI_Ethernet_getByte

Prototype |function SPI Ethernet getByte() : byte;

Returns Byte read from enc28760 RAM.

This is MAC module routine. It fetches a byte from address pointed to by cur-

Description .
rent ENC28J60 read pointer (ERDPT).
Requires Ethernet module has to be initialized. See SPI_Ethernet_|Init.
var
buffer : byte;
Example S
buffer := SPI Ethernet getByte(); // read a byte from ENC28J60
buffer
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SPI_Ethernet_getBytes

procedure SPI Ethernet getBytes (ptr : “byte; addr : word; n :

Prototype byte) ;

Returns Nothing.
This is MAC module routine. It fetches equested number of bytes from
ENC28J60 RAM starting from given address. If value of 0xrFrrF is passed as the
address parameter, the reading will start from current Exnc28J60 read pointer
(ErDPT) location.

Description

Parameters:

- ptr: buffer for storing bytes read from enc28760 RAM.
- addr: ENC28J60 RAM start address. Valid values: 0. .8192.
- n: number of bytes to be read.

Requires Ethernet module has to be initialized. See SPI_Ethernet_|Init.

var
buffer: array 16] of byte;
Example o
SPI Ethernet getBytes (buffer, 0x100, 16); // read 16 bytes,
starting from address 0x100
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SPI_Ethernet_UserTCP

Prototvpe function SPI Ethernet UserTCP(var remoteHost : array[ 4] of byte;
yp remotePort, localPort, reqlength : word) : word;
- 0 - there should not be a reply to the request.
Returns ply q

- Length of TCP/HTTP reply data field - otherwise.

This is TCP module routine. It is internally called by the library. The user
accesses to the TCP/HTTP request by using some of the SPI_Ethernet_get rou-
tines. The user puts data in the transmit buffer by using some of the SPI_Ether-
net_put routines. The function must return the length in bytes of the TCP/HTTP
reply, or O if there is nothing to transmit. If there is no need to reply to the
TCP/HTTP requests, just define this function with return(0) as a single state-
ment.

Description |Parameters:

- remoteHost : client's IP address.

- remotePort: client's TCP port.

- localport: port to which the request is sent.

- reglength: TCP/HTTP request data field length.

Note: The function source code is provided with appropriate example projects.
The code should be adjusted by the user to achieve desired reply.

Requires Ethernet module has to be initialized. See SPI_Ethernet_Init.

This function is internally called by the library and should not be called by the

Example
P user's code.
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SPI_Ethernet_UserUDP

Protot function SPI Ethernet UserUDP(var remoteHost : arrayl 4] of byte;
rototype remotePort, destPort, reglength : word) : word;

Returns - 0 - there should not be a reply to the request.
- Length of UDP reply data field - otherwise.
This is UDP module routine. It is internally called by the library. The user
accesses to the UDP request by using some of the SPI_Ethernet_get routines.
The user puts data in the transmit buffer by using some of the
SPI_Ethernet_put routines. The function must return the length in bytes of the
UDP reply, or 0 if nothing to transmit. If you don't need to reply to the UDP
requests, just define this function with a return(0) as single statement.

i Parameters:

Description
- remoteHost! client's IP address.
- remoteport: client's port.
- destport: port to which the request is sent.
- regLength: UDP request data field length.
Note: The function source code is provided with appropriate example projects.
The code should be adjusted by the user to achieve desired reply.

Requires Ethernet module has to be initialized. See SPI_Ethernet_Init.
This function is internally called by the library and should not be called by the

Example '
user's code.
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SPI_Ethernet_getlpAddress

Prototype function SPI Ethernet getIpAddress() : word;

Returns Ponter to the global variable holding IP address.

This routine should be used when DHCP server is present on the network to
fetch assigned IP address.

Description Note: User should always copy the IP address from the RAM location returned
by this routine into it's own IP address buffer. These locations should not be
altered by the user in any case!

Ethernet module has to be initialized. See SPI_Ethernet_Init.

Requires
Available for PIC18 family MCUs only.
var
ipAddr : arrayl[ 4] of byte; // user IP address buffer
Example o
memcpy (ipAddr, SPI Ethernet getIpAddress(), 4); // fetch IP
address a B

SPI_Ethernet_getGwlpAddress

Prototype function SPI Ethernet getGwIpAddress() : word;

Returns Ponter to the global variable holding gateway IP address.

This routine should be used when DHCP server is present on the network to
fetch assigned gateway IP address.

Description Note: User should always copy the IP address from the RAM location returned
by this routine into it's own gateway IP address buffer. These locations should
not be altered by the user in any case!

Ethernet module has to be initialized. See SPI_Ethernet_Init.

Requires
Available for PIC18 family MCUs only.
var
gwIpAddr : arrayl 4] of byte; // user gateway IP address
buffer
Example
memcpy (gwIpAddr, SPI _Ethernet getGwIpAddress(), 4); // fetch

gateway IP address
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SPI_Ethernet_getDnsipAddress

Prototype function SPI Ethernet getDnsIpAddress () : word;

Returns Ponter to the global variable holding DNS IP address.

This routine should be used when DHCP server is present on the network to
fetch assigned DNS IP address.

Description Note: User should always copy the IP address from the RAM location returned
by this routine into it's own DNS IP address buffer. These locations should not

be altered by the user in any case!

Ethernet module has to be initialized. See SPI_Ethernet_|Init.

Requires
Available for PIC18 family MCUs only.
var
dnsIpAddr : arrayl 4] of byte; // user DNS IP address buffer
Example

memcpy (dnsIpAddr, SPI Ethernet getDnsIpAddress(), 4); // fetch
DNS server address

SPI_Ethernet_getlpMask

Prokﬂype function SPI Ethernet getIpMask() : word;

Returns Ponter to the global variable holding IP subnet mask.

This routine should be used when DHCP server is present on the network to
fetch assigned IP subnet mask.

Description Note: User should always copy the IP address from the RAM location returned
by this routine into it's own IP subnet mask buffer. These locations should not

be altered by the user in any case!

Ethernet module has to be initialized. See SPI_Ethernet_Init.

Requires
Available for PIC18 family MCUs only.
var
IpMask : arrayl 4] of byte; // user IP subnet mask buffer
Example o
memcpy (IpMask, SPI Ethernet getIpMask(), 4); // fetch IP subnet
mask
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SPI_Ethernet_confNetwork

procedure SPI Ethernet confNetwork(var ipMask, gwIpAddr,

Prototype || -/ .iar . array 4] of byte);

Returns Nothing.

Configures network parameters (IP subnet mask, gateway IP address, DNS IP
address) when DHCP is not used.

Parameters:
Description |- ipMask: IP subnet mask.
- gwIpAddr gateway |IP address.

- dnsIpAddr: DNS IP address.

Note: The above mentioned network parameters should be set by this routine
only if DHCP module is not used. Otherwise DHCP will override these settings.

Ethernet module has to be initialized. See SPI_Ethernet_Init.

Requires
Available for PIC18 family MCUs only.
var
ipMask : array| 4] of byte; // network mask (for example
255.255.255.0)
gwIpAddr : arrayl 4] of byte; // gateway (router) IP address
dnsIpAddr : arrayl 4] of byte; // DNS server IP address
gwIpAddzr| 0] = 192;
gwIpAddr| 1] := 168;
gwIpAddr[ 2] := 20;
gwIpAddr[ 3] = 067
Example dnsIpAddr] 0] := 192;
dnsIpAddr[ 1] := 168;
dnsIpAddr[ 2] := 20;
dnsIpAddr[ 3] := 100;
ipMask[ 0] .= 255;
ipMask[ 1] .= 255;
ipMask[ 2] .= 255;
ipMask[ 3] = 07

SPI Ethernet confNetwork (ipMask, gwIpAddr, dnsIpAddr); // set
network configuration parameters

436 MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



CHAPTER 7
mikroPASCAL PRO for PIC Libraries

SPI_Ethernet_arpResolve

function SPI Ethernet arpResolve (var i : arrayl 4] of byte; tmax
Prototype : ST _arp p Vi y

: byte) : word;
Returns - MAC address behind the IP address - the requested IP address was resolved.

- 0 - otherwise.

This is ARP module routine. It sends an ARP request for given IP address and
waits for ARP reply. If the requested IP address was resolved, an ARP cash
entry is used for storing the configuration. ARP cash can store up to 3 entries.
For ARP cash structure refer to "eth enc28j60Libbef.h" header file in the
compiler's Uses/P18 folder.

Description |[Parameters:

- ip: IP address to be resolved.
- tmax: time in seconds to wait for an reply.

Note: The Ethernet services are not stopped while this routine waits for ARP
reply. The incoming packets will be processed normaly during this time.

Ethernet module has to be initialized. See SPI_Ethernet_Init.

Requires
Available for PIC18 family MCUs only.
var
IpAddr : array[ 4] of byte; // IP address
TpAddr[ 0] := 192;
IpAddr[ 0] := 168;
Example TpAddr( 0] := 1;
IpAddr[ 0] := 1;

SPI Ethernet arpResolve (IpAddr, 5); // get MAC address behind
the above IP address, wait 5 secs for the response

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD 437



CHAPTER 7
Libraries mikroPASCAL PRO for PIC

SPI_Ethernet_sendUDP

function SPI Ethernet sendUDP(var destIP : arrayl 4] of byte;
sourcePort, destPort : word; pkt : "“byte; pktlLen : word) : byte;

Prototype

- 1 - UDP packet was sent successfully.

Returns .
- 0 - otherwise.

This is UDP module routine. It sends an UDP packet on the network.
Parameters:

Description |- dest1P: remote host IP address.

- sourcePort: local UDP source port number.
- destprort: destination UDP port number.

- pkt: packet to transmit.

- pktLen: length in bytes of packet to transmit.

Ethernet module has to be initialized. See SPI_Ethernet_Init.

Requires
Available for PIC18 family MCUs only.
var
IpAddr : arrayl 4] of byte; // remote IP address
IpAddr[ 0] := 192;
IpAddr[ 0] := 168;
Example IpAddr[ 0] := 1;
IpAddr[ 0] := 1;

SPI Ethernet sendUDP (IpAddr, 10001, 10001, 'Hello', 5); // send
Hello message to the above IP address, from UDP port 10001 to
UDP port 10001
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SPI_Ethernet_dnsResolve

Protot function SPI Ethernet dnsResolve(var host : arrayf 4] of byte;
rototype tmax : byte) : word;
- pointer to the location holding the IP address - the requested host name was
Returns resolved.
- 0 - otherwise.
This is DNS module routine. It sends an DNS request for given host name and
waits for DNS reply. If the requested host name was resolved, it's IP address is
stored in library global variable and a pointer containing this address is returned
by the routine. UDP port 53 is used as DNS port.
Parameters:
. - host: host name to be resolved.
Description L .
- tmax: time in seconds to wait for an reply.
Note: The Ethernet services are not stopped while this routine waits for DNS
reply. The incoming packets will be processed normaly during this time.
Note: User should always copy the IP address from the RAM location returned
by this routine into it's own resolved host IP address buffer. These locations
should not be altered by the user in any case!
Ethernet module has to be initialized. See SPI_Ethernet_Init.
Requires
Available for PIC18 family MCUs only.
var
remoteHostIpAddr : arrayl 4] of byte; // user host IP address
buffer
// SNTP server:
Exanuﬂe // Zurich, Switzerland: Integrated Systems Lab, Swiss Fed.
Inst. of Technology
// 129.132.2.21: swisstime.ethz.ch
// Service Area: Switzerland and Europe
memcpy (remoteHostIpAddr,
SPI Ethernet dnsResolve('swisstime.ethz.ch', 5), 4);

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD

439



CHAPTER 7
Libraries mikroPASCAL PRO for PIC

SPI_Ethernet_initDHCP

Prototype function SPI Ethernet initDHCP(tmax : byte) : byte;

- 1 - network parameters were obtained successfully.

Returns .
- 0 - otherwise.

This is DHCP module routine. It sends an DHCP request for network parame-
ters (IP, gateway, DNS addresses and IP subnet mask) and waits for DHCP
reply. If the requested parameters were obtained successfully, their values are
stored into the library global variables.

These parameters can be fetched by using appropriate library IP get routines:
- SPI_Ethernet_getlpAddress - fetch IP address.

- SPI_Ethernet_getGwlIpAddress - fetch gateway IP address.

- SPI_Ethernet_getDnslpAddress - fetch DNS IP address.

- SPI_Ethernet_getlpMask - fetch IP subnet mask.

Description [UDP port 68 is used as DHCP client port and UDP port 67 is used as DHCP
server port.

Parameters:
- tmax: time in seconds to wait for an reply.

Note: The Ethernet services are not stopped while this routine waits for DNS
reply. The incoming packets will be processed normaly during this time.

Note: When DHCP module is used, global library variable
SPI Ethernet userTimerSec is used to keep track of time. It is user responsi-
bility to increment this variable each second in it's code.

Ethernet module has to be initialized. See SPI_Ethernet_Init.
Requires
Available for PIC18 family MCUs only.

SPI Ethernet initDHCP(5); // get network configuration from

Example DHCP server, wait 5 sec for the response
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SPI_Ethernet_doDHCPLeaseTime

Prototype function SPI Ethernet doDHCPLeaseTime () : byte;
yp _ _

- 0 - lease time has not expired yet.

Returns - 1 - lease time has expired, it's time to renew it.

This is DHCP module routine. It takes care of IP address lease time by decre-
Description |menting the global lease time library counter. When this time expires, it's time to
contact DHCP server and renew the lease.

Ethernet module has to be initialized. See SPI_Ethernet_Init.

Requires
Available for PIC18 family MCUs only.
while true do
begin
if (SPI Ethernet doDHCPLeaseTime () <> 0) then
Example L -
begin
// it's time to renew the IP address lease
end;

end;

SPI_Ethernet_renewDHCP

Prototype function SPI Ethernet renewDHCP (tmax : byte) : byte;
yp _ _

- 1 - upon success (lease time was renewed).

Returns - 0 - otherwise (renewal request timed out).

This is DHCP module routine. It sends IP address lease time renewal request to
DHCP server.

Description Parameters:

- tmax: time in seconds to wait for an reply.

Ethernet module has to be initialized. See SPI_Ethernet_|Init.
Requires
Available for PIC18 family MCUs only.
while true do

begin

if (SPI Ethernet doDHCPLeaseTime () <> 0) then
begin
SPI Ethernet renewDHCP(5); // it's time to renew the IP
address lease, with 5 secs for a reply
end;

Example

end;
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Library Example
This code shows how to use the PIC18 Ethernet mini library :

- the board will reply to ARP & ICMP echo requests

- the board will reply to UDP requests on any port :
returns the request in upper char with a header made of remote host IP &
port number

- the board will reply to HTTP requests on port 80, GET method with pathnames :
/ will return the HTML main page
/s will return board status as text string
/t0 ... t7 will toggle RDO to RD7 bit and return HTML main page
all other requests return also HTML main page.

program enc_ethernet;

{***********************************
* RAM variables
*}
var myMacAddr : array[ 6] of byte ; // my MAC address
myIpAddr : array[ 4] of byte ; // my IP address

// mE ehternet NIC pinout
SPI Ethernet Rst : sbit at PORTC.BO;

SPI Ethernet CS : sbit at PORTC.BI1;
SPI Ethernet Rst Direction : sbit at TRISC.BO;
SPI Ethernet CS Direction : sbit at TRISC.B1;

// end ethernet NIC definitions

{\k*\k*\k*\k*\k*\k*\k*\k*\k*\k*\k*\k*\k*\k*\k*******************************
* ROM constant strings
*}

const httpHeader : stringf 30] = 'HTTP/1.1 200 OK'+#10+'Content-type:
' ; // HTTP header

const httpMimeTypeHTML : string] 11] = 'text/html'+#10+#10 ;
// HTML MIME type

const httpMimeTypeScript : stringl 12] = 'text/plain'+#10+#10 ;
// TEXT MIME type

const httpMethod : string( 5] = 'GET /';

{ *

* web page, splited into 2 parts

* when coming short of ROM, fragmented data is handled more effi-
ciently by linker

*

* this HTML page calls the boards to get its status, and builds
itself with javascript

*}
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const indexPage : stringl 759] =
'<meta http-equiv="refresh"
content="3;url=http://192.168.20.60">" +
'<HTML><HEAD></HEAD><BODY> '+
'<h1>PIC + ENC28J60 Mini Web Server</hl>'+
'<a href=/>Reload</a>"+
'<script src=/s></script>'+
'<table><tr><td valign=top><table border=1
style="font-size:20px ;font-family: terminal ;">'+
'<tr><th colspan=2>ADC</th></tr>"'+

'<Er><td>AN2</td><td><script>document.write (AN2)</script></td></tr>"'
+

'<tr><td>AN3</td><td><script>document.write (AN3)</script></td></tr>"
+

'</table></td><td><table border=1 style="font-
size:20px ;font-family: terminal ;">'+

'<tr><th colspan=2>PORTB</th></tr>"'+

'<script>"'+

'var str,i; '+

'str=""; "+

'for (1=0;1<8;1i++) "+

"{ str+="<tr><td bgcolor=pink>BUTTON #"+i+"</td>"; "'+

'if (PORTB& (1<<1i) ){ str+="<td bgcolor=red>ON";} '+

'else { str+="<td bgcolor=#cccccc>OFF";} "+

'str+="</td></tr>";} '+

'document.write (str) ;'+

'</script>"';

const indexPage2 : string] 466] =
'</table></td><td>'+
'<table border=1 style="font-size:20px ;font-
family: terminal ;">'+
'<tr><th colspan=3>PORTD</th></tr>"'+
'<script>"'+
'var str,i; '+
'str=""; "'+
'for (1=0;1<8;1i++) '+
"{ str+="<tr><td bgcolor=yellow>LED #"+i+"</td>";'+
'if (PORTD& (1<<1i) ){ str+="<td bgcolor=red>ON";} '+
'else { str+="<td bgcolor=#cccccc>OFF";} "+
'str+="</td><td><a
href=/t"+i+">Toggle</a></td></tr>";} '+
'document.write (str) ;'+
'</script>'+
'</table></td></tr></table>'+
'This is HTTP request
#<script>document.write (REQ)</script></BODY></HTML>';
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var getRequest : array| 15] of byte; // HTTP request buffer
dyna : arrayl 30] of Dbyte; // buffer for dynamic
response
tmp: stringl 11] ; // auxiliary ram string
httpCounter : word ; // counter of HTTP requests

{*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k***********************

* user defined functions

*}

{*

* this function is called by the library

* the user accesses to the HTTP request by successive calls to
SPI Ethernet getByte()

* the user puts data in the transmit buffer by successive calls to
SPI Ethernet putByte()

* the function must return the length in bytes of the HTTP reply,
or 0 if nothing to transmit

*

* 1f you don't need to reply to HTTP requests,

* just define this function with a return(0) as single statement

*

*}

function SPI Ethernet UserTCP(var remoteHost : arrayl 4] of byte;
remotePort, localPort, reqlength
word) : word;
var 1 : word ; // my reply length
bitMask : byte ; // for bit mask
begin
result := 0;

if (localPort <> 80) then // I listen only to web request on port
80
begin
result := 0;
exit;
end;

// get 10 first bytes only of the request, the rest does not mat-
ter here
for i := 0 to 9 do
getRequest[ i] = SPI Ethernet getByte() ;
getRequest[ i] := 0 ;

// copy httpMethod to ram for use in memcmp routine
for i := 0 to 4 do
tmp[ 1] := httpMethod i] ;
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if (memcmp (@getRequest, @tmp, 5) <> 0) then // only GET method is
supported here
begin
result := 0 ;
exit;
end;

Inc (httpCounter) ; // one more request done

if (getRequest[ 5] = 's') then // if request path name starts with
s, store dynamic data in transmit buffer
begin
// the text string replied by this request can be interpret-
ed as javascript statements
// by browsers
result := SPI Ethernet putConstString(ChttpHeader) ;
// HTTP header

result = result +

SPI Ethernet putConstString(@httpMimeTypeScript) ; // with text MIME
type

// add AN2 value to reply

WordToStr (ADC Read(2), dyna) ;

tmp := 'var AN2='";

result := result + SPI Ethernet putString(Qtmp) ;

result := result + SPI Ethernet putString(Q@dyna) ;

tmp = ';';

result := result + SPI Ethernet putString(Qtmp) ;

// add AN3 value to reply

WordToStr (ADC_Read(3), dyna) ;

tmp := 'var AN3=';

result := result + SPI Ethernet putString(Ctmp) ;

result := result + SPI Ethernet putString(Qdyna) ;

tmp = ';';

result := result + SPI Ethernet putString(Qtmp) ;

// add PORTB value (buttons) to reply

tmp := 'var PORTB= ';

result := result + SPI Ethernet putString(Qtmp) ;
WordToStr (PORTB, dyna) ;

result := result + SPI Ethernet putString(Qdyna) ;
tmp = ';';

result := result + SPI Ethernet putString(Ctmp) ;

// add PORTD value (LEDs) to reply

tmp := 'var PORTD= ';

result := result + SPI Ethernet putString(Qtmp) ;
WordToStr (PORTD, dyna) ;

result := result + SPI Ethernet putString(@dyna) ;
tmp = ';"';

result := result + SPI Ethernet putString(Qtmp) ;
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// add HTTP requests counter to reply
WordToStr (httpCounter, dyna) ;

tmp := 'var REQ= '
result := result + SPI Ethernet putString(Qtmp) ;
result := result + SPI Ethernet putString(@dyna) ;
tmp = ';';
result := result + SPI Ethernet putString(Qtmp) ;

end

else
if (getRequest[ 5] = 't') then // if request path
name starts with t, toggle PORTD (LED) bit number that comes after
begin
bitMask := 0;

if (isdigit (getRequest[ 6] ) <> 0) then // if 0 <= bit num-
ber <= 9, bits 8 & 9 does not exist but does not matter

begin
bitMask := getRequest[ 6] - 'O' ; // convert ASCII to
integer
bitMask := 1 shl bitMask ; // create bit mask
PORTD := PORTD xor bitMask ; // toggle PORTD with
XOor operator
end;

end;

if (result = 0) then // what do to by default

begin
result := SPI Ethernet putConstString(@httpHeader) ; // HTTP
header
result = result +
SPI Ethernet putConstString(@httpMimeTypeHTML) ; // with HTML MIME
type
result := result + SPI Ethernet putConstString(@indexPage) ;
// HTML page first part
result := result + SPI Ethernet putConstString(@indexPage2)
; // HTML page second part
end;
// return to the library with the number of bytes to transmit
end;

{*

* this function is called by the library

* the user accesses to the UDP request by successive calls to
SPI Ethernet getByte()

* the user puts data in the transmit buffer by successive calls to
SPI Ethernet putByte ()

* the function must return the length in bytes of the UDP reply, or
0 if nothing to transmit

*
* 1f you don't need to reply to UDP requests,

* just define this function with a return(0) as single statement
*

*

}
function SPI Ethernet UserUDP(var remoteHost : array[ 4] of byte;
remotePort, destPort, reglLength
word) : word;
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begin

result := 0;

// reply is made of the remote host IP address in human readable
format

byteToStr (remoteHost[ 0] , dyna) ; // first IP address byte

dyna[ 3] := '.'

byteToStr (remoteHost[ 1] , tmp) ; // second

dynal 4] := tmp[ 0] ;

dyna[ 5] = tmp[ 1] ;

dyna[ 6] = tmp[ 2] ;

dynal 7] = "'.' ;

byteToStr (remoteHost[ 2] , tmp) ; // second

dynal 8] := tmp[ 0] ;

dynal 9] = tmp[ 1] ;

dyna[ 10] = tmp[ 2] ;

dynal[ 11] == "'.' ;

byteToStr (remoteHost[ 3], tmp) ; // second

dynal 12] = tmp[ 0] ;

dyna[ 13] = tmp[ 1] ;

dyna[ 14] = tmp[ 2] ;

dynal 15] := ':' ; // add separator

// then remote host port number
tmp)

WordToStr (remotePort,

dynal 16] := tmp[ 0] ;
dynal 17] = tmp[ 1] ;
dyna[ 18] = tmp[ 2] ;
dynal 19] := tmp[ 3] ;
dynal 20] := tmp[ 4] ;
dynal 21] := '[ ' ;
WordToStr (destPort, tmp)
dynal 22] := tmp[ 0] ;
dynal 23] := tmp[ 1] ;
dynal 24] := tmpl 2] ;
dynal 25] := tmp[ 3] ;
dynal 26] := tmp[ 4] ;
dynal 27] := ']"' ;
dynal 28] := 0 ;

’

// the total length of the request is the length of the dynamic
string plus the text of the request

result := 28 + reglength

’

// puts the dynamic string into the transmit buffer
SPI Ethernet putBytes(@dyna, 28) ;

// then puts the request string converted into upper char into the

transmit buffer
while (regLength <> 0)

do
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begin
SPI Ethernet putByte(SPI Ethernet getByte()) -
regqlLength := reglength - 1;
end;
// back to the library with the length of the UDP reply
end;
begin

ANSEL := 0x0C ; // BAN2 and AN3 convertors will be used
PORTA := 0 ;
TRISA := Oxff ; // set PORTA as input for ADC
ANSELH := 0; // Configure other AN pins as digital I/O
PORTB = 0 ;
TRISB = 0Oxff ; // set PORTB as input for buttons
PORTD := 0 ;
TRISD := 0 ; // set PORTD as output
httpCounter := 0;

// set mac address

myMacAddr[ 0] := 0x00;
myMacAddr 1] := 0x14;
myMacAddzr[ 2] := 0xA5;
myMacAddr[ 3] := 0x76;
myMacAddzr[ 4] := 0x19;
myMacAddr[ 5] := O0x3F;

// set IP address

myIpAddr[ 0] := 192;
myIpAddr[ 1] := 168;
myIpAddr 2] := 20;
myIpAddr 3] := 60;
{*k
* starts ENC28J60 with
* reset bit on PORTC.BO
* CS bit on PORTC.B1
* my MAC & IP address
* full duplex
*

SPI1 Init(); // init spi module
SPI Ethernet Init (myMacAddr, myIpAddr, SPI Ethernet FULLDUPLEX) ;
// init ethernet module
SPI Ethernet setUserHandlers (@SPI Ethernet UserTCP,
@SPI Ethernet UserUDP); // set user handlers
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while true do // do forever
begin
SPI Ethernet doPacket() ; // process incoming Ethernet packets

{*
* add your stuff here if needed
* SPI Ethernet doPacket () must be called as often as possible
* otherwise packets could be lost
*}
end;
end.
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SPI GRAPHIC LCD LIBRARY

The mikroPascal PRO for PIC provides a library for operating Graphic Lcd 128x64
(with commonly used Samsung KS108/KS107 controller) via SPI interface.

For creating a custom set of Glcd images use Glcd Bitmap Editor Tool.

Note: The library uses the SPI module for communication. User must initialize SPI
module before using the SPI Graphic Lcd Library.

For MCUs with two SPI modules it is possible to initialize both of them and then
switch by using the SPI_Set_Active() routine.

Note: This Library is designed to work with the mikroElektronika's Serial Lcd/Gled
Adapter Board pinout, see schematic at the bottom of this page for details.

External dependencies of SPI Graphic Lcd Library

The implementation of SPI Graphic Lcd Library routines is based on Port Expander
Library routines.

External dependencies are the same as Port Expander Library external dependencies.
Library Routines
Basic routines:

- SPI_Glcd_lInit

- SPI_Glcd_Set_Side

- SPI_Glcd_Set_Page
- SPI_Glcd_Set X

- SPI_Glcd_Read_Data
- SPI_Glcd_Write_Data

Advanced routines:

- SPI_Gilcd_Fill

- SPI_Glcd_Dot

- SPI_Glcd_Line

- SPI_Glcd_V _Line

- SPI_Glcd_H_Line

- SPI_Glcd_Rectangle
- SPI_Glcd_Box

- SPI_Glcd_Circle

- SPI_Glcd_Set_Font
- SPI_Glcd_Write_Char
- SPI_Glcd_Write_Text
- SPI_Glcd_Image
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SPI_Glcd_Init
Prototype procedure SPI Glcd Init (DeviceAddress : byte);
Returns Nothing.
Initializes the Glcd module via SPI interface.
i Parameters :
Description
- DeviceAddress: spi expander hardware address, see schematic at the
bottom of this page
Global variables :
- sPExpandercs: Chip Select line
- SPExpanderRST: Reset line
. - sPExpanderCs Direction: Direction of the Chip Select pin
Requires - ‘ S .
- SPExpanderRST Direction: Direction of the Reset pin
must be defined before using this function.
SPI module needs to be initialized. See SPI1_Init and SPI1_Init Advanced routines.
// port expander pinout definition
var SPExpanderCs : sbit at RC1 bit;
SPExpanderRST : sbit at RCO bit;
SPExpanderCS Direction : sbit at TRISC1 bit;
SPExpanderRST Direction : sbit at TRISC bit;
Example
// If Port Expander Library uses SPI1 module :
SPI1 Init(); // Initialize SPI module
used with PortExpander
SPI Glcd Init(0);
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SPI_Glcd_Set_Side

Prototype procedure SPI Glcd Set Side(x_pos : byte);

Returns Nothing.

Selects Glcd side. Refer to the Glcd datasheet for detail explanation.
Parameters :

- x_pos: position on x-axis. Valid values: 0..127
Description
The parameter =« pos specifies the Glcd side: values from 0 to 63 specify the
left side, values from 64 to 127 specify the right side.

Note: For side, x axis and page layout explanation see schematic at the bottom
of this page.

Requires Glcd needs to be initialized for SPI communication, see SPI_Glcd_Init routines.

The following two lines are equivalent, and both of them select the left side of Glcd:

Exampl
ample SPI Glcd Set side(0);

SPI Glcd Set Side(10);

SPI_Glcd_Set_Page

Prototype procedure SPI Glcd Set Page (page : byte);

Returns Nothing.

Selects page of Glcd.
Parameters :
Description |_ page: page number. Valid values: 0..7

Note: For side, x axis and page layout explanation see schematic at the bottom

of this page.
Requires Glcd needs to be initialized for SPI communication, see SPI_Glcd_Init routines.
Example SPI _Glcd Set Page(5);
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SPI_Glcd_Set_X

Prototype procedure SPI Glcd Set X(x _pos : byte);
Returns Nothing.
Sets x-axis position to x pos dots from the left border of Glcd within the select-
ed side.
Parameters :
Description
- x_pos: position on x-axis. Valid values: 0..63
Note: For side, x axis and page layout explanation see schematic at the bottom
of this page.
Requires Glcd needs to be initialized for SPI communication, see SPI_Glcd_Init routines.
Example SPI Glcd Set X(25);

SPI_Glcd_Read_Data

Prototype function SPI Glcd Read Data() : byte;
Returns One byte from Glcd memory.
i Reads data from the current location of Glcd memory and moves to the next
Description !
location.
Glcd needs to be initialized for SPI communication, see SPI_Glcd_Init routines.
Requires Glcd side, x-axis position and page should be set first. See the functions
SPI_Glcd_Set_Side, SPI_Glcd_Set_X, and SPI_Glcd_Set_Page.
var data : byte;
Example S
data := SPI Glcd Read Data();
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SPI_Glcd_Write_Data

Prototype procedure SPI Glcd Write Data(ddata : byte);
Returns Nothing.
Writes one byte to the current location in Glcd memory and moves to the next
location.
Description Parameters :
- Ddata: data to be written
Glcd needs to be initialized for SPI communication, see SPI_Glcd_Init routines.
Requires Glcd side, x-axis position and page should be set first. See the functions
SPI_Glcd_Set_Side, SPI_Glcd_Set_X, and SPI_Glcd_Set_Page.
var ddata : byte;
Example S
SPI Glcd Write Data (ddata);
SPL_Glcd_Fill

Prokﬁype procedure SPI Glcd Fill (pattern: byte);

Returns Nothing.

Fills Glcd memory with byte pattern.
Parameters :

Description |- pattern: byte to fill Glcd memory with

To clear the Glcd screen, use SPI_Glcd_Fill(0).

To fill the screen completely, use SPI_Glcd_Fill(OxFF).

Requires Glcd needs to be initialized for SPI communication, see SPI_Glcd_Init routines.

// Clear screen

Example SPI_Glcd Fill(0);
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SPI_Glcd_Dot
Prototype procedure SPI Glcd Dot (x pos : byte; y pos : byte; color : byte);
Returns Nothing.
Draws a dot on Glcd at coordinates (x_pos, y_pos).
Parameters :
- x_pos: X position. Valid values: 0..127
. - v pos: y position. Valid values: 0..63
Description | color: color parameter. Valid values: 0..2
The parameter color determines the dot state: O clears dot, 1 puts a dot, and 2
inverts dot state.
Note: For x and y axis layout explanation see schematic at the bottom of this page.
Requires Glcd needs to be initialized for SPI communication, see SPI_Glcd_Init routines.
E I // Invert the dot in the upper left corner
xample SPI Glcd Dot (0, 0, 2);
SPI_Glcd_Line
procedure SPI Glcd Line(x start : integer; y start : integer;
Prototype x _end : integer; y end : integer; color : byte);
Returns Nothing.
Draws a line on Glcd.
Parameters :
- x_start: X coordinate of the line start. Valid values: 0..127
Description |- v start: y coordinate of the line start. Valid values: 0..63
- x_end: X coordinate of the line end. Valid values: 0..127
- v_end: y coordinate of the line end. Valid values: 0..63
- color: color parameter. Valid values: 0..2
Parameter color determines the line color: 0 white, 1 black, and 2 inverts each dot.
Requires Glcd needs to be initialized for SPI communication, see SPI_Glcd_Init routines.
// Draw a line between dots (0,0) and (20, 30)
Example
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SPI_Glcd_V_Line

procedure SPI Glcd V Line(y start: byte; y end: byte; x pos:
PrOtOtype byte; color: byte);
Returns Nothing.
Draws a vertical line on Glcd.
Parameters :
. -y start: y coordinate of the line start. Valid values: 0..63
Description - . . .
- v end: y coordinate of the line end. Valid values: 0..63
- x_pos: X coordinate of vertical line. Valid values: 0..127
- color: color parameter. Valid values: 0..2
Parameter co1or determines the line color: 0 white, 1 black, and 2 inverts each dot.
Requires Glcd needs to be initialized for SPI communication, see SPI_Glcd_Init routines.
Example // Draw a vertical line between dots (10,5) and (10,25)
xamp SPI Glecd V Line(5, 25, 10, 1);
SPI_Glcd_H_Line
procedure SPI Glcd V Line(x start : byte; x end : byte; y pos
PrOtOtype byte; color : byte);
Returns Nothing.
Draws a horizontal line on Glcd.
Parameters :
- x start: x coordinate of the line start. Valid values: 0..127
Description |- x end: x coordinate of the line end. Valid values: 0..127
- v pos: y coordinate of horizontal line. Valid values: 0..63
- color: color parameter. Valid values: 0..2
The parameter color determines the line color: 0 white, 1 black, and 2 inverts
each dot.
Requires Glcd needs to be initialized for SPI communication, see SPI_Glcd_Init routines.
// Draw a horizontal line between dots (10,20) and (50,20)
Example

SPI Glcd H Line(10, 50, 20, 1);
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SPI_Glcd_Rectangle

procedure SPI Glcd Rectangle (x upper left : byte; y upper left :

Prototype byte; x bottom right : byte; y bottom right : byte; color : byte);
Returns Nothing.

Draws a rectangle on Glcd.

Parameters :

- x upper left: X coordinate of the upper left rectangle comner. Valid values: 0..127

-y upper left: y coordinate of the upper left rectangle corner. Valid values: 0..63

o - x bottom right: X coordinate of the lower right rectangle corner. Valid

Description = -

values: 0..127

-y bottom right: y coordinate of the lower right rectangle corner. Valid
values: 0..63

- color: color parameter. Valid values: 0..2

The parameter color determines the color of the rectangle border: 0 white, 1
black, and 2 inverts each dot.

Requires Glcd needs to be initialized for SPI communication, see SPI_Glcd_Init routines.

// Draw a rectangle between dots (5,5) and (40,40)

Example SPI Glcd Rectangle(5, 5, 40, 40, 1);
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SPI_Glcd_Box
Prokﬂype procedure SPI Glcd Box(x upper left : byte; y upper left : byte;

x _bottom right : byte; y bottom right : byte; color : byte);

Returns Nothing.

Draws a box on Glcd.
Parameters :

- x upper left: x coordinate of the upper left box corner. Valid values: 0..127
-y upper left:y coordinate of the upper left box corner. Valid values: 0..63

Description | % bottom right: X coordinate of the lower right box corner. Valid values: 0..127
-y bottom right:y coordinate of the lower right box corner. Valid values: 0..63
- color: color parameter. Valid values: 0..2
The parameter color determines the color of the box fill: 0 white, 1 black, and 2
inverts each dot.

Requires Glcd needs to be initialized for SPI communication, see SPI_Glcd_Init routines.
// Draw a box between dots (5,15) and (20,40)

Example

SPT_Glcd Box (5, 15, 20, 40, 1);

SPI_Glcd_Circle

procedure SPI Glcd Circle(x center : integer; y center : integer;
Prototype . L - o -

radius : integer; color : byte);
Returns Nothing.

Draws a circle on Glcd.
Parameters :

- x_center: X coordinate of the circle center. Valid values: 0..127
Description |- v center:y coordinate of the circle center. Valid values: 0..63
- radius: radius size

- color: color parameter. Valid values: 0..2

The parameter color determines the color of the circle line: 0 white, 1 black, and
2 inverts each dot.

Requires Glcd needs to be initialized for SPI communication, see SPI_Glcd_Init routine.

// Draw a circle with center in (50,50) and radius=10

Example SPT Glecd Circle (50, 50, 10, 1);
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SPI_Glcd_Set_Font

Prototvpe procedure SPI Glcd Set Font(activeFont : longint; aFontWidth :
yp byte; aFontHeight : byte; aFontOffs : word);
Returns Nothing.
Sets font that will be used with SPI_Glcd_Write_Char and SPI1_Glcd_Write_Text
routines.
Parameters :

- activeFont: font to be set. Needs to be formatted as an array of char

- aFontwidth: width of the font characters in dots.

Description |- arontHeight: height of the font characters in dots.

- aFontOffs: number that represents difference between the mikroPascal char
acter set and regular ASCII set (eg. if ‘A" is 65 in ASCII character, and 'A' is 45
in the mikroPascal character set, aFontOffs is 20). Demo fonts supplied with
the library have an offset of 32, which means that they start with space.

The user can use fonts given in the file “__Lib_ GLCD_fonts.mpas” file located in
the Uses folder or create his own fonts.

Requires Glcd needs to be initialized for SPI communication, see SPI_Glcd_Init routines.

// Use the custom 5x7 font "myfont" which starts with space (32):

Exan“ﬂe SPI Glcd Set Font (€myfont, 5, 7, 32);
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SPI_Glcd_Write_Char

procedure SPI Glcd Write Char(chrl : byte; x pos : byte; page num

PrOtOtype : byte; color : byte);

Returns Nothing.

Prints character on Glcd.
Parameters :

- chr1: character to be written

- x_pos: character starting position on x-axis. Valid values: 0..(127-FontWidth)
- page num: the number of the page on which character will be written. Valid
Description | values: 0..7

- color: color parameter. Valid values: 0..2

The parameter color determines the color of the character: 0 white, 1 black,
and 2 inverts each dot.

Note: For x axis and page layout explanation see schematic at the bottom of
this page.

Glcd needs to be initialized for SPI communication, see SPI_Glcd_Init routines.

Requires Use the SPI_Glcd_Set_Font to specify the font for display; if no font is speci-
fied, then the default 5x8 font supplied with the library will be used.
// Write character 'C' on the position 10 inside the page 2:
Example SPI_Glecd Write Char("cC", 10, 2, 1);
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SPI_Glcd_Write_Text
procedure SPI Glcd Write Text (var text : arrayl 40] of byte; x pos
PrOtOtype : byte; page numb : byte; color : byte);
Returns Nothing.
Prints text on Glcd.
Parameters :
- text: text to be written
- x_pos: text starting position on x-axis.
. - page num: the number of the page on which text will be written. Valid values: 0..7
Description - ; )
- color: color parameter. Valid values: 0..2
The parameter color determines the color of the text: 0 white, 1 black, and 2
inverts each dot.
Note: For x axis and page layout explanation see schematic at the bottom of
this page.
Glcd needs to be initialized for SPI communication, see SPI_Glcd_Init routines.
Requires Use the SPI_Glcd_Set Font to specify the font for display; if no font is speci-
fied, then the default 5x8 font supplied with the library will be used.
E I // Write text "Hello world!"™ on the position 10 inside the page 2:
xample SPI_Glcd Write Text("Hello world!"™, 10, 2, 1);
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SPI_Glcd_Image

Prototype procedure SPI Glcd Image (const image : “byte);

Returns Nothing.

Displays bitmap on Glcd.
Parameters :
- image: image to be displayed. Bitmap array can be located in both code and

RAM memory (due to the mikroPascal PRO for PIC pointer to const and
pointer to RAM equivalency).

Description

Use the mikroPascal’s integrated Glcd Bitmap Editor (menu option Tools > Gled
Bitmap Editor) to convert image to a constant array suitable for displaying on Glcd.

Requires Glcd needs to be initialized for SPI communication, see SPI_Glcd_Init routines.

// Draw image my image on Glcd

Example SPI Glcd TImage (my image);

Library Example

The example demonstrates how to communicate to KS0108 Glcd via the SPI module, using seri-
al to parallel convertor MCP23S17.

program SPI Glcd;
uses bitmap;

// Port Expander module connections
var SPExpanderRST : sbit at RCO bit;

SPExpanderCS : sbit at RC1l bit;
SPExpanderRST Direction : sbit at TRISCO bit;
SPExpanderCS Direction : sbit at TRISC1 bit;

// End Port Expander module connections

var someText : arrayl 20] of char;
counter : byte;

procedure Delay2S;
begin
Delay ms (2000);
end;

begin
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ANSEL := 0; // Configure AN pins as
digital
ANSELH := 0;
CION bit := 0; // Disable comparators
C20N bit := 0;

// If Port Expander Library uses SPI1 module
SPI1 Init(); // Initialize SPI module used with PortExpander

// // 1f Port Expander Library uses SPI2 module
//  SPI2 Init(); // Initialize SPI module used with PortExpander

SPI Glcd Init (0); // Initialize Glcd via SPI
SPI Glecd Fill (0x00); // Clear Glcd

while (TRUE) do
begin

SPI Glcd Image (@truck bmp); // Draw image
Delay2s(); Delay2s/();

SPI Glcd Fill (0x00); // Clear Glcd

Delavy?2s;

SPI Glcd Box(62,40,124,63,1); // Draw box

SPI Glcd Rectangle(5,5,84,35,1); // Draw rectangle

SPI Glcd Line (0, 0, 127, 63, 1); // Draw line

Delay2s();

counter := 5;

while (counter < 60) do // Draw horizontal and vertical line
begin

Delay ms (250);
SPI Glcd V Line(2, 54, counter, 1);
SPI Glcd H Line(2, 120, counter, 1);

counter := counter + 5;
end;
Delay2s();
SPI Glcd Fill (0x00); // Clear Glcd

SPI Glcd Set Font (@Character8x7, 8, 7, 32); // Choose font,
see  Lib GLCDFonts.c in Uses folder
SPI Glcd Write Text ('mikroE', 1, 7, 2); // Write string

for counter := 1 to 10 do// Draw circles
SPI Glcd Circle(63,32, 3*counter, 1);
Delay2s();

SPI Glcd Box (10,20, 70,63, 2); // Draw box
Delay2s();
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SPTI Glcd Fill (OxFF);

SPI Glcd Set Font (Q@Character8x7, 8,
someText := '8x7 Font';

SPI Glcd Write Text (someText, 5, O,
Delay2s();

SPI Glcd Set Font (@System3x6, 3, 5,
someText := '3X5 CAPITALS ONLY';

SPI Glcd Write Text (someText, 60, 2,

Delay2s();

SPI Glcd Set Font (@fontbx7, 5, 7, 32);

someText := '5x7 Font';
SPI Glcd Write Text (someText, 5, 4,
Delay2s();

SPI Glcd Set Font (@FontSystemb5x7 vZ2,

someText := '5x7 Font (v2)';
SPI Glcd Write Text (someText, 50, 6,
Delay2s();

end;

// Fill Glcd

7, 32); // Change font
2); // Write string
32); // Change font
2); // Write string

// Change font

2); // Write string

5, 7, 32); // Change font

2); // Write string
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SPI LCD LIBRARY

The mikroPascal PRO for PIC provides a library for communication with Lcd (with
HD44780 compliant controllers) in 4-bit mode via SPI interface.

For creating a custom set of Lcd characters use Lcd Custom Character Tool.

Note: The library uses the SPI module for communication. The user must initialize
the SPI module before using the SPI Lcd Library.

For MCUs with two SPI modules it is possible to initialize both of them and then
switch by using the SPI_Set_Active() routine.

Note: This Library is designed to work with the mikroElektronika's Serial Lcd
Adapter Board pinout. See schematic at the bottom of this page for details.

External dependencies of SPI Lcd Library

The implementation of SPI Lcd Library routines is based on Port Expander Library
routines.

External dependencies are the same as Port Expander Library external dependencies.
Library Routines

- SPI_Lcd_Config
- SPI_Lcd Out

- SPIl _Lcd Out Cp
- SPI_Lcd_Chr

-SPIl _Lcd _Chr_Cp
- SPIl_Lcd Cmd
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SPI_Lcd_Config

Prototype procedure SPI Lcd Config(DeviceAddress: byte);

Returns Nothing.

Initializes the Lcd module via SPI interface.

o Parameters :
Description

- DeviceAddress: spi expander hardware address, see schematic at the bottom
of this page

Global variables :

- spExpanderCs: Chip Select line

- sPExpanderRST: Reset line

. - SPExpanderCs Direction: Direction of the Chip Select pin
Requires - TR ;
- SPExpanderRST Direction: Direction of the Reset pin

must be defined before using this function.

SPI module needs to be initialized. See SPI1_Init and SPI1_Init Advanced routines.

// port expander pinout definition
var SPExpanderCs : sbit at RC1 bit;
SPExpanderRST : sbit at RCO bit;
SPExpanderCS Direction : sbit at TRISC1 bit;
SPExpanderRST Direction : sbit at TRISC bit;
Example
// If Port Expander Library uses SPI1 module
SPI1 Init(); // Initialize SPI module
used with PortExpander
SPI Lcd Config(0); // initialize lcd over spi inter-
face
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SPI_Lcd_Out
procedure SPI Lcd Out (row: byte; column: byte; wvar text:
PrOtOtype arrayl 20] of byte);
Returns Nothing.
Prints text on the Lcd starting from specified position. Both string variables and
literals can be passed as a text.
i Parameters :
Description
- row: starting position row number
- column: starting position column number
- text: text to be written
Requires Lcd needs to be initialized for SPI communication, see SPI_Lcd_Config routines.
E I // Write text "Hello!"™ on Lcd starting from row 1, column 3:
xample SPT_Lcd Out (1, 3, "Hello!™);

SPI_Lcd_Out_CP

Prototype procedure SPI Lcd Out CP(var text : arrayl 20] of byte);

Returns Nothing.

Prints text on the Lcd at current cursor position. Both string variables and liter-
als can be passed as a text.

Description Parameters :
- text: text to be written

Requires Lcd needs to be initialized for SPI communication, see SPI_Lcd_Config routines.
// Write text "Here!" at current cursor position:

Example

SPI Lcd Out CP("Here!");
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SPI_Lcd_Chr

Prototype procedure SPI Lcd Chr (Row : byte; Column : byte; Out Char : byte);

Returns Nothing.

Prints character on Lcd at specified position. Both variables and literals can be
passed as character.

o Parameters :

Description
- Row: Writing position row number
- Column: writing position column number
- Out Char: character to be written

Requires Lcd needs to be initialized for SPI communication, see SPI_Lcd_Config routines.
// Write character "i" at row 2, column 3:

Example

SPI Lcd Chr(2, 3, '"i'");

SPI_Lcd_Chr_CP

Prototype |procedure SPI Lcd Chr CP(Out Char : byte);

Returns Nothing.

Prints character on Lcd at current cursor position. Both variables and literals
can be passed as character.

Description Parameters :

-Out Char: character to be written

Requires Lcd needs to be initialized for SPI communication, see SPI_Lcd_Config routines.

// Write character "e" at current cursor position:

Example SPI Lcd Chr CP('e');
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SPI_Lcd_Cmd

Prototype procedure SPI Lcd Cmd(out char : byte);

Returns Nothing.

Sends command to Lcd.

Parameters :

Description
P - out char: command to be sent

Note: Predefined constants can be passed to the function, see Available Lcd
Commands.

Requires Lcd needs to be initialized for SPI communication, see SPI_Lcd_Config routines.

// Clear Lcd display:

Example SPI Led Cmd( LCD_CLEAR) ;

Available SPI Lcd Commands

Lcd Command Purpose
_LCD_FIRST ROW Move cursor to the 1st row
_LCD_SECOND_ROW Move cursor to the 2nd row
_LCD_THIRD ROW Move cursor to the 3rd row
_LCD_FOURTH_ROW Move cursor to the 4th row
_LCD_CLEAR Clear display

Return cursor to home position, returns a shifted display to its original

LCD_RETURN_HOME position. Display data RAM is unaffected.

_LCD_CURSOR OFF Turn off cursor

_LCD_UNDERLINE ON Underline cursor on

_LCD_BLINK CURSOR ON Blink cursor on

_LCD_MOVE_CURSOR_LEFT [Move cursor left without changing display data RAM

_LCD_MOVE_CURSOR_RIGHT [Move cursor right without changing display data RAM

_LCD_TURN_ON Turn Lcd display on
LCD TURN OFF Turn Lcd display off
LCD SHIFT LEFT Shift display left without changing display data RAM
LCD SHIFT RIGHT Shift display right without changing display data RAM
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Library Example

This example demonstrates how to communicate Lcd via the SPI module, using
serial to parallel convertor MCP23S17.

program SPI Lcd;

var

// Port Expander module connections
sbit at RCO bit;
sbit at RC1 bit;

var

text : array| 16] of char;

SPExpanderRST
SPExpanderCS

SPExpanderRST Direction : sbit at TRISCO bit;

SPExpanderCS Direction

begin

ule

ule

SPI

1st

2nd

text := 'mikroElektronika';

sbit at TRISCl bit;
// End Port Expander module connections

// If Port Expander Library uses SPI1 module

SPI1 Init();
used with PortExpander

// Initialize SPI mod-

// If Port Expander Library uses SPI2 module

// SPI2 Init();

used with PortExpander

SPI Lcd Config(0);
interface

SPI Lcd Cmd( LCD CLEAR) ;
SPT Lcd Cmd( LCD CURSOR OFF) ;
SPT Lcd Out (1,6, 'mikroE');
row, 6th column

SPI Lcd Chr CP('"!'");

SPI Lecd Out (2,1, text);
row, 1lst column

end.

// Initialize SPI mod-
// Initialize Lcd over
// Clear display

// Turn cursor off

// Print text to Lcd,

// Append '!'
// Print text to Lcd,
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HW Connection
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SPI LCDS8 (8-BIT INTERFACE) LIBRARY

The mikroPascal PRO for PIC provides a library for communication with Lcd (with
HD44780 compliant controllers) in 8-bit mode via SPI interface.

For creating a custom set of Lcd characters use Lcd Custom Character Tool.

Note: Library uses the SPI module for communication. The user must initialize the
SPI module before using the SPI Lcd Library.
For MCUs with two SPI modules it is possible to initialize both of them and then
switch by using the SPI_Set_Active() routine.

Note: This Library is designed to work with mikroElektronika's Serial Lcd/Glcd
Adapter Board pinout, see schematic at the bottom of this page for details.

External dependencies of SPI Lcd Library

The implementation of SPI Lcd Library routines is based on Port Expander Library
routines.

External dependencies are the same as Port Expander Library external dependencies.
Library Routines

- SPI_Lcd8_Config

- SPI_Lcd8 Out

- SPl_Lcd8_Out_CP
- SPI_Lcd8_Chr

- SPI_Lcd8_Chr_CP
- SPI_Lcd8_Cmd
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SPI_Lcd8_Config

Prototype procedure SPI Lcd8 Config(DeviceAddress : byte);
Returns Nothing.
Initializes the Lcd module via SPI interface.
. Parameters :
Description
- DeviceAddress: spi expander hardware address, see schematic at the
bottom of this page
Global variables :
- sPExpandercs: Chip Select line
- SPExpanderRST: Reset line
. - SPExpanderCs Direction: Direction of the Chip Select pin
Requires - ‘ N .
- SPExpanderRST Direction: Direction of the Reset pin
must be defined before using this function.
SPI module needs to be initialized. See SPI1_Init and SPI1_Init Advanced routines.
// port expander pinout definition
var SPExpanderCS : sbit at RC1 bit;
SPExpanderRST : sbit at RCO bit;
SPExpanderCS Direction : sbit at TRISC1 bit;
SPExpanderRST Direction : sbit at TRISC bit;
Example - -
SPI1 Init(); // Initialize SPI module used with
PortExpander
SPI Lcd8 Config(0); // intialize lcd in 8bit mode via spi
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SPI_Lcd8_Out

procedure SPI Lcd8 Out(row: byte; column: byte; wvar text:

PrOtOtype arrayl 20] of byte);

Returns Nothing.

Prints text on Lcd starting from specified position. Both string variables and liter-
als can be passed as a text.

i Parameters :
Description
- row: starting position row number

- column: starting position column number
- text: text to be written

Requires Lcd needs to be initialized for SPI communication, see SPI_Lcd8_Config routines.

// Write text "Hello!"™ on Lcd starting from row 1, column 3:

Example |57 (g5 out(1, 3, "Hello!™);

SPI_Lcd8_Out_CP

Prototype procedure SPI Lcd8 Out CP(var text : arrayl 20] of byte);

Returns Nothing.

Prints text on Lcd at current cursor position. Both string variables and literals
can be passed as a text.

Description o o meters :

- text: text to be written

Requires Lcd needs to be initialized for SPI communication, see SPI_Lcd8_Config routines.

// Write text "Here!" at current cursor position:

Example SPI Lcd8 Out CP("Here!");

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD 475



CHAPTER 7
Libraries mikroPASCAL PRO for PIC

SPI_Lcd8_Chr

Prototype procedure SPI Lcd8 Chr(Row : byte; Column : byte; Out Char : byte);

Returns Nothing.

Prints character on Lcd at specified position. Both variables and literals can be
passed as character.

i Parameters :
Description
- row: writing position row number
- column: writing position column number
- out char: character to be written

Requires Lcd needs to be initialized for SPI communication, see SPI_Lcd8_Config routines.

// Write character "i" at row 2, column 3:

Example SPliLcd87Chr(2, 3, 'i");

SPI_Lcd8_Chr_CP

Prototype |procedure SPI Lcd8 Chr CP(Out Char : byte);

Returns Nothing.

Prints character on Lcd at current cursor position. Both variables and literals
can be passed as character.

Description Parameters :

- out char : character to be written

Requires Lcd needs to be initialized for SPI communication, see SPI_Lcd8 Config routines.

“ 0

Print “e” at current cursor position:

Example . o
P // Write character "e" at current cursor position:

SPI Lcd8 Chr CP('e');
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Lcd Command

Purpose

_LCD_FIRST ROW

Move cursor to the 1st row

_LCD_SECOND_ROW

Move cursor to the 2nd row

_LCD_THIRD_ROW

Move cursor to the 3rd row

_LCD_FOURTH_ROW

Move cursor to the 4th row

_LCD_CLEAR

Clear display

_LCD_RETURN HOME

Return cursor to home position, returns a shifted display to its original
position. Display data RAM is unaffected.

_LCD_CURSOR_OFF

Turn off cursor

_LCD_UNDERLINE ON

Underline cursor on

_LCD_BLINK CURSOR ON

Blink cursor on

_LCD_MOVE CURSOR_LEFT

Move cursor left without changing display data RAM

_LCD_MOVE CURSOR_RIGHT

Move cursor right without changing display data RAM

_LCD_TURN ON

Turn Lcd display on

_LCD_TURN OFF

Turn Lcd display off

_LCD_SHIFT LEFT

Shift display left without changing display data RAM

_LCD_SHIFT RIGHT

Shift display right without changing display data RAM

mikroPASCAL PRO for PIC Libraries

SPI_Lcd8_Cmd

Prototype |procedure SPI Lcd8 Cmd(out char : byte);

Returns Nothing.
Sends command to Lcd.
Parameters :

Description |_ out char: command to be sent
Note: Predefined constants can be passed to the function, see Available Lcd
Commands.

Requires Lcd needs to be initialized for SPI communication, see SPI_Lcd8_Config routines.
// Clear Lcd display:

Example SPI_Lcd8 Cmd ( LCD CLEAR) ;
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Library Example

This example demonstrates how to communicate Lcd in 8-bit mode via the SPI mod-
ule, using serial to parallel convertor MCP23S17.

program Spi Lcd8 Test;
var text : arrayl 16] of char;

// Port Expander module connections
var SPExpanderRST : sbit at RCO bit;

SPExpanderCS : sbit at RC1l bit;
SPExpanderRST Direction : sbit at TRISCO bit;
SPExpanderCS Direction : sbit at TRISC1 bit;

// End Port Expander module connections

begin
text := 'mikroE';
// If Port Expander Library uses SPI1 module
SPI1 Init(); // Initialize SPI

module used with PortExpander

// // If Port Expander Library uses SPI2 module
// SPI2 Init(); // Initialize SPI
module used with PortExpander

SPI Lcd8 Config(0); // Intialize Lcd in
8bit mode via SPI

SPI Lcd8 Cmd( LCD CLEAR); // Clear display

SPI Lcd8 Cmd( LCD CURSOR OFF); // Turn cursor off

SPI Lcd8 Out(l,6, text); // Print text to Lcd,
1st row, 6th column...

SPI Lcd8 Chr CP('!'"); // RAppend '!'

SPI Lcd8 Out (2,1, 'mikroelektronika'); // Print text to Lcd,
2nd row, 1lst column...

SPI Lcd8 Out(3,1, text); // For Lcd modules
with more than two rows

SPI Lcd8 Out (4,15, text); // For Lcd modules
with more than two rows
end.
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SPI T6963C GRAPHIC LCD LIBRARY

The mikroPascal PRO for PIC provides a library for working with GLCDs based on
TOSHIBA T6963C controller via SPI interface. The Toshiba T6963C is a very popu-
lar Lcd controller for the use in small graphics modules. It is capable of controlling
displays with a resolution up to 240x128. Because of its low power and small out-
line it is most suitable for mobile applications such as PDAs, MP3 players or mobile
measurement equipment. Although this controller is small, it has a capability of dis-
playing and merging text and graphics and it manages all interfacing signals to the
displays Row and Column drivers.

For creating a custom set of Glcd images use Glcd Bitmap Editor Tool.

Note: The library uses the SPI module for communication. The user must initialize
SPI module before using the SPI T6963C Glcd Library.

For MCUs with two SPI modules it is possible to initialize both of them and then
switch by using the sp1 set Active () routine.

Note: This Library is designed to work with mikroElektronika's Serial Glcd 240x128
and 240x64 Adapter Boards pinout, see schematic at the bottom of this page for
details.

Note: Some mikroElektronika's adapter boards have pinout different from T6369C
datasheets. Appropriate relations between these labels are given in the table below:

Adapter Board|T6369C datasheet

RS C/D
R/W /RD
E /WR

External dependencies of SPI T6963C Graphic Lcd Library

The implementation of SPI T6963C Graphic Lcd Library routines is based on Port
Expander Library routines.

External dependencies are the same as Port Expander Library external dependencies.
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Library Routines

- SPI_T6963C_Config

- SPI_T6963C_WriteData

- SPI_T6963C_WriteCommand
- SPI_T6963C_SetPtr

- SPI_T6963C_WaitReady

- SPI_T6963C_Fill

- SPI_T6963C_Dot

- SPI_T6963C_Write_Char

- SPI_T6963C_Write_Text

- SPI_T6963C_Line

- SPI_T6963C_Rectangle

- SPI_T6963C_Box

- SPI_T6963C_Circle

- SP1_T6963C_Image

- SPI_T6963C_Sprite

- SPI_T6963C_Set Cursor

- SPI_T6963C_ClearBit

- SPI_T6963C_SetBit

- SPI_T6963C_NegBit

- SPI1_T6963C_DisplayGrPanel
- SPI_T6963C_DisplayTxtPanel
- SPI_T6963C_SetGrPanel

- SPI_T6963C_SetTxtPanel

- SPI_T6963C_PanelFill

- SPI_T6963C_GrFill

- SPI_T6963C_TxtFill

- SPI_T6963C_Cursor_Height
- SPI_T6963C_Graphics

- SPI_T6963C_Text

- SPI_T6963C_Cursor

- SPI_T6963C_Cursor_Blink
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SPI_T6963C_Config

procedure SPI T6963C Config(width : word; height : byte; fntwW :
Prokﬂype byte; DeviceAddress : byte; wr : byte; rd : byte; cd : byte; rst
: byte);

Returns Nothing.
Initializes T6963C Graphic Lcd controller.

Parameters :

- width: width of the Glcd panel

- height: height of the Glcd panel

- fntw: font width

- DeviceAddress: SPIl expander hardware address, see schematic at the
bottom of this page

- wr: write signal pin on Glcd control port

- rd: read signal pin on Glcd control port

- cd: command/data signal pin on Glcd control port

- rst: reset signal pin on Glcd control port

Display RAM organization:
The library cuts RAM into panels : a complete panel is one graphics panel fol-
lowed by a text panel (see schematic below).

Description
schematic:
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Global variables :

- sPExpanderCs: Chip Select line
- SPExpanderRST: Reset line
- SpExpanderCS Direction: Direction of the Chip Select pin

Requires o ;
q - SPExpanderRST Direction: Direction of the Reset pin
must be defined before using this function.
SPI module needs to be initialized. See SPI1_Init and SPI1_Init Advanced routines.
// port expander pinout definition
var SPExpanderCS : sbit at RC1 bit;
SPExpanderRST : sbit at RCO bit;
SPExpanderCS Direction : sbit at TRISC1 bit;
Example SPExpanderRST Direction : sbit at TRISC bit;

// Initialize SPI module
SPT1 Tnit();
SPI T6963C Config (240, 64, 8, 0, 0, 1, 3, 4);

SPI_T6963C_WriteData

Prototype procedure SPI T6963C WriteData(Ddata : byte);

Returns Nothing.
Writes data to T6963C controller via SPI interface.

Description |Parameters :

- Ddata: data to be written

Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.

Example SPI_T6963C_WriteData (AddrL) ;
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SPI_T6963C_WriteCommand

Prototype procedure SPI T6963C WriteCommand (Ddata : byte);
Returns Nothing.
Writes command to T6963C controller via SPI interface.
Description |Parameters :
- Ddata: command to be written
Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
Example SPT T6963C WriteCommand (SPT T6963C CURSOR POINTER SET) ;

SPI_T6963C_SetPtr

Prototype procedure SPI T6963C SetPtr(p : word; c : byte);
Returns Nothing.
Sets the memory pointer p for command c.
Description Parameters :
- p: address where command should be written
- ¢: command to be written
Requires SToshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
Example 'S'Pli"l'6963CiSvetPtr('l'v6'9v63C7”q'rltiomeAddr + start,
T6963C ADDRESS POINTER SET);
SPI_T6963C_WaitReady
Prototype [procedure SPI T6963C WaitReady();
Returns Nothing.
Description [Pools the status byte, and loops until Toshiba Glcd module is ready.
Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
Example SPI T6963C WaitReady () ;
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SPI_T6963C_Fill
Prototype procedure SPI T6963C Fill(v : byte; start : word; len : word);
Returns Nothing.
Fills controller memory block with given byte.
Parameters :
Description
- v: byte to be written
- start: starting address of the memory block
- len: length of the memory block in bytes
Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
Example SPI T6963C Fill(0x33; OxO00FF; 0x000F);
SPI_T6963C_Dot
Prototype procedure SPI T6963C Dot (x : integer; y : integer; color : byte);
Returns Nothing.
Draws a dot in the current graphic panel of Glcd at coordinates (x, y).
Parameters :
Description | «: dot position on x-axis
- v: dot position on y-axis
- color: color parameter. Valid values: SPI_T6963C_BLACK and
SPI_T6963C_WHITE
Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
Example SPI T6963C Dot (x0, y0O, pcolor);
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SPI_T6963C_Write_Char

procedure SPI T6963C Write Char(c : byte; x : byte; y : byte;
mode : byte);

Prototype

Returns Nothing.

Writes a char in the current text panel of Glcd at coordinates (x, y).
Parameters :

- c: char to be written

- x: char position on x-axis

- v: char position on y-axis

- mode: mode parameter. Valid values: SPI_T6963C_ROM_MODE_OR,
SPI_T6963C_ROM_MODE_XOR, SPI_T6963C_ROM_MODE_AND and
SPI_T6963C_ROM_MODE_TEXT

Mode parameter explanation:

Description

- OR Mode: In the OR-Mode, text and graphics can be displayed and the data
is logically “OR-ed”. This is the most common way of combining text and
graphics for example labels on buttons.

- XOR-Mode: In this mode, the text and graphics data are combined via the
logical “exclusive OR”. This can be useful to display text in negative mode, i.e.
white text on black background.

- AND-Mode: The text and graphic data shown on display are combined via the
logical “AND function”.

- TEXT-Mode: This option is only available when displaying just a text. The Text
Attribute values are stored in the graphic area of display memory.

For more details see the T6963C datasheet.

Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.

Example SPI T6963C Write Char ("A",22,23,AND);
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SPI_T6963C_Write_Text

procedure SPI T6963C write text(var str : arrayl 10] of byte; x,
y, mode : byte);

Prototype

Returns Nothing.

Writes text in the current text panel of Glcd at coordinates (x, y).
Parameters :

- str: text to be written

- x: text position on x-axis

- v: text position on y-axis

- mode: mode parameter. Valid values: SPI_T6963C_ROM_MODE_OR,
SPI_T6963C_ROM_MODE_XOR, SPI_T6963C_ROM_MODE_AND and
SPI_T6963C_ROM_MODE_TEXT

Mode parameter explanation:

Description

- OR Mode: In the OR-Mode, text and graphics can be displayed and the data
is logically “OR-ed”. This is the most common way of combining text and
graphics for example labels on buttons.

- XOR-Mode: In this mode, the text and graphics data are combined via the
logical “exclusive OR”. This can be useful to display text in negative mode, i.e.
white text on black background.

- AND-Mode: The text and graphic data shown on the display are combined via
the logical “AND function”.

- TEXT-Mode: This option is only available when displaying just a text. The Text
Attribute values are stored in the graphic area of display memory.

For more details see the T6963C datasheet.

Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.

SPI T6963C Write Text ('Glcd LIBRARY DEMO, WELCOME !', 0, 0,

Example T6963C_ROM_MODE_EXOR) ;
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SPI1_T6963C_Line
procedure SPI T6963C Line(x0 : integer; y0 : integer; xlI inte-
PrOtOtype ger; vyl integer; color : byte);
Returns Nothing.
Draws a line from (x0, y0) to (x1, y1).
Parameters :
Description |” =0: X coordinate of the line start
P - y0: y coordinate of the line end
- x1: x coordinate of the line start
- y1:y coordinate of the line end
- pcolor: color parameter. Valid values: SPI_T6963C_BLACK and
SPI_T6963C_WHITE
Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
Example SPI T6963C Line(0, 0, 239, 127, T6963C WHITE);
SPI_T6963C_Rectangle
procedure SPI T6963C Rectangle (x0 integer; y0 : integer; x1
PrOtOtype integer; vyl integer; pcolor : byte);
Returns Nothing.
Draws a rectangle on Glcd.
Parameters :
Describtion |~ =0: X coordinate of the upper left rectangle corner
P - y0: y coordinate of the upper left rectangle corner
- x1: x coordinate of the lower right rectangle corner
- y1:y coordinate of the lower right rectangle corner
- pcolor: color parameter. Valid values: SPI_T6963C_BLACK and
SPI_T6963C_WHITE
Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
Example SPI_T6963C_Rectangle (20, 20, 219, 107, T6963C_WHITE);
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SPI_T6963C_Box

procedure SPI T6963C Box (x0 integer; yo0 integer; x1 : inte-
PrOtOtype ger; vyl integer; pcolor : byte);
Returns Nothing.

Draws a box on the Glcd

Parameters :
Descriotion |~ *°F % coordinate of the upper left box corner

P - y0: y coordinate of the upper left box corner

- x1: x coordinate of the lower right box corner

- y1: y coordinate of the lower right box corner

- pcolor: color parameter. Valid values: SPI_T6963C_ BLACK and

SPI_T6963C_WHITE

Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
Example SPI T6963C Box (0, 119, 239, 127, T6963C WHITE);
SPI_T6963C_Circle

procedure SPI T6963C Circle(x : integer; y : integer; r :
Prototype longint; pcolor : word);
Returns Nothing.

Draws a circle on the Glcd.

Parameters :
Description |- x: x coordinate of the circle center

- v: y coordinate of the circle center

- r: radius size

- pcolor: color parameter. Valid values: SPI_T6963C_BLACK and

SPI_T6963C_WHITE

Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
Example SPI_T6963C Circle (120, 64, 110, T6963C _WHITE) ;
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SPI_T6963C_Image

Prototype procedure SPI T6963C image (const pic : “byte);
Returns Nothing.
Displays bitmap on Glcd.
Parameters :
- pic: image to be displayed. Bitmap array can be located in both code and
RAM memory (due to the mikroPascal PRO for PIC pointer to const and
Description | pointer to RAM equivalency).
Use the mikroPascal’s integrated Glcd Bitmap Editor (menu option Tools > Glcd
Bitmap Editor) to convert image to a constant array suitable for displaying on
Gled.
Note: Image dimension must match the display dimension.
Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
Example SPI T6963C Image (my image);
SPI_T6963C_Sprite
Prototype proc.:edure S.?17T6963C75prite (px, py : byte; const pic : "“byte; sx,
sy : byte);
Returns Nothing.
Fills graphic rectangle area (px, py) to (px+sx, py+sy) with custom size picture.
Parameters :
- px: x coordinate of the upper left picture corner. Valid values: multiples of the
font width
Description |- oy: y coordinate of the upper left picture corner
- pic: picture to be displayed
- sx: picture width. Valid values: multiples of the font width
- sy: picture height
Note: If px and sx parameters are not multiples of the font width they will be
scaled to the nearest lower number that is a multiple of the font width.
Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
Example SPI T6963C Sprite(76, 4, einstein, 88, 119); // draw a sprite
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SPI1_T6963C_Set_Cursor

Prototype procedure SPI T6963C_set cursor(x, y : byte);

Returns Nothing.

Sets cursor to row x and column vy.

. Parameters :
Description

- x: cursor position row number
- y: cursor position column number

Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.

Example SPI T6963C Set Cursor (cposx, Cposy);

SPI_T6963C_ClearBit

Prototype procedure SPI T6963C clearBit(b : byte);

Returns Nothing.

Clears control port bit(s).
Description |Parameters :

- b: bit mask. The function will clear bit =< on control port if bit x in bit mask is set to 1.

Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.

// clear bits 0 and 1 on control port

Example SPT_T6963C_ClearBit (0x03);

SPI_T6963C_SetBit

Prototype procedure SPI T6963C _setBit(b : byte);

Returns Nothing.

Sets control port bit(s).
Description |[Parameters :

- b: bit mask. The function will set bit < on control port if bit = in bit mask is set to 1.

Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.

// set bits 0 and 1 on control port

Example SPI_T6963C_SetBit (0x03);
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SPI_T6963C_NegBit

Prototype procedure SPI T6963C negBit (b : byte);

Returns Nothing.

Negates control port bit(s).

. Parameters :
Description

- b: bit mask. The function will negate bit < on control port if bit x in bit mask is
set to 1.

Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.

// negate bits 0 and 1 on control port

Example SPI_T6963C_NegBit (0x03) ;

SPI1_T6963C_DisplayGrPanel

Prototype procedure SPI T6963C DisplayGrPanel(n : byte);

Returns Nothing.

Display selected graphic panel.
Description |Parameters :

- n: graphic panel number. Valid values: 0 and 1.

Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.

// display graphic panel 1

Exan“ﬂe SPI T6963C DisplayGrPanel (1)
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SPI_T6963C_DisplayTxtPanel

Prototype procedure SPI T6963C DisplayGrPanel(n : byte);

Returns Nothing.
Display selected graphic panel.

Description |Parameters :
- n: graphic panel number. Valid values: 0 and 1.

Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
// display graphic panel 1

Example SPI T6963C DisplayGrPanel (1) ;

SPI_T6963C_SetGrPanel

Prototype procedure SPI T6963C SetGrPanel(n : byte);
Returns Nothing.
Compute start address for selected graphic panel and set appropriate internal point-
ers. All subsequent graphic operations will be preformed at this graphic panel.
Description Parameters :
- n: graphic panel number. Valid values: 0 and 1.
Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
E I // set graphic panel 1 as current graphic panel.
Xxample SPI T6963C SetGrPanel(1l);
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SPI_T6963C_SetTxtPanel

Prototype procedure SPI T6963C_SetTxtPanel(n : byte);

Returns Nothing.

Compute start address for selected text panel and set appropriate internal point-
ers. All subsequent text operations will be preformed at this text panel.

Description Parameters :

- n: text panel number. Valid values: 0 and 1.

Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.

// set text panel 1 as current text panel.

Example SPI_T6963C_SetTxtPanel (1);

SPI_T6963C_PanelFill

Prototype procedure SPI T6963C PanelFill(v : byte);

Returns Nothing.

Fill current panel in full (graphic+text) with appropriate value (0 to clear).
Description |Parameters :

- v: value to fill panel with.

Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.

clear current panel

Example SPI_T6963C_PanelFill (0);

SPI_T6963C_GrFill

Prototype |procedure SPI T6963C GrFill(v : byte);

Returns Nothing.

Fill current graphic panel with appropriate value (0 to clear).
Description |Parameters :

- v: value to fill graphic panel with.

Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.

// clear current graphic panel

Example SPI_T6963C_GrFill(0);

494 MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



CHAPTER 7
Libraries

mikroPASCAL PRO for PIC
SPI_T6963C_TxtFill
Prototype |procedure SPI T6963C TxtFill(v : byte);
Returns Nothing.
Fill current text panel with appropriate value (0 to clear).
Description |Parameters :
- v: this value increased by 32 will be used to fill text panel.
Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
// clear current text panel
Example SPI_T6963C_TxtFill (0);
SPI_T6963C_Cursor_Height
Prototype procedure SPI T6963C Cursor Height(n : byte);
Returns Nothing.
Set cursor size.
Description |Parameters :
- n: cursor height. Valid values: 0..7.
Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
Example SPI T6963C Cursor Height(7);

SPI_T6963C_Graphics

Prototype procedure SPI T6963C Graphics(n : byte);
Returns Nothing.
Enable/disable graphic displaying.
i Parameters :
Description
- n: graphic enable/disable parameter. Valid values: 0 (disable graphic
dispaying) and 1 (enable graphic displaying).
Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
Example // enable graphic displaying

SPI T6963C Graphics(1l);
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SPI_T6963C_Text

Prototype procedure SPI T6963C_Text(n : byte);
Returns Nothing.
Enable/disable text displaying.
i Parameters :
Description
- n: text enable/disable parameter. Valid values: 0 (disable text dispaying) and 1
(enable text displaying).
Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
// enable text displaying
Exan“ﬂe SPI T6963C Text(1l);
SPI_T6963C_Cursor
Prototype procedure SPI T6963C Cursor(n : byte);
Returns Nothing.
Set cursor on/off.
Description |[Parameters :
- n: on/off parameter. Valid values: 0 (set cursor off) and 1 (set cursor on).
Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
E I // set cursor on
xample SPI T6963C Cursor(1l);

SPI_T6963C_Cursor_Blink

Prototype procedure SPI T6963C Cursor Blink(n : byte);

Returns Nothing.
Enable/disable cursor blinking.

e Parameters :

Description

- n: cursor blinking enable/disable parameter. Valid values: 0 (disable cursor
blinking) and 1 (enable cursor blinking).

Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
// enable cursor blinking

Example

SPT7T6963C7CUTsor7R1ﬁnk(?);
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Library Example

The following drawing demo tests advanced routines of the SP1 T6963C Glcd library.
Hardware configurations in this example are made for the T6963C 240x128 display,
EasyPIC5 board and 16F887.

program SPI T6963C 240x128;
uses Lib SPIT6963C Const, bitmap, bitmap2;
var

// Port Expander module connections
SPExpanderRST : sbit at RCO bit;

SPExpanderCS : sbit at RC1 bit;
SPExpanderRST Direction : sbit at TRISCO bit;
SPExpanderCS Direction : sbit at TRISCI bit;

// End Port Expander module connections

var panel : byte; // current panel
i : word; // general purpose register
curs : byte; // cursor visibility
Cposx,
cposy : word; // cursor x-y position

txt, txtl : string] 29];

begin
txtl := ' EINSTEIN WOULD HAVE LIKED mE';
txt := ' GLCD LIBRARY DEMO, WELCOME !';
ANSEL := 0; // Configure AN pins as digital I/O
ANSELH := 0O;
ClON bit := 0; // Disable comparators
C20N bit := 0;
TRISBO bit := 1; // Set RBO as input
TRISBL bit := 1; // Set RBl as input
TRISB2 bit := 1; // Set RB2 as input
TRISB3 bit := 1; // Set RB3 as input
TRISB4 bit := 1; // Set RB4 as input

// Initialize SPI module
SPI1 Init();

// // If Port Expander Library uses SPI2 module
// Pass pointer to SPI Read function of used SPI module

// Initialize SPI module used with PortExpander
// SPI2 Init Advanced( SPI MASTER, _SPI_FCY DIV32,
_SPT CLK HI TRAILING) ;
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{*

init display for 240 pixel width and 128 pixel height

8 bits character width

data bus on MCP23S17 portB

control bus on MCP23S17 portA

bit 2 is !WR

bit 1 is !RD

bit 0 is !CD

bit 4 is RST

chip enable, reverse on, 8x8 font internaly set in library

X% ok ok ok X ok % X X

// Initialize SPI Toshiba 240x128
SPI_T6963C Config(240, 128, 8, 0, 2, 1, 0, 4) ;
//Delay ms (1000) ;
{*
* Enable both graphics and text display at the same time
*}
SPI T6963C graphics(1l) ;

SPI_T6963C text (1) ;

panel := 0 ;
i =07
curs := 0 ;
cposx := 0;
cposy := 0 ;

{*

* Text messages

*}

SPI T6963C write text(txt, 0, 0, SPI T6963C _ROM MODE XOR) ;
SPI T6963C write text(txtl, 0, 15, SPI T6963C ROM MODE XOR) ;

{*
* Cursor

*}

SPI T6963C cursor height (8) ; // 8 pixel height
SPI T6963C_set cursor (0, 0) ; // move cursor to top left
SPI T6963C cursor (0) ; // cursor off

{*

* Draw rectangles

*}

SPI T6963C rectangle (0, 0, 239, 127, SPI T6963C WHITE) ;
SPI T6963C rectangle (20, 20, 219, 107, SPI T6963C WHITE) ;
SPI T6963C rectangle (40, 40, 199, 87, SPI T6963C WHITE) ;
SPI T6963C rectangle (60, 60, 179, 67, SPI T6963C WHITE) ;
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{ *

* Draw a Ccross

*}

SPI_T6963C line(0, 0, 239, 127, SPI_T6963C_WHITE) ;
SPT_T6963C line (0, 127, 239, 0, SPI_T6963C_WHITE) ;
{ *

* Draw solid boxes

*}

SPT_T6963C_box (0, 0, 239, 8, SPI_T6963C WHITE) ;

SPT_T6963C box (0, 119, 239, 127, SPI T6963C_WHITE) ;
{ *

* Draw circles

*}

SPI T6963C circle(120, 64, 10, SPI T6963C WHITE) ;
SPI_T6963C_circle (120, 64, 30, SPI T6963C_WHITE) ;
SPTI_T6963C_circle (120, 64, 50, SPI T6963C_WHITE) ;

SPI T6963C circle(120, 64, 70, SPI T6963C WHITE) ;
SPI_T6963C_circle (120, 64, 90, SPI T6963C_WHITE) ;

SPI T6963C circle(120, 64, 110, SPI T6963C WHITE) ;
SPT_T6963C_circle (120, 64, 130, SPI_T6963C_WHITE) ;

SPI T6963C_sprite(76, 4, @einstein, 88, 119) ; // Draw a sprite
SPI T6963C_setGrPanel (1) ; // Select other graphic panel

SPI T6963C sprite(0, O, @me, 240, 64); // 240x128 can't

be stored in most of PIC16 MCUs
SPI T6963C sprite(0, 64, @me, 240, 64); // it is replaced
with smaller picture 240x64
// Smaller picture is drawn two times
while (TRUE) do // Endless loop
begin

{*
* If PORTA 0 is pressed, toggle the display between graphic
panel 0 and graphic 1
*}
if ( RBO bit <> 0) then
begin
Inc (panel) ;
panel := panel and 1;
SPI T6963C setPtr ((SPI_T6963C grMemSize +
SPI T6963C txtMemSize) * panel, SPI T6963C GRAPHIC HOME ADDRESS SET)
Delay ms (300) ;
end
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{*
* If PORTA 1 is pressed, display only graphic panel
*}
else
if ( RB1 bit <> 0) then
begin
SPI T6963C graphics(1l)
SPI T6963C text (0) ;
Delay ms (300) ;
end

{*
* If PORTA 2 is pressed, display only text panel
*}
else
if ( RB2 bit <> 0) then
begin
SPI T6963C graphics (0) ;
SPT T6963C text (1) ;
Delay ms(300) ;
end

{*
* If PORTA 3 is pressed, display text and graphic panels
*}
else
if ( RB3 bit <> 0) then
begin
SPI T6963C graphics(1l)
SPT T6963C text (1) ;
Delay ms(300) ;
end

{ *
* If PORTA 4 is pressed, change cursor
*}

else
if( RB4 bit <> 0) then
begin
Inc(curs);

if (curs 3) then
curs := 0;
case curs of

0:
// no cursor
SPI T6963C cursor(0) ;
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1: begin
// blinking cursor
SPI T6963C cursor(l) ;
SPI T6963C cursor blink(l) ;
end;
2: begin
// non blinking cursor
SPI T6963C cursor(l) ;
SPI T6963C cursor blink(0) ;

end;
end;
Delay ms(300) ;
end;

{ *
* Move cursor, even 1if not visible
*}
Inc (cposx) ;
if (cposx = SPI T6963C txtCols) then
begin
cposx := 0 ;
Inc (cposy) ;
if (cposy = SPI T6963C grHeight /
SPI T6963C CHARACTER HEIGHT) then
cposy := 0 ;
end;
SPI T6963C set cursor(cposx, cposy) ;

Delay ms (100) ;
end;
end.
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HW Connection
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T6963C GRAPHIC LCD LIBRARY

The mikroPascal PRO for PIC provides a library for working with GLCDs based on
TOSHIBA T6963C controller. The Toshiba T6963C is a very popular Lcd controller
for the use in small graphics modules. It is capable of controlling displays with a res-
olution up to 240x128. Because of its low power and small outline it is most suitable
for mobile applications such as PDAs, MP3 players or mobile measurement equip-
ment. Although small, this contoller has a capability of displaying and merging text
and graphics and it manages all the interfacing signals to the displays Row and Col-
umn drivers.

For creating a custom set of Glcd images use Glcd Bitmap Editor Tool.
Note: ChipEnable(CE), FontSelect(FS) and Reverse(MD) have to be set to appro-
priate levels by the user outside of the T6963C_Init function. See the Library Exam-

ple code at the bottom of this page.

Note: Some mikroElektronika's adapter boards have pinout different from T6369C
datasheets. Appropriate relations between these labels are given in the table below:

Adapter Board|T6369C datasheet

RS C/D
R/W /RD
E /WR
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External dependencies of T6963C Graphic Lcd Library

The following variables
must be defined in all
projects using T6963C

Graphic Lcd library:

Description:

Example :

var T6963C dataPort
byte; sfr; external;

T6963C Control Port.

var T6963C dataPort
byte at PORTD;

var T6963C ctrlwr
sbit; sfr; external;

Write signal.

var T6963C ctrlwr
sbit at RC2Z _bit;

var T6963C ctrlrd
sbit; sfr; external;

Read signal.

var T6963C ctrlrd
sbit at RC1 bit;

var T6963C ctrlcd
sbit; sfr; external;

Command/Data signal.

var T6963C ctrlcd
sbit at RCO bit;

var T6963C ctrlrst

var T6963C ctrlrst

sbit; sfr; external; Reset signal. sbit at RC4 bit;

var var

T6963C ctrlwr Directi . . . . T6963C ctrlwr Directi
on : sbit; sfr; Direction of the Write pin. on : sbit at
external; TRISC2 bit;

var var

T6963C ctrlrd Directi . . . T6963C ctrlcd Directi
on : sbit; sfr: Direction of the Read pin. on : sbit at
external; TRISCO bit;

var var

T6963C ctrlcd Directi Direction of the Com- T6963C ctrlcd Directi
on : sbit; sfr; mand/Data pin_ on : sbit at
external; TRISCO bit;

var var

T6963C ctrlrst Direct . . . T6963C ctrlrst Direct
: e Direction of the Reset pin. |. . -

ion : sbit; sfr; ion : sbit at
external; TRISC4 bit;
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Library Routines

- T6963C_Init

- T6963C_WriteData

- T6963C_WriteCommand
- T6963C_SetPtr

- T6963C_WaitReady
- T6963C_Fill

- T6963C_Dot

- T6963C_Write_Char
- T6963C_Write_Text
- T6963C_Line

- T6963C_Rectangle
- T6963C_Box

- T6963C_Circle

- T6963C_Image

- T6963C_Sprite

- T6963C_Set_Cursor

Note: The following low level library routines are implemented as macros. These
macros can be found in the T6963C.h header file which is located in the T6963C

example projects folders.

- T6963C_DisplayGrPanel
- T6963C_DisplayTxtPanel
- T6963C_SetGrPanel

- T6963C_SetTxtPanel

- T6963C_PanelFill

- T6963C_GrFill

- T6963C_TxtFill

- T6963C_Cursor_Height
- T6963C_Graphics

- T6963C_Text

- T6963C_Cursor

- T6963C_Cursor_Blink
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T6963C_Init

Prototype procedure T6963C _init (width, height, fntW : byte);

Returns Nothing.

Initalizes the Graphic Lcd controller.
Parameters :

- width: width of the Glcd panel
- height: height of the Glcd panel
- fntw: font width

Display RAM organization:
The library cuts the RAM into panels : a complete panel is one graphics panel
followed by a text panel (see schematic below).

schematic:
Fm + /\
R + GRAPHICS PANEL #0 + |
Description | P
+ +
+ +
R e T + | PANEL O
+ TEXT PANEL # +
+ +\/
Fm + /\
+ GRAPHICS PANEL #1 +
+ +
+ +
+ +
R e T + | PANEL 1
+ TEXT PANEL #1 +
+ +
fom + \/

Global variables :

- 76963C dataport: Data Port

- T6963C ctrlwr: Write signal pin

- T6963C ctrlrd: Read signal pin

- T6963C ctrlcd: Command/Data signal pin

Requires - T6963C ctrlrst: Reset signal pin

- T6963C ctrlwr Direction: Direction of Write signal pin

- T6963C ctrlrd Direction: Direction of Read signal pin

- T6963C ctrled Direction: Direction of Command/Data signal pin
- T6963C ctrlrst Direction: Direction of Reset signal pin

must be defined before using this function.
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// T6963C module connections
var T6963C dataPort byte at PORTD;
var T6963C ctrlwr sbit at RC2 bit;
var T6963C ctrlrd sbit at RC1 bit;
var T6963C ctrlcd sbit at RCO bit;
var T6963C ctrlrst sbit at RC4 bit;
var T6963C ctrlwr Direction sbit at TRISC2Z bit;

Example var T6963C ctrlrd Direction sbit at TRISCl bit;
var T6963C ctrlcd Direction sbit at TRISCO bit;
var T6963C ctrlrst Direction sbit at TRISC4 bit;
// End of T6963C module connections
// init display for 240 pixel width, 128 pixel height and 8 bits
character width
T6963C _init (240, 128, 8);

T6963C_WriteData

Prototype procedure T6963C WriteData (mydata byte) ;
Returns Nothing.
Writes data to T6963C controller.
Description |Parameters :
- mydata: data to be written
Requires Toshiba Glcd module needs to be initialized. See the T6963C _Init routine.
Example T6963C WriteData (AddrL) ;

T6963C_WriteCommand

Prokﬂype procedure T6963C WriteCommand (mydata byte) ;
Returns Nothing.
Writes command to T6963C controller.
Description |[Parameters :
- mydata: command to be written
Requires Toshiba Glcd module needs to be initialized. See the T6963C _Init routine.
Example T6963C_ WriteCommand (T6963C CURSOR POINTER SET) ;
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T6963C_SetPtr

Prototype procedure T6963C SetPtr(p : word; c : byte);

Returns Nothing.
Sets the memory pointer p for command c.

e Parameters :

Description
- p: address where command should be written
- ¢: command to be written

Requires Toshiba Glcd module needs to be initialized. See the T6963C _Init routine.
T6963C SetPtr (T6963C grHomeAddr + start,

Example - =

T6963C ADDRESS POINTER SET);

T6963C_WaitReady

Prototype procedure T6963C WaitReady () ;
Returns Nothing.
Description |Pools the status byte, and loops until Toshiba Glcd module is ready.
Requires Toshiba Glcd module needs to be initialized. See the T6963C _Init routine.
Example T6963C WaitReady () ;
T6963C_Fill
Prototype procedure T6963C Fill(v : byte; start, len : word);
Returns Nothing.
Fills controller memory block with given byte.
Parameters :
Description
- v: byte to be written
- start: starting address of the memory block
- len: length of the memory block in bytes
Requires Toshiba Glcd module needs to be initialized. See the T6963C_Init routine.
Example T6963C Fill (0x33,0x00FF, 0x000F) ;
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T6963C_Dot
Prototype procedure T6963C Dot (x, y : integer; color : byte);
Returns Nothing.
Draws a dot in the current graphic panel of Glcd at coordinates (x, y).
Parameters :
Description
- x: dot position on x-axis
- v: dot position on y-axis
- color: color parameter. Valid values: T6963C_ BLACK and T6963C_WHITE
Requires Toshiba Glcd module needs to be initialized. See the T6963C _Init routine.
Example T6963C Dot (x0, y0, pcolor);
T6963C_Write_Char
Prototype procedure T6963C Write Char(c, x, y, mode : byte);
Returns Nothing.
Writes a char in the current text panel of Glcd at coordinates (x, y).
Parameters :
- c: char to be written
- x: char position on x-axis
- v: char position on y-axis
- mode: mode parameter. Valid values: T6963C_ROM_MODE_OR,
T6963C_ROM_MODE_XOR, T6963C_ROM_MODE_AND and
T6963C_ROM_MODE_TEXT
Mode parameter explanation:
Description
- OR Mode: In the OR-Mode, text and graphics can be displayed and the data
is logically “OR-ed”. This is the most common way of combining text and
graphics for example labels on buttons.
- XOR-Mode: In this mode, the text and graphics data are combined via the
logical “exclusive OR”. This can be useful to display text in the negative mode,
i.e. white text on black background.
- AND-Mode: The text and graphic data shown on display are combined via the
logical “AND function”.
- TEXT-Mode: This option is only available when displaying just a text. The Text
Attribute values are stored in the graphic area of display memory.
For more details see the T6963C datasheet.
Requires Toshiba Glcd module needs to be initialized. See the T6963C_Init routine.
Example T6963C Write Char ('A',22,23,AND);
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T6963C_Write_Text

procedure T6963C Write Text (var str : arrayl 10] of byte; x, vy,
mode : byte);

Prototype

Returns Nothing.

Writes text in the current text panel of Glcd at coordinates (x, y).
Parameters :

- str: text to be written

- x: text position on x-axis

- v: text position on y-axis

- mode: mode parameter. Valid values: T6963C_ROM_MODE_OR,
T6963C_ROM_MODE_XOR, T6963C_ROM_MODE_AND and
T6963C_ROM_MODE_TEXT

Mode parameter explanation:

Description

- OR Mode: In the OR-Mode, text and graphics can be displayed and the data
is logically “OR-ed”. This is the most common way of combining text and
graphics for example labels on buttons.

- XOR-Mode: In this mode, the text and graphics data are combined via the
logical “exclusive OR”. This can be useful to display text in the negative mode,
i.e. white text on black background.

- AND-Mode: The text and graphic data shown on display are combined via the
logical “AND function”.

- TEXT-Mode: This option is only available when displaying just a text. The Text
Attribute values are stored in the graphic area of display memory.

For more details see the T6963C datasheet.

Requires Toshiba Glcd module needs to be initialized. See the T6963C_Init routine.

T6963C Write Text (" Glcd LIBRARY DEMO, WELCOME !", 0, O,

Example T6963C_ROM MODE_XOR) ;
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T6963C_Line

Prototype procedure T6963C Line(x0, y0, x1, yl : integer; pcolor : byte);

Returns Nothing.

Draws a line from (x0, y0) to (x1, y1).
Parameters :

Description |- x0: x coordinate of the line start
- v0: y coordinate of the line end
- x1: x coordinate of the line start
- y1: y coordinate of the line end
- pcolor: color parameter. Valid values: T6963C_BLACK and T6963C_WHITE

Requires Toshiba Glcd module needs to be initialized. See the T6963C_Init routine.

Example T6963C_Line (0, 0, 239, 127, T6963C_WHITE);

T6963C_Rectangle

procedure T6963C Rectangle (x0, y0, x1, yl : integer; pcolor :

Prototype byte) ;

Returns Nothing.

Draws a rectangle on Glcd.
Parameters :

Description |- x0: x coordinate of the upper left rectangle corner

- y0: y coordinate of the upper left rectangle corner

- x1: x coordinate of the lower right rectangle corner

- y1: y coordinate of the lower right rectangle corner

- pcolor: color parameter. Valid values: T6963C_BLACK and T6963C_WHITE

Requires Toshiba Glcd module needs to be initialized. See the T6963C _Init routine.

Example T6963C Rectangle (20, 20, 219, 107, T6963C WHITE);
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T6963C_Box
Prototype procedure T6963C Box(x0, y0, x1, vyl integer; pcolor : byte);
Returns Nothing.

Draws a box on Glcd

Parameters :
Description |- x0: x coordinate of the upper left box corner

- y0: y coordinate of the upper left box corner

- x1: x coordinate of the lower right box corner

- y1: y coordinate of the lower right box corner

- pcolor: color parameter. Valid values: T6963C_BLACK and T6963C_WHITE
Requires Toshiba Glcd module needs to be initialized. See the T6963C _Init routine.
Example T6963C Box (0, 119, 239, 127, T6963C WHITE);
T6963C_Circle
Prototype procedure T6963C Circle(x, y : integer; r : longint; pcolor : word);
Returns Nothing.

Draws a circle on Glcd.

Parameters :
Description |_ = : X coordinate of the circle center

- v: y coordinate of the circle center

- r: radius size

- pcolor: color parameter. Valid values: T6963C_BLACK and T6963C_WHITE
Requires Toshiba Glcd module needs to be initialized. See the T6963C_Init routine.
Example T6963C Circle (120, 64, 110, T6963C WHITE) ;
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T6963C_Image

Prototype procedure T6963C Image (const code pic : “byte);

Returns Nothing.

Displays bitmap on Glcd.

Parameters :

- pic: image to be displayed. Bitmap array can be located in both code and
RAM memory (due to the mikroPascal PRO for PIC pointer to const and

Description | pointer to RAM equivalency).

Use the mikroPascal’s integrated Glcd Bitmap Editor (menu option Tools > Glcd

Bitmap Editor) to convert image to a constant array suitable for displaying on

Glcd.

Note: Image dimension must match the display dimension.

Requires Toshiba Glcd module needs to be initialized. See the T6963C_Init routine.

Example T6963C_Image (mc);

T6963C_Sprite

procedure T6963C Sprite(px, py : byte; const pic : "“byte; sx, sy
: byte);

Prototype

Returns Nothing.

Fills graphic rectangle area (px, py) to (px+sx, py+sy) with custom size picture.
Parameters :

- px: X coordinate of the upper left picture corner. Valid values: multiples of the
font width

Description |- ov: y coordinate of the upper left picture corner

- pic: picture to be displayed

- sx: picture width. Valid values: multiples of the font width

- sy: picture height

Note: If px and sx parameters are not multiples of the font width they will be
scaled to the nearest lower number that is a multiple of the font width.

Requires Toshiba Glcd module needs to be initialized. See the T6963C_Init routine.

Example T6963C Sprite (76, 4, einstein, 88, 119); // draw a sprite
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T6963C_Set_Cursor

Prototype procedure T6963C_Set Cursor(x, y : byte);

Returns Nothing.

Sets cursor to row x and column vy.

o Parameters :
Description

- x: cursor position row number
- yv: cursor position column number

Requires Toshiba Glcd module needs to be initialized. See the T6963C_Init routine.

Example T6963C_Set Cursor (cposx, cposy);

T6963C_DisplayGrPanel

Proknype procedure T6963C DisplayGrPanel (n : byte);

Returns Nothing.

Display selected graphic panel.
Description |[Parameters :

- n: graphic panel number. Valid values: 0 and 1.

Requires Toshiba Glcd module needs to be initialized. See the T6963C_Init routine.

// display graphic panel 1

Exan“ﬂe T6963C DisplayGrPanel (1) ;

T6963C_DisplayTxtPanel

Prototype procedure T6963C DisplayTxtPanel (n : byte);

Returns Nothing.

Display selected text panel.
Description |Parameters :

- n: text panel number. Valid values: 0 and 1.

Requires Toshiba Glcd module needs to be initialized. See the T6963C _Init routine.

// display text panel 1

Exan“ﬂe T6963C DisplayTxtPanel (1) ;
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T6963C_SetGrPanel

Prototype procedure T6963C SetGrPanel(n : byte);

Returns Nothing.

Compute start address for selected graphic panel and set appropriate internal point-
ers. All subsequent graphic operations will be preformed at this graphic panel.

Description Parameters :
- n: graphic panel number. Valid values: 0 and 1.
Requires Toshiba Glcd module needs to be initialized. See the T6963C _Init routine.

// set graphic panel 1 as current graphic panel.

Example T6963C SetGrPanel (1) ;

T6963C_SetTxtPanel

Prototype procedure T6963C SetTxtPanel(n : byte);

Returns Nothing.

Compute start address for selected text panel and set appropriate internal point-
ers. All subsequent text operations will be preformed at this text panel.

Description Parameters :

- n: text panel number. Valid values: 0 and 1.

Requires Toshiba Glcd module needs to be initialized. See the T6963C_Init routine.

// set text panel 1 as current text panel.

Example T6963C SetTxtPanel (1);

T6963C_PanelFill

Prototype |procedure T6963C PanelFill (v : byte);

Returns Nothing.

Fill current panel in full (graphic+text) with appropriate value (0 to clear).
Description |Parameters :

- v: value to fill panel with.

Requires Toshiba Glcd module needs to be initialized. See the T6963C_Init routine.

clear current panel

Example T6963C_PanelFill (0);
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T6963C_GrFill
Prototype procedure T6963C GrFill(v : byte);
Returns Nothing.
Fill current graphic panel with appropriate value (0 to clear).
Description |Parameters :
- v: value to fill graphic panel with.
Requires Toshiba Glcd module needs to be initialized. See the T6963C_Init routine.
// clear current graphic panel
Example T6963C_GrFill (0);

T6963C_TxtFill

Prototype procedure T6963C TxtFill(v : byte);
Returns Nothing.
Fill current text panel with appropriate value (0 to clear).
Description |Parameters :
- v: this value increased by 32 will be used to fill text panel.
Requires Toshiba Glcd module needs to be initialized. See the T6963C_Init routine.
Example // clear current text panel

T6963C TxtFill (0);

T6963C_Cursor_Height

Prokﬂype procedure T6963C Cursor Height(n : byte);
Returns Nothing.
Set cursor size.
Description |Parameters :
- n: cursor height. Valid values: 0. .7.
Requires Toshiba Glcd module needs to be initialized. See the T6963C _Init routine.
Example T6963C_Cursor Height (7);
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T6963C_Graphics

Prototype procedure T6963C Graphics(n : byte);

Returns Nothing.

Enable/disable graphic displaying.

Description Parameters :
- n: on/off parameter. Valid values: 0 (disable graphic dispaying) and 1 (enable
graphic displaying).
Requires Toshiba Glcd module needs to be initialized. See the T6963C_Init routine.
Example // enable graphic displaying

T6963C Graphics(1l);

T6963C_Text

Prototype procedure T6963C Text(n : byte);

Returns Nothing.

Enable/disable text displaying.

o Parameters :
Description

- n: on/off parameter. Valid values: 0 (disable text dispaying) and 1 (enable text
displaying).

Requires Toshiba Glcd module needs to be initialized. See the T6963C_Init routine.

// enable text displaying

Example T6963C Text (1) ;

T6963C_Cursor

Prototype procedure T6963C Cursor(n : byte);

Returns Nothing.

Set cursor on/off.
Description |Parameters :

- n: on/off parameter. Valid values: 0 (set cursor off) and 1 (set cursor on).

Requires Toshiba Glcd module needs to be initialized. See the T6963C _Init routine.

// set cursor on

Example T6963C Cursor(1);
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T6963C_Cursor_Blink
Prototype procedure T6963C Cursor Blink(n : byte);

Returns Nothing.

Enable/disable cursor blinking.

A Parameters :
Description

- n: on/off parameter. Valid values: 0 (disable cursor blinking) and 1 (enable
cursor blinking).

Requires Toshiba Glcd module needs to be initialized. See the T6963C_Init routine.

// enable cursor blinking

Example T6963C Cursor Blink(1);

Library Example

The following drawing demo tests advanced routines of the T6963C Gilcd library. Hardware configura-
tions in this example are made for the T6963C 240x128 display, EasyPIC5 board and 16F887.

program T6963C 240x128;
uses Lib T6963C Consts, einstein bmp, mikroe bmp;

// T6963C module connections

var T6963C dataPort : byte at PORTD; // DATA port

var T6963C ctrlwr : sbit at RC2 bit; // WR write signal

var T6963C ctrlrd : sbit at RC1 bit; // RD read signal

var T6963C ctrlcd : sbit at RCO bit; // CD command/data signal
var T6963C ctrlrst : sbit at RC4 bit; // RST reset signal

var T6963C ctrlwr Direction : sbit at TRISC2 bit; // WR write signal direction
var T6963C ctrlrd Direction : sbit at TRISC1 bit; // RD read signal direction
var T6963C ctrlcd Direction : sbit at TRISCO bit; // CD command/data sig-
nal direction

var T6963C ctrlrst Direction : sbit at TRISC4 bit; // RST reset signal direction

// Signals not used by library, they are set in main function

var T6963C ctrlce : sbit at RC3 bit; // CE signal
var T6963C ctrlfs : sbit at RC6 bit; // FS signal
var T6963C ctrlmd : sbit at RC5 bit; // MD signal
var T6963C ctrlce Direction : sbit at TRISC3 bit; // CE signal direction
var T6963C ctrlfs Direction : sbit at TRISC6 bit; // FS signal direction
var T6963C ctrlmd Direction : sbit at TRISC5 bit; // MD signal direction

// End T6963C module connections
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var panel : byte; // current panel
i : word; // general purpose register
curs : byte; // cursor visibility
cposx,
cposy : word; // cursor x-y position
txtcols : byte; // number of text coloms

txt, txtl : string] 29];

begin
txtl := ' EINSTEIN WOULD HAVE LIKED mE';
txt := ' GLCD LIBRARY DEMO, WELCOME !';
ANSEL = 0; // Configure AN pins as digital I/O
ANSELH := 0;
CION bit := 0; // Disable comparators
C20N bit := 0;
TRISBO bit := 1; // Set RBO as input
TRISBl bit := 1; // Set RB1l as input
TRISB2 bit := 1; // Set RB2 as input
TRISB3 bit := 1; // Set RB3 as input
TRISB4 bit := 1; // Set RB4 as input
T6963C ctrlce Direction := 0;
T6963C_ctrlce := 0; // Enable T6963C
T6963C ctrlfs Direction := 0;
T6963C_ctrlfs := 0; // Font Select 8x8
T6963C ctrlmd Direction := 0;
T6963C_ctrlmd := 0; // Column number select
panel := 0;
i = 0;
curs := 0;
cposx := 0;
cposy := 0;

// Initialize T6369C
T6963C_init (240, 128, 8);

{ *
* Enable both graphics and text display at the same time
*}

T6963C graphics(1);

T6963C text(1);

{*

* Text messages

*}

T6963C write text(txt, 0, 0, T6963C ROM MODE XOR);
T6963C write text(txtl, 0, 15, T6963C ROM MODE XOR);
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{*
* Cursor

*}

T6963C cursor height (8); // 8 pixel height
T6963C_set cursor (0, 0); // Move cursor to top left
T6963C cursor (0); // Cursor off

{*
* Draw rectangles
*}

T6963C rectangle

T6963C rectangle

T6963C rectangle

T6963C rectangle

0, 0, 239, 127, T6963C_WHITE);
20, 20, 219, 107, T6963C_WHITE);
40, 40, 199, 87, T6963C_WHITE);
60, 60, 179, 67, T6963C WHITE);

{*

* Draw a Ccross

*}

T6963C line (0, 0, 239, 127, T6963C WHITE);
T6963C line (0, 127, 239, 0, T6963C WHITE);

{*
* Draw solid boxes
*}
T6963C box (0, 0, 239, 8, T6963C WHITE);
T6963C box (0, 119, 239, 127, T6963C WHITE);
//while true do nop;
{*
* Draw circles
*}
T6963C circle (120, 64, 10, T6963C WHITE);
T6963C circle (120, 64, 30, T6963C WHITE);
T6963C circle (120, 64, 50, T6963C WHITE
T6963C circle (120, 64, 70, T6963C WHITE
(
(
(

)
)
)
)
T6963C circle (120, 64, 90, T6963C WHITE)
E
E

’

’

T6963C circle (120, 64, 110, T6963C WHIT

) ;
T6963C circle (120, 64, 130, T6963C WHITE)

T6963C sprite(76, 4, Qeinstein, 88, 119); // Draw a sprite

T6963C_setGrPanel (1); // Select other
graphic panel

T6963C sprite (0, O, @mikroe bmp, 240, 64);// 240x128 can't be
stored in most of PIC16 MCUs
T6963C_sprite (0, 64, @mikroe bmp, 240, 64);// it is replaced with
smaller picture 240x64
// Smaller
picture is drawn two times

520 MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



mikroPASCAL PRO for PIC

CHAPTER 7
Libraries
while (TRUE) do // Endless loop
begin
{ *
* If PORTA 0 is pressed, toggle the display between graphic
panel 0 and graphic 1

*}
if ( RBO bit <> 0) then
begin
T6963C graphics(1);
T6963C text (0);

Delay ms (300);
end

{ *

*

If PORTA 1 is pressed, display only graphic panel
*}

else
if ( RB1 bit <> 0) then
begin
Inc (panel) ;
panel := panel and 1;
T6963C setPtr ((T6963C grMemSize + T6963C txtMemSize) *
panel, T69 63C_GRAPHIC_HOME_ADDRESS_SET)

Delay ms (300)
end

’

{ *
*
*}

else

If PORTA 2 is pressed, display only text panel

if ( RB2 bit <> 0) then
begin
T6963C graphics(0)
T6963C text (1)

Delay ms (300)
end

’
’

’

{ *
* If PORTA 3 is pressed, display text and graphic panels
*}
else
if ( RB3 bit <> 0) then
begin
T6963C graphics (1)
T6963C text (1)

Delay ms (300)
end

’
’

’
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{ *
* If PORTA 4 is pressed, change cursor

*}

else
if( RB4 bit <> 0) then
begin
Inc(curs);
if (curs = 3) then
curs := 0;
case curs of
0:
// no cursor
T6963C cursor (0) ;
1: begin
// blinking cursor
T6963C cursor (1) ;
T6963C cursor blink(l) ;
end;
2: begin
// non blinking cursor
T6963C cursor (1) ;
T6963C cursor blink(0) ;
end;
end;
Delay ms(300) ;
end;

{ *
* Move cursor, even if not visible
*}

Inc (cposx) ;

if (cposx T6963C txtCols) then

begin
cposx := 0 ;
Inc (cposy) ;
if (cposy = T6963C grHeight / T6963C CHARACTER HEIGHT) then
cposy := 0 ;
end;

T6963C set cursor (cposx, cposy) ;

Delay ms (100) ;
end;
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UART LIBRARY

UART hardware module is available with a number of PIC MCUs. mikroPascal PRO for
PIC UART Library provides comfortable work with the Asynchronous (full duplex) mode.

You can easily communicate with other devices via RS-232 protocol (for example
with PC, see the figure at the end of the topic — RS-232 HW connection). You need
a PIC MCU with hardware integrated UART, for example 16F887. Then, simply use
the functions listed below.

Note: Some PIC18 MCUs have multiple UART modules. Switching between the
UART modules in the UART library is done by the UART_Set_Active function (UART
module has to be previously initialized).

Note: In order to use the desired UART library routine, simply change the number
1 in the prototype with the appropriate module number, i.e. UART2 TInit (2400);

Library Routines

- UART1_Init

- UART1_Data_Ready
- UART1_Tx_Idle

- UART1_Read

- UART1_Read_Text

- UART1_Write

- UART1_Write_Text

- UART_Set_Active
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UART1_Init
Prototype procedure UART1 Init(baud rate: longint);
Returns Nothing.
Initializes hardware UART module with the desired baud rate. Refer to the
device data sheet for baud rates allowed for specific Fosc. If you specify the
unsupported baud rate, compiler will report an error.
Description |[Parameters :
- baud rate: requested baud rate
Refer to the device data sheet for baud rates allowed for specific Fosc.
You'll need PIC MCU with hardware UART.
UART1 Init needs to be called before using other functions from UART Library.
Requires Note: Calculation of the UART baud rate value is carried out by the compiler, as
it would produce a relatively large code if performed on the libary level.
Therefore, compiler needs to know the value of the parameter in the compile
time. That is why this parameter needs to be a constant, and not a variable.
This will initialize hardware UART1 module and establish the communication at
Example 2400 bps:
UART1 Tnit (2400);
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UART1_Data_Ready

Prototype function UART1 Data Ready(): byte;

Returns Function returns 1 if data is ready or 0 if there is no data.

Description |The function tests if data in receive buffer is ready for reading.

MCU with the UART module.

Requires The UART module must be initialized before using this routine. See the

UART_lInit routine.

var receive: byte;

Example // read data if ready
if (UART1 Data Ready() = 1) then
receive := UART1 Read();

UART1_Tx_Idle

Prototype function UART1 Tx Idle(): byte

- 1 if the data has been transmitted

Returns .
- 0 otherwise

Description |Use the function to test if the transmit shift register is empty or not.

UART HW module must be initialized and communication established before

Requires . . : :
q using this function. See UART1_Init.
// If the previous data has been shifted out, send next data:
if (UART1 Tx Idle() <> 0)
Example begin

end;
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UART1_Read
Prototype function UART1 Read(): byte;
Returns Received byte.
Description The function receives a byte via UART. Use the UART1_Data_Ready function

to test if data is ready first.
MCU with the UART module.

Requires The UART module must be initialized before using this routine. See UART1_Init

routine.

var receive: byte;

Example // read data if ready
if (UART1 Data Ready() = 1) then
receive := UART1 Read();

UART1_Read_Text

procedure UART1 Read Text (var Output, Delimiter : arrayl 255] of
byte; Attempts : byte);

Prototype

Returns Nothing.

Reads characters received via UART until the delimiter sequence is detected.
The read sequence is stored in the parameter output; delimiter sequence is
stored in the parameter delimiter.

Description This is a blocking call: the delimiter sequence is expected, otherwise the proce-
dure exits( if the delimiter is not found). Parameter 2t tempts defines number of
received characters in which pelimiter sequence is expected. If Attempts is
set to 255, this routine will continuously try to detect the pe1imiter sequence.

UART HW module must be initialized and communication established before

Requires using this function. See UART1_Init.

Read text until the sequence “OK” is received, and send back what’'s been received:

UART1 Init(4800); // initialize UART module
Delay ms (100);

while TRUE do
begin
Example if (UART1 Data Ready ()
begin
UART1 Read Text (output, 'delim', 10); // reads text
until 'delim' is found
UART1 Write Text (output); // sends back text
end;
end;

1) then // 1f data is received
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UART1_Write

Prototype procedure UART1 Write (TxData: byte);

Returns Nothing.

The function transmits a byte via the UART module.
Description |Parameters :

- TxData: data to be sent
MCU with the UART module.

Requires The UART module must be initialized before using this routine. See UART1_Init
routine.
var data : byte;

Example C’iét;a := 0x1E

UART1 Write(data );

UART1_Write_Text

Prototype procedure UART1 Write Text (var uart text : arrayl 255]) of byte);

Returns Nothing.

Description |Sends text (parameter uvart text) via UART. Text should be zero terminated.

UART HW module must be initialized and communication established before

Requires | sing this function. See UART1_Init.

Read text until the sequence “OK” is received, and send back what's been received:

UART1 Init (4800); // initialize UART module
Delay ms (100);

while TRUE do
begin
if (UART1 Data Ready() = 1) then // if data is received
begin
UART1 Read Text (output, 'delim', 10); // reads text
until 'delim' is found
UART1 Write Text (output); // sends back text
end;
end;

Example
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UART_Set_Active

procedure UART Set Active (read ptr : "Tread ptr; write ptr :
Prokﬂype *"Twrite ptr; ready ptr : "Tready ptr; tx idle ptr :
"Ttx idle ptr);
Returns Nothing.
Sets active UART module which will be used by the UART library routines.
Parameters :
Description |_ read ptr: UART1_Read handler
-write ptr: UART1_Write handler
- ready ptr: UART1_Data_Ready handler
- tx idle ptr: UART1_Tx_ldle handler
Routine is available only for MCUs with two UART modules.
Requires Used UART module must be initialized before using this routine. See
UART1_Init routine
// Activate UART2 module
Example UART Set Active (RUART1 Read, QUART1 Write, QUART1 Data Ready,
QUART1 Tx Idle);

Library Example

This example demonstrates simple data exchange via UART. If MCU is connected to the PC, you
can test the example from the mikroPascal PRO for PIC USART Terminal.

program UART;

var uart rd

begin

UARTL Init (9600);
Delay ms (100);

: byte;

while (TRUE) do // Endless loop
begin
if (UART1 Data Ready() <> 0) then // If data is received,
begin
uart rd := UART1 Read(); // read the received data,
UART1 Write (uart rd); // and send data via UART
end;
end;
end.

// Initialize UART module at 9600 bps
// Wait for UART module to stabilize
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HW Connection
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USB HID LIBRARY

Universal Serial Bus (USB) provides a serial bus standard for connecting a wide variety of
devices, including computers, cell phones, game consoles, PDA’s, etc.

mikroPascal PRO for PIC includes a library for working with human interface devices via Univer-
sal Serial Bus. A human interface device or HID is a type of computer device that interacts direct-
ly with and takes input from humans, such as the keyboard, mouse, graphics tablet, and the like.

Descriptor File

Each project based on the USB HID library should include a descriptor source file which contains
vendor id and name, product id and name, report length, and other relevant information. To cre-
ate a descriptor file, use the integrated USB HID terminal of mikroPascal PRO for PIC (Tools >
USB HID Terminal). The default name for descriptor file is USBdsc.ppas, but you may rename it.

The provided code in the “Examples” folder works at 48MHz, and the flags should not be modi-
fied without consulting the appropriate datasheet first.

Library Routines

- Hid_Enable
- Hid_Read
- Hid_Write
- Hid_Disable

Hid_Enable

Prototype procedure Hid Enable (readbuff, writebuff : word);

Returns Nothing.

Enables USB HID communication. Parameters recadbuff and writebuff are
the addresses of Read Buffer and the Write Buffer, respectively, which are used
Description |for HID communication. You can pass buffer names with the @ operator.

This function needs to be called before using other routines of USB HID Library.

Requires Nothing.

Example Hid Enable (@rd, Qwr);
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Hid_Read
Prototype function Hid Read() : byte;
Returns Number of characters in the Read Buffer received from the host.

Receives message from host and stores it in the Read Buffer. Function returns
the number of characters received in the Read Buffer.

Requires USB HID needs to be enabled before using this function. See Hid_Enable.

Description

Example length := Hid Read();

Hid_Write

Prototype procedure Hid Write(writebuff : word, len : byte);

Returns Nothing.

Function sends data from Write Buffer writebuff to host. Write Buffer is the
address of the parameter used in initialization; see Hid_Enable. You can pass a
buffer name with the @ operator. Parameter len should specify a length of the
data to be transmitted.

Description

Requires USB HID needs to be enabled before using this function. See Hid_Enable.

Example Hid Write (Qwr, len);

Hid_Disable

Prototype procedure Hid Disable();

Returns Nothing.

Description |Disables USB HID communication.

Requires USB HID needs to be enabled before using this function. See Hid_Enable.

Example Hid Disable();

Library Example

This example establishes connection with the HID terminal that is active on the PC. Upon con-
nection establishment, the HID Device Name will appear in the respective window. After that soft-
ware will wait for data and it will return received data back. Examples uses USBdsc descriptor file,
which is in the same folder, and can be created by the HID Terminal.
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program USB HID test;
uses USBdsc;

var
k, i, ch . byte;
userWR buffer : arrayl 64] of byte;
userRD buffer : arrayl 64] of byte;

// Main Interrupt Routine
procedure interrupt;
begin

HID InterruptProc;
end;

// Initialization Routine
procedure Init Main;

begin

// Disable interrupts

INTCON := 0; // Disable GIE, PEIE,
TMROIE, INTOIE,RBIE

INTCON2 := O0xF5;

INTCON3 = 0xCO;

RCON.IPEN := 0; // Disable Priority Levels on interrupts

PIE1 := 0;

PIE2 := 0;

PIR1 := 0y

PIR2 := 0;

ADCON1 := ADCON1 or O0OxOF; // Configure all ports with ana-

log function as digital
// Ports Configuration

TRISA := OxFF;
TRISB := OxFF;
TRISC := OxFF;
TRISD := 0;
TRISE := 0x07;
LATA 0;
LATB := 0;
LATC := 0;
LATD := 0;
LATE := 0;
end;

// Main Program Routine
begin
Init_Main();
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HID Enable (@userRD buffer, (@userWR buffer);
Delay mS (1000) ;
Delay mS (1000) ;
while true do
begin
k := HID Read():;
i = 0;
while i < k do
begin
ch := userRD buffer| 0] ;
userWR buffer[ 0] := ch;
HID Write (QuserWR buffer, 1);
inc (i) ;
end;

end;

HID Disable();
end.

HW Connection
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MISCELLANEOUS LIBRARIES
- Button Library
- Conversions Library
- Math Library

- String Library

- Time Library

- Trigonometry Library

BUTTON LIBRARY

Button library contains miscellaneous routines useful for project development.

- Button

Button

Prokﬂype fu2§tz?n Button (var port : byte; pin, time, active state : byte)

Returns Returns 0 or 255.

Function eliminates the influence of contact flickering upon pressing a button
(debouncing).

Description |Parameter port specifies the location of the button; parameter pin is the pin
number on designated port and goes from 0..7; parameter + ine is a debounce
period in milliseconds; parameter active state can be either 0 or 1, and it
determines if the button is active upon logical zero or logical one.

Requires Button pin must be configured as input.

Example reads RBO, to which the button is connected; on transition from 1 to 0
(release of button), PORTD is inverted:

while true do

begin

Exanuﬂe if Button(PORTB, 0, 1, 1) then oldstate := 255;

if oldstate and Button (PORTB, 0, 1, 0) then
begin
PORTD := not (PORTD) ;
oldstate := 0;
end;
end;
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CONVERSIONS LIBRARY

mikroPascal PRO for PIC Conversions Library provides routines for numerals to strings and
BCD/decimal conversions.

Library Routines

You can get text representation of numerical value by passing it to one of the following routines:

- ByteToStr

- ShortToStr

- WordToStr

- IntToStr

- LongintToStr

- LongWordToStr
- FloatToStr

- StrTolnt

- StrToWord

The following functions convert decimal values to BCD and vice versa:
- Dec2Bcd

- Bcd2Dec16

- Dec2Bcd16

ByteToStr

Prokﬂype procedure ByteToStr (input : word; wvar output : arrayl 3] of char);

Returns Nothing.

Converts input byte to a string. The output string is right justified and remaining
positions on the left (if any) are filled with blanks.

Description |Parameters :

- input: byte to be converted
- output: destination string

Requires Nothing.

var t : word;
txt : arrayl 3] of char;
Example
t = 24;
ByteToStr (t, txt); // txt is " 24" (one blank here)
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WordToStr (t, txt); // txt is " 437" (two blanks here)

mikroPASCAL PRO for PIC Libraries

ShortToStr
Prototype procedure ShortToStr (input : short; war output : arrayl 4] of char);
Returns Nothing.

Converts input short (signed byte) number to a string. The output string is right

justified and remaining positions on the left (if any) are filled with blanks.
Description |Parameters :

- input: short number to be converted

- output : destination string
Requires Nothing.

var t : short;

txt : arrayl 4] of char;

Example -

t = =-24;

ByteToStr (t, txt); // txt is " -24" (one blank here)
WordToStr
Prokﬂype procedure WordToStr (input : word; wvar output : array[ 5] of char);
Returns Nothing.

Converts input word to a string. The output string is right justified and the

remaining positions on the left (if any) are filled with blanks.
Description |Parameters :

- input: word to be converted

- output : destination string
Requires Nothing.

var t : word;

arrayl 5] of char;

Example -

t := 437;
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IntToStr

Prototype procedure IntToStr (input : integer; var output : array 6] of char);

Returns Nothing.

Converts input integer number to a string. The output string is right justified and
the remaining positions on the left (if any) are filled with blanks.

Description |Parameters :

- input: integer number to be converted
- output: destination string

Requires Nothing.

var input : integer;
txt : string] 5] ;

VA
Example begin

input := -4220;

IntToStr (input, txt); // txt is ' -4220"'
LongintToStr

rocedure LongintToStr (input : longint; wvar output : arrayl 11] of
Prototype Ehar) - g ( P g b yl ]

Returns Nothing.

Converts input longint number to a string. The output string is right justified and
the remaining positions on the left (if any) are filled with blanks.

Description |[Parameters :

- input: longint number to be converted
- output: destination string

Requires Nothing.

var input : longint;
txt : array| 11] of char;
/]
Example begin
input := -12345678;
IntToStr (input, txt); // txt is ! -12345678"
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LongWordToStr
procedure LongWordToStr (input : dword; wvar output : array| 10] of
Prototype char) ;
Returns Nothing.

Converts input double word number to a string. The output string is right justi-
fied and the remaining positions on the left (if any) are filled with blanks.

Description |Parameters :

- input : double word number to be converted
- output : destination string

Requires Nothing.

var input : longint;
txt : arrayl 10] of char;
/]
Example begin
input := 12345678;
IntToStr (input, txt); // txt is ! 12345678"
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FloatToStr
Prototype procedure FloatToStr (input : real; var output : arrayl 23] of char);
- 3 if input number is NaN
Returns - 2 if input number is -INF
- 1 if input number is +INF
- 0 if conversion was successful
Converts a floating point number to a string.
Parameters :
- input: floating point number to be converted
Description |- cutput: destination string
The output string is left justified and null terminated after the last digit.
Note: Given floating point number will be truncated to 7 most significant digits
before conversion.
Requires Nothing.
var ffl, ff2, ff3 : real;
txt : array| 23] of char;
ffl 1= -374.2;
E I ff2 := 123.456789;
Xample ££3 := 0.000001234;
FloatToStr (ff1l, txt); // txt is "-374.2"
FloatToStr (ff2, txt); // txt is "123.4567"
FloatToStr (f£f3, txt); // txt is "1.234e-6"
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StrToint
Prototype function StrTolnt (var input:stringl 6] ):integer;
Returns Integer variable.
Description |[Converts a string to integer.
Requires The string is assumed to be a correct representation of a number.
var ii:integer
Example begin
ii := StrToInt ('-1234");
StrToWord
Prokﬂype function StrToWord(var input:stringl 5] ) :word;
Returns Word variable.
Description |Converts a string to word.
Requires input string with length of max 5 chars.
q The string is assumed to be a correct representation of a number.
var ww:word;
Example begin
ww := StrToword('65432");
Dec2Bcd
Prokﬂype function Dec2Bcd(decnum : byte) : byte;
Returns Converted BCD value.
Converts input number to its appropriate BCD representation.
Description |Parameters :
- decnum: number to be converted
Requires Nothing.
var a, b : byte;
Example o iz 22
b := Dec2Bcd(a); // b equals 34
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Bcd2Dec16
Prototype function Bcd2Decl6 (bcdnum : word) : word;
Returns Converted decimal value.

Converts 16-bit BCD numeral to its decimal equivalent.
Description |Parameters :

- bednum: 16-bit BCD numeral to be converted

Requires Nothing.

var a, b : word;
Example a := 0x1234; // a equals 4660

b := Bcd2Declé6(a); // b equals 1234
Dec2Bcd16
Prototype function Dec2Bcdl6 (decnum : word) : word;
Returns Converted BCD value.

Converts decimal value to its BCD equivalent.
Description |Parameters :

- decnum decimal number to be converted

Requires Nothing.

var a, b : word;
Example iz 2345,
b := Dec2Bcdlé6 (a); // b equals 9029
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MATH LIBRARY

The mikroPascal PRO for PIC provides a set of library functions for floating point math handling.
See also Predefined Globals and Constants for the list of predefined math constants.

Library Functions

- acos
- asin

- atan
- atan2
- ceill

- COS

- cosh
- eval_poly
- exp

- fabs
- floor
- frexp
- Idexp
- log

- log10
- modf
- pow
- sin

- sinh

- sqrt

- tan

- tanh

acos

Prototype function acos(x : real) : real;

The function returns the arc cosine of parameter x; that is, the value whose
Description |cosine is x. The input parameter x must be between -1 and 1 (inclusive). The
return value is in radians, between 0 and I1 (inclusive).

asin

Prototype function asin(x : real) : real;

The function returns the arc sine of parameter x; that is, the value whose sine is
Description |x. The input parameter x must be between -1 and 1 (inclusive). The return value
is in radians, between -I1/2 and I1/2 (inclusive).
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atan
Prototype function atan(arg : real) real;
Description The function computes the arc tangent of parameter arg; that is, the value whose
P tangent is arg. The return value is in radians, between -1/2 and /2 (inclusive).
atan2
Prototype function atan2(y : real; x : real) real;
This is the two-argument arc tangent function. It is similar to computing the arc
Description tangent of v/x, except that the signs of both arguments are used to determine
P the quadrant of the result and = is permitted to be zero. The return value is in
radians, between -I1 and I1 (inclusive).
ceil
Prototype function ceil(x : real) : real;
Description | The function returns value of parameter = rounded up to the next whole number.
cos
Prototype function cos(arg : real) real;
Description | The function returns the cosine of arg in radians. The return value is from -1 to 1.
cosh
Prototype function cosh (x real) : real;
Description The function returns the hyperbolic cosine of x, defined mathematically as
P (e*+e™ %) /2. If the value of x is too large (if overflow occurs), the function fails.
eval_poly
Prototype functi:on eya.tlipoly (x : real; wvar d : arrayl 10] of real; n : inte-
ger) : real;
. L Function Calculates polynom for number x, with coefficients stored in [ 1, for
Description
degree n.
exp
Prototype function exp(x : real) real;
I The function returns the value of e — the base of natural logarithms — raised to
Description .
the power x (i.e. e¥).
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fabs
Prototype |function fabs(d : real) : real;

Description | The function returns the absolute (i.e. positive) value of 4.

floor

Prototype function floor(x : real) : real;

Description | The function returns the value of parameter x rounded down to the nearest integer.

frexp

Prototype function frexp(value : real; var eptr : integer) : real;

The function splits a floating-point value value into a normalized fraction and an
Description |integral power of 2. The return value is a normalized fraction and the integer
exponent is stored in the object pointed to by eptr.

Idexp
Prototype function ldexp(value : real; newexp : integer) : real;
- The function returns the result of multiplying the floating-point number value by
Description ; . ‘
2 raised to the power newexp (i.e. returns value » 20EWexP),
log
Prototype function log(x : real) : real;

Description | The function returns the natural logarithm of x (i.e. log. (x)).

log10

Prototype function loglO(x : real) : real;

Description | The function returns the base-10 logarithm of « (i.e. 1og; (x)).

modf
Prototype function modf (val : real; wvar iptr : real) : real;
i The function returns the signed fractional component of va1, placing its whole
Description . . ) ,
number component into the variable pointed to by iptr.
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pow
Prototype function pow(x : real; y : real) : real;
Description The function r_eturn.s the valug of x raised _to the poyver y (i.e. xY). If x is nega-
tive, the function will automatically cast y into 1ongint.

sin

Prototype function sin(arg : real) : real;

Description [ The function returns the sine of arg in radians. The return value is from -1 to 1.

sinh

Pl'OtOtype function sinh(x : real) : real;

Description The function returns the hyperbolic sine of %, defined mathematically as (e*-
%) /2. If the value of x is too large (if overflow occurs), the function fails.

sqrt

Prototype function sqrt(x : real) : real;

Description | The function returns the non negative square root of x.

tan

Prototype function tan(x : real) : real;

Description The function returns the tangent of x in radians. The return value spans the
P allowed range of floating point in mikroPascal PRO for PIC.

tanh

Prototype function tanh(x : real) : real;

Description The function returns the hyperbolic tangent of =, defined mathematically as

sinh (x) /cosh (x) .

546 MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



CHAPTER 7
mikroPASCAL PRO for PIC Libraries

STRING LIBRARY

The mikroPascal PRO for PIC includes a library which automatizes string related tasks.
Library Functions

- memchr
- memcmp
- memcpy
- memmove
- memset
- strcat

- strchr

- strcmp

- strcpy

- strlen

- strncat

- strncpy

- strspn

- strcspn

- strncmp
- strpbrk

- strrchr

- strstr

memchr

Prototype function memchr (p : “byte; ch : byte; n : word) : word;

The function locates the first occurrence of the word ch in the initial n words of
memory area starting at the address p. The function returns the offset of this
occurrence from the memory address p or 0xrrrF if ch was not found.
Description
For the parameter p you can use either a numerical value (literal/variable/con-
stant) indicating memory address or a dereferenced value of an object, for
example @mystring Or @PORTB.
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memcmp
Prototype function memcmp (pl, p2 : "“byte; n : word) : short;

The function returns a positive, negative, or zero value indicating the relation-
ship of first n words of memory areas starting at addresses p1 and p2.

This function compares two memory areas starting at addresses o1 and p2 for n
words and returns a value indicating their relationship as follows:

Value Meaning

<0 pl "less than" p2
Description |~ ¢ pl "equal to" p2

> 0 pl "greater than" p2

The value returned by the function is determined by the difference between the
values of the first pair of words that differ in the strings being compared.

For parameters p1 and p2 you can use either a numerical value (literal/vari-
able/constant) indicating memory address or a dereferenced value of an object,
for example émystring Or @ PORTB.

memcpy

Prototype procedure memcpy (pl, p2 : “byte; nn : word);

The function copies nn words from the memory area starting at the address p2
to the memory area starting at p1. If these memory buffers overlap, the memcpy
function cannot guarantee that words are copied before being overwritten. If

o these buffers do overlap, use the memmove function.

Description
For parameters p1 and p2 you can use either a numerical value (literal/vari-
able/constant) indicating memory address or a dereferenced value of an object,
for example @mystring Or @PORTE.

memmove

Prototype procedure memmove (pl, p2 : “byte; nn : word);

The function copies nn words from the memory area starting at the address p2
to the memory area starting at o 1. If these memory buffers overlap, the Memmove
function ensures that the words in p2 are copied to o1 before being overwritten.
Description
For parameters o1 and p2 you can use either a numerical value (literal/vari-
able/constant) indicating memory address or a dereferenced value of an object,
for example @mystring Or GPORTE.
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memset

Prototype procedure memset (p : “byte; character : byte; n : word);

The function fills the first n words in the memory area starting at the address p
with the value of word character.

Description For parameter p you can use either a numerical value (literal/variable/constant)
indicating memory address or a dereferenced value of an object, for example
@mystring OF @PORTB.

strcat

Prototype procedure strcat(var sl, s2 : string] 100]);

The function appends the value of string s2 to string s1 and terminates s1 with

Description
P a null character.
strchr
Prototype function strchr(var s : stringf 100] ; ch : byte) : word;
The function searches the string s for the first occurrence of the character ch.
The null character terminating s is not included in the search.
Description
The function returns the position (index) of the first character ch found in s; if no
matching character was found, the function returns 0xrrrr.
strcmp
Prototype function strcmp(var sl, s2 : stringf{ 100]) : short;
The function lexicographically compares the contents of the strings s1 and s2
and returns a value indicating their relationship:
Value Meaning
L. < 0 sl "less than" s2
Description | _ s1 "equal to" s2
> 0 sl "greater than" s2

The value returned by the function is determined by the difference between the
values of the first pair of words that differ in the strings being compared.
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strcpy
Prototype procedure strcpy(var sl, s2 : string] 100]);
I The function copies the value of the string s2 to the string =1 and appends a
Description
null character to the end of s1.
strcspn
Prototype function strcspn(var sl, s2 : stringf 100]) : word;
The function searches the string s1 for any of the characters in the string s2.
o . The function returns the index of the first character located in s1 that matches
Description ; ! : ,
any character in s2. If the first character in s1 matches a character in s2, a
value of 0 is returned. If there are no matching characters in s1, the length of
the string is returned (not including the terminating null character).
strlen
Prototype function strlen(var s : string] 100]) : word;
. The function returns the length, in words, of the string s. The length does not
Description |. o
include the null terminating character.
strncat
Prototype procedure strncat (var sl, s2 : stringl 100]; size : byte);
The function appends at most size characters from the string s2 to the string s1
Description |and terminates s1 with a null character. If s2 is shorter than the size charac-
ters, s2 is copied up to and including the null terminating character.
strncmp
Prototype function strncmp(var sl, s2 : stringl 100]; len : byte) : short;
The function lexicographically compares the first 1en words of the strings s1 and
s2 and returns a value indicating their relationship:
Value Meaning
< 0 sl "less than" s2
Description =0 sl "equal to" s2
> 0 sl "greater than" s2

The value returned by the function is determined by the difference between the
values of the first pair of words that differ in the strings being compared (within
first 1en words).
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strncpy
Prototype procedure strncpy(var sl, s2 : stringl 100]; size : word);

Description

The function copies at most size characters from the string =2 to the string s1.
If s2 contains fewer characters than size, s1 is padded out with null characters
up to the total length of the size characters.

strpbrk
Prototype function strpbrk(var sl, s2 : string[ 100]) : word;
The function searches s1 for the first occurrence of any character from the
. string s2. The null terminator is not included in the search. The function returns
Description . . . .
an index of the matching character in s1. If s1 contains no characters from s2,
the function returns 0xFrrF.
strrchr
Prototype function strrchr(var s : string[ 100]; ch : byte) : word;
The function searches the string s for the last occurrence of the character ch.
Describtion The null character terminating s is not included in the search. The function
P returns an index of the last ch found in s; if no matching character was found,
the function returns 0xrrrF.
strspn
Prototype function strspn(var sl, s2 : string[ 100]) : byte;
The function searches the string s1 for characters not found in the s2 string.
Describtion The function returns the index of first character located in =1 that does not
P match a character in s2. If the first character in s1 does not match a character in
s2, a value of 0 is returned. If all characters in s1 are found in s2, the length of
s1 is returned (not including the terminating null character).
strstr
Prototype function strstr(var sl, s2 : stringf 100]) : word;
The function locates the first occurrence of the string s2 in the string s1 (exclud-
ing the terminating null character).
Description

The function returns a number indicating the position of the first occurrence of
s2 in s1; if no string was found, the function returns 0xrrer. If s2 is a null string,
the function returns o.
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TIME LIBRARY

The Time Library contains functions and type definitions for time calculations in the UNIX time for-
mat which counts the number of seconds since the "epoch”. This is very convenient for programs
that work with time intervals: the difference between two UNIX time values is a real-time differ-
ence measured in seconds.

What is the epoch?

Originally it was defined as the beginning of 1970 GMT. ( January 1, 1970 Julian day ) GMT,
Greenwich Mean Time, is a traditional term for the time zone in England.

The TimeStruct type is a structure type suitable for time and date storage.

Library Routines

- Time_dateToEpoch

- Time_epochToDate

- Time_datediff

Time_dateToEpoch

Prokﬂype function Time dateToEpoch(var ts : TimeStruct) : longint;

Returns Number of seconds since January 1, 1970 0hOOmnQO0s.
This function returns the UNIX time : number of seconds since January 1, 1970
0hO0OmMnNQOO0s.

Description Parameters :

- ts: time and date value for calculating UNIX time.

Requires Nothing.

var tsl : TimeStruct;

Epoch : longint;
Example ce
// what is the epoch of the date in ts ?
epoch := Time dateToEpoch (tsl);
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Time_epochToDate

Prototype procedure Time epochToDate (e: longint; wvar ts : TimeStruct);

Returns Nothing.

Converts the UNIX time to time and date.

o Parameters :
Description

- e: UNIX time (seconds since UNIX epoch)
- ts: time and date structure for storing conversion output

Requires Nothing.

var ts2 : TimeStruct;
epoch : longint;
Example //what date 1is epoch 1234567890 2
epoch := 1234567890;
TimeiepochToDate(epoch,tsZ);

Time_dateDiff

function Time dateDiff (tl : "TimeStruct; t2 : "TimeStruct)
Prototype 1 . -
ongint;
Returns Time difference in seconds as a signed long.
This function compares two dates and returns time difference in seconds as a
signed long. The result is positive if +1 is before t2, null if t1 is the same as 2
and negative if 1 is after 2.
Description

Parameters :

- £1: time and date structure (the first comparison parameter)
- £2: time and date structure (the second comparison parameter)

Requires Nothing.

var tsl, ts2 : TimeStruct;
diff : longint;
Exan“ﬂe //how many seconds between these two dates contained in tsl and
ts2 buffers?
diff := Time dateDiff (tsl, ts2);
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Library Example

Demonstration of Time library routines usage for time calculations in UNIX time format.
program Time Demo;
program Time Demo;

var epoch, diff : longint;

tsl, ts2 : TimeStruct;

begin
tsl.ss := 0;
tsl.mn := 7;
tsl.hh := 17;
tsl.md := 23;
tsl.mo := 5;
tsl.yy := 2006;

{*

* What is the epoch of the date in ts ?
*}

epoch := TimeidateToEpoch(tsl);

{*
* What date is epoch 1234567890 ?
*}

epoch := 1234567890;

Time epochToDate (epoch, ts2);

{*
* How much seconds between this two dates ?
*}

diff := Time dateDiff (tsl, ts2);

end.

TimeStruct type definition

type TimeStruct = record
ss : byte; // seconds
mn : byte; // minutes
hh : byte; // hours
md : byte; // day in month, from 1 to 31
wd : byte; // day in week, monday=0, tuesday=1, .... sunday=6
mo : byte; // month number, from 1 to 12 (and not from
0 to 11 as with unix C time !)
yy : word; // year Y2K compliant, from 1892 to 2038
end;
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TRIGONOMETRY LIBRARY

The mikroPascal PRO for PIC implements fundamental trigonometry functions. These functions
are implemented as look-up tables. Trigonometry functions are implemented in integer format in
order to save memory.

Library Routines

- sinE3
- cosE3

sinE3

Prototype function sinkE3(angle deg : word): integer;

Returns The function returns the sine of input parameter.

The function calculates sine multiplied by 1000 and rounded to the nearest integer:
result := round(sin(angle deg)*1000)

Description |Parameters:

- angle deg: input angle in degrees

Note: Return value range: -1000..1000.

Requires Nothing.

var res : integer;

Example S
res := sinE3(45); // result is 707
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cosE3

Prototype function cosE3(angle deg : word): integer;

Returns The function returns the cosine of input parameter.

The function calculates cosine multiplied by 1000 and rounded to the nearest
integer:

result := round(cos(angle deg)*1000)
Description
p Parameters:

- angle deg: input angle in degrees

Note: Return value range: -1000..1000.

Requires Nothing.

var res: integer;
Example
res := coskE3(196); // result is -193
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@Iasﬂ U

KomnaHus ((3J'IeKTpO|_|J'|aCT» npeanaraeT 3akKn4vyeHmne onrocpoYHbIX OTHOLLIEHUN npu
NOoCTaBKaxX MMMNOPTHbIX 3NTEKTPOHHbIX KOMMOHEHTOB Ha B3aMMOBbLIFO4HbIX yCJ'IOBI/lFlX!

Hawwn npeumyuiectsa:

e OnepaTuBHbIE NOCTABKM LUMPOKOrO CMeKTpa 3NeKTPOHHbIX KOMMNOHEHTOB OTEYECTBEHHOIO U
MMMOPTHOrO NPON3BOACTBA HANPAMYO OT MPOM3BOAMTENEN U C KPYNMHENLLNX MUPOBbLIX
CKNaaos.;

MocTaBka 6onee 17-TM MUNIIMOHOB HAMMEHOBAHWUIN 3NEKTPOHHbLIX KOMMNOHEHTOB;

MocTaBka CNoXHbIX, AeULNTHBIX, MMOO CHATLIX C MPOM3BOACTBA NO3ULIUIA;

OnepaTtunBHbIE CPOKM NOCTABKM Nof 3aka3 (0T 5 pabounx gHewn);

OKcnpecc goctaska B Nnobyto Touky Poccuu;

TexHnyeckas nogaepkka npoekTa, NomMoLLlb B nogdope aHanoros, NocTaBka NPOTOTUMOB;

Cuctema MeHeXMeHTa KavyecTBa cepTuduumnposaHa no MexayHapogHomy ctaHgapTty 1ISO

9001;

o JlnueHausa ®CH Ha ocyulecTBneHne paboT ¢ NCNONb30BaHWEM CBEOEHUIN, COCTABAOLLINX
rocygapCTBEHHYIO TalHy;

o [locTaBka cneumnanmampoBaHHbIX KOMNoHeHToB (Xilinx, Altera, Analog Devices, Intersil,
Interpoint, Microsemi, Aeroflex, Peregrine, Syfer, Eurofarad, Texas Instrument, Miteq,
Cobham, E2V, MA-COM, Hittite, Mini-Circuits,General Dynamics v gp.);

MoMMMO 3TOro, O4HMM M3 HanpaBnNeHU koMnaHum «AnekTpollnacT» ABNseTca HanpaBneHne

«UcTouHmkn nutaHua». Mel npeanaraem Bam nomoub KoHCTpyKTOpCKOro otaena:

e [logGop onTuManeHOro peleHus, TexHn4eckoe 060CHOBaHME Npu BbIOOpPE KOMMOHEHTA;
Monbop aHanoros.;
KoHcynbTaumm no NpUMEHEHMIO KOMMOHEHTA;
MocTaBka 06pa3yoB M NPOTOTUMNOB;
TexHn4veckasn noaaepka npoekTa;
3awmTa OT CHATMSA KOMMOHEHTA C NPON3BOACTBA.

Kak c Hamu cBfizaTbCcA

TenedoH: 8 (812) 309 58 32 (MHOrokaHanbHbIN)
Pakc: 8 (812) 320-02-42

OnekTpoHHas nouTta: org@eplastl.ru

Aapec: 198099, r. Cankt-INeTepbypr, yn. KannHuHa,
Oom 2, kopnyc 4, nutepa A.
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